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The information disclosed in this document, including all designs and related materials, is the 
valuable property of NEC Corporation (NEC) and /or its licensors.  NEC and/or its licensors, as 
appropriate, reserve all patent, copyright and other proprietary rights to this document, including all 
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Keep this User's Guide handy for quick reference when necessary. 

SAFETY INDICATIONS 

To use NEC Express5800 Series safely, follow the instructions in this User's Guide. 
 
This guide explains components that pose a danger, types of dangers caused by failing to follow the 
instructions, and actions taken to prevent them; such components are labeled warning. 
 
 
 
This guide and warning labels use “WARNING” and “CAUTION” to indicate a danger depending on 
the degree.  These terms are defined as follows: 
 

WARNING Indicates a danger that could lead to a death or serious injury. 

CAUTION Indicates a danger that could lead to a burn, other injuries or damage to 
physical assets. 

 
This guide uses the following three types of symbols to give indications and precautions against a 
danger.  They are defined as follows: 
 

 
Indicates that a failure to follow the instructions could cause a danger. Each image 
symbolizes a particular type of danger. (Attention) 

 
Indicates what you must not do. Each image symbolizes a particular type of 
prohibition. (Prohibited actions) 

 
Indicates what you must do. Each image symbolizes a particular type of action 
necessary to avoid a danger. (Mandatory actions) 

 
(Example) 

Symbol to draw attention 
 Term indicating a degree of danger 

 

 

 CAUTION   

   
 High temperature. 

 
Immediately after the power-off, system components such as hard disk are 
very hot. Wait the server to cool down completely before adding/removing 
some component. 

   
   
Symbol indicating a prohibited 
action (may not always be 
indicated) 

  Description of a danger  

 



 

SYMBOLS USED IN THIS USER'S GUIDE AND WARNING LABELS 

Attention 

 
Indicates a risk of an electric shock. 

 
Indicates a risk of an injury due to heat. 

 
Indicates a risk of catching your fingers. 

 
Indicates a risk of a fire or smoke. 

 
Indicates a general precaution or warning that are not defined herein. 

 
Indicates a risk of losing eyesight due to laser beam. 

 
Indicates a risk of an injury or damage to physical assets due to a hazardous material. 

 
Prohibited actions 

 
Indicates a general prohibition that is not defined herein. 

 

Do not disassemble, repair, or modify the equipment.  Otherwise, there is a risk of an 
electric shock or fire. 

 
Mandatory actions 

 
Unplug the server.  Otherwise, there is a risk of an electric shock or fire. 

 

Indicates a general action to take that is not defined herein.  Make sure to follow the 
instructions. 

 



 

 

NOTE:  This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference when the equipment is operated in a commercial 
environment.  This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instruction manual, may cause harmful interference to 
radio communications. Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his own expense. 

 

 
 

This class A digital apparatus meets all requirements of the Canadian Interference-Causing 
Equipment Regulations. 

Cet appareil numériqeu de la classe A respecte toutes les exigences du Règlement sur le matériel 
brouilleur du Canada. 

CE Statement 
Warning:  This is a Class A product. In residential environment, this product may cause radio 
interference, in which case the user may be required to take adequate measures (EN55022). 

 
NOTE: This product provides resistance against hardware faults with its redundant hardware 

modules.  However, this does not mean complete fault-tolerance is assured.  For 
example, there is a risk of system down when: 
– A fatal fault occurs in software. 
– Both modules within a redundant hardware pair break down. 
– A fatal fault occurs in a non-redundant component, such as the clock generator circuitry 

or the interconnect backplane.  
– The entire system is cut off from AC power. 

 
 



 

Trademarks 

NEC EXPRESSBUILDER, NEC ESMPRO, and NEC Express5800/ft series are trademarks of NEC 
Corporation. 

Stratus is a registered trademark of Stratus Technologies Bermuda Ltd. 

Microsoft, Windows, Windows NT, and MS-DOS are registered trademarks of Microsoft 
Corporation in the United States and other countries. 

Intel and Pentium are registered trademarks of Intel Corporation. 

AT is a registered trademark of International Business Machines Corporation in the United States 
and other countries. 

VERITAS is a registered trademark of VERITAS Software Corporation in the U.S. and other 
countries.  

The VERITAS logo and VERITAS Volume Manager are trademarks of VERITAS Software 
Corporation. 

Adobe, the Adobe logo, Acrobat, and the Acrobat logo are trademarks of Adobe Systems 
Incorporated. 

Datalight is a registered trademark of Datalight, Inc. ROM-DOS is a trademark of Datalight, Inc. 

Xeon is a trademark of Intel Corporation in the United States.  DLT and DLTtape are trademarks of 
Quantum Corporation in the United States.  QLogic and its logo are trademarks of QLogic 
Corporation in the United States.  Fast!UTIL is a trademark of QLogic Corporation in the United 
States. 

All other product, brand, or trade names used in this publication are the trademarks or registered 
trademarks of their respective trademark owners. 

Microsoft Windows 2000 Server operating system, Microsoft Windows 2000 Advanced Server 
operating system and Microsoft Windows 2000 Professional operating system are called Windows 
2000 for short.  Microsoft Windows NT Server network operating system version 3.51/4.0 and 
Microsoft Windows NT Workstation operating system version 3.51/4.0 are called Windows NT for 
short.  Microsoft Windows Millennium Edition Operating System is called Windows Me for short.  
Microsoft Windows 98 operating system is called Windows 98 for short.  Microsoft Windows 95 
operating system is called Windows 95 for short. 

Names used with sample applications are all fictitious.  They are unrelated to any existing product 
names, names of organizations, or individual names. 

 
 

 

To prevent voltage sag: 

This product may be affected by voltage sag caused due to lightning.  To prevent voltage sag, you 
are recommended to use an AC uninterruptible power supply (UPS) unit. 

 



 

Notes: 

(1) No part of this manual may be reproduced in any form without prior written permission of 
NEC Corporation. 

(2) The contents of this manual are subject to change without prior notice. 

(3) The contents of this manual shall not be copied or altered without prior written permission of 
NEC Corporation. 

(4) All efforts have been made to ensure the accuracy of all information in this manual.  If you 
find any part unclear, incorrect, or omitted in this manual, contact the sales agent where you 
purchased this product. 

(5) NEC assumes no liability arising from the use of this product, nor any liability for incidental or 
consequential damage arising from the use of this manual regardless of (4) above. 

PREFACE 
Welcome to the NEC Express5800/ft series. 

NEC Express5800/ft series is a “fault-tolerant (ft)” server focusing on “high reliability” in terms of 
fault-tolerance, in addition to “high performance,” “scalability,” and “general versatility” provided 
by NEC Express5800 series.  In the event of trouble, its dual configuration will allow the system to 
instantaneously isolate the failed parts to assure non-stop running; operation will be moved 
smoothly from one module to the other, minimizing damage to it.  You can use this ft series in a 
mission-critical system where high availability is required.  By the use of Windows2000 operating 
system, it also provides outstanding openness for general-purpose applications, etc. 

To make the best use of these features, read this User's Guide thoroughly to understand how to 
operate NEC Express5800/ft series. 
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ABOUT THIS USER'S GUIDE 
This User's Guide helps a user to properly setup and use the product. 

Consult this guide to ensure safety as well as to cope with trouble during a system setup and daily 
operation. 

Keep this manual handy. 

This User's Guide is intended for users who have a good knowledge on the basic use of 
Windows2000/NT operating systems and general I/O devices such as a keyboard and mouse. 

 
 
How to Use This User's Guide 
This guide consists of eight chapters and appendices.  To help you find a solution quickly, the 
guide contains the following information: 

Read “Precautions for Use” first. 
Before going on to main chapters, be sure to read “Precautions for Use.”  These precautions are 
very important for using the product safely. 

Chapter 1  Precautions for Use 
This chapter describes precautions necessary to use the product safely and properly. Be 
sure to read this chapter before using theproduct. It also provides information on user 
support. It will be helpful when you need maintenance service, support, etc. 

Chapter 2  General Description 
This chapter describes what you should know about the product: its component names, 
functions, operating procedures as well as handling of devices and other parts. 

Chapter 3  Setup 
This chapter walks you through the setup procedures from unpacking of the product. 
See also this chapter when you perform a re-setup. 

Chapter 4  System Configuration  
This chapter describes how to make settings of built-in basic input/output system. It also 
describes factory-shipped parameters. 

Chapter 5  Installing and Using Utilities 
This chapter describes features and operating procedures of a standard utility “NEC 
EXPRESSBUILDER.” It also describes procedures to install and operate various 
software programs contained in its CD-ROM. 

Chapter 6  Maintenance 
This chapter describes maintenance procedures and use of maintenance tools. If you 
need to move the product for maintenance purposes, follow the steps provided in this 
chapter. 

Chapter 7  Troubleshooting 
If the product does not work properly, see this chapter before deciding that it is a 
breakdown. 

Chapter 8  System Upgrade 
This chapter describes procedures to add options and precautions. See also this chapter 
when you replace failed components. 

Appendix A  Specifications 
This appendix lists specifications of the product. 

Appendix B  I/O Port Addresses 
This appendix lists factory-assigned I/O port addresses. 
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Additional symbols 

The following symbols are used throughout this User's Guide in addition to the caution symbols 
describe at the beginning.   

IMPORTANT:  Important points or instructions to keep in mind when using the 
server or software 

CHECK: Something you need to make sure when using the server of 
software 

NOTE:  Helpful information, something useful to know 

    
 

Accessories 

This product is shipped with various accessories.  See the attached list to make sure everything is 
included and check the individual items.  If some component is missing or damaged, contact your 
sales agent. 

� Keep the accessories in a safe place.  You will need them when you perform setup, 
addition of options, or replacement of failed components. 

� To check NEC EXPRESSBUILDER components, see the attached list. 

� Be sure to fill out and mail the software registration card that is attached to your operating 
system. 

� Make backup copies of included floppy disks, if any.  Keep the original disks as the 
master disks; use these copies in operation. 

� Improper use of an included floppy disk or CD-ROM may alter your system environment.  
If you find something unclear, stop using them and contact your sales agent. 
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Chapter 1 

Precautions for Use 

This chapter includes information necessary for proper and safe operation of the server. 
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WARNING LABELS 
Warning labels are placed in certain parts of the system so that the user stays alert to possible risks 
(Do not remove or damage these labels). 

If some label is missing, about to peel off, or illegible, contact your sales agent. 

The figures below show locations of the labels on tower model and rack-mount model servers. 

 

Tower model  

 

Label E

Label A

Label D

Label B
Label C
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 Label A 

Label B 

Label C 

Label E Label D 
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Rack-mount model 
 

Label B

Label A

Label C 

Label D
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Label D Label C 

Label B 

Label A 
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PCI/CPU Modules 
 
 
PCI Module 

 

 
 

 

 
 
CPU Module 

 

 

 

 
Label A 

 
  

Label A 

Label A
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PRECAUTIONS FOR SAFETY 
This section provides precautions for using the server safely.  Read this section carefully to ensure 
proper and safe use of the server.  For symbol meanings, see "SAFETY INDICATIONS" described 
in the previous section. 

 

General 

WARNING  
  

 
Do not use the equipment in an operation where human lives are involved or 
high reliability is required. 

  
 This equipment is not intended for use in controlling or use with facilities or 

systems where human lives are involved or high reliability is required, including 
medical devices or nuclear, aerospace, transportation, and traffic control 
facilities.  NEC assumes no liability for any accidents or damage to physical 
assets resulting from the use of this equipment in such systems or facilities. 

  
Do not continue to use the equipment if you detect smoke, odor, or noise. 
  If the equipment emits smoke, odor, or noise, immediately flip off the POWER 
switch, unplug the cord, and contact your sales agent.  There is a risk of a fire. 

  
Do not insert a wire or metal object 
  Do not insert a wire or metal objects into a vent or disk drive slot.  There is a 
risk of an electric shock. 

  
Do not use the equipment in an unsuitable place. 
  Do not install a server rack in an unsuitable environment. 
Otherwise, other systems also may be affected, and the rack may fall over to 
cause a fire or injuries.  For details about installation environment and 
quake-resistant engineering, see the attached manual or contact you sales 
agent. 

  
Do not install the equipment on a nonconforming rack. 
  Install the equipment on a 19-inch rack confirming to the EIA standard.  Do not 
use the equipment without a rack or install it on a nonconforming rack..  
Otherwise, the equipment may not function properly, and there is a risk of 
damage to physical assets or injuries.  For suitable racks, contact your sales 
agent. 
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CAUTION  
  

Prevent water or foreign objects from getting into the equipment. 
  

 
Do not let water or foreign objects (e.g., pins or paper clips) enter the 
equipment.  There is a risk of a fire, electric shock, and breakdown.  When 
such things accidentally enter the equipment, immediately turn off the power 
and unplug the cord.  Contact your sales agent instead of trying to 
disassemble it yourself. 

  
Do not touch any damaged LCD. 
  

 The LCD on the server front contains a liquid harmful to the human body.  If 
the liquid leaked from the LCD accidentally gets in your mouth, immediately 
gargle and see a doctor.  If it accidentally gets on your skin or in your eye, 
rinse it with water immediately for at least 15 minutes. 
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Use of Power Supply and Power Cord 

WARNING  
  

Do not handle a power plug with a wet hand. 
  Do not plug/unplug a power cord with a wet hand.  There is a risk of an electric 
shock. 

  
Do not connect the ground wire to a gas pipe. 
  Never connect the ground wire to a gas pipe.  There is a risk of a gas 
explosion. 

  
 

CAUTION  
  

Do not plug the cord in a nonconforming outlet. 
  

 

 

Use a wall outlet with specified voltage and power type.  Otherwise, there is a 
risk of a fire or current leakage. 
Avoid installing the equipment where you may need an extension cord.  If the 
cord that does not meet the power specifications, there is a risk of overheating 
that could lead to a fire. 

  
Do not plug too many cords in a single outlet. 
  If the rated current is exceeded, there is a risk of overheating that could lead to 
a fire. 

  
Do not plug the cord insecurely. 
  Insert the plug firmly into an outlet.  Otherwise, there is a risk of heat or fire 
due to poor contact.  If dust settles on the slots and it absorbs moisture, there 
is also a risk of heat or fire.  

  
Do not use nonconforming power cords. 
  

 

Use only the power cords that come with the product.  If the rated current is 
exceeded, there is a risk of a fire. 
You also have to observe the following prohibitions to prevent damage to the 
cords. 
� Do not pull on the cord. 
� Do not pinch the cord. 
� Do not bend the cord. 
� Keep chemicals away from the cord. 
� Do not twist the cord. 
� Do not place any object on the cord. 
� Do not bundle several cords. 
� Do not alter, modify, or repair the cord. 
� Do not staple the cord. 
� Do not use any damaged cord.  (Replace it with a new one of the same 

specifications.  For replacement procedures, contact your sales agent.) 
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Installation, Relocation, Storage, and Connection 

WARNING  
  

Disconnect the power cord(s) before installing or removing the equipment. 
  
Be sure to power off the equipment and unplug its power cords from the wall 
outlet before installation/relocation.  All voltage is removed only when the 
power cords are unplugged. 

  
 

CAUTION  
  

Never attempt to lift the equipment alone. 
  
The equipment weighs around 70 kg (depending on its hardware configuration).  
If you carry it alone, you may strain your back.  It takes at least four people to 
carry it; hold the equipment firmly by its bottom.  Do not hold the front bezel, or 
it may become detached, causing an injury. 

  
Do not install the equipment in an unsuitable place . 
  
Install the equipment in such a place as specified in this User's Guide.  Avoid 
the following, or there is a risk of a fire. 
� a dusty place 
� a humid place located near a boiler, etc 
� a place exposed to direct sunlight 
� an unstable place 

  
Be careful not to hurt your fingers. 
  
Exercise great care not to hurt your fingers on the rail when you 
mount/dismount the equipment into/from the rack. 
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CAUTION  
  

Do not connect any interface cable with the power cord of the server plugged to 
a power source. 
 

 

 Make sure to power off the server and unplug the power cord from a power 
outlet before installing/removing any optional internal device or 
connecting/disconnecting any interface cable to/from the server.  If the server 
is off-powered but its power cord is plugged to a power source, touching an 
internal device, cable, or connector may cause an electric shock or a fire 
resulted from a short circuit. 

  
Do not use any non-designated interface cable. 
  
Use only interface cables designated by NEC; identify which component or 
connector to attach beforehand.  If you use a wrong cable or make a wrong 
connection, there is a risk of short-circuit that could lead to a fire. 
You also have to observe the following prohibitions about handling and 
connecting interface cables: 
� Do not use any damaged cable connector. 
� Do not step on the cable. 
� Do not place any object on the cable. 
� Do not use the equipment with loose cable connections. 
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Cleaning and Handling of Internal Devices 

WARNING  
  

Do not disassemble, repair, or alter the server. 
  

 

 

Unless described herein, never attempt to disassemble, repair, or alter the 
equipment.  There is a risk of an electric shock or fire as well as malfunction. 

  
Do not look into the CD-ROM drive 
  

 
The CD-ROM drive uses a laser beam.  Do not look or insert a mirror inside 
while the system is on.  A laser beam is invisible; if your eyes get exposed to 
it, there is a risk of losing eyesight. 

  
Do not detach a lithium battery yourself. 
 
This equipment has a lithium battery.  Do not detach it yourself.  If the battery 
is exposed to fire or water, it could explode. 
 

 

When the lithium battery is running down and the equipment doesn’t work 
correctly, contact your sales agent instead of disassembling, replacing or 
recharging it yourself. 

  
Disconnect the power plug before cleaning the server.  
 
Make sure to power off the server and disconnect the power plug from a power 
outlet before cleaning or installing/removing internal optional devices.  
Touching any internal device of the server with its power cord connected to a 
power source may cause an electric shock even of the server is off-powered. 
 

 

Disconnect the power plug from the outlet occasionally and clean the plug with 
a dry cloth.  Heat will be generated if condensation is formed on a dusty plug, 
which may cause a fire. 

  
 

CAUTION  
  

High temperature 
  
Immediately after powering off the system, system components such as hard 
disk may be very hot. Wait for the server to cool down completely before 
adding/removing components. 

  
Make sure to complete installation. 
  
Firmly install all power cords, interface cables and/or boards.  An incompletely 
installed component may cause a contact failure, resulting in fire and/or smoke. 
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During Operation 

CAUTION  
  

Do not pull out a device during operation. 
  
Do not pull out or remove a device while it works. There is a risk of malfunction 
and injuries. 

  
Do not touch the fan. 
  
While the equipment is on, be careful not to get your fingers or hair caught in 
the cooling fan that is located in the back. 

  
Do not touch the equipment when it thunders. 
  
Unplug the equipment when it threatens to thunder.  If it starts to thunder 
before you unplug the equipment, do not touch the equipment and cables.  
There is a risk of a fire or electric shock. 

  
Keep animals away. 
  

 
Animal’s waste or hair may get inside the equipment to cause a fire or electric 
shock. 

  
Do not place any object on top of the server. 
  
The server may fall down to cause damage to physical assets. 

  
Do not leave the CD tray ejected. 
  
Dust may get in the equipment to cause malfunction. The ejected tray may also 
become a cause of injuries. 

  
Do not use a cellular phone or pager around the equipment. 
  
Turn off your cellular phone or pager when you use the equipment.  Their radio 
waves may cause the equipment to malfunction. 
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Rack-mount Model 

CAUTION  
  

Do not attempt to install the server yourself. 
  
To avoid a risk of injuries, users should not attempt to install the equipment into 
a rack. Installation should be performed by trained maintenance personnel. 

  
< For Maintenance Personnel Only > 

Do not carry or install the equipment alone. 
  
It takes at least two people to carry or install a rack.  Otherwise, it may be 
dropped and cause injuries or damage to physical assets.  A tall rack (such as 
44U rack) is quite unstable, especially when not fixed by stabilizers. 

  
Do not install the equipment in such a manner that its weight is imposed on a 
single place. 
 

 

To distribute the weight, attach stabilizers or install two or more racks.  
Otherwise, it may fall down to cause injuries. 

  
Do not assemble parts alone. 
  
It takes at least two people to mount doors and trays to a rack.  Otherwise, you 
may drop some parts to cause a breakage or injuries.. 

  
Do not pull a device out of the rack if it is unstable. 
  
Before pulling out a device, make sure that the rack is fixed (by stabilizers or 
quake-resistant engineering). 

  
Do not leave two or more devices pulled out from the rack. 
  
If you pull out two or more devices the rack may fall down.  You can only pull 
out one device at a time. 

  
Do not install excessive wiring. 
  
To prevent burns, fires, and damage to the equipment, make sure that the rated 
load of the power branch circuit is not exceeded.  For more information on 
installation and wiring of power-related facilities, contact your electrician or local 
power company. 
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For Proper Operation 

Observe the following instructions for successful operation of the server.  Failure to observe them 
could lead to malfunction or breakdown. 

� Perform installation in a place where the system can operate correctly.  For details, see 
Chapter 3. 

� Before turning off the power or ejecting a disk, make sure that the access LED is off. 

� When you have just turned off the power, wait at least 30 seconds before turning it on 
again. 

� Once you have turned on the server, do not turn it off until the "NEC" logo appears on the 
screen. 

� Before you move the equipment, turn off the power and unplug the cord. 

� This server shall not assure reproduction of copy-protect CDs using reproduction 
equipment if such disks do not comply with CD standards. 

� Clean the equipment regularly.  (For procedures, see Chapter 6.)  Regular cleaning is 
effective in preventing various types of trouble. 

� Lightning may cause voltage sag.  As a preventive measure, it is recommended to use  
UPS (uninterruptible power supply). 

This equipment does not support the connection through an UPS serial port (Rc232-C) or 
the control using PowerChutePlus. 

� Make sure that your options are compatible with the system.  If you attach any 
incompatible option, there is a risk of malfunction that could lead to a breakdown. 

� It is recommended to use NEC's genuine option products.  Some competitors’ products 
are compatible with this server.  However, servicing for trouble or damage resulting from 
such a product will be charged even within the warranty period. 



1-16  Precautions for Use 

TRANSFER TO THIRD PARTY 
When you transfer (or sell) the product or its included items, you must observe the following: 

 

Server 

Attach this User's Guide to the server you are transferring (or selling) to a third party. 

IMPORTANT: Data remaining on hard disk: 

When you transfer your server, you are responsible for erasing 
important data stored on its hard disk (e.g., customer information, 
accounting information); you must be careful to prevent such data from 
leaking out to outsiders. 

Even if you perform “Empty trash” on Windows or Linux operating 
system or execute a “format” command to erase data superficially, the 
data actually remains on the hard disk.  If data is not erased 
completely, it could be restored by certain software and be used for 
unexpected purposes. 

You are strongly recommended to buy a special type of software or 
service to avoid such trouble.  For details, contact your sales agent. 

NEC shall not be accountable for such data leakage caused by your 
failure to take necessary measures. 

 

Included Software 

When you transfer or sell the included software to a third party, you must meet the following 
conditions: 

� Transfer all of the software included with the system.  Do not retain any copies. 

� Meet the conditions of transfer described in each software license agreement. 

� Uninstall untransferable programs, if any, from the server before the transfer. 
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DISPOSAL OF EQUIPMENT AND CONSUMABLES 
� When you dispose of the main unit, hard drive, floppy disks, CD-ROMs, optional boards, 

etc., you need to observe your local disposal rules.  For details, ask your municipal 
office. 

IMPORTANT: For disposal (or replacement) of batteries on the 
motherboard, consult with your sales agent. 

If data remains on the hard disk, backup data cartridges, floppy disks, 
or other writable media (such as CD-R and CD-RW), it could be 
restored and reused by outsiders. The customer is responsible for 
wiping out such data before disposal. You need to exercise sufficient 
care to protect privacy and confidential information. 

� Some of the system components have limited lifetime (e.g., cooling fans, built-in batteries, 
built-in CD-ROM drive, floppy disk drive, mouse).  For stable operation, it is 
recommended to replace them regularly.  For lifetime of individual components and 
replacing procedures, ask your sales agent. 

WARNING  
  

Do not detach a lithium battery yourself. 
  
This equipment has a lithium battery.  Do not detach it yourself.  If the battery 
is exposed to fire or water, it could explode. 

 RISK OF EXPLOSION IF BATTERY IS REPLACED WITH INCORRECT TYPE.  
DISPOSE OF USED BATTERIES ACCORDING TO THE INSTRUCTIONS. 

 When the lithium battery is running down and the equipment doesn’t work 
correctly, contact your sales agent instead of disassembling, replacing or 
recharging it yourself. 

 

 
 PCI module board 
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IF SYSTEM TROUBLE IS SUSPECTED 
Before sending the equipment for repair, try the following: 

1. Check if its power cord and connection cables are attached correctly. 

2. See “Error Messages” in Chapter 7 to check if there is a relevant symptom.  If yes, take 
measures as instructed. 

3. Certain software programs are required for operation of NEC Express5800/ft series.  
Check if these programs are properly installed. 

4. Use a commercially available anti-virus program to check the server. 

If the problem isn’t solved by the above actions, stop using the server and consult with your sales 
agent.  In this case, check LED indications of the server and alarm indications on the display, 
which will serve as helpful information at the time of repair. 

    
ABOUT OUR WEB SERVICE 
Information on NEC Express5800/ft series including modification modules is also available on our 
web site, NEC Express5800 Web Site Asia Pacific, at  
http://www.nec.co.jp/epxress/index.html 
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Advice for Your Health 

 
Prolonged use of a computer may affect your health.  Keep in mind the 
following to reduce stresses on your body: 

 

  
Sit in a good posture  
Sit on your chair with your back straight.  If the desk height is appropriate, 
you will slightly look down at the screen and your forearms will be parallel to 
the floor.  This “good” work posture can minimize muscle tension caused 
by sedentary work. 
If you sit in a “bad” posture—for example, sit round-shouldered or with you 
face too close to the display—you may easily suffer fatigue or have your 
eyesight affected. 

 

  
Adjust the installation angle of Display  
Most types of displays allow you to adjust the angle vertically and 
horizontally.  This adjustment is very important to prevent the reflection of 
light as well as to make the screen more comfortable to see.  Without this 
adjustment, it is difficult to maintain a “good” work posture and may get tired 
soon.  Be sure to adjust the angle before using the display. 

 

  
Adjust Brightness and Contrast 
Displays allow you to adjust brightness and contrast.  Optimum brightness 
and contrast vary depending on the individual, age, brightness of the room, 
etc; you need to make an adjustment accordingly.  If the screen is too 
bright or too dark, it is bad for your eyes. 

 
  
Adjust the installation angle of Keyboard  
Some types of keyboards allow you to adjust the angle.  If you adjust the 
angle to make the keyboard more comfortable to use, you can greatly 
reduce stresses on your shoulders, arms, and fingers. 

 
Clean the Equipment  
Cleanliness of the equipment is very important not only for reasons of 
appearance but also from the viewpoints of function and safety.  Especially, 
you need to regularly clean the display, which gets unclear due to the 
accumulation of dirt. 

 

  
Take a break when you get tired 
If you feel tired, you are recommended to refresh yourself by taking a short 
break or doing a light exercise. 

 
 



1-20  Precautions for Use 

(This page is intentionally left blank.) 
 



 

Chapter 2 

General Description 

This chapter describes what you need to know to use the NEC Express5800/ft series.  Refer to this 
chapter when you want to know about certain components and how to operate them. 
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STANDARD FEATURES 
High performance  
� Intel  Xeon   Processor (2.4 GHz) 
� High-speed Ethernet interface 

(1000Mbps/100Mbps/10Mbps supported) 
� High-speed disk access (Ultra160 SCSI 

Wide) 

Expandability 
� Wide variety of optional I/O slots 

Two 64-bit/33 MHz, four 32-bit/33 MHz 
PCI slots 

� Large memory of up to 3 GB 
� Remote power-on feature 
� USB interface 

 

  
High-reliability Various Features 

� Graphic accelerator "CT69000" 
supported 

� El Torito Bootable CD-ROM (no 
emulation mode) format supported 

� POWER switch mask 
� Remote power-on feature 
� AC-LINK feature 
� Consoleless feature 

 
Self-diagnosis 

� Memory monitoring feature (1-bit error 
correction/ 2-bit error detection) 

� Bus parity error detection 
� Temperature monitoring 
� Error notification 
� Built-in fan monitoring feature 
� Internal voltage monitoring feature 
� BIOS password feature 
� Security feature (security lock for front 

door and front bezel) 
� Power On Self-Test (POST) 
� Test and Diagnosis (T&D) Utility 

  
Management Utilities Maintainability 
� NEC ESMPRO 
� NEC Management Workstation 

Application (NEC MWA) 

� Off-line Maintenance Utility 

Ready-to-use Easy and Fine Setup 
� Quick cableless connection: hard disk, 

CPU module, and PCI module (hot-swap 
supported) 
 

� NEC EXPRESSBUILDER (system setup 
utility) 

� SETUP (BIOS setup utility) 
� Fast!UTIL (SCSI device utility) 

Fault-tolerant Feature  
� Redundant modules achieved within a 

system 
� Higher hardware availability by isolation 

of failed module 
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The NEC Express5800/ft series achieves fault-tolerant high-availability in a space-saving form 
factor by incorporating redundant hardware module pairs in a single chassis.  These modules work 
in synchronous tight lockstep while constantly making comparisons wit each other and detecting 
anomalous diversions in operation. 

 
Even if one hardware module stops, the server can continue operation with the other module.  After the failed 
module is replaced, the new module will obtain information from the other and resume operation. 

 
NEC Express5800/ft series is a highly fault-tolerant Windows 2000 server that achieves continuous 
computing operations, data storage mirror, and continuous network connection.  It allows you to 
run Windows 2000-based applications. 

NEC Express5800/ft series achieves continuous computing operations for the Windows 2000 server 
and server-based applications with its redundant CPU processing and redundant memory.  It 
assures data redundancy through duplication of server data on an independent storage system.  
These features eliminate server downtime that is usually caused by network disconnection or trouble 
with the I/O controller, Ethernet adapter or disk drive, and support operation of the network and 
server applications continuously.  While being transparent to application software, NEC 
Express5800/ft series achieves high fault-tolerance. 

NEC Express5800/ft series detects status changes, errors and other events and notifies the Windows 
2000 Event Log of these events.  If you use an alarm notification tool, you can configure NEC 
Express5800/ft series to notify you when certain events occur. 

ESMPRO is installed on the system as a server management solution.  ESMPRO, a GUI-based 
management tool, allows you to monitor, view, and configure NEC Express5800/ft series.  This 
tool also supports both local and remote management of NEC Express5800/ft series. 

 

Standard product New fault-tolerant technology 

Mirror

Compare/Sync

Mirrored

Windows 2000 software programs 

Memory
Memory

CPU Module #1 
CPU Module #2

PCI Module #1 
PCI Module #2 
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NEC Express5800/ft series mainly provides the following advantages: 

� Highly fault-tolerant processing and I/O subsystems 

NEC Express5800/ft series use redundant hardware and software to assure server 
operation even if one module suffers trouble with its processor, memory, I/O (including 
trouble related to the I/O controller), disk drive, or Ethernet adapter. 

� Continuous network connection 

NEC Express5800/ft series maintains continuous network connection by detecting any 
trouble with the network adapter, connection, etc.  If trouble occurs, the standby network 
connection will take over all network traffic processing and thus securely maintain the 
network system connection of NEC Express5800/ft series without losing network traffic 
or client connection. 

� Support of multiple network connections 

Since NEC Express5800/ft series can support multiple Ethernet connections, you can add 
network redundant control or network traffic control. 

� Industry standard hardware platform 

NEC Express5800/ft series uses IA (Intel Architecture)-based system hardware. 

� No need to modify applications 

You can run Windows 2000-compliant applications on NEC Express5800/ft series.  Thus, 
unlike other highly fault-tolerant products, special API or scripts are not necessary. 

� Automatic mirroring 

NEC Express5800/ft series automatically maintains data as the current data.  (You need 
to make a setting with VERITAS Volume Manager.) 

� Automatic detection and notification of faults 

NEC Express5800/ft series detects and sorts out all events such as general status changes 
and faults, and notifies Windows 2000 Event Log of these events. 

� Transparent migration 

NEC Express5800/ft series constantly monitors events.  If trouble occurs on NEC 
Express5800/ft series’ server module, it will transparently use a redundant module of the 
failed module.  This feature maintains data and user access without losing application 
service.  

� Automatic reconfiguration 

When the failed module restarts after the trouble is corrected, NEC Express5800/ft series 
will perform reconfiguration automatically, and if necessary, resynchronize the affected 
modules.  Reconfiguration can include CPU processing (e.g., CPU memory), server's 
operating system (and related applications), and system data stored on the hard disks.  In 
most cases, NEC Express5800/ft series automatically restores redundancy of the server 
modules after recovery. 
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� Local and remote management 

NEC Express5800/ft series uses ESMPRO as a server management tool.  This tool uses a 
GUI that enables monitoring and setting of NEC Express5800/ft series.  ESMPRO can 
be used both locally and remotely on Windows 2000/NT or Windows 95/98/Me. 

� Event notification function 

When trouble or other events are detected on NEC Express5800/ft series, they will be 
notified to Windows 2000 Event Log and saved.  Therefore, you can view the log items 
locally or remotely by a usual Windows 2000 procedure.  Since an NEC Express5800/ft 
series events use unique IDs, they are easy to distinguish.   

� In-service repairing 

You can repair or replace a failed module even if NEC Express5800/ft series is operating. 
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 NAMES AND FUNCTIONS OF COMPONENTS 
Names and functions of components are shown below:  

 

Front View 

 

 

 

Tower model 

Rack-mount model



General Description  2-7 

1 Front bezel 
 A door that covers internal components.  You can lock it with the included security key. 

2 Key slot 
 Insert the security key in this slot to unlock the front bezel. 

3 Stabilizers 
 Parts for stabilizing a tower-model unit. 

4 Casters 
 Wheels for moving a tower-model unit. 

5 BMC status LED 
 See “LEDs” in this chapter for details. 

6 PCI module status LED 1 
 See “LEDs” in this chapter for details. 

7 PCI module status LED 2 
 See “LEDs” in this chapter for details. 

8 DISK ACCESS LED 
 See “LEDs” in this chapter for details. 

9 CPU module status LED 1 
 See “LEDs” in this chapter for details. 

10 CPU module status LED 2 
 See “LEDs” in this chapter for details. 
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Front View (inside) 

 

Tower model

Rack-mount model
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1 PCI module (for group 1) 
 A module that includes a PCI board and LAN controller. 

2 PCI module (for group 2) 
 A module that includes a PCI board and LAN controller. 

3 CPU module (for group 1) 
 A module that includes a CPU (processor) and memory (DIMM). 

4 CPU module (for group 2) 
 A module that includes a CPU (processor) and memory (DIMM). 

5 POWER switch 
 A switch for turning on/off power to the system.  The POWER switch on the primary PCI 

module will be lit.  Press it once to turn on power.  Press it again to turn off power.  
Depress the switch for more than four seconds to force the system to power down.  The 
POWER switch on the secondary PCI module will be unlit and will not respond until a failure 
in the primary PCI module causes the secondary PCI module to assume primary 
functionality. 

6 CD-ROM drive 
 Used for reading data from CD-ROMs. 

Although there are two CD-ROM drives, only the one on the active primary PCI module can 
be used (the module with the lit POWER Switch LED). 

7 3.5-inch disk bay 
 Slots for adding hard disks.  On a tower model, they are called Slots 1, 2, and 3 from the 

bottom.  On a rack-mount model, they are called Slots 1, 2, and 3 from the left.  Slots of 
the same number are mirrored between the groups 1 and 2. 

8 DUMP switch 
 A switch for outputting a memory image from the kernel to a file. 

9 DISK LED (green/amber) 
 An LED that blinks in green while the hard disk is accessed.  When operating in simplex 

mode or the hard disk fails, it will turn amber. 
 

 

CD- ROM Drive 

 

1 Status LED 
 An LED that stays on while the loaded CD-ROM is accessed. 
2 CD tray eject button 
 A button for ejecting the CD tray. 
3 Manual release hole 
 When the eject button does not work, insert a metal pin into this hole to forcefully eject the CD 

tray. 
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Rear View 

     

Rack-mount model

Tower model 

PCI module (for Group1)

PCI module (for Group2)

CPU module (for Group1)

CPU module (for Group2)

CPU module (for Group1)

CPU module (for Group2)

PCI module (for Group2) 

PCI module (for Group1) 
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1 Serial port A connector 
 Connected to a device that has a serial interface.  For maintenance use only. 

2 AC inlet 
 PC socket for plugging a power cord. 

3 Serial port B connector 
 Connected to a device that has a serial interface.  For maintenance use only. 

4 USB connector 1 (top)/USB connector 2 (bottom) 
 Connected to devices that support the USB interface. 

Connect the mouse to USB 1; connect the keyboard to USB 2. 
5 AC inlet 
 PC socket for plugging a power cord. 

6 Monitor connector 
 Connected to the display unit. 

7 SCSI connector 
 Used for connecting external SCSI devices. 

8 PCI module status LED 1 
 See “LEDs” in this chapter for details. 

9 PCI module status LED 2 
 See “LEDs” in this chapter for details. 

10 PCI board slot status LED (Slot1) 
 See “LEDs” in this chapter for details. 

11 PCI board slot status LED (Slot2) 
 See “LEDs” in this chapter for details. 

12 PCI board slot status LED (Slot3) 
 See “LEDs” in this chapter for details. 

13 LINK/ACT LED 
 See “LEDs” in this chapter for details. 

14 LAN connector 2 
 A connector for 1000BASE-TX, 100BASE-TX, and 10BASE-T.  Connected to the network 

system on LAN. 
15 100/10 LED 
 See “LEDs” in this chapter for details. 

16 LINK/ACT LED 
 See “LEDs” in this chapter for details. 

17 100/10 LED 
 See “LEDs” in this chapter for details. 

18 LAN connector 1 
 A connector for 100BASE-TX and 10BASE-T.  Connected to the network system on LAN. 
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CPU Module 

 
Group 1 and group 2 have the same configuration. 

1 Module handle 
2 Cooling fan  
3 CPU module board 
4 CPU socket #2 (additional) 
5 AC inlet (in the back) 
6 Backboard connector (in the back) 
7 CPU socket #1 (standard) 
8 DIMM 
9 Power unit 
10 Power backboard 

 



General Description  2-13 

 

 
CPU module board 

Group 1 and group 2 have the same configuration. 

1 Cooling fan connector  
2 LED connector 
3 Power connector 
4 CPU socket #2 
5 CPU socket #1 
6 DIMM sockets (Slots #1 to #6 from left.  Add memory modules in pairs: #1 and #2, #3 and 

#4, #5 and #6.) 
*This section only describes connectors that are used for replacing parts or upgrading.  Other 
connectors have been setup before shipment. 
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PCI Module 

 
Group 1 and group 2 have the same configuration. 

1 Cooling fan 
2 Power unit 
3 AC inlet (in the rear) 
4 Backboard connector (in the rear) 
5 PCI module board 
6 Video board 
7 PCI riser card 
8 PCI board retention bracket 
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PCI module board 

Group 1 and group 2 have the same configuration. 

1 SCSI connector (external) 
2 Configuration jumper pin 
3 Battery (lithium battery) 
4 Cooling fan 1 connector 
5 Power connector 
6 IDE connector 
7 Power switch connector 
8 
9 

LED connector 
SCSI connector (internal) 

 

 

 

 

Chassis Board Layout 

Rack-mount model 

 
 

8

Clock board Interface board Back panel 
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LEDs 

This section describes indications and meanings of the LEDs on NEC Express5800/ft series. 

 

POWER LED 

The POWER switch of the PCI module also functions as a POWER LED.  When power is 
supplied to the modules, POWER LED on the primary side will illuminate (the switch also works 
on the primary side alone).  

 

BMC Status LED 

The BMC Status LED indicates the status of the Baseboard Management Controller (BMC) 
installed on NEC Express5800/ft series. 

The LED stays green while the server is running normally.  If the LED is not green, there is 
something wrong with the server. 

The table below shows indications of the BMC Status LED and their meanings. 

Tips:  
� To determine the cause of trouble, use the NEC ESMPRO or the 

Off-line Maintenance Utility to view the error log. 

� When you want to restart the server, perform a shutdown if the OS 
allows you to shut down the system.  If not, perform a reset or 
forced shutdown, or you can restart the server by unplug and 
plugging the power cord. 

 
LED indications Description Action 
Green BMC operates 

normally and CPU 
and PCI modules 
are in duplex 
mode. 

– 

Green (blinking 
every 1 second) 

CPU or PCI 
modules are not in 
duplex mode 
during operation. 

Remount components whose Status LED is red.  If 
the problem persists, replace that module. 

AC power is all off. Turn on the AC power. 
Performing POST. Wait for a while; it will illuminate in green shortly after 

POST. 
CPU module error 
occurred. 

Off 

PCI module error 
occurred. 

After turning off the power, turn it on to restart the 
system.  If some error message appears on the 
POST screen, write it down and contact your sales 
agent. 
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LED indications Description Action 
Detected a fatal 
temperature error. 

If LCD displays some error message, refer to the error 
message list (see Chapter 7). 
Check if dust is accumulated on internal fans and 
confirm that the fan cables are connected firmly.  If 
the message does not disappear, contact your sales 
agent. 

Amber 

Detected a fatal 
voltage error. 

Contact your sales agent. 

Detected a 
temperature error 
to be warned. 

If LCD displays some error message, refer to the error 
message list (see Chapter 7). 
Check if dust is accumulated on internal fans and 
confirm that the fan cables are connected firmly.  If 
the message does not disappear, contact your sales 
agent. 

Detected a voltage 
error to be warned. 
Detected a device 
defect. 

Contact your sales agent. 

Amber (blinking 
every 1 second) 

Detected a fan 
alarm. 

If LCD displays some error message, refer to the error 
message list (see Chapter 7). 
Check if dust is accumulated on internal fans, and 
confirm that the fan cables are connected firmly.  If 
the message does not disappear, contact your sales 
agent. 

BMC is being 
dumped 

Wait for a while; it will go off soon. 

PCI module may 
be connected 
incorrectly. 

Check if PCI module is connected correctly.  Look for 
loose screws. 

Red in one module

BMC may be out of 
order. 

BMC firmware may need reprogramming.  Contact 
your sales agent. 

Red in both 
modules 

Both BMCs are out 
of order. 

Check if both PCI modules are connected correctly.  
Look for loose screws.  If the message does not 
disappear, contact your sales agent. 

Red (blinking every 
1 second) 

Revisions to BMC 
firmware don’t 
match. 

Contact your sales agent. 

Red (blinking every 
0.5 second) 

Transfer of synced 
data after a PCI 
module is replaced 
(this is not an 
error). 

Do not loosen a screw on PCI modules or turn off the 
AC power before the LED stops blinking. 
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PCI Module Status LEDs (1 and 2) 

Disk Access LED 
The PCI module has three LEDs. 
Combined, the three LEDs show the status of the PCI modules and hard disks: 

LED indications 

1 2 Disk 
Access 

Description Action 

Status LEDs and Disk Access LED stay 
green on both PCI modules, they operate 
normally in duplex mode. 

– Green 

Status LEDs and Disk Access LED stay 
green only on one module, there is some 
kind if trouble with the hard disk.  
In this case, Status LED 2 and Disk 
access LED on the other PCI module 
stay in amber. 

Check the condition of hard disk 
mirrors. 
If the problem persists, contact your 
sales agent. 

Green 

Off Disk Access LED is off only on one PCI 
module; power is not supplied to the hard 
disk.  
In this case, Status LED 2 and Disk 
access LED on the other PCI module 
stay in amber. 

Check the condition of hard disk 
mirrors. 
Remount the hard disks. 
If the problem persists, contact your 
sales agent. 

Off Off AC power is not supplied to the PCI 
modules. 

Remount the PCI module. 
Check the condition of power unit. 
Check if the power cord is connected 
correctly. 
Check the condition of breaker and 
UPS. 
If the problem persists, contact your 
sales agent. 

Status LEDs and Disk Access LED stay 
amber on both PCI modules, they are 
shifting to duplex mode by mirroring. 

Wait until the mirroring is finished. 

Off 

Amber Amber 

The PCI module is mounted correctly 
and operates in simplex mode. 

Start the other PCI module to use ft 
series features.  If the problem 
persists, contact your sales agent. 

Green Off The PCI module is performing diagnosis. – 
On standby (AC power is supplied 
through the cord, but the system has not 
been powered on yet.) 

After turning on the power, wait for the 
OS to start.  When the OS starts and 
duplex mode is established, the 
indications will get back to normal.  If 
they do not get back to normal, 
remount the CPU module. 

Off Off 

Power is not supplied due to a failure of 
the CPU module.  

Remount the CPU module. If the 
problem persists, contact your sales 
agent. 

Green 

Red 
 
 
 
 

Amber 
Amber 

Memory is being dumped.  
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CPU Module Status LEDs (1 and 2) 

The CPU module has two LEDs. 

Combined, the two LEDs show the status of CPU modules: 

LED status 
1 2 Description Action 

Green The CPU module 
operates normally in 
duplex mode. 

– 

Off Power is not supplied to 
the CPU module. 

Remount the CPU module. 
Check the condition of power unit. 
Check if the power cord is connected 
correctly. 
Check the condition of breaker and UPS. 
If the problem persists, contact your sales 
agent. 

Off 

Amber The CPU module is 
mounted correctly and 
operates in simplex 
mode. 

Start the other CPU module to use ft 
series features.  If the problem persists, 
contact your sales agent. 

Green The CPU module is 
performing diagnosis. 

– 

On standby (AC power is 
supplied through the 
cord, but the system has 
not been powered on 
yet.) 

After turning on the power, wait for the 
OS to start.  When the OS starts and 
duplex mode is established, the 
indications will get back to normal.  If 
they do not get back to normal, remount 
the CPU module. 

Off 

Power is not supplied due 
to a failure of the CPU 
module. 

Remount the CPU module. If the problem 
persists, contact your sales agent. 

Red 

Amber Memory is being 
dumped. 

– 
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PCI Board Slot Status LEDs (P1, P2, P3) 

To show the status of PCI board slots, each PCI module has three status LEDs. 

LED 
indications Description Action 

PCI board is mounted 
correctly and operates 
in duplex mode. 

The system operates normally. Off 

The PCI board is not 
mounted; is mounted 
incorrectly; or power 
is not supplied. 

If the PCI board is not mounted or is mounted 
incorrectly, just mount it correctly; there is no problem. 
Check the condition of power unit. 
If the problem persists, contact your sales agent. 

Amber Performing POST; or 
the PCI board is 
mounted correctly and 
operates in simplex 
mode. 

Simplex mode is not a problem. 
To use ft series features, attach a PCI board to a slot 
of the same on the other PCI module. 

Red Although the PCI 
board is mounted, it 
may be offline or not 
be working. 

Remount the PCI board correctly. 
Remount the PCI module correctly. 
If the problem persists, contact your sales agent. 

For LED indications when option boards are attached, see “PCI Module” in Chapter 8.  

 

Hard Disk LED 

A hard disk LED shows the status of hard disks that are mounted in the 3.5-inch device bay. 

Combined, the two hard disk LEDs on PCI modules 1 and 2 show the status of the hard disks. 

PCI 
module 1 

PCI 
module 2 Description Action 

Green Green Hard disks are mirrored and 
operate normally. 

– 

Green Amber Some trouble occurred on the hard 
disk of the PCI module 1. 
The hard disk on the PCI module 2 
is operating without mirroring. 

Check the condition of hard disk 
mirrors. 
If the problem persists, contact 
your sales agent. 

Amber Amber Hard disk mirroring is being 
performed. 

Wait until the mirroring is 
finished. 

 

Tips:  
� When there are many accesses, the access LED will blink frequently.  

Check if the LED blinks in green when the number of accesses 
decreases, or if it is green when there are no accesses anymore. 

� When you power on NEC Express5800/ft series and the access 
LEDs do not illuminate green, remount the hard disks. 
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LAN Connector LEDs 

Two LAN ports (connectors) located in the back have two LEDs each. 

• 100/10 LED (LAN connector 1), 1000/100/10 LED (LAN connector 2)  

These LEDs show the transfer rate of the network that is being connected. 

LED indications LAN connector 1 
100/10 

LAN connector 2 
1000/100/10 

Amber Operating as 100BASE-TX. Operating as 1000BASE-T. 
Off Operating as 10BASE-T. Operating as 10BASE-T. 

 

• LINK/ACT LED 

The LINK/ACT LED shows the status of a standard network port.  It is green if power is 
supplied to the main unit and hub, and they are connected correctly (“LINK”).  It blinks green 
while the network port sends or receives data (ACT). 

When the LED does not illuminate during “LINK,” check the condition and connection of 
network cables.  If there is nothing wrong with the cables, a defect is suspected in the network 
(LAN) controller.  In this case, contact your sales agent. 
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BASIC OPERATION 
This section describes basic operation procedures of NEC Express5800/ft series. 

 

Locking and Unlocking the Front Bezel 

The front bezel covers built-in components of the server such as the POWER switch, CD-ROM 
drive, and hard disks. 

The tower model server has a door-type bezel (it can also be detached).  The rack-mount model 
server has a cover-like detachable bezel 

You need to open the front bezel when you access the POWER switch, CD-ROM drive or hard disk. 

IMPORTANT:  
� Without using the security key, you cannot open or detach the front 

bezel. 

� It is not recommended to use the server with its bezel detached. 

Tower Model 

Insert the security key into the slot and turn it to release the lock.  Hold the handle on the left side 
of the bezel and pull it.  After closing the front bezel, lock it with the key for security. 

 

 

Release Lock
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Rack-mount Model 

The rack-mount model server is equipped with a detachable front bezel. 

 

Detach 

Follow the steps below to detach the front bezel: 

1. Insert the security key into the slot and turn it with a little pressure to release the lock.  

 

2. Hold the right side of the front bezel lightly and pull it open. 

3. Detach the bezel from the main unit by sliding it to the left a little to disengage the tabs 
from the frame. 

 

 

Attach 

To attach the front bezel, engage the tabs on the frame on the left side of the main unit.  After 
attaching and closing the front bezel, lock it with the key for security. 

 

 

 

 

Tabs Frame 

Release Lock 
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Power ON 

To power on NEC Express5800/ft series, press the POWER switch located on the front panel. 

Follow the steps below to turn on the power. (A rack-mount model is shown here for convenience of 
explanation.  However, the steps are the same for a tower model except that the modules are 
mounted vertically.) 

1. Power on the display unit and other peripheral devices connected to the server. 

NOTE: If the power cord is connected to a power controller like a UPS, 
make sure that it is powered on. 

2. Open the front bezel (or detach it in the case of a rack-mount model). 

3. Press the POWER switch located on the front panel. 

After a while, the "NEC" logo will appear on the screen. 

 

IMPORTANT: Do not turn off the power before the "NEC" logo 
appears. 

While the "NEC" logo is displayed on the screen, NEC Express5800/ft series is 
performing a power-on self test (POST) to check itself.  For details, see "Check by 
POST" described later in this manual.  Upon the completion of POST, Windows 2000 
Advanced Server will start. 

NOTE: If the server finds errors during POST, it will interrupt POST 
and display the error message.  See Chapter 7. 

 
 
 
 

POWER switches* (LEDs) 
*You can only use a power
switch whose LED is on. 
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Power OFF 

Follow the steps below to turn off the power.  If NEC Express5800/ft series is plugged to a UPS, 
see manuals included with the UPS or the application that controls the UPS. 

1. Perform a normal shutdown from Windows 2000 Advanced Server. 

The system will be powered off automatically and the POWER LED will turn off. 

2. Power off all peripheral devices. 
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POST Check 

POST (power-on self test) is a self-test function stored on the motherboard of NEC Express5800/ft 
series. 

When you power on the server, POST will start automatically to check the motherboard, ECC 
memory modules, CPU modules, keyboard, mouse, etc.  It also shows startup messages for various 
BIOS setup utilities. 

 

 
According to the factory default settings, the “NEC” logo appears on the display while POST is 
being performed.  (To view POST’s details, press Esc.) 

Tips:  
� You can view POST details from the beginning without the need to 

press Esc when the BIOS menu is displayed: select [System 
Configuration] → [Advanced], and set [Boot-time Diagnostic 
Screen] to "Enabled" (see Chapter 4). 

� You can view the test items and details from a management PC 
where NEC ESMPRO Manager or MWA is installed. 

You don't always need to check POST details.  You will need to check messages when: 

� You install a new NEC Express5800/ft series. 

� A failure is suspected. 

� You hear several beeps between the time of the power-on and OS start-up.  

� The display unit or the LCD* shows an error message. 

*For details, see “Error Messages on LCD” in Chapter 7. 
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Flow of POST 

This section walks you through how POST is performed. 

1. When you power on the system, one selected CPU/PCI module will start up. 

POST will be performed on this selected CPU/PCI module. 

2. Memory check starts. 

A message appears at the upper left of the screen to show that the basic and expanded 
memories are being counted.  The memory check may take a few minutes to complete 
depending on the server’s memory size.  Likewise, it may take about one minute for the 
screen to appear when the server is rebooted. 

Note that if you have replaced the PCI module, the server will perform a reset of the MAC 
address, then reboot itself before the memory check. 

3. The server starts processor check, IO check, and initialization. 

Several messages appear: they show the ID of the selected CPU/PCI modules, information 
on the processor, detection of the keyboard and mouse, etc. 

4. A message appears at the lower left of the screen, prompting for startup of the BIOS setup 
utility “SETUP.” 

Press <F2> to enter SETUP
 

You will need to start it when you want modify the configuration for using the server.  
Unless this message appears together with an error message, you don't need to start the 
utility to modify the configuration. (If you wait for a few seconds, POST will go on 
automatically.) 

To start the SETUP utility, press F2 while the above message is displayed.   For setting 
and parameter functions, see the section of BIOS setup. 

When SETUP is completed, the server will reboot itself automatically and perform POST. 

5. A message appears prompting for startup of SCSI BIOS setup utility. 

When a built-in SCSI controller is detected, a message will appear prompting for startup 
of SCSI BIOS setup utility. (If you wait for a few seconds, POST will go on 
automatically.) 

If you press Ctrl + Q, the SCSI BIOS setup utility will start.  For setting and parameter 
functions, see the section on SCSI setup. 

You will need to use this utility, for example, when you have changed the server’s internal 
SCSI device connections.  However, you usually don’t need to use it. 

When SETUP is complete, the server will reboot automatically and perform POST again. 

If multiple SCSI controller boards are mounted on the PCI bus, the SCSI BIOS startup 
message will appear for these boards in numerical order (PCI #1, PCI #2, PCI #3…). 

6. The screen shows SCSI ID numbers used by the connected SCSI devices. 

7. Upon completion of POST, the password entry screen appears prior to OS startup. 
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The password entry screen will appear after the normal termination of POST only if you 
have set a password in the BIOS setup utility “SETUP.” 

You can enter a password up to three times.  If you enter an incorrect password three 
times, the startup will be unsuccessful.  In this case, turn off the power and then turn it 
on again after waiting ten seconds to boot the server. 

IMPORTANT: Do not set a password before installing the OS. 

8. Upon completion of POST, the OS will start up. 

 

Behavior at Occurrence of Error 

If POST or OS startup does not finish normally, the server will reboot itself automatically. 

At the time of reboot, it will select the other CPU/PCI module and run POST or OS startup. 

In this manner, the server retries POST or OS startup with different combinations of CPU/PCI 
modules.  If POST does not finish normally with any combinations, the server will stop with the 
state of DC OFF. 

Press <F1> to resume, <F2> to enter SETUP 

While performing retries, the server displays or registers the error types. 

For details of error messages, see Chapter 7 “Troubleshooting.” 

 

POST Error Messages 

When the server detects an error during POST, it will notify you of the occurrence in the following 
manners: 

� Displays an error message on the display unit. 

� Displays an error message on the LCD*. 

� Makes a beeping sound. 

*For details, see “Error Messages on LCD” in Chapter 7. 

These notification methods are described in the Operation and Maintenance Guide. 

IMPORTANT: Before you contact your sales agent, write down the 
error messages and patterns of the beeping sound.  They will serve as 
helpful information at the time of maintenance. 
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Floppy Disk Drive 

A USB floppy disk drive is attached to the main unit.  It allows you to read and write (save) data 
using floppy disks. 

The USB floppy disk drive accepts the following types of floppy disks: 

� 2HD floppy disk (1.44MB) 
� 2DD floppy disk (720KB) 

 

 

Drive letter of floppy disk drive 

The drive letter will change when the primary PCI module is switched to the standby PCI module 
while the Windows 2000operating system is in operation.  The drive letter of the floppy disk will 
be determined as follows: 

“A” will be assigned to the floppy disk drive for the PCI module that is operating as the primary 
PCI module during Windows 2000 operating system boot-up.  “B” will be assigned to the floppy 
disk drive for the standby PCI module. 

Only the floppy disk drive of the primary PCI module will be recognized by the Windows 2000 
operating system.  The floppy disk drive of the secondary PCI module will not be recognized. 
(Only one floppy disk drive is recognized at any given time.) 

Ex) Primary PCI module connects the floppy disk drive to the group 1 for the first time, initial 
floppy disk drive connection made when the primary PCI module is group 1. 

 Primary PCI module 

  PCI module (for group 1): A drive 

  PCI module (for group 2): B drive 

IMPORTANT: In the event that the active PCI module switches to the 
standby PCI module due to a failure while the system is in operation, 
the floppy disk drive letter will change at the point PCI module 
switches to the standby module. 
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Insert/Remove Floppy Disk 

Before inserting a floppy disk into the drive, make sure that NEC Express5800/ft series is on and 
that the drive’s USB cable is connected to the USB connector at the back of the server. 

Insert a floppy disk into the drive firmly with the label side up and its protective shutter facing the 
drive. 

NOTES: 
� If you insert an unformatted disk, you will see a message that the 

disk cannot be read or that needs formatting.  To format a floppy 
disk, see your OS manual. 

� If you power on or restart NEC Express5800/ft series with a floppy 
disk left in the drive, the server will access the floppy disk to start 
the system.  Unless a system exits on the FD, the server will be 
unable to start. 

To remove a floppy disk from the drive, press the eject button. 

NOTE: Before removing a floppy disk, make sure that the access LED 
is off.  If you eject a floppy disk while the LED is on, the stored data 
could be damaged. 
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Use of Floppy Disk 

You may need to store important data on floppy disks.  Since the floppy disk is a very delicate 
medium, you must handle it with extra care: 

� Push the floppy disk gently into place. 

� Attach the label on a proper position. 

� Do not use a pencil or ballpoint pen to write on the disk. 

� Do not open the protective shutter. 

� Do not use the floppy disk in a dusty place. 

� Do not place anything on the floppy disk. 

� Do not leave the floppy disk in a place that is subject to direct sunlight or high 
temperatures (e.g., near a heater). 

� Keep away from cigarette smoke. 

� Do not leave the floppy disk near water or chemicals. 

� Keep away from magnetic objects. 

� Do not clip disks.  Be careful not to drop. 

� Store floppy disks in a protective case where they are kept away from magnetic waves or 
dust. 

� To prevent data from being erased accidentally, the floppy disk has a write-protect notch.  
When the disk is write-protected, you can read data, but you cannot write the data or 
format the disk.  It is recommendable to write-protect floppy disks that contain important 
data.  To write-protect a floppy disk, slide the write-protect notch located on its back. 

� The floppy disk is a very delicate storage medium.  Dust or changes in temperature could 
cause data to be lost.  Data loss could also be caused by faulty operation and computer 
trouble.  To avoid such possible data loss, it is recommendable to back up important data 
regularly.  (Be sure to make back-up copies of the disks that are included with NEC 
Express5800/ft series.) 
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CD-ROM Drive 

NEC Express5800/ft series has a CD-ROM drive on the front panel.  It is a device used to read 
data from a CD-ROM (compact disc read-only memory).  Compared to a floppy disk, a CD-ROM 
allows for larger volume and fast data readout. 

CAUTION  
  

Observe the following instructions to use the server safely.  Otherwise, there 
are risks of a burn, injury, or damage to physical assets.  For details, see 
safety precautions in Chapter 1. 
 

 

 
■ Do not leave the CD tray ejected.   

 

When you cannot eject a CD-ROM 

When you cannot eject the CD-ROM by pressing the eject button, follow the steps below to eject it: 

 

1. Press the POWER switch to power off the server. 

2. Use a metal pin of about 1.2 mm in diameter and 100 mm long (alternatively, you can use 
a fairly large paper clip after straightening).  Insert it gently into the manual release hole 
located to the right of the eject button until the tray is ejected. 

IMPORTANT: 
� Do not use a toothpick, plastic pin, or other breakable objects. 

� If you cannot eject the CD-ROM by following the steps above, 
contact your sales agent. 

3. Hold the tray and pull it out. 

4. Take out the CD-ROM. 

5. Push the tray back. 

Manual release hole 
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Use of CD-ROM 

Observe the following when you use a CD-ROM on NEC Express5800/ft series: 

� As for a disk such as a noncompliant “copy-protected CD,” we shall not guarantee that 
you can use a CD player to play it with this server. 

� Be careful not to drop the CD-ROM. 

� Do not bend or place anything on the CD-ROM. 

� Do not attach labels on the CD-ROM. 

� Do not touch the signal side (blank side). 

� Place the CD-ROM gently on the tray with the printed side up. 

� Do not scratch, or use a pencil or ballpoint pen to write on the CD-ROM. 

� Keep away from cigarette smoke. 

� Do not leave the CD-ROM in a place that is subject to direct sunlight or high temperatures 
(e.g., due to a heater). 

� If the CD-ROM gets dirty with dust or fingerprints, wipe it gently from its center to edge 
with a dry soft cloth. 

� When you clean the CD-ROM, use a CD cleaner.  Do not use a record cleaner (spray), 
benzine, or thinner. 

� Store the CD-ROM in a protective case when not in use. 
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Chapter 3 

Setup 

This chapter describes setup procedures to make NEC Express5800/ft series ready for use. 
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BEFORE SETUP 
This section describes the setup procedures of your server.  Set up the hardware first. 

 

Setup of Hardware 

Set up the hardware as follows: 

Procedures are different between the standard configurations and the custom configurations of 
“build-to-order”. 

• Standard configurations 

1. Install the optional memory and/or CPU purchased separately (for the NEC Express5800/ft 
series supporting the expansion of CPU). (See Chapter 8) 

IMPORTANT: Install hard disks and optional PCI boards after the setup of the 
operating system is completed. 

2. Install NEC Express5800/ft series in a most suitable place (environment). 

3. Connect the display unit, external USB-FDD, mouse and keyboard to the server. 

IMPORTANT: Connect peripherals such as external backup device to the server 
after the setup of the operating system is completed. 

4. Connect the accessory power cord to the receptacle on the server and an AC outlet. 

5. Change the BIOS settings depending on the configuration of the server and system uses. 

See the sample setup shown in Chapter 4. 

IMPORTANT: Set BIOS correctly depending on your environment. Make sure that 
the date and time are set correctly. 
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• Custom configurations for “Build-to-Order” 

1. Confirm that options specified in “Build-to-Order” are all installed. 

2. Install NEC Express5800/ft series in a most suitable place (environment). 

3. Connect the display unit, external USB-FDD, mouse and keyboard to the server.  And 
connect the optional PCI card and external devices. 

IMPORTANT: Connect peripherals and PCI card with cables. 

4. With the attached power cord, connect the server to an AC outlet. 

5. Change the BIOS settings depending on the configuration of the server and system uses. 

See the sample setup shown in Chapter 4. 

IMPORTANT: Set BIOS correctly depending on your environment. Make sure that 
the date and time are set correctly. 

Setup of Windows 2000 Advanced Server 

After completing hardware setup, set up the Windows 2000 Advanced Server.  Procedures are 
different depending on your hard disks or whether to install it for the first time. 
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SETUP OF HARDWARE 
Follow the procedures below to make NEC Express5800/ft series ready for power-on: 

 

Unpacking 

NEC Express5800/ft series comes with various accessories.  See the component list to make sure 
everything is included and check the individual components.  If some component is missing or 
damaged, contact your sales agent. 

IMPORTANT: Accessories 

� Keep the accessories in a safe place.  You will need them when you perform 
setup, addition of options, or replacement of failed components. 

� To check NEC EXPRESSBUILDER components, see the attached list. 

� Always mail the software registration card attached to the operating system after 
filling the proper information in the card. 

� Make backup copies of included floppy disks, if any.  Keep the original disks as 
the master disks; use these copies in operation. 

� Improper use of an included floppy disk or CD-ROM may alter your system 
environment.  If you find something unclear, stop using them and contact your 
sales agent. 
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Installation 

This section describes installation of NEC Express5800/ft series. 

 

Tower Model 

IMPORTANT: NEC Express5800/ft series is a precision instrument.  You should 
ask maintenance personnel to install it. 

Select a suitable site for tower model. 

CAUTION  
  

Observe the following instructions to use the equipment safely.  Failure to 
follow these instructions could cause a burn, injury, or damage to physical 
assets.  For details, see safety precautions in Chapter 1. 
 

 

 
■ Do not lift the equipment alone. 
■ Do not install the equipment in non-designated places. 

  
 

 

 
 

 

 
* It is recommendable to use the server in a room where 

temperature can be kept between 15 and 25ºC. 

100V - 120 V or 200V - 240 V 
parallel bi-polar power outlet 
with grounding 

Room that can maintain the following 
conditions during operation:  
Temperature: 10 to 35ºC 
Humidity: 20 to 80% (non-condensing) 

Wall outlet within the 
reach of supplied power 
cord. 

UPS to prevent momentary voltage drop due to power 
failure or lightning * 
* Optional.  UPS is recommended for best use of 

features of ft server. 

Close enough to connect the 
mouse and the display. 

Floor or a level 
and robust desk or 
table.

Clean and tidy room 

Place having a space enough to fully open 
the front door (The front door extrudes about 
50 mm from the right side of the server 
when fully opened.) 
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Do not install NEC Express5800/ft series in such places as listed below.  Otherwise, the server 
may malfunction. 

� Place where temperatures change widely (near a heater, air conditioner, or refrigerator). 

� Place that is subject to intense vibration. 

� Place where corrosive gas (sodium chloride, sulfur dioxide, hydrogen sulfide, nitrogen 
dioxide, or ozone) is generated, or a place that is close to chemicals or exposed to 
chemicals. 

� Place whose floor is covered with non-antistatic carpet. 

� Place that may be subject to falling objects. 

� Place where you may step or trip on the power cords or interface cables. 

� Place that is close to some equipment that generates intense magnetic field (e.g., TV set, 
radio, broadcasting/communications antenna, power transmission wire, and 
electromagnetic crane). (If unavoidable, contact your sales agent to request proper shield 
construction.) 

� Place where the power cord of the server must be connected to an AC outlet that shares 
the outlet of another device with large power consumption. 

� Place that is close to some equipment that causes power noises (e.g., sparks caused by 
power-on/off using a relay).  If you must install the server close to such equipment, 
request your sales agent for separate power cabling or noise filter installation. 

It takes at least four people to carry the server; hold it firmly by its bottom and place it slowly on the 
selected site. 

IMPORTANT: Do not hold the front door to lift it, or it may become detached and 
fall down. 

After placing the main cabinet, lock its two front casters and screw the attached four stabilizers on 
the cabinet adjusting their height.  

 

Screws 

Stabilizer 

Lock lever 
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After fastening the main cabinet, open its front door to mount the CPU and PCI modules.  For 
details, see the following section “Installation of Rack-mount Model.”  Procedures are basically 
the same for the tower model except that its modules are mounted vertically instead of horizontally.   

IMPORTANT: Follow the procedures below to install the CPU and PCI modules.  
Note the followings before installing them. 

� Confirm the main cabinet is immobilized. 

� Place removed modules to the side of the system.  Do not place modules  on 
top of the system.  

� It takes at least two people to mount the modules; mount them slowly and 
carefully. 

� If you cannot install modules smoothly, remove them and try again. 

� Install the CPU modules in the left two slots, the PCI modules in the right two 
slots. 

� Perform installation from the left slots. 
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Installation of Rack-mount Model 

IMPORTANT: NEC Express5800/ft series is a precision instrument.  You should 
ask maintenance personnel to install it. 

You can mount NEC Express5800/ft series on a rack that conforms to the EIA standards.  To install 
a rack, contact your sales agent or maintenance personnel. 

CAUTION  
  

Do not attempt to install the server. 
 

 

 

To avoid the risk of personal injury, users should not attempt to install the 
server into the rack assembly.  The server should be installed in the rack only 
by trained maintenance personnel. 

  
 

 

 

 

 

 
 

 

 

* It is recommened to use the server in a room where 
temperature can be kept between 15 and 25ºC. 

Wall outlet within the 
reach of supplied power 
cord. 

100V - 120 V or 200V - 240 V 
parallel bi-polar power outlet 
with grounding 

Space 40 cm or more on top, 1 m or more 
on the front and rear, and 60 cm or more on 
the right and left. Room that can maintain the 

following conditions during 
operation:  
Temperature: 10 to 35ºC 
Humidity: 20 to 80% 
(non-condensing) 

Level and reinforced 
floor. 
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WARNING  
  

Observe the following instructions to use the server safely.  Failure to follow 
these instructions could lead to a death or serious injury.  For details, see 
safety precautions in Chapter 1. 
 

 

 ■ Do not install the equipment in non-designated places. 
■ Do not connect the ground wire to a gas pipe. 

  
 

CAUTION  
  

Observe the following instructions to use the equipment safely.  Failure to 
follow these instructions may cause a burn, personal injury, or damage to 
physical assets.  For details, see safety precautions in Chapter 1. 
 

 

 
■ Do not carry or install the equipment alone. 
■ Do not install the equipment in such a manner that its weight is imposed on a 

single place. 
■ Do not assemble or disassemble parts alone. 
■ Do not pull a device out of the rack if it is unstable. 
■ Do not leave two or more devices pulled out from the rack. 
■ Do not install excessive wiring. 

  
 

Do not install NEC Express5800/ft series in such places as listed below.  Otherwise, the server 
may malfunction. 

� Place where you cannot pull out the components fully. 

� Place that cannot sustain the total weight of the rack system. 

� Place where you cannot mount stabilizers or where you cannot perform installation 
without quake-resistant engineering. 

� Place whose floor is uneven or inclined. 

� Place where temperatures change widely (near a heater, air conditioner, or refrigerator). 

� Place that is subject to intense vibration. 

� Place where corrosive gas (sodium chloride, sulfur dioxide, hydrogen sulfide, nitrogen 
dioxide, or ozone) is generated, or a place that is close to chemicals or exposed to 
chemicals. 

� Place whose floor is covered with non-antistatic carpet. 

� Place that may be subject to falling objects. 

� Place that is close to some equipment that generates intense magnetic field (e.g., TV set, 
radio, broadcasting/communications antenna, power transmission wire, and 
electromagnetic crane). (If unavoidable, contact your sales agent to request proper shield 
construction.) 

� Place where the power cord of the server must be connected to an AC outlet that shares 
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the outlet of another device with large power consumption. 

� Place that is close to some equipment that causes power noises (e.g., sparks caused by 
power-on/off using a relay).  If you must install the server close to such equipment, 
request your sales agent for separate power cabling or noise filter installation. 

IMPORTANT: Temperature increase inside the rack and airflow 

If you install several components or the ventilation isn’t good inside the rack, the internal 
temperature may increase due to heat emitted from the components.  When the operating 
temperatures of NEC Express5800/ft series (10° to 35°C) are exceeded, there is a risk of 
malfunction.  You must take adequate precautions and measures for airflow inside the rack as 
well as in the room so that the internal temperature can be kept within this range during operation. 
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Connection 

Connect peripheral devices to NEC Express5800/ft series.  The server is provided with connectors 
for wide variety of peripheral devices on its front and rear.  The figure below illustrates available 
peripheral devices for the server in the standard configuration, and locations of the connectors for 
the devices.  After connecting t the peripheral devices, connect the provided power cord with the 
server, then plug the power cord into the power outlet. 

WARNING  
  

Observe the following instructions to use the server safely.  Failure to follow 
these instructions could lead to a death or serious injury.  For details, see 
safety precautions in Chapter 1. 
 

 

 ■ Do not hold the power plug with a wet hand. 
■ Do not connect the ground wire to a gas pipe. 

  
 

CAUTION  
  

Observe the following instructions to use the equipment safely.  Failure to 
follow these instructions may cause a burn, personal injury, or damage to 
physical assets.  For details, see safety precautions in Chapter 1. 
 

 

 
■ Do not plug the power cord in a nonconforming outlet. 
■ Do not plug too many cords in a single outlet. 
■ Do not plug the cord insecurely. 
■ Do not use nonconforming power cords. 

  
 

IMPORTANT: 
� Power off the server before connecting peripheral devices, with the exception of 

peripherals with USB interface.  Connecting a powered peripheral device to the 
powered server will cause malfunctions and failures. 

� To connect a third-party peripheral device or interface cable to the server, check 
with your sales agent to see if they are compatible with NEC Express5800/ft 
series.  Some third-party devices may not be used with the server. 

� The total cable length of SCSI device connections is up to 6 m, including the 
internal SCSI cables. 

� The serial port connectors are reserved for maintenance. 
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A tower model is shown here for convenience of explanation.  However, the steps are the same for 
a rack-mount model except that its modules are mounted horizontally. 

IMPORTANT: Place the USB floppy disk drive on top of the tower cabinet.  
However, to place it on a rack-mount model, put a distance of one unit between the 
disk drive and the module. 

 

 

IMPORTANT: Connection of optional devices 

� In the case of standard configuration, you need to complete setup of the operating 
system before mounting optional PCI cards or hard disks that you bought 
separately. 

� In the case of “Build-to-Order” configurations, if N8803-030 or 031 is mounted, 
be sure to connect cables to the additional cabinets before going on to the next 
steps. 

 

Display  

To a 100Mbps  
network 

To a 1000Mbps 
network 

To a SCSI  
backup device 

Keyboard (via keyboard hub to mouse) 

Reserved for
maintenance 

Reserved for
maintenance 

USB floppy 
disk drive 

1

1

2
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After connecting cables to PCI modules, secure them with the cable ties. 
<Tower model> 

 

When completing connection to peripheral equipment, connect the two provided power cords to the 
server.  After that, secure the cables with the cable tie provided in the server. 

Connect the plug at the other end of the power cord to a wall outlet with parallel double-pole 
grounds provided or to an uninterruptible power supply (UPS). 

To use the functions of the server, you should connect the server to the UPS. 

IMPORTANT: 
� Be sure to use both of the power cords to use ft series functions. 

� If both PCI modules are mounted, the one you plug in first will become the 
primary module. The power connector A is used for Group 1; the power connector 
B is for Group 2. 

� The module whose POWER switch LED is on is the primary. 

To connect the power cord from the server to an uninterruptible power supply (UPS), use service 
outlets on the rear of the UPS. 

The UPS service outlets are categorized into two groups: SWITCH OUT and UN-SWITCH OUT.  
(They may be called "OUTPUT1" and "OUTPUT2".) 

To control power supply with an application (NEC ESMPRO/UPSController) that controls the UPS, 
connect the power cord to a SWITCH OUT outlet. 

For constant power supply, connect the power cord to a UN-SWITCH OUT outlet.  (Connect the 
modem that is in service for 24 hours to this outlet.) 

When the power cord from the server is connected to a UPS, change the BIOS setup of the server to 
link with power supply from the UPS. 

Power cords
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Select [System Hardware] → [AC-LINK] on the BIOS setup utility and change parameters.  See 
Chapter 4 for details. 
< Example> 
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Setup of Windows 2000 Advanced Server 
Set up Windows 2000 Advanced Server and the system after hardware installation.  When 
reinstalling the system, also see this section. 

IMPORTANT: 
� Be sure to use the methods described here.  If you use the other ways, the installation of 

Windows 2000 Advanced Server will fail. 

� The status LEDs of CPU and PCI modules stay red; this is not a failure of the module. When 
the setup is finished and the duplex module is established, these LEDs will turn green.  For 
details, see “LEDs” in Chapter 2. 

� ft series Setup 

The ft series Setup is the install program for the NEC Express5800/ft series.  The ft 
series Setup helps you to install Windows 2000 Advanced Server.  You can use the ft 
series Setup is for reinstalling Windows 2000 Advanced Server to your server as well. 

IMPORTANT: Using the ft series Setup will format your system disk. 

The "NEC EXPRESSBUILDER" CD-ROM that comes with your server is used to run the 
ft series Setup program. 

You will also use the ft series Setup when you reinstall the operating system. 

IMPORTANT: 
If your computers have Windows 2000, Windows NT, or Windows 95/98/Me that 
communicate with the NEC Express5800/ft series through TCP/IP protocol, make the 
following settings for each computer: 
 
(1) Copy WINNT\W2K\FTREG.EXE from the NEC EXPRESSBUILDER CD-ROM into an 

arbitrary directory. 
(2) Activate the command prompt, enter desired directory for copying the above file, and then enter 

the following command: 
FTREG.EXE 
This setting is to avoid a timeout caused by non-communication state between the NEC 
Express5800/ft series and computers connected by the LAN protocol that may occur 
immediately after the NEC Express5800/ft series startup or a CPU module reinstallation (dual 
processing). 
Non-communication time immediately after the NEC Express5800/ft series startup or module 
reinstallation is proportional to the size of memory mounted. 
 

Memory size Non-communication time 
256MB About 2.3 seconds 
512MB About 4.7 seconds 
1GB About 9.3 seconds 
2GB About 18.6 seconds 
3GB About 27.9 seconds 
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This setup program sets the following Windows registry: 
� Windows NT or Windows 2000: 

 Registry key: 
  HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters 
 Values: 
  TcpMaxConnectRetransmissions 
  Type: REG_DWORD 
  Set value: 5 
 Values: 
  TcpMaxDataRetransmissions 
  Type: REG_DWORD 
  Set value: 8 
 Values: 
  TcpMaxConnectREsponseRetransmissions 
  Type: REG_DWORD 
  Set value: 5 
� Windows 95/98/Me: 

 Registry key: 
  HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\VxD\MSTCP 
 Values: 
  MaxConnectRetries 
  Type: String 
  Set value: 5 
 Values: 
  MaxDataRetries 
  Type: String 
  Set value: 8 
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Setup Flow 

Follow the flowchart below to setup the server.  See also this section when re-installing the system. 

  

START 

ft series Setup 

Setup for Failure Management

System Data Backup 

Setup Completed
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ft Series Setup 

Use NEC EXPRESSBUILDER to setup the NEC Express5800/ft series. 

IMPORTANT: 
� NEC Express5800/ft series is a precision instrument.  You should ask 

maintenance personnel to install it. You perform ft series setup for reinstallation. 
 

The ft series Setup program is exclusively used for the NEC Express5800/ft series.  To execute the 
setup program, simply select the item [Setup] from the menu displayed when starting the system 
through the provided CD-ROM "NEC EXPRESSBUILDER."  The setup program automatically 
performs the complete setups from hardware internal parameter/status settings to installation of the 
operating system (Windows 2000 Advanced Server) and various utilities. 

Use the ft series Setup program for the first installation and reinstallation of the operating system.  
This program accomplishes complicate setups. 

Before performing ft Series Setup, contact your sales agent about the latest release of ft control 
software. 

 

Operating System Installation 

Read the notes here carefully before installing the operating system. 

 

Operating System Supported by the NEC Express5800/ft series 

NEC Express5800/ft series supports the operating system, Microsoft Windows 2000 Advanced 
Server (English) (hereinafter called "Windows 2000 Advanced Server"). 

NEC Express5800/ft series does not support any operating systems (e.g., Windows 2000 Server and 
Windows NT 4.0) other than the above. 

 

BIOS Setup 

Check the BIOS settings for hardware before installing Windows 2000 Advanced Server.  The 
items in BIOS setting include functions (e.g., plug and play, and USB interface) that became 
available from Windows 2000 Advanced Server.  For details, see Chapter 4. 
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About Windows 2000 Advanced Server 

Use the ft series Setup program to install Windows 2000 Advanced Server.  Note the following at 
installation 

IMPORTANT: 
� Complete all the setups such as the memory expansion and BIOS setting before installing 

Windows 2000 Advanced Server. 

� NEC software package, which is to be purchased separately, is also provided with the 
documentation for installation.  However, see this User's Guide for installation into this server. 

� After completing the ft series Setup program, make settings for failure management (e.g., 
memory dump (debug information) setting) according to Chapter 3. 

Installation into a Mirrored Volume 

To install Windows 2000 Advanced Server into mirrored volumes by using [Volume Manager for 
Windows], disable volume mirroring to return to the basic disk before starting the installation, and 
mirror the volumes when completing the installation. 

To create mirrored volumes or disable/delete them, select [Volume Manager for Windows] from 
[Computer Management]. 

 

Size of the Partition to be Created 

The required minimum size of a partition to install the system can be obtained from the following 
formula: 

2048MB + paging file size + dump file size 
2048MB = size required for installation 
Paging file size (recommended) = size of memory mounted* × 1.5 
Dump file size = size of memory mounted* + 12MB 

 

IMPORTANT: 
� The above paging file size is necessary for collecting debug information (memory dump).  If 

a value smaller than the [Recommended] value is set for the initial size of the paging file, 
correct debug information (memory dump) may not be collected. 

� The maximum paging file size is 4095MB in a partition.  If 1.5 times the size of mounted 
memory is larger than 4095MB, set the size at 4095MB. 

� If the size of mounted memory is larger than 2GB, the maximum size of dump file is 
“2048MB+12MB.” 

 

NOTE: The mounted memory size means the total of memory installed on a single CPU module 

For example, if memory of 512MB is mounted, the required minimum partition size obtained from 
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the above formula is as follows: 

2048MB +(512MB × 1.5)+(512MB +12MB)=3340MB 

NOTE: In the case of ft series setup, you need to create a partition of 3072MB or 
more to perform auto installation. 

 

About Auto Installation of Utilities 

The ft series setup installs the following utilities automatically. 

� NEC ESMPRO Agent 

� VERITAS Volume Manager 

� NEC ESMPRO report service for VERITAS Volume Manager 
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Flowchart of Setup by the ft series Setup Program 

The following is the flowchart of setup by the ft series Setup program: 

Preparation for installing Windows 2000 

: Entered or selected by the 
user 

: Proceeds automatically 
 

Setup completed

Get ready to install Windows2000 Advanced Server 
and ft control software 

Enter the product ID of Windows 2000 

Specify the size of the partition to install the OS 

Insert Windows 2000 Advanced Server CD-ROM 

Automatic installation starts:
Windows2000 Advanced Server 
ft control software 
NEC ESMPRO Agent 
VERITAS Volume Manager 

Windows2000 Setup Wizard starts 

Agree to the terms of software license 
Enter user name and company name 

Set dual LAN configuration

 

 

Make setting of BIOS

Run [Setup] from NEC EXPRESSBUILDER top menu 

Set dual disk configuration 

Do necessary post-installation work  

Copy OS module to hard disk

Insert Windows 2000 Service Pack CD-ROM 
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Installing Windows 2000 Advanced Server 

The following explains the setup procedure using the ft series Setup program: 

IMPORTANT: Be sure to apply the required version of Windows2000 Service Pack.  
Other service packs cannot be applied. 

If you apply the service pack again after the setup, see “Apply Windows2000 Service 
Pack.” 
 

NOTE: For the latest information on support for Windows 2000 Service Pack, contact your sales 
agent. 

You need the following to install Windows 2000 Advanced Server: 

� NEC EXPRESSBUILDER (CD-ROM) 

� ft Control Software UPDATE CD-ROM 

This CD-ROM is used to update ft control software; it may not be included with the equipment. 
(Not included if “NEC EXPRESSBUILDER” CD-ROM contains the latest version of software 
programs at the time of shipment.) 

� Microsoft Windows 2000 Advanced Server CD-ROM 

� Windows 2000 Service Pack CD-ROM 

� User’s Guide (this manual) 

IMPORTANT: For the latest release of ft control software and purchase of the latest version of 
its Update CD-ROM, contact your sales agent. 
 

1. Turn on the peripheral equipment, and then the NEC Express5800/ft series.  

IMPORTANT: 
� You can mount only one disk into Slot #1 of the PCI module (for Group 1); the PCI module 

(for Group2) must be detached.  If more than one disk is mounted, you cannot specify the 
disk to perform installation.  If the PCI module (for Group2) is attached, the system may not 
recognize the hard disk during installation. 

� Before starting setup, attach all CPU modules. 

� Detach all LAN cables. 

� Detach all optional PCI boards before starting setup. 

2. Change the BIOS setup. 

Select [Advanced] → [Monitoring Configuration], and select [Disable] for [Boot 
Monitoring].  For details, see Chapter 4. 

IMPORTANT: If you skip this setting, BIOS will be restarted forcefully while Windows2000 
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Advanced Server setup screen is shown and the setup will be unsuccessful; BIOS may repeat 
Windows2000 setup in an invalid manner.  In this case, you will need to restart the setup 
procedures from the beginning. 
 

3. Insert the NEC EXPRESSBUILDER CD-ROM into the CD-ROM drive of the server. 

4. When having inserted the CD-ROM correctly, reset the system (press Ctrl, Alt, and 
Delete together), or turn the power off and then turn it on to restart the NEC 
Express5800/ft series. 

The system starts through the CD-ROM, and NEC EXPRESSBUILDER is activated. 

5. Click [Setup]. 

The "Notice" window appears. 

6. Press Enter. 

After the system restarts, formatting starts. 
The following message is displayed.  

"When you use ft control software 
UPDATE CD-ROM, please insert 
CD-ROM." 

7. If you have the "ft control software 
(Ver:n.n) UPDATE" CD-ROM, change the 
CD in the drive to the UPDATE CD-ROM, 
and press any key. If you do not have the UPDATE CD-ROM, press any keywithout 
changing the CD. 

When the system files are  copied, the product ID input box appears. 

8. Enter the product ID of Windows 2000 Advanced Server. 

The product ID of Windows 2000 Advanced Server is printed on the label of NEC 
Express5800/ft series. 

9. Specify the size of the partition to install the operating system. 

For details on partitions, see Chapter 3. 

10. Remove the "NEC EXPRESSBUILDER CD-ROM" or the "ft control software (Ver:n.n) 
UPDATE CD-ROM" from the CD-ROM drive according to the message, and insert the 
Windows CD-ROM into the CD-ROM drive. 

11. When the contents of the Windows 2000 Advanced Server CD-ROM are copied, remove 
the Windows 2000 Advanced Server CD-ROM from the CD-ROM drive according to the 
message, and insert the Windows 2000 service pack CD-ROM into the CD-ROM drive. 

Installation of Windows 2000 Advanced Server automatically starts.   
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IMPORTANT: 
� During automatic installation, a 

window will appear to show messages 
on progress and the applications will 
show their install wizards.  However, 
before “Windows 2000 Setup Wizard” 
window appears, do not do any 
operation on the screen. 

� If you close the installation progress 
window, the installation will be 
interrupted and Windows will be ready 
for use.  However, the dual 
configuration will not be established 
successfully.  In this case, you will 
need to install Windows 2000 
Advanced Server all over again. 

� If you find “Previous Operating 
System C:” on the OS selection screen, never select this.  If you have selected “Previous 
Operating System C:,” the following message will appear; press a key as instructed to return to 
the OS selection screen. 

  Non-system disk or disk error 

  Press a key to reboot 
 

When the installation is completed, the [Welcome to the Windows 2000 Setup Wizard] 
screen appears. 

12. Click [Next]. 

The [License Agreement] screen appears. 

13. Carefully read the terms of software license agreement, and click [Agree] when you agree 
to the terms, and then click [Next].  If you do not agree to the terms, click [Disagree], 
and then [Next]. 

IMPORTANT: If you do not agree to the terms of software license, the ft series 
Setup program terminates and Windows 2000 Advanced Server will not be installed. 

14. Enter user-specific information such as the user name and company name according to the 
messages, and complete the setup. 

15. After the setup is completed and the system restarts, log on as 
Administrator.  

16. Update software programs 

If you have performed installation using "NEC Express5800/ft series ft control software 
(Ver:n.n) UPDATE CD-ROM," apply all update modules by referring to "ft control 
software (Ver:n.n)" in the CD-ROM.  However, it is unnecessary to apply individual 
update modules here because the latest update module is automatically applied from the 
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NEC Express5800/ft series ft control software (Ver:n.n) UPDATE CD-ROM. 

– ft control software (Ver:n.n) update module 
– VERITAS Volume Manager 
– ESMPRO Report Service for VERITAS Volume Manager 

Although NEC ESMPRO Agent is automatically installed at ft series setup, the latest 
module is not applied.  You need to apply an update module separately from NEC 
Express5800/ft series ft control software (Ver:n.n) UPDATE CD-ROM. 

17. Register VERITAS Volume Manager’s authentic license key. 

Perform replacement of the license key by referring to [General Procedures] – [License 
Procedures] – [Using the System License Command] of VM3.1_Win2k_Users_Guide.pdf 
stored on the included NEC EXPRESSBUILDER CD-ROM.  This pdf file is located in 
the following directory: 

CD-ROM: \VXVM\VM Documentation 

You will find VERITAS Volume Manager’s authentic license key in an ID label that is 
placed on NEC Express5800/ft series.  The license key does not use the following 
alphanumeric characters: 1, 5, and Q. 

IMPORTANT: Do not use VERITAS Volume Manager’s dynamic relocation and hot spare 
functions for this server. 

18. After the re-startup, log on to the system as Administrator. 

19. Insert a PCI module (for Group 2). 

IMPORTANT: Do not mount disks in advance into the module you are going to insert.  You 
will mount disks in the procedures of setting dual disk configuration.  

 
Installation of Windows2000 Advanced Server is completed.  After checking if there are 
four icons for “Network and Dial-up Connections,” go on to dual configuration of LAN 
and disk. 
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Setting Dual LAN Configuration 

The NEC Express5800/ft series builds a dual LAN configuration by using "Stratus emb-82559 
10/100 Enet Adapter" (100Base) and "Stratus emb- 82544GC Copper Gigabit Adapter" (1000Base) 
mounted as standard on the PCI module. 

1. Click [Start] → [Settings] → [Control Panel]. 

The [Control Panel] dialog box appears. 

2. Double-click the [Intel(R)PROSet II] icon in the [Control Panel] dialog box. 

The [Intel(R)PROSet II] dialog box appears. 

3. Select [Network Components] from Network 
Component Tree.  The pop-up menu appears.  
Select [Create New Team...] → [Fault 
Tolerance]. 

 

IMPORTANT: Do not select the command other than 
[Fault Tolerance] on the standard PCI module. 

[Team #1: Adaptive Fault Tolerance Mode] is added to 
Network Component Tree. 

 

 

 

 

 

 

 

 

4. Select [Stratus emb- 10/100 Enet Adapter] from 
Network Component Tree.  The pop-up menu 
appears.  Select [Add to Team] → [Team #1: 
Adaptive Fault Tolerance Mode], and add the 
adapters. 

You will see the warning message when you 
add the team.  You can ignore this warning 
message by clicking [OK]. This warning 
message is to inform you that only one adapter 
is added to the team. 

5. Select [Stratus emb-82559 10/100 Enet Adapter 
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#2] from Network Component Tree in the same manner as for step 4.  The pop-up menu 
appears.  Select [Add to Team] → [Team #1: Adaptive Fault Tolerance Mode], and add the 
adapters. 

IMPORTANT: Do not set [Preferred Primary] or [Preferred Secondary] to each adapter. 

6. Make settings of dual configuration for "Stratus emb- 82544GC Copper Gigabit Adapter" 
(1000Base) as well. 

Perform Steps 3 –5 in the same manner, replacing [Stratus emb-82559 10/100 Enet Adapter] 
with [Stratus emb- 82544GC Copper Gigabit Adapter]. 

In Step 3, you can also select [Load Balancing].  In this case, [Team #X: Adaptive Load 
Balancing Mode] will be added. 

7. Click [OK]. 

The [Intel(R)PROSet II] dialog 
box closes after a while, and the 
settings become effective. 

IMPORTANT: 
� [Digital signature not found] 

dialog box may appear 
(several times).  If it 
appears, click [Yes]. 

� After the settings of dual 
configuration, “Intel(R) 
Advanced Network Services 
Virtual Adapter” will appear on [Network and dialup connection] or [Device 
Manager] dialog box.  Do not “disable” the status of this adapter.  If you enable it 
again, the system may become unstable and you may need to restart it. 
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Setting Dual Disk Configuration 

NEC Express 5800/ft series secures data by mirroring disks.  Be sure to make dual disk settings. 

NOTE: To set dual disk configuration, log on as "Administrator" or a member of the 
group "Administrators". 
 

IMPORTANT: 
� Make sure to mirror the volumes not only when installing an operating system but also when 

creating partitions. 

� After upgrading the volume that contains system partition to dynamic disk, set the disk for 
mirroring to the slot. Do not set the disk to the slot before upgrading. 

� Set the mirroring for the disk with the same target ID. See "Hard Disk configurations that can 
be built by VxVM on the NEC Express5800/ft series" in Chapter 5 for details.  

1. Select [Start] → [Setting] → [Control Panel], and then [Control 
Panel] screen appears 

2. Double-click [Administration Tool], double-click [Computer 
Management], and then [Computer Management] window 
appears. 

3. In the Tree view, under [Storage], click [Volume Management] 
→ [VERITAS Enterprise Administrator]. 

 

 

 

 

 

4. In the [Connection] dialog box, select “localhost (or machine 
name)” in [Host name]. 
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5. In the tree under localhost (or machine 
name) of [VERITAS Enterprise 
Administrator], click [Disk group] → 
[Basic group] to list hard disks on the 
right panel.  Right-click the disk on 
which the system is installed, and select 
[New dynamic disk group].   

A Dynamic Disk Group creation wizard 
will appear. 

 

 

 

 

 

6. Enter “DynamicGroup” in [Group name], and select the [Create Windows2000 Disk 
Management compatible group] check box.  

 
7. Check to see if the selected disk is the one where you installed the system, and click [Next]. 

8. Check the list of disks you are going to upgrade and click [Next].  
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9. Click [Finish] to upgrade the disk to a dynamic disk. 

If the selected disk contains a system partition, you will have to restart the computer to 
complete the upgrade of the disk. The message also states that file systems on any of the 
disks to be upgrade will be forcedly dismounted. This means if any file systems are in use 
at the time of upgrade, they will be dismounted, so that the upgrade can continue. 

Before restarting the server, check if the PCI module has a dual configuration. 

 

 
 

IMPORTANT: Note the following when restarting the machine for dual disk settings: 

� For the upgrade to the dynamic disk in which the system is installed, machine restarting 
may be requested several times. Always restart the machine after confirming the PCI 
module duplication. When the machine is restarted before the PCI module duplication, 
the dual LAN may become invalid If the dual LAN becomes invalid, make the settings 
of dual Lan again. 

� Check the PCI module duplication as follows: 

   The PCI module duplication is valid if both the status LED of PCI module #1 and that 
of PCI module #2 are lit green. See "PCI Module Status LED 1/2" for details. 

 

10. After reboot, when [VERITAS Volume Manager] appears, make settings of the disk to 
mirror volumes. 

When [Disk Upgrade and Signature] wizard appears, perform a disk upgrade and 
signature. 

IMPORTANT: A disk for mirroring should be placed in its 
corresponding slot. 
See "3.5-inch Hard Disk Drive" in Chapter 8 for details. 

11. Choose "Display a list of the known drivers for this device so that I can choose a specific 
driver", click [Next]. 
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12. Check and see that the device model is displayed as "Stratus Dual initiated disk Device" in 
the list,  and then keep on clicking [Next] until [Finish] appears. 

13. If the disk that has been set is not dynamic dick, upgrade the disk to dynamic disk. 

14. Right-click a volume and then click [Mirror]→[Add] to access the Add Mirror Wizard. 

 
15. When the Add Mirror wizard appears, check [Select disk manually], select a disk to mirror, 

and click [Select]. 

 
16. After checking the settings, click [OK]. 

TIPS: To add mirror to the volume having 18-GB, it will take about 37 minutes. 
 

IMPORTANT: If you reboot system while mirroring the volume, mirroringwill not 
complete. Until the mirroring is finished, DO NOT reboot the system. 

And then follow the instructions on the screen to continue operation. 
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Procedures after Completion of Installation 

Then make the following settings. 

� Connections and settings of several option devices 

If there are optional PCI boards and/or peripherals to be connected, turn off the power of 
the server and connect them referring to "Setup of Optional PCI Module" in Chapter 8 and 
the operation manuals of the peripheral devices. Set dual configurations after the LAN 
cards and hard disk drives are added. See "Setting Dual LAN Configuration" and 
"Mirroring the Volume with Volume Manager for Windows 2000" in Chapter 3. 

� Changes to BIOS settings 

After completing the installation, start the BIOS setup utility to set [Boot Monitoring] of 
[Advanced] - [Monitoring Configuration] to [Enable], save the settings, and restart the 
NEC Express5800/ft series. See Chapter 4 for details.  

� Setup for failure management 

� Backup of system information 
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 Setup for Failure Management 

Make the following settings beforehand to ensure quick recovery from failure. 

 

Setting Memory Dump (Debug Information) 

This section explains the setting for collecting memory dump (debug information) in the server. 

IMPORTANT: Notes on memory dump 

� The maintenance personnel designated by your sales agent are responsible for 
collecting memory dump.  Customers should make settings of memory dump 
only. 

� Sometimes a message indicating a shortage of virtual memory appears at the 
system startup, when a failure has occurred after making settings described here 
and you have restarted the system to save the memory dump.  Continue the 
startup.  If you restarting the system, you may not be able to collect the memory 
dump accurately. 

Take the following steps to set memory dump: 

1. Click [Start] → [Settings] → [Control Panel]. 

The [Control Panel] dialog box appears. 

2. Double-click the [System] icon. 

The [System Properties] dialog box appears. 

3. Click the [Advanced] tab. 

4. Click [Setup and Recovery...]. 
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5. Enter the location, where debug information is to be written, in the text box. 

When writing debug information 
under the file name 
"MEMORY.DMP" in the D drive: 

D:\MEMORY.DMP 

 

 

 

 

 

 

 

 

This server has the following location as a default value for installation.  It is 
recommendable to store file in this default location. 

%SystemDrive%\NECDump\MEMORY.DMP 

 

IMPORTANT: 
� [Full Memory Dump] should be specified for writing debug information.  However, if the 

mounted memory size is over 2GB, specify [Kernel Memory Dump]; you cannot specify [Full 
Memory Dump] 

� Specify a drive which has a free space of the size of memory in the NEC Express5800/ft 
series + 12MB or more. 

� If the memory has been expanded, the size of debug information (memory dump) to be 
collected changes.  Check the size of free space where debug information (memory dump) is 
to be written.  If memory of 2GB or more is mounted, the dump file size can be up to 
2048MB.  Free space of about [2048MB + 12MB] is required. 

6. Click [Performance Options...]. 

7. Click [Change...] in the [Virtual Memory] dialog box. 

8. Change the value set for [Initial Size] in the [Paging file size for selected drive] box to the 
[Recommended] value or more, and then click [Set]. 

IMPORTANT: 
� Be sure to create the file in the above size in the OS partition.  If a value smaller than the 

[Recommended] value is set for [Initial Size] of the paging file, accurate debug information 
(memory dump) may not be collected. 

� For the [Recommended] value, see "Size of the partition to be created" in Chapter 3. 
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� To be prepared for failure, it is recommended to press the dump button to see if the memory 
dump can be collected in normally beforehand. 

� If the memory has been expanded re-set the paging file according to the memory size 

9. Click [OK]. 

A message is displayed asking you to restart the system depending on the changed settings.  
Restart the system according to the messages. 
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Setting Dr. Watson 

Dr. Watson of Windows 2000 is a debugger for application errors.  When detecting an application 
error, Dr. Watson diagnoses the NEC Express5800/ft series, and records the diagnostic information 
(log).  Take the following steps to collect diagnostic information: 

1. Click [Start] → [Run...]. 

2. Enter "drwtsn32.exe" in the [Open] box, and 
click [OK]. 

The [Dr. Watson for Windows 2000] dialog 
box appears. 

 

 

3. Specify where you want to save diagnostic 
information in the [Log File Path] box. 

Diagnostic information is saved under the 
file name "DRWTSN32.LOG." 

NOTE: Do not specify a network path.  Be sure to 
specify a path on the local computer. 

4. Specify the crash dump file save destination 
in the [Crash Dump] box. 

TIPS: A "crash dump file" is a binary file that can be 
read by Windows Debugger. 

5. Select the following check boxes in the 
[Options] box. 

� [Dump Symbol Table] 

� [Dump All Thread Contexts] 

� [Append To Existing Log File] 

� [Create Crash Dump File] 

For the above functions, see the online help. 

6. Click [OK]. 
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Installing a Network Monitor 

A network monitor is useful for examining the causes of network failures and taking the 
countermeasures.  To use the network monitor, you need to restart the system after the installation.  
It is recommended to install the network monitor before a failure occurs. 

1. Click [Start] → [Settings] → [Control Panel]. 

The [Control Panel] dialog box appears. 

2. Double-click the [Add/Remove Programs] icon. 

The [Add/Remove Programs] dialog box appears. 

3. Click [Add/Remove Windows Components]. 

The [Windows Components Wizard] dialog box appears. 

4. Select the  [Management and Monitoring Tools] check box of components, and click 
[Next]. 

5. If a message is displayed asking you to insert "Windows 2000 Advanced Server" or 
"Service Pack 3" disk, insert the "Windows 2000 Advanced Server" CD-ROM into the 
CD-ROM drive, and click [OK]. 

6. Click [Finish] in the [Windows Components Wizard] dialog box. 

7. Click [Close] of the [Add/Remove Programs] dialog box. 

8. Close the [Control Panel] dialog box. 

You can also activate the network monitor by clicking [Start] → [Programs] → [Administrative 
Tools] → [Network Monitor]. 

For details on the operation, see the online help. 
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About Terminal Services installation 

When you install Windows 2000 Advanced Server Terminal Services in Application Server mode, 
you should install the service in the following procedure. 

1. Uninstall the hotfix of VERITAS Volume Manager. 

(If the hotfix isn't applied, skip 1) 

2. Uninstall the VERITAS Volume Manager. 

(If the VERITAS Volume Manager isn't installed, skip 2) 

From [Add/Remove Programs] on [Control Panel], uninstall the three programs in the listed 
order: 

(1) VERITAS Volume Manager 

(2) VERITAS Enterprise Administrator Service 

(3) VERITAS Enterprise Administrator 

3. Install the Terminal Services. 

4. Install VERITAS Volume Manager. 

5. Install the hotfix of VERITAS Volume Manager. 

(If there is no hotfix to apply, skip 5) 

TIPS: When the installation of terminal services is started, the warning for the four 
applications appears as you see in the figure below.  Ignore the warning because it 
does not show any trouble. 

 

NOTE: If any application other than the four applications in the figure above 
appears, uninstall the application. Then reinstall it after the terminal services are 
installed. 
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Updating the System 

IMPORTANT: NEC Express5800/ft series is a precision instrument.  You should 
ask maintenance personnel to update the system. 

You will need to update the system after you repair the system using the repair process. 

IMPORTANT: Applying Windows 2000 Service Pack 3 

Windows2000 Service Pack 3 is pre-loaded in the NEC Express5800/ft series. If you 
want to reinstall Service Pack 3 for an application or a service installation, follow the 
steps in “Applying Windows2000 Service Pack.” You do not need to use the system 
update function. 

  

IMPORTANT: 
� After you implement the following procedure, update a system. 

� Update the system after all the optional PCI boards are removed. 

1. Log on to the system with OS installed as user with Administrator authority. 

IMPORTANT: Check that the dual system is configured properly. (Check that 
STATUS2 LED of each PCI module stays green.) 

2. Dual LAN is canceled.  

IMPORTANT: When dual LAN is disabled, a setup of LAN will be deleted. Note 
down the setup information. 

a. Click [Start]-[Settings]-[Control Panel].  

And then, the [Control Panel] dialog box will be displayed. 

b. Double Click the [Intel(R)PROSet II] icon on the [Control Panel] dialog box.  

And then, the [Intel(R)PROSet II] dialog box will be displayed. 
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c. Remove the adapter from dual 
configuration. 

Right-click the [Stratus emb-82559 
10/100 Enet Adapter] adapter on 
control-tree which is left side of 
[Intel(R)PROSet II] dialog box. 

 

 

 

You will then see the dialogue box on the 
right of this 
paragraph. This is 
because one of two 
teamed adapters 
constituting dual 
configuration is 
removed. 

Click [Yes] button, to remove the adapter from Team. 

Remove the other adapter [Stratus emb-82559 10/100 Enet Adapter] and [Stratus 
emb-82544GC Copper Gigabit Adapter] in the same way. 

d. Right click [Team 
#1:Adaptive Fault 
Tolerance Mode] and 
select [Remove]. 

 

 

 

 

 

At that time, the dialog 
box shown on the right is 
displayed. This is a message for 
confirmation, so click [Yes] 
button. 

Remove the [Team #2:Adaptive 
Fault Tolerance Mode] in the 
same way. 
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e. Click [OK] button 
on [Intel PROSet 
II] dialog box, 
close it, and make 
a setup effective. 

The dual LAN will 
be canceled. 

 

 

 

 

 

 

3. Uninstallation of Intel(R) PROSet II 

a. Click [Start]-[Settings]-[Control Panel]. 

And then, the [Control Panel] dialog box will be displayed. 

b. Double-click the [Add/Remove Programs] icon on the [Control Panel] dialog box. 

And then, the [Add/Remove Programs] dialog box will be displayed. 

 
c. Select [Intel(R) PROSet II] from a list of [Currently installed programs:]. 

d. Click the [Change/Remove] button. 

At that time, the message on dialog box will be displayed. 

This is a message for confirmation of deletion, so click [OK] button. 
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e. Click the [Close] button on the [Add/Remove Programs] dialog box to close it. 

f. Reboot the system. 

IMPORTANT: Be sure to perform the following procedure No.6 after 
rebooting the system 
If you perform the next procedure (installation of PROSet II) without 
rebooting, PROSet II does not start after reboot. 
The system may become unstable. 

4. After rebooting the system, log on to the system as a user with Administrative rights. 

IMPORTANT: Check the dual system is configured properly. 
(Check that STATUS2 LED of each PCI module stays green.) 

5. Follow the steps below to update the system: 

Apply Windows 2000 Service Pack 3 during the system update. 

 

z If you do not have an UPDATE CD-ROM of NEC Express5800/ft series’ ft control 
software (and use NEC EXPRESSBUILDER CD-ROM): 

a) After logging in to the system as an account (such as Administrator), insert NEC 
EXPRESSBUILDER CD-ROM into the drive. 

b) On the “Master Controller Menu” screen that appears, click [Software Setup] and click 
[System Update] on the menu. 

c) Follow the messages that appear on the screen to continue. 

z If you have an UPDATE CD-ROM of NEC Express5800/ft series’ ft control software: 

a) After logging in to the system as an account (such as Administrator), insert the 
UPDATE CD-ROM into the drive. 

b) From [Start] of the taskbar, select [Specify filename and run] to run CD-ROM 
drive:\WINNT\W2K\UPDATE.EXE. 

c) Follow the messages that appear on the screen to continue. 
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Applying Windows2000 Service Pack 3 

To reapply Windows 2000 Service Pack 3 when you install some application on NEC 
Express5800/ft series, follow the steps below: 

IMPORTANT: Do not apply other service pack versions.  For the latest 
information on support for Windows 2000 Service Pack, contact your sales agent. 

1. Insert Windows 2000 Service Pack 3 CD-ROM into the drive. 

2. Run \W2Ksp3.exe. 

3. When finished, restart the system. 

4. Start Explorer from [Program] of Start menu. 

5. Overwrite the following files by copying them: 

File names: USBD.SYS 

 OPENHCI.SYS 

From: C:/PNPDRVRS 

To: C:/Winnt/system32/drivers 

Since the NEC Express5800/ft series module is replaced with the Service Pack module by applying 
Windows 2000 Service Pack 3, you will need to replace it with ft series module again. After that 
check to see that the file version is 1.0.1700.0 (file version is shown in the file properties). 

Modules File version 

ft series module OPENHCI.SYS: 1.0.1700.0 
USBD.SYS: 1.0.1700.0 

Service Pack 3 module OPENHCI.SYS: 5.0.2195.3649 

USBD.SYS: 5.0.2195.4943 

 

6. Restart the system. 
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INSTALLING MANAGEMENT UTILITIES 
The provided "NEC EXPRESSBUILDER" CD-ROM contains "NEC ESMPRO Agent" for 
monitoring NEC Express5800/ft series and "NEC ESMPRO Manager" for managing the NEC 
Express5800/ft series.  Install and setup these utilities in the NEC Express5800/ft series or the 
computer (management PC) that manages the NEC Express5800/ft series.  

 

NEC ESMPRO Agent 

NEC ESMPRO Agent is automatically installed by executing the "ft series Setup program."  (It has 
been installed on the hard disk of a pre-installed model at shipment.) 

Click [Start] → [Programs], and make sure that the installed utility folder exists.  If it has not bee 
installed while setting up the ft series, see Chapter 5 and install it. 

IMPORTANT: Make sure that NEC ESMPRO Agent is installed because it is 
indispensable for continuous operation of NEC Express5800/ft series. 

To set details about NEC ESMPRO Agent, double-click the 
[NEC ESMPRO Agent] icon in the [Control Panel] dialog box.  
The properties dialog box appears for changing the settings. 

 

 

 

For details on the set items, see the online help displayed by 
clicking on [Help]. 
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NEC ESMPRO Manager 

Linked with NEC ESMPRO Agent installed in the server, NEC ESMPRO Manager monitors the 
server status and receives alerts from the server. 

 
When a failing module in the server is to be replaced, NEC ESMPRO Manager enables logical 
module disconnection from the server and logical installation after module replacement. 

For the installation of NEC ESMPRO Manager and notes on the operation, see Chapter 5. 

 

NEC MWA 

Management Workstation Application (NEC MWA) is an application program for remote 
management of NEC Express5800/ft series from a management PC (a computer with the NEC 
ESMPRO Manager running) through a network.  The MWA provides management on the process 
from power-on, POST execution, to OS boot-up of the server. 

� Checking the BIOS setup of the NEC Express5800/ft series from the management PC 

� Starting the server through the floppy disk in the floppy disk drive of the management PC 

To establish communication between the NEC Express5800/ft series and the management PC via a 
LAN, WAN, or serial port, install "MWA Manager" in the management PC. 

For the installation of NEC MWA and notes on the operation, see Chapter 5. 

 

 

Global Array Manager 

Global Array Manager (hereinafter called GAM) is a utility that manages and maintains 
N8190-82F/82AF Fibre Channel Disk Array Unit. For GAM functions and installation, see the 
manuals provided with N8190-82F/82AF Fibre Channel Disk Array Unit. 
 
 

Error

Notify

Monitor 

NEC ESMPRO Manager 

NEC ESMPRO Agent
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BACKUP OF SYSTEM INFORMATION 
After setting up the system, back up the system information using the Off-line Maintenance Utility. 

Without backup for system information, the information and settings that are specific to your server 
cannot be restored if the server is repaired.  Take the following steps to make a backup copy of the 
system information: 

1. Get a 3.5-inch floppy disk. 

2. Insert the "NEC EXPRESSBUILDER" CD-ROM into the CD-ROM drive of the server, and 
restart the system. 

NEC EXPRESSBUILDER is activated and the [NEC EXPRESSBUILDER Top Menu] is 
displayed. 

3. Select [Tool] → [Off-line Maintenance Utility]. 

4. Select [Save System NVRAM/ROM Data] from [System Information Management]. 

Follow the instructions you see on the screen. 

 

SETTING UP THE OPTIONAL BOARDS 
If one or more optional boards for the NEC Express5800/ft series including the SCSI controller and 
network boards are inserted, see “Setup of Optional PCI Board in Chapter 8. 

IMPORTANT: NEC Express5800/ft series is a precision instrument.  You should 
ask maintenance personnel to set up optional boards. 
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CONFIRMATION OF THE ft CONTROL SOFTWARE VERSION 
The following describes how to check the version of ft control software, which consists of various 
types of software for fault tolerance.  Perform the procedure when you need to check the ft control 
software version of the current system before adding units or attachment to NEC Express5800/ft 
series. 

A tool for checking the version is provided.  Confirm the version afollowing the steps below: 

1. Log in the system as an authorized Administrator. 

2. Insert the provided "NEC EXPRESSBUILDER" CD-ROM in the CD-ROM drive. 

Use the "NEC Express5800/ft series ft control software UPDATE" CD-ROM, if it is 
available. 

3. Run the tool installed in the CD to check the version of ft control software. 

Tool name: ftVerChk.exe 

Location: <CD-ROM drive>: FTSVTOOL\VERSION 

The ft control software version of the current system is displayed. 

 
This completes confirmation of the version. 
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Chapter 4 

System Configuration 

This chapter describes Basic Input Output System (BIOS) configuration. 

When you install the server for the first time or install/remove optional devices, thoroughly read this 
chapter for better understanding and correct setups. 
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SYSTEM BIOS ~ SETUP ~ 
The SETUP utility is provided to make basic hardware configuration for the server.  This utility is 
pre-installed in the flash memory of the server and ready to run. 

The server is configured with the correct parameters using the SETUP utility and shipped in the best 
conditions.  Thus, you don't need to use the SETUP utility in most cases.  However, you might 
wish to use the SETUP utility in the cases described below. 

IMPORTANT:  

� The SETUP utility is intended for system Administrator use only. 

� The SETUP utility allows you to set a password.  The server is 
provided with two levels of password: Supervisor and User.  With 
the Supervisor password, you can view and change all system 
parameters of the SETUP utility.  With the User password, system 
parameters available for viewing and changing are limited. 

� Do not set any password before installing the OS. 

� The server contains the latest version of the SETUP utility.  Dialog 
boxes appearing on your SETUP utility, thus, may differ from 
descriptions in this User's Guide.  If you find anything unclear, see 
the online help or ask your sales agent. 
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Starting SETUP Utility 

Powering on the server starts POST (Power On Self-Test) and displays its check results.  If the 
NEC logo is displayed, press Esc. 

After a few seconds, either of the following messages appears at bottom left on the screen 
depending on your system configuration. 

Press <F2> to enter SETUP
 

Press <F2> to enter SETUP, Press <F12> to Network
 

You may see either of the following messages at bottom left on the screen when POST terminates. 

 

Press <F1> to resume, <F2> to SETUP
 

Press <F1> to resume, <F2> SETUP, <F12> Network
 

Press F2 to start the SETUP utility and display its Main menu. 

If you have previously set a password with the SETUP utility, the password entry screen appears.  
Enter the password. 

Enter password:[              ]
 

Up to three password entries will be accepted.  If you fail to enter the password correctly for three 
consecutive times, the server halts.  (You can no longer proceed.)  Power off the server. 

TIPS: The server is provided with two levels of password: Supervisor 
and User.  With the Supervisor password, you can view and change all 
system configurations.  With the User password, the system 
configurations you can view or change are limited. 
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Description of On-Screen Items and Key Usage 

Use the following keyboard keys to work with the SETUP utility.  (Key functions are also listed at 
the bottom of the screen.) 
 

Thermal Sensor 
Wake On Events 
AC-LINK: 
Error Log Initialization: 
Console Redirection

Thermal Sensor Menu.

Item Specific Help

[Last State]  
Enter

Main Advanced Security System Hardware Boot

Phoenix BIOS Setup Utility

Exit

F1   -/+      Change F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter Select Esc Exit 

Select Item 
Select Menu 

Indicates the current menu.

Explanation of key 
function menu 

Parameter (high-lights upon selection) menu 

Online help 
window 

Indicates there 
are submenus. 

Setup item 
menu 

ft Memory

 

Cursor (↑ , ↓ ): Selects an item on the screen.  The highlighted item is currently 
selected. 

Cursor (←, →): Selects the Main, Advanced, Security, System Hardware, Boot, or 
Exit menu. 

– and +: Changes the value (parameter) of the selected item.  When a 
submenu option (an option preceded by " ") is selected, these 
keys are disabled. 

Enter Press Enter to choose the selected parameter. 
Esc Displays the previous screen. 
F1: Press F1 when you need help on SETUP operations.  The help 

screen for SETUP operations appears.  Press Esc to return to 
the previous screen. 

F9: Sets the default parameter to the parameter of the currently 
displayed item.  (The default parameter may differ from the 
factory setting. 

F10: Save configuration values and exit. 
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Configuration Examples 

The following describes examples of configuration required to use software-link features or for 
system operations. 

 

Link with Management Software 

To link thermal sensor monitoring feature with NEC ESMPRO 

Select [System Hardware] → [Thermal Sensor] → [Thermal Sensor] → [Disabled]. 

To control power supply of the server with NEC ESMPRO Manager via the network 

Select [System Hardware] → [AC-LINK] → [StayOff]. 

To use the management PC with "NEC MWA" installed for remote operations 

� Remote operation via LAN 

Select [Advanced] → [Advanced] → [RomPilot Support] → [Enabled]. 

� Remote operation via direct connection using cross cable 

Select [System Hardware] → [Console Redirection] → [Direct]. 

� Remote operation via WAN 

Select [System Hardware] → [Console Redirection] → [Modem]. 

 

UPS 

To link power supply with the UPS 

� To power on the server when power is supplied from the UPS 

Select [System Hardware] → [AC-LINK] → [Power On]. 

� To keep the server off-powered even when power is supplied from the UPS if the POWER 
switch was used to power off 

Select [System Hardware] → [AC-LINK] → [Last State]. 

� To keep the server off-powered even when power is supplied from the UPS 

Select [System Hardware] → [AC-LINK] → [StayOff]. 

 

Keyboard 

To set Numlock and key repeat 

Select [Advanced] → [Numlock] and set each item. 
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Security 

To set passwords on the BIOS level 

Select [Security] → [Set Supervisor Password] and enter a password. 

Set Supervisor password first, then User password. 

To enable/disable the POWER switch 

Select [Security] → [Power Switch Mask] → [Unmasked]. 

Select [Security] → [Power Switch Mask] → [Masked]. 

IMPORTANT: Masking the POWER switch disables forced 
shutdown (see Chapter 7) as well as power on/off using the POWER 
switch. 

 

External Devices 

To setup external devices 

Select [Advanced] → [Peripheral Configuration] and setup each device. 

 

Internal Devices 

To install the disk array controller board or graphic accelerator board 

Select [Advanced] → [Option ROM] [PCI Slot n] → [Enabled]  

n: Slot number to install the board 
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Boot 

To change the boot order of devices connected to the server 

Select [Boot] and specify the boot order. 

To display POST check results 

Select [Advanced] → [Advanced] → [Boot-time Diagnostic Screen] → [Enabled]. 

You can also press Esc while the NEC log is on the screen to display POST check results. 

To control from the HW console 

� Remote operation via LAN 

Select [Advanced] → [Advanced] → [RomPilot Support] → [Enabled]. 

� Remote operation via WAN 

Select [System Hardware] → [Console Redirection] and set each item. 

 

Memory 

To check the installed memory (DIMM) status 

Select [Advanced] → [Memory Reconfiguration] and check the status indications. 

 

Saving the Configuration Data 

To save the BIOS configuration data 

Select [Exit] → [Save Changes & Exit] or [Save Changes]. 

To discard changes to the BIOS configuration data 

Select [Exit] → [Exit Without Saving Changes] or [Load Previous Value]. 

To restore the factory-set BIOS configuration data 

Select [Exit] → [Get Default Values]. 
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Menu and Parameter Descriptions 

The SETUP utility has the following six major menus: 

� Main 

� Advanced 

� Security 

� System Hardware 

� Boot 

� Exit 

To configure detailed settings of functions, select a submenu from the above menus.  Below 
describes configurable functions and parameters and the factory settings displayed in the screen for 
each menu. 

 

Main 

Start the SETUP utility to display the Main menu. 

 Phoenix BIOS Setup Utility

Main Advanced Security System Hardware Boot

Processor Type: 
Processor Speed: 
Cache RAM: 
System Memory: 
Extended Memory: 

  BIOS Version: 
System Time: 
System Date: 
Language: 

  Primary Master: 

  
  

<Tab>, <Shift-Tab>, or 
<Enter> selects field.

Item Specific Help

Exit

Intel(R) Xeon(TM)processor 
2.40 GHz 
512KB 
584KB 
511MB 

 REL.6.0.8:M-1 
[18:54:08] 
[
[English(US)] 

 CD-ROM 

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter Select Esc Exit 

/ 12/ 2002] 11

Select Item 
Select Menu  
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Available options in the Main and descriptions are listed below. 

Option Parameter Description Your Setting 
Processor Type Intel®Xeon™Processor Indicates the type of the installed 

CPU (view only). 
 

Processor Speed 2.4GHz Indicates the clock speed of the 
installed CPU (view only). 

 

Cache RAM 512KB Indicates the cache RAM size (view 
only). 

 

System Memory 584KB Indicates the total size of the basic 
memory (view only). 

 

Extended Memory (Extended memory 
size) 

Indicates the total size of the 
extended memory (view only). 

 

BIOS Version (Version of BIOS) Indicates the version of the system 
BIOS (view only). 

 

System Time HH:MM:SS Specify the current time.  
System Date MM/DD/YYYY Specify the current date.  
Language English (US) 

Français 
Deutsch 
Italiano 
Español 

Select a language in which the 
SETUP is displayed. 

 

Primary Master CD-ROM Indicates device type connected to 
IDE (Primary master).  (View only) 

 

  [   ]: Factory-set 
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Advanced 

Move the cursor onto "Advanced" to display the Advanced menu.  

 

 
Advanced 
Processor Information 
Memory Information 
Peripheral Configuration 
Monitoring Configuration 
Option ROM 
Keyboard Features

Select Advanced  
options.

Item Specific Help

Phoenix BIOS Setup Utility

Main Advanced Security System Hardware Boot Exit

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter SelectEsc Exit

Select Item
Select Menu  

There is no configurable items on the above Advanced menu screen .  Display each sub menu and 
make settings on the sub menu screen.  Select an option with the "►" mark and press Enter to 
display its submenu. 
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Advanced 
Select "Advanced" on the Advanced menu to display the following screen. 

 
See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
Boot-time 
Diagnostic Screen

[Disabled] 
Enabled 

Specify whether to display the Power On 
Self-Test (POST) screen at start-up.  If 
"Disabled" is selected, the NEC logo 
appears while POST is in progress.  (To 
display POST check results, press Esc.) 
If "RomPilot Support" is set to "Enabled" or 
"Console Redirection" is set, this option is 
unconditionally set to "Enabled". 

 

RomPilot Support [Disabled] 
Enabled 

Enable or disable the RomPilot (the remote 
console and remote drive features during 
OS start-up).  If this option is set to 
"Enabled", "Boot-time Diagnostic Screen" is 
unconditionally set to "Enabled". 

 

Post Error Pause [Enabled] 
Disabled 

Specify whether to stop POST at the end of 
POST when an error occurs during POST. 

 

  [   ]: Factory-set 

NOTE: "RomPilot" is a BIOS feature for communications with the 
NEC Management Workstation Application (NEC MWA).  To use the 
MWA for management of the server, select "Enable" for "RomPilot 
Support."  Use of the RomPilot features requires setups for the MWA. 

Select Item
Select Menu

 
 

Boot-time Diagnostic Screen: 
RomPilot Support: 
POST Error Pause:

Display the diagnostic 
screen during POST 
instead of the Logo. 
The boot-time diagnostic 
screen is redirection  
or rompilot is enabled. 

Item Specific HelpAdvanced
 
 

[Disabled]
[Disabled]
[Enabled]

Phoenix BIOS Setup Utility

Advanced

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter SelectEsc Exit

Select Item
Select Menu
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Processor Information 
Select "Processor Information" on the Advanced menu to display the following screen. 

 
 

Processor 1 Type: 
Processor 2 Type:

 

Item Specific HelpProcessor Information
 
 

xxxxxxxx 
xxxxxxxx

Phoenix BIOS Setup Utility

Advanced

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter SelectEsc Exit

Select Item
Select Menu  

See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
Processor 1 Type 
Processor 2 Type 

– Indicates processor type installed on 
Processor 1 or Processor 2 (view 
only). 
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Memory Information 
Select "Memory Information" on the Advanced menu to display the following screen. 

 
See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
DIMM #1- #6 Size – Indicates the size of memory installed 

on DIMMs 1 (#1) to 6 (#6).  "None" 
indicates no DIMM installed (view 
only). 

 

DIMM #1- #6 Speed – Indicates the type of DIMM 
(DDR200/DDR266) installed on 
DIMMs 1 (#0) to 6 (#6).  "None" 
indicates no DIMM installed (view 
only). 
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Peripheral Configuration 
Select "Peripheral Configuration" on the Advanced menu to display the following screen. 

 
See the table below for setup options on the screen. 

IMPORTANT: Make sure to avoid any conflict in the interrupt 
requests or the base I/O addresses. 

Option Parameter Description Your Setting 
Serial Port A 
Serial Port B 

Disabled 
3F8, IRQ 3 
[3F8, IRQ 4]*1 
[2F8, IRQ 3]*2 
2F8, IRQ 4 
3E8, IRQ 3 
3E8, IRQ 4 
2E8, IRQ 3 
2E8, IRQ4 
Auto 

Enable or disable the serial port A and 
B, or specify a base address and 
interrupt. 
 
*1  Factory setting for the serial port 
A 
*2  Factory setting for the serial port 
B 
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Serial Port A: 
Serial Port B:

Disables serial port 1 
or sets the base 
address/IRQ of
serial port 1.

Item Specific HelpPeripheral Configuration
 
 
[3F8, IRQ 4] 
[2F8, IRQ 3]

Phoenix BIOS Setup Utility

Advanced

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter Select Esc Exit

Select Item
Select Menu
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Monitoring Configuration 
Select "Monitoring Configuration" on the Advanced menu to display the following screen. 

Option ROM Scan Monitoring:  
  Option ROM Monitoring 

Boot Monitoring:  
   Boot Monitoring Time-out Period:  
POST Pause Monitoring: 
   POST Pause Monitoring Time-out: 

Option ROM Scan  
Monitoring features

Item Specific HelpMonitoring Configuration

[Disabled] 
[5] 
[Enabled] 
[8] 
[Enabled] 
[3]

Phoenix BIOS Setup Utility

Advanced

F1   -/+      Change F9  Setup
F10 Save Changes & ExitSub-MenuEnter SelectEsc Exit

Select Item
Select Menu

Displayed only when "Enabled" is selected for "Option ROM Scan 
Monitoring", "Boot Monitoring" or "POST Pause Monitoring".  

See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
Option ROM 
Scan Monitoring

[Disabled] 
Enabled 

Enable or disable the Option ROM scan monitoring 
feature. 

 

Option ROM 
Monitoring 
Time-out 

1 - [5] - 20 Specify the Option ROM monitoring time-out 
period.  This option is displayed only when 
"Enabled" is selected for "Option ROM Scan 
Monitoring". 

 

Boot Monitoring Disabled 
[Enabled] 

Enable or disable the boot monitoring feature.  
This function is unique to the ft series: detects 
errors until the OS boots up, and immediately 
reboots the OS upon detection of an error. (For 
details, see “Behavior at Occurrence of Error” in 
Chapter 2.) Enable this function if NEC ESMPRO 
Agent is installed on the OS. Disable this function if 
NEC ESMPRO Agent is not installed or when you 
install the OS.  Otherwise, the OS will boot up 
after “Specified boot timeout.” 

 

Boot Monitoring 
Time-out Period 

1 - [10] - 20 Specify the boot monitoring time-out period.  This 
option is displayed only when "Enabled" is selected 
for "Boot Monitoring". 

 

POST Pause 
Monitoring 

[Disabled] 
Enabled 

Enable or disable the POST monitoring feature 
during boot-up restriction.   

 

POST Pause 
Monitoring 
Time-out 

1 - [3] - 20 Specify the POST monitoring time period during 
boot-up restriction. 

 

  [   ]: Factory-set 

IMPORTANT: When connecting a Fibre Channel disk array device, change the set 
value of "Boot Monitoring Time-out Period" depending on the wait time for the 
completion of the Fibre Channel disk array device initialization. 
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Ex.: If the wait time for the completion of the Fibre Channel disk array 
device initialization is 4 minutes, change the value of "Boot 
Monitoring Time-out Period" from 8 (default) to 12 minutes. 

 
Option ROM 
Select "Option ROM" on the Advanced menu to display the following screen and enable/disable 
expansion of Option Rom BIOS on the PCI bus. 

 
See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
On Board SCSI Disabled 

[Enabled] 
Enable or disable expansion of SCSI 
BIOS on the motherboard. 

 

On Board LAN 1, 2 Disabled 
[Enabled] 

LAN1: Enable or disable 10/100BASE 
LAN controller on the 
motherboard. 

LAN2: Enable or disable 1000BASE 
LAN controller on the 
motherboard. 

 

PCI Slot 1 - PCI Slot 3 Disabled 
[Enabled] 

Enable or disable BIOS on a device 
(board) connected to the PCI bus.   
Select "Enabled" for the graphic 
accelerator board.  Always select 
"Enabled" for the SCSI PCI device to 
which the hard disk that contains OS 
is connected. 
Select "Disabled" for Option ROM of 
PCI LAN device when the network 
boot feature is not used. 

#1: 
#2: 
#3: 
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On Board SCSI:
On Board LAN 1: 
On Board LAN 2:
PCI Slot 1: 
PCI Slot 2: 
PCI Slot 3: 

 

Disables/enables the 
mapping of the on-board 
SCSI BIOS.

Item Specific HelpOption ROM
 
 
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]

 

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter Select Esc Exit

Phoenix BIOS Setup Utility

Advanced

Select Item
Select Menu
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Keyboard Features 
Select "Keyboard Features" on the Advanced menu to display the following screen.  The Numlock 
submenu allows you to make keyboard settings. 

 
 

NumLock: 
Key Click: 
Keyboard Auto-repeat Rate: 
Keyboard Auto-repeat Delay:

Selects Power-on state 
for Numlock.

Item Specific HelpKeyboard Features
 
 

[Auto] 
[Disabled] 
[10/sec] 
[1 sec]

Phoenix BIOS Setup Utility

Advanced

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter SelectEsc Exit

Select Item
Select Menu  

See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
Numlock [Auto] 

On 
Off 

Enable or disable the Numlock feature 
at system start-up.  If "Auto" is 
selected, the Numlock feature will be 
enabled when an entry with the 
keypad is detected. 

 

Key Click [Disabled] 
Enabled 

Enable or disable the key click sound.  

Keyboard 
Auto-repeat Rate 

2/sec 
6/sec 
[10/sec] 

Select the number of characters 
repeatedly output in one second when 
a key is pressed. 

 

Keyboard 
Auto-repeat Delay

0.25 sec 
0.5 sec 
0.75 sec 
[1 sec] 

Select a period before a key character 
starts repeated. 
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Security 

Move the cursor onto "Security" to display the Security menu. 

 
Select "Set Supervisor Password" or "Set User Password" and press Enter to display the following 
pop-up screen. 

The screen below shows when "Set Supervisor Password" is selected. 

 Phoenix BIOS Setup Utility

Supervisor Password is 
User Password is 
Set Supervisor Password 
Set User Password 
Password on boot: 

  
Power Switch Mask: 
Option ROM Menu Mask: 

Supervisor Password 
controls access to the 
setup utility.

Item Specific Help
Clear 
Clear 
[Enter] 
Enter 
[Disabled] 

 [Unmasked] 
[Unmasked] 
[Disabled] [                     ] 

[                     ]

Set Supervisor Password

Enter new password: 
Confirm new Password: 

Main Advanced Security System Hardware Boot Exit

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter Select Esc Exit 

Select Item 
Select Menu  

Set a password on this pop-up screen.  Enter a password of up to seven alphanumeric characters 
and symbols from the keyboard. 

 

Supervisor Password is
User Password is 
Set Supervisor Password
Set User Password 
Password on boot:

 Power Switch Mask: 
Option ROM Menu Mask: 

Supervisor Password 
controls access to the 
setup utility.

Item Specific Help
Clear 
Clear 
[Enter] 
Enter 
[Disabled] 

 [Unmasked] 
[Unmasked] 

Main Advanced Security System Hardware Boot Exit

Phoenix BIOS Setup Utility

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter Select Esc Exit

Select Item
Select Menu



System Configuration  4-19 

IMPORTANT:  

� User password setup is not available before Supervisor password 
setup. 

� Do not set any password before installing the OS. 

See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
Supervisor 
Password is 

[Clear] 
Set 

Indicates Supervisor password setup status (view 
only). 

 

User Password 
is 

[Clear] 
Set 

Indicates User password setup status (view only).  

Set Supervisor 
Password 

Up to 7 
alphanumeric 
characters 

Press Enter to display the supervisor password 
entry screen.  With the supervisor password, all 
SETUP menus are available for access.  This 
option is available only when you log into the 
SETUP utility with the supervisor password. 

 

Set User 
Password 

Up to 7 
alphanumeric 
characters 

Press Enter to display the user password entry 
screen.  With a user password, accessing the 
SETUP menus is restricted.  This option is 
available only if the Supervisor Password is 
specified. 

 

Password on 
boot 

Enabled 
[Disabled] 

Specify whether to request a password entry at 
boot-up.  Supervisor password setup is required 
beforehand.  When the supervisor password is 
specified and this option is disabled, the BIOS 
assumes that a system boot attempt is made by a 
user. 

 

Power Switch 
Mask 

[Unmasked] 
Masked 

Enable or disable the POWER switch on the 
server.  If "Masked" is selected, power-off with 
the POWER switch becomes unavailable after OS 
boot-up.  (Forced shut down also becomes 
unavailable.  Forced shut down is a feature to 
shut down by pressing the POWER switch for 
over four seconds.) 

 

Option ROM 
Menu Mask 

[Unmasked] 
Masked 

Enable or disable key entries during optional 
ROM expansion. 

 

  [   ]: Factory-set 
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System Hardware 

Move the cursor onto "System Hardware" to display the System Hardware menu. 

 
The table below lists options that you can specify on the System Hardware menu screen and their 
functions.  To make a selection for "Thermal Sensor", "Wake On Event", and "Console 
Redirection", first select a desired option and press Enter to display its submenu. 

See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
AC LINK Stay Off 

[Last State] 
Power On 

Specify the AC LINK feature by selecting the 
status of the power supply unit of the server 
when the AC power supply restarts.  (See 
the table below for details.)  Do not select 
the parameters other than "Stay Off" when 
"Enabled" is selected for "Wake On Lan." 

 

Error Log 
Initialization 

Enter Press Enter to initialize the error log.  The 
message "Error Log Cleared" appears upon 
successful completion.  If failed, the 
message "Error Log Not Cleared!" appears. 

 

  [   ]: Factory-set 
 
The table below lists how selections for "AC LINK" determine the power status of the server when 
the power supply to the server restarts. 

Parameter State before powered off Stay Off Last State Power On 
In service Off On On 
Out of service (DC power: Off) Off Off On 
Forced shutdown * Off Off On 

* Pressing the POWER switch for over four seconds shuts down the power to the server. 
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Thermal Sensor 
Select "Thermal Sensor" on the System Hardware menu and press Enter to display the following 
screen. 

 
See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
Thermal 
Sensor 

[Enabled] 
Disabled 

Enable or disable the thermal sensor 
monitoring feature. 

 

Upper Limit 7 - [48] - 80 Specify the upper limit temperature for 
boot-up restriction in Celsius.  Specify a 
value greater than the "Lower Limit" by at 
least 8 using + and – keys. 

 

Lower Limit 0 - [5] - 73 Specify the lower limit temperature for 
boot-up restriction in Celsius.  Do not 
specify 4 degrees or lower.  Specify a value 
smaller than the "Upper Limit" value by at 
least 8 using + and – keys. 

 

[   ]: Factory-set 
 

Thermal Sensor: 

 Upper Limit: 
Lower Limit:

Determines if BIOS will 
disable boot, if the
temperature is not 
within safe range.

Item Specific HelpThermal Sensor 
 
 
[Enabled]

 [48] 
[5]

System Hardware

Phoenix BIOS Setup Utility

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter SelectEsc Exit

Select Item
Select Menu
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Wake On Events 
Select "Wake On Events" on the System Hardware menu and press Enter to display the following 
screen. 

 
 

Wake On LAN: 
 

Enables Wake On LAN 
support.

Item Specific HelpWake On Events
 
 

[Enabled]

System HardwareSystem Hardware

Phoenix BIOS Setup Utility

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter SelectEsc Exit

Select Item
Select Menu  

See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
Wake On LAN Disabled 

[Enabled] 
Enable or disable the remote power-on 
feature via the network. 
When "Enable" is selected, change the 
"AC-LINK" setting in the "System Hardware" 
to "Stay Off". 
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Console Redirection 
Select "Console Redirection" on the System Hardware menu and press Enter to display the 
following screen. 

 
 

Serial Port Address: 
 
Baud Rate: 
Flow Control: 
Console Connection:

If enabled, the console 
will be redirected to 
this port.

Item Specific HelpConsole Redirection
 
 

[Disabled] 
 
[19.2K] 
[XON/XOFF] 
[Direct]

System Hardware

Phoenix BIOS Setup Utility

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter SelectEsc Exit

Select Item
Select Menu  

See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
Serial Port 
Address 

[Disabled] 
On-board COM B 

Select a serial port to connect the HW 
console.   
Selecting "On-board COM B" changes 
"Boot-time Diagnostic Screen" to 
"Enabled".   

 

Baud Rate [19.2K] 
57.6K 

Select a baud rate for communications 
with the connected HW console. 

 

Flow Control [None] 
XON/XOFF 

Select a flow control method.  

Console 
Connection 

[Direct] 
Via modem 

Select a connection with the HW console.  

  [   ]: Factory-set 
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ft Memory 
Select "ft Memory" on the System Hardware menu and press Enter to display the following screen. 

 
See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
Size [0] Size of ft Memory is specified (MB)  
Start Address - Shows the start address of ft Memory (view 

only) 
 

[   ]: Factory-set 

IMPORTANT:  

� Unless you use ft Memory, do not change the factory setting. 

� To use ft Memory, you need to prepare an “ft Memory RAM Disk.” 

� If you specify/change the size of ft Memory on the ft Memory RAM 
Disk (not this menu), the changes will take effect automatically. 

� For details, see manuals included with the ft Memory RAM Disk. 
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Boot 

Move the cursor onto "Boot" to display the Boot menu. 

    ATAPI CD-ROM Drive 
+  Removable Device 
+  Hard Drive 
    Intel(R) Boot Agent Version 4.0.1.7

Item Specific Help

Main Advanced Security System Hardware Boot

Phoenix BIOS Setup Utility

Exit

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter SelectEsc Exit

Select Item
Select Menu

Use <
select a device, then  
press <+> to move it up 
the list, or <
move it down the list. 
Press <Esc> to exit  
this menu.

>or< >to

>to

 
The server searches for the boot device according to the order specified in this menu and use the 
software to boot the system if found. 

You can change the boot device order using ↑↑↑↑  or ↓↓↓↓  and + or –.  Move the cursor to select the 
device by ↑↑↑↑  or ↓↓↓↓ , and then change the priority using + or –. 

IMPORTANT: Specify the device boot order as shown above to start 
the NEC EXPRESSBUILDER. 
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Exit 

Move the cursor onto "Exit" to display the Exit menu. 

Save Changes & Exit 
Exit Without Saving Changes 
Get Default Value 
Load Previous Value 
Save Changes

Exit System Setup and 
save your changes to  
CMOS.

Item Specific Help

Main Advanced Security System Hardware Boot

Phoenix BIOS Setup Utility

Exit

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter SelectEsc Exit

Select Item
Select Menu  

The following describes each option on the Exit menu: 

� Save Changes & Exit 

Select this option to save the current configuration data into the CMOS (non-volatile 
memory) and exit the SETUP utility. 

The following screen appears: 

Save configuration changes and exit now? 
 

[Yes]                  [No]

Setup Confirmation!

 
Select "Yes" to save the current configuration data into the CMOS (non-volatile memory) 
and exit the SETUP utility.  The server will automatically restart the system. 

� Exit Without Saving Changes 

Select this option to discard the current configuration data and exit the SETUP utility. 

Configuration has not been saved! 
Save before exiting? 

 

[Yes]                  [No]

Setup Warning!

 
Select "No" to discard the current configuration data and exit the SETUP utility.  Select 
"Yes" to save the current configuration data into the CMOS, to exit the SETUP utility, and 
to restart the server automatically. 
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� Get Default Value 

Select this option to restore all default values (factory-set values) of the SETUP utility. 

The following screen appears: 

Load default configuration now? 
 

[Yes]                  [No]

Setup Confirmation!

 
Select "Yes" to restore default values.  Select "No" to return to the Exit menu screen. 

� Load Previous Values 

Select this option to discard the current configuration data and restore the previous 
configuration data.  

The following screen appears: 

Load previous configuration now? 
 

[Yes]                  [No]

Setup Confirmation!

 
Select "Yes" to discard the current configuration data and restore the previous one. 

� Save Changes 

Select this option to save the current configuration data into the CMOS (non-volatile 
memory) and stay on the SETUP utility. 

The following screen appears: 

Save configuration changes now? 
 

[Yes]                  [No]

Setup Confirmation!

 
Select "Yes" to save the current configuration data into the CMOS (non-volatile memory). 
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SCSI BIOS ∼∼∼∼  FAST!UTIL ∼∼∼∼  
For several settings of the SCSI controller on the motherboard (or the SCSI controller on the 
optional board), the SCSI BIOS utility "Fast!UTIL" is used. 

The SCSI BIOS utility can be started by simple keystrokes during execution of POST without use 
of a special start disk. 

The SCSI BIOS built in the server is set to the optimum at the shipment. Accordingly, the SCSI 
BIOS may not be changed by using this utility. 

IMPORTANT:  
� Use Fast!UTIL only when an optional SCSI controller is used. Leave the settings 

for the SCSI controller to which built-in hard disks are connected as they are at 
shipment. If any of the settings are changed, see the description in this document 
to return to the settings at shipment.  The controllers installed in each module 
must be configured individually. 

� Fast!UTIL of the latest version is installed in the NEC Express5800/ft series.  
Accordingly, the setting screen may be different from that described in this 
document. See the online help or contact your sales agent for the setting items 
different from those in this document. 

Start 

The procedure of starting Fast!UTIL is described below. 

 
Notes 

Note the following before starting Fast!UTIL. 

� Settings for built-in hard disk 

Leave the settings for the built-in hard disk as they are at shipment. The built-in host 
adapter is specified as QLA12160 Ultra3 5000 in the Select Host Adapter dialog box. 

� Settings of SCSI controller installed in each group 

− Only the PCI module in which the SCSI controller card to be set is installed should be 
inserted into the system before Fast!UTIL can be started for the setting. Remove the 
other PCI module from the system.  

− Make sure that the number of the PCI slot connected with the SCSI controller card 
installed in a PCI module is the same as the number of the PCI slot connected with the 
SCSI controller card installed in the other PCI module. Provide the same settings for 
both the PCI modules. 

− Don't change the factory settings of the SCSI controller card.  

− Although there may be descriptions that the SCSI BIOS of the host adapter needs to be 
configured in manuals for tape devices, etc., this server does not require modifications 
to the settings.  Do not change the settings.   
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Start Procedure 

Start Fast!UTIL in the procedure below: 

1. Turn on the power of the server. 

The start message appears on a screen in the middle of POST.  

2. Press Q and Ctrl together. 

Fast!UTIL is started. 

IMPORTANT: Press these keys before message "QLogic Adapter using 
IRQ number x" or later appears. 

QLogic Corporation
QLA 1216x PCI SCSI ROM BIOS Version X.XX
Copyright (C) QLogic Corporation 1993-2001 All rights reserved.
www.qlogic.com

Press <CTRL-Q> for Fast!UTIL

ISP12160 Firmware Version xx.xx.xx
QLogic Adapter using IRQ number X

Device Device Adapter SCSI SCSI Vendor Product Product
Number Type Number ID LUN ID ID Revision

81 Disk 0 0 0 SEAGATE ST32550 7394

 
 

3. Highlight "Select Host Adapter" using the cursor keys and press Enter. 

Configuration Settings
Scan SCSI Bus
SCSI Disk Utility
Select Host Adapter
Exit Fast!UTIL

Fast!UTIL Options
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4. Select the proper adapter. 

IMPORTANT: The adapter "QLA12160 Ultra3 5000" is used for 
built-in hard disk. Do not select it. 

Highlight the displayed item with the cursor keys and press Enter. 

QLA12160 Ultra3 5000
xxxxxxxxxxxxxxxxxxxxxxxx xxxx
xxxxxxxxxxxxxxxxxxxxxxxx xxxx

Select Host Adapter

Adapter Type I/O Address

 
The display returns to "Fast!UTIL Options." The name of the selected host adapter 
appears at the upper left corner of the screen. 

Configuration Settings
Scan SCSI Bus
SCSI Disk Utility
Select Host Adapter
Exit Fast!UTIL

Fast!UTIL Options
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Configuration Settings 

If you select "Configuration Settings" from the "Fast!UTIL Options" menu, the screen for setting 
the configuration appears. 

Host Adapter Settings
SCSI Device Settings
SCSI Bus Settings
Autoconfigure SCSI Device
Selectable Boot Settings
Restore Default Adapter Settings
Raw Nvram Data

Configuration Settings

 
 

Host Adapter Settings 

If you put the cursor on "Host Adapter Settings" with keyboard cursors (↓↓↓↓  and ↑↑↑↑ ) in the 
"Configuration Settings" menu and press Enter, the screen for setting the information on the host 
adapter appears. 

The table below shows the parameters of the setting items and their factory settings. 

Submenu item Parameter Description 
BIOS Address - View only 
BIOS Revision - View only 
Adapter Serial Number - View only 
Interrupt level - View only 
Host Adapter BIOS [Enable] 

Disable 
Specify whether the BIOS extension of the host 
adapter is enabled or disabled. 

PCI Bus DMA Burst [Enable] 
Disable 

Specify whether the DMA burst transfer on the PCI 
bus is enabled or disabled. 

CDROM Boot Enable 
[Disable] 

Specify whether the start from CD-ROM is enabled or 
disabled. 

Adapter Configuration Auto 
[Manual] 
Safe 

Specify whether the adapter configuration is set 
automatically by BIOS, manually, or safely. 

Drivers Load RISC [Enable] 
Disable 

Specify whether the load of RISC codes is enabled or 
disabled. 

>4GByte Addressing Enable 
[Disable] 

Specify whether hard disks of 4 GB or larger is used 
or not. 

Fast Command Porting [Enable] 
Disable 

Do not change the factory setting. 

  [  ]: Factory-set 
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SCSI Device Settings 

If you put the cursor on "SCSI Device Settings" with keyboard cursors (↓↓↓↓  and ↑↑↑↑ ) in the 
"Configuration Settings" menu and press Enter, the screen for setting the information on the device 
connected to the host adapter appears. 

The table below shows the parameters of the setting items and their factory settings. 

IMPORTANT: The settings can be made for each SCSI bus. 

Parameter Submenu item 
SCSI Bus0 SCSI Bus1 

Description 

Disconnects OK [Yes] 
No* 

[Yes] 
No* 

Specify whether the disconnection of 
SCSI devices from the SCSI bus is 
enabled or disabled. 
* On Bus0, select "No" for ID8. 

Check Parity [Yes] 
No 

[Yes] 
No 

Specify whether the parity check is 
provided or not. 

Enable LUNs [Yes] 
No 

[Yes] 
No 

Specify whether more than one LUN 
numbers are given to SCSI ID. 

Enable PPR [Yes] 
No 

[Yes] 
No 

Do not change the factory setting. 

Enable Device [Yes] 
No 

[Yes] 
No 

Do not change the factory setting. 

Negotiate Wide [Yes] 
No 

[Yes] 
No 

Specify whether the wide (32 bits) 
transfer is enabled or disabled. 

Negotiate 
Synchronous 

[Yes] 
No 

[Yes] 
No 

Specify whether the synchronous 
transfer is enabled or disabled. 

Tagged Queuing [Yes] 
No 

[Yes] 
No 

Do not change the factory setting. 

Sync Offset 00, 02, 04, 06, 08, 
10, 12, 14, 16, 18, 
20, 22, [24] 

00, 02, 04, 06, [08], 
10, 12, 14, 16, 18, 
20, 22, 24 

Select the proper offset value in 
synchronous transfer. 

 Transfer Rate 
(Mbytes/sec) 

 Transfer Rate 
(Mbytes/sec) 

[9] 160 (Ultra3 
SCSI) 

9 160 (Ultra3 
SCSI) 

10 80 (Ultra2 
SCSI) 

[10] 80 (Ultra2 
SCSI) 

12 40 (Ultra 
SCSI) 

12 40 (Ultra 
SCSI) 

25 20 (Fast 
SCSI) 

25 20 (Fast 
SCSI) 

Sync Period 

40 12.5 40 12.5 

Select the proper speed in 
synchronous transfer. 

Exec Throttle 1, 4, 8, [16], 32, 
64, 128, 255 

1, 4, 8, [16], 32, 64, 
128, 255 

Do not change the factory setting. 

  [  ]: Factory-set 
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SCSI Bus Settings 

If you put the cursor on "SCSI Bus Settings" with keyboard cursors (↓↓↓↓  and ↑↑↑↑ ) in the "Configuration 
Settings" menu and press Enter, the screen for setting the information on the SCSI bus of the host 
adapter appears. 

The table below shows the parameters of the setting items and their factory settings. 

IMPORTANT: The settings can be made for each SCSI bus.  

Parameter Submenu item 
SCSI Bus0 SCSI Bus1 

Description 

SCSI Bus SCSI ID 0, 1, 2, 3, 4, 5, 6, 
[7], 8, 9, 10, 11, 
12, 13, 14, 15 

0, 1, 2, 3, 4, 5, 6, 
[7], 8, 9, 10, 11, 
12, 13, 14, 15 

Select the SCSI ID given to SCSI 
bus. 

SCSI Bus Reset [Enable]  
Disable 

[Enable]  
Disable 

Make the reset valid or invalid in 
SCSI buses. 

SCSI Bus Reset 
Delay 

0, 1, 2, 3, 4, [5], 
6, 7, 8, 9, 10, 11, 
12, 13, 14, 15 

0, 1, 2, 3, 4, [5], 
6, 7, 8, 9, 10, 11, 
12, 13, 14, 15 

Leave this item as factory-set. 

SCSI Bus 
Termination 

Auto 
High only 
Disabled 
[Enabled] 

[Auto] 
High only 
Disabled 
Enabled 

Set the termination resistance of 
SCSI bus. 

  [  ]: Factory-set 
 
Autoconfigure SCSI Device 

If you put the cursor on "Autoconfigure SCSI Device" with keyboard cursors (↓↓↓↓  and ↑↑↑↑ ) in the 
"Configuration Settings" menu and press Enter, the screen for setting the information on the device 
connected to the host adapter appears. 

The parameters of the setting items and their factory settings are the same as those shown in the 
table for "SCSI Device Settings." 

IMPORTANT:  
� The settings can be made for each SCSI bus and SCSI ID. Check the SCSI ID of 

the target device before changing the settings. 

� The factory settings are the same for both SCSI bus 0 and SCSI bus 1. 

� The following items can be changed by setting "Adapter Configuration" in 
"SCSI Device Setting" to "Manual." 

 – Enable Device 
 – Enable LUNs 
 – Negotiate Wide 
 – Negotiate Sync 
 – Tagged Queuing 
 – Sync Offset 
 – Sync Period 
 – Exec Throttle 
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Selectable Boot Settings 

If you put the cursor on "Selectable Boot Settings" with keyboard cursors (↓↓↓↓  and ↑↑↑↑ ) in the 
"Configuration Settings" menu and press Enter, the screen for setting the information on the start 
from the device connected to the host adapter appears. 

Submenu item Parameter Description 
Selectable 
SCSI Boot 

Enabled 
[Disabled] 

Specify whether the boot from SCSI device can be 
selected or not. 

SCSI Bus [0] 
1 

Select the bus to which the started SCSI device is 
connected. 

SCSI Boot ID [0], 1, 2, 3, 4, 5, 6, 7, 
8, 9, 10, 11, 12, 13, 
14, 15 

Set the SCSI ID of the started SCSI device. 

SCSI Boot Lun [0], 1, 2, 3, 4, 5, 6, 7, 
8, 9, 10, 11, 12, 13, 
14, 15 

Select the number of the LUN to which the started 
SCSI device is bound. 

  [  ]: Factory-set 
 

Restore Default Settings 

If you put the cursor on "Restore Default Settings" with keyboard cursors (↓↓↓↓  and ↑↑↑↑ ) in the 
"Configuration Settings" menu and press Enter, the display changes to the screen for returning the 
setting values to the default values. 

IMPORTANT: The default values can be restored for each SCSI bus. 

Raw Nvram Data 

If you put the cursor on "Raw Nvram Data" with keyboard cursors (↓↓↓↓  and ↑↑↑↑ ) in the "Configuration 
Settings" menu and press Enter, the information on NvRAM installed in the host adapter is 
displayed in the hexadecimal format. 

This function is provided to solve problems. The information cannot be edited. 
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Scan SCSI Bus 

If you select "Scan SCSI Bus" from the "Fast!UTIL Options" menu, the list of devices connected to 
each SCSI bus is displayed in the order of SCSI IDs. The information to be displayed includes the 
device manufacturer, product name and firmware revision. 

 

SCSI Disk Utility 

If you select "SCSI Disk Utility" from the "Fast!UTIL Options" menu, the utility menu which is 
used to format or verify the connected SCSI devices appears. 

IMPORTANT:  
� Devices can be processed in each SCSI bus and SCSI ID. Be careful 

not to forget the selected bus and ID.  

� The selection of "Continue With Format" in "Low- Level Format" 
causes all data in disks to be lost. 

� Low-Level Format 

Formats the device selected in "Continue With Format" physically. If you select "Do Not 
Format Disk," the previous menu appears again. 

� Verify Disk Media 

Verifies the device selected in "Continue With Verify." If you select "Do Not Verify 
Media," the previous menu appears again. 

� Select Different Disk 

Selects another SCSI device on the same SCSI bus. 

 

Select Host Adapter  

If you select "Select Host Adapter" from the "Fast!UTIL Options" menu, the list of the host adapters 
installed in the main system is displayed. Select the adapter for which the settings are modified. 

IMPORTANT: The adapter "QLA12160 Ultra3 5000" is used for 
built-in hard disk. Do not select it. 

The utility menu, which is used to format or verify the connected SCSI devices, appears. 
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Exit Fast!UTIL ∼∼∼∼  Termination and Storage of Fast!UTIL ∼∼∼∼  

After changing the settings, press Esc several times to display the "Fast!UTIL Options" menu.  If 
you select "Exit Fast!UTIL" from the menu, the screen for terminating Fast!UTIL appears. 

However, if the settings are different from those before the start, the screen prompting you to save 
the settings appears before the display of the termination screen. 

Save Changes
Do not save changes

Configuration settings modified

 

Select either "Save changes" or "Do not save changes" by using keyboard cursors (↓↓↓↓  and ↑↑↑↑ ) and 
press Enter. 

Pressing Enter causes the screen for terminating Fast!UTIL to appear. 

Reboot System
Return to Fast!UTIL

Exit Fast!UTIL

 

Select either "Reboot System" or "Return to Fast!UTIL" and press Enter. 

 

 

Setting List for Optional SCSI Device 

If you add an optional SCSI device, don’t change the factory settings of SCSI controller card. 
For information on optimal SCSI devices for the NEC Express5800/ft series, contact your sales 

agent.  
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FORCED SHUTDOWN AND CLEAR 
Read this section if your server does not operate as expected, or if you want to return all setup 
values to those made at shipment. 

 

Forced Shutdown 

 

Use this function when an OS command does not shut down the server, the POWER switch does not 
turn off the server, or resetting does not work. 

Press and hold the POWER switch on the server for over four seconds.  The power is forcibly 
turned off.  To turn on the power back again, wait approximately 10 seconds after turning off the 
power (forced shutdown). 

 
 

 

IMPORTANT: If the remote power-on feature is used, power on the 
server and start the OS, and turn off the power in the normal way. 

<Rack-mount model> 

Press it for over 4 seconds. 
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Clear CMOS / Password (Configuring Motherboard Jumpers) 

With the pre-installed SETUP utility, you can set desired passwords to protect data stored on the 
server from unauthorized user access.  If you forget the passwords, you can clear them by 
following the procedure described in this section.   

You can also use the same procedure to clear the CMOS data in the server. 

IMPORTANT:  

� Clearing the CMOS data restores the factory settings. 

� To clear passwords or CMOS data, power off the server. 

To clear passwords or the CMOS data, use the jumper switch on the PCI module board of the server.  
The following figure illustrates the jumper switch location. 

IMPORTANT: Do not change any other jumper switch settings.  
Any improper change may cause the server to fail or malfunction. 

 

 
 

Use clips on  
pins 11 and 12

Pins for protecting/clearing 
passwords 

Pins for protecting/clearing 
CMOS data 
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� Pins for protecting/clearing the passwords 

Place the clip on the two pins to clear the passwords. 

Remove the clip from these pins to protect the passwords (factory-set). 

� Pins for protecting/clearing the CMOS data 

Place the clip on the two pins to clear the CMOS data. 

Remove the clip from these pins to protect the CMOS data (factory-set). 

The following describe the clearing procedure. 

WARNING  
  

Observe the following instructions to use the server safely.  Failure to follow 
these instructions may result in death or serious personal injury.  See safety 
precautions in Chapter 1. 
  

 � Do not disassemble, repair, or alter the server. 
  

 

How to Clear CMOS 

1. Power off the server and unplug the power cord(s). 

2. Remove the PCI modules (#1 and #2) from the server (see Chapter 8). 

3. Make setting of jumper switch on one PCI module (PCI Module #1 in this example) to 
clear CMOS. 

IMPORTANT:  

� Before clearing CMOS, NEC Express5800/ft series must be ready 
for use with a keyboard hooked up. 

� Use the clip located on jumper pins (pins 11 and 12) on the 
motherboard. 

� Be careful not to lose the clip. 

4. Mount only PCI Module#1 (where a CMOS clear jumper has been mounted) to the server 
(see Chapter 8). 

5. Plug the power cord; when the POWER Switch LED turns on, press it to power on the 
server. 

6. Shortly after the startup, the following message will appear: 

 

 

 

 



4-40  System Configuration 

 

7. Use the cursor to select [CLEAR CMOS] and press Enter. 

NOTE:  

A message appears for 10 seconds prompting you to clear CMOS. If 
you select [CONTINUE] or do nothing (considered as “CONTINUE”), 
the process goes on. However, the server stops after sounding beeps 
(1-3-3-2). In this case, power off/on the server and perform the 
procedure again. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8. After CMOS is cleared, the system will reboot automatically. 

9. When the following message appears, press the POWER button to turn off the server and 
then unplug the cord. 

 

 

 

 

This means that CMOS clear jumper is mounted. 
 
This is not a message to show that CMOS clear has 
been completed. 
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NOTE:  

After CMOS clear is completed, a message will appears for 10 seconds 
prompting you to remove the jumper. If you select [CONTINUE] or do 
nothing (considered as “CONTINUE”), the process goes on. However, 
the server stops after sounding beeps (1-3-3-2) during POST. 

This is not an error; this rechecks the presence of the jumper to prevent 
you from forgetting to dismount it. In this case, power off/on the server 
and continue from Step 10. 

 

10. Remove the PCI Module #1 from the server (see Chapter 8). 

11. Reset the jumper switch. 

TIPS:  

Place the clip on the jumper pins 11 and 12 after use to keep the clip.  
If you place it on other pins, the server may malfunction. 

 

12. Mount PCI Module #1 again to the server (see Chapter 8). 

13. Mount PCI Module #2 (on which CMOS has not been cleared) to the server. 

14. Shortly after you connect the power cord, the BMC status LED of PCI Module #2 will 
start to blink.  

15. When CMOS clear is completed, the BMC status LED will go off. 

NOTE:  

The BMC status LED blinks to show that synchronous processing is 
being performed between the two modules.  When this process is 
complete, CMOS has also been cleared on PCI Module #2 

 

TIPS: 
� For the location of the BMC status LED, see “Names and Functions 

of Components” in Chapter 2. 

� For description of the BMC status LED, see “LED” in Chapter 2. 
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How to Clear Passwords 

1. Power off the server and unplug the power cord(s). 

2. Remove the PCI modules (#1 and #2) from the server (see Chapter 8). 

3. Make setting of jumper switch on one PCI module (PCI Module #1 in this example) to 
clear passwords. 

IMPORTANT:  

� Use the clip located on jumper pins (pins 11 and 12) on the 
motherboard. 

� Do not lose the clip. 

4. Mount the PCI module to the server (see Chapter 8). 

5. Plug the power cord; when the POWER Switch LED turns on, press it to power on the 
server. 

6. When the following POST screen appears after the startup, press the POWER Switch to 
turn off the power. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. Unplug the power cord. 

8. Remove PCI Module #1 from the server (see Chapter 8). 

9. Reset the jumper switch. 
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TIPS:  

Place the clip on the jumper pins 11 and 12 after use to keep the pin.  
If you place it on other pins, the server may malfunction. 

 

10. Remove the PCI Module #1 from the server (see Chapter 8). 

11. Mount PCI Module #2 (on which Password has not been cleared) to the server. 

12. Shortly after you connect the power cord, the BMC status LED on PCI Module #2 will 
start to blink. 

13. When Password clear is completed, the BMC status LED will go off.  

NOTE:  

The BMC status LED blinks to show that synchronous processing is 
being performed between the two modules.  When this process is 
complete, Password has also been cleared on PCI Module #2 

 

TIPS: 
� For the location of the BMC status LED, see “Names and Functions 

of Components” in Chapter 2. 

� For description of the BMC status LED, see “LED” in Chapter 2. 
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Chapter 5 

Installing and Using Utilities 

This section describes how to use the NEC EXPRESSBUILDER CD-ROM that comes with your 
server and to install the utilities stored on the NEC EXPRESSBUILDER.  
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NEC EXPRESSBUILDER 
The NEC EXPRESSBUILDER, integrated setup software, can automatically detect the hardware 
connected to an NEC Express5800/ft series machine to advance the processing. The hardware 
subject to setup with the NEC EXPRESSBUILDER should have the same configuration as that for 
operation. 

 

Start Menu 

The NEC EXPRESSBUILDER provides three procedures to start the server as described below. The 
menus and items appearing on the screen vary depending on the procedures. 

� Booting (starting) the server from NEC EXPRESSBUILDER CD-ROM 

For the procedure, insert the NEC 
EXPRESSBUILDER CD-ROM into the 
CD-ROM drive of the NEC Express5800/ft 
series and start the NEC Express5800/ft 
series from the system in the NEC 
EXPRESSBUILDER. When the NEC 
Express5800/ft series is started by using this 
procedure, the NEC EXPRESSBUILDER 
top menu shown on the right appears. 

Perform the NEC Express5800/ft series 
setup from this menu. 

IMPORTANT:  
� Don’t use this CD-ROM on computers other than NEC 

Express5800/ft series with which it is packaged (including other 
NEC Express5800 models).  Otherwise, a breakdown may result. 

� The execution of "Setup" of the menu causes the OS installed 
previously to be erased. OS must also be reinstalled. 

See "NEC EXPRESSBUILDER Top Menu" for details. 

 

� Booting (starting) the server from NEC EXPRESSBUILDER CD-ROM in the consoleless 
state 

If the NEC EXPRESSBUILDER is 
started from the CD-ROM drive in the 
server with the keyboard, mouse, and/or 
display unit not connected to the server, 
the NEC EXPRESSBUILDER Tools 
Menu shown on the right appears on the 
screen of the management computer (PC) 
connected to the server through LAN or 
COM (serial port). 
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Then operate the server remotely from the management PC by using the items in the menu. 

IMPORTANT:  
� Don’t use this CD-ROM on computers other than NEC 

Express5800/ft series with which it is packaged (including other 
NEC Express5800 models).  Otherwise, a breakdown may result. 

� To use the consoleless feature, make sure that keyboard is not 
connected to the server. When a keyboard is connected, the 
consoleless feature is disabled because the NEC 
EXPRESSBUILDER determines that the server has a console.  
(The menu will not be displayed on the management PC.) 

See "Consoleless Menu" described later for details. 

� Inserting NEC EXPRESSBUILDER CD-ROM after Windows startup 

The "Master Control Menu" (see figure below) starts automatically after you place the 
"NEC EXPRESSBUILDER" in the CD-ROM drive.  A dialog box called “Master 
Control Menu” will appear. 

For this dialog, see “Master Control Menu” described later. 
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NEC EXPRESSBUILDER Top Menu 

The NEC EXPRESSBUILDER top menu is used for the setup of hardware and the setup and 
installation of OS. 

 

Start 

Start the NEC EXPRESSBUILDER top menu following the procedure below: 

1. Turn on the powers of peripherals and the power of the server in this order. 

2. Insert the NEC EXPRESSBUILDER CD-ROM into the CD-ROM drive of the server. 

3. After the CD-ROM is inserted, reset the system (by pressing Ctrl + Alt + Delete) or turn 
off the power and then on again to restart the server. 

The system is activated from the CD-ROM to start the NEC EXPRESSBUILDER. 

After the NEC EXPRESSBUILDER is started, the NEC EXPRESSBUILDER top menu shown 
below appears. 

 

  
A Setup 
 Performs various automatic setup operations including settings of internal parameters and 

states of hardware and installations of Windows 2000 Advanced Server and several 
utilities. Select this setup procedure if hard disks are used in a partition different from that 
defined at the purchase, or if OS is reinstalled. 
 

B Tool 
 Starts each of the utilities stored in the NEC EXPRESSBUILDER individually to allow the 

operator to provide setup.  Enables the setup without influence of installed OS. 
 

C Help 
 Describes the NEC EXPRESSBUILDER. We recommend you to read through the help 

1 

B

C

D

A 



Installing and Using Utilities  5-5 

before the setup. 
 

D Exit 
 The NEC EXPRESSBUILDER termination screen appears. 

 

Setup 

The setup program is exclusively used for your server to perform automatic setup operations within 
the range from the settings of internal parameters and states of hardware to the installation of 
Windows 2000 Advanced Server and several utilities. 

Use the setup program if hard disks are used with a partition different from that at purchase, or if 
OS is reinstalled. This feature carries out the complicated setup. 

IMPORTANT:  
� To install Windows 2000 Advanced Server in your server, use the 

setup program (excluding the case of performing the setup for the 
first time after the purchase). Any other methods cannot install 
Windows 2000 Advanced Server in the server. 

� Because the setup is started from its first stage, the execution of 
the setup causes the data in the hard disk to be erased. 
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Tools 

The Tools Menu is used to start each of the several utilities stored in the NEC EXPRESSBUILDER 
CD-ROM individually for manual setup by operator. Use the Tools Menu to provide settings that the 
setup program cannot do automatically or detailed settings. Also use the Tools Menu when system 
diagnosis is performed or a support disk is created. The items in the Tools Menu are described 
below. 

NEC Express5800 NEC EXPRESSBUILDER Ver3. xxxx-x Copyright (C) NEC Corporation 2003 
   

Tools Menu 
 

  

Off-line Maintenance Utility                     

System Diagnostics 
 

RAID Board: None 
Server Management Board: None 
System Configuration: None 

Create Support Disk 
 

 
BIOS/FW/etc. Update 

 

 
System Management 

 

 
Help 

 

 
Return to the Top Menu 

 

 
 

� Off-line Maintenance Utility 

The Off-line Maintenance Utility analyzes the cause of a fault if it occurs. See the 
description in Chapter 6 or the online help for details. 

� System Diagnostics 

Executes several tests on the main system to examine the features of the system and the 
connections between the system and extension boards. If the system diagnosis is executed, 
the system check program is started depending on the system status. See the description in 
Chapter 6 to manipulate the system check program  

� Create Support Disk 

In the support disk creation procedure, the starting support disk for starting a utility within 
the NEC EXPRESSBUILDER from a floppy disk and the support disk required in the 
installation of the operating system can be created. If you write down the titles appearing 
on the screen on the floppy disk labels, they can be easily managed later. 

The customer should prepare the floppy disks for creating the support disks. 

− Windows 2000 OEM-DISK for NEC EXPRESSBUILDER 

Creates a support disk for installing Windows 2000 Advanced Server. (No need to 
create this disk when installing the operating system with the Setup.) 

− ROM- DOS Startup FD 
The support disk for starting the ROM -DOS system is created. 

− Off-line Maintenance Utility FD 
The support disk for starting the Off-line Maintenance Utility is created. 

− System Diagnostics Utility FD 
The support disk for starting the system check program is created. 

− System Management Function FD 
The support disk for system management functions is created. 
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� BIOS/FW/etc. Update 

The program which is necessary for the update work is transferred to the floppy disk 
which the various update modules of BIOS/FW were stored in. After the reboot, an update 
program is started automatically from the floppy disk, and various BIOS/FW's are 
updated. 

IMPORTANT: During the execution of the update program, do not 
turn off the power of the system. If the update is interrupted halfway, 
the system will not be able to be started. 

� System Management functions 

Allow you to make settings of BMC (Baseboard Management Controller) to use its report 
functions and remote control from the management PC.  

� Help 

Indicates the descriptions on several features of the NEC EXPRESSBUILDER. 

� Return to the Top Menu 

Indicates the NEC EXPRESSBUILDER top menu. 
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Consoleless Menu 

The NEC EXPRESSBUILDER contains the "consoleless" feature that enables configuration of the 
server by remote operation from the management PC, even if a console device such as keyboard is 
not connected to the server.  

IMPORTANT:  
� Don’t use this CD-ROM on computers other than NEC Express5800/ft series 

with which it is packaged (including other NEC Express5800 models).  
Otherwise, a breakdown may result. 

� To use the consoleless feature, make sure that keyboard is not connected to the 
server. When a keyboard is connected, the consoleless feature is disabled 
because the NEC EXPRESSBUILDER determines that the server has a console.  
(The menu will not be displayed on the management PC.) 

Starting 

Depending on the connection between the management PC and the main unit, there are two ways 
for startup: 

� Startup from the management PC connected to LAN 

� Startup from the management PC directly connected (serial port B) 

For startup procedures, see “Remote Console Connection When no Console is Hooked up” 
described later in this chapter. 

IMPORTANT:  
� Do not change the boot device order in the BOOT menu of BIOS SETUP.  The 

consoleless feature cannot be used if the CD-ROM drive is not the first device to 
launch the system. 

� For LAN connection, you can only use LAN port 1. 

� For direct connection, you can only use Serial port B. 

� For consoleless remote operation of the NEC Express5800/ft series, you need to 
save configuration information to a floppy disk.  Prepare a formatted floppy 
disk. 

TIPS: BIOS will be set as follows: 
� RomPilot Support:  [Enabled] 
� Serial Port B:   [2F8, IRQ3] 
� Serial Port Address:  [On-board COM B] 
� Baud Rate:   [19.2K] 
� Flow Control:   [None] 
� Console Connection:  [Direct] 
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Menu Items 

Only the menu items available in consoleless operation are extracted from the NEC 
EXPRESSBUILDER Top Menu.  See the NEC EXPRESSBUILDER Top Menu described earlier 
for each function. 

1

2

3  
1 See the "NEC EXPRESSBUILDER Top Menu". 
2 Shows detailed explanation of each function. 
3 Terminate the NEC EXPRESSBUILDER. 

 

IMPORTANT:  
� The following functions differ from the Tools Menu in the NEC 

EXPRESSBUILDER Top Menu. 

 – Contents and operations of System Diagnostics (see "System 
Diagnostics" in Chapter 6 for details.) 

 – Disk type created in "Created Support Disk". 

� System Diagnostics Utility 
When no keyboard is connected to the server, the System 
Diagnostic window is not displayed on the local console.  Make 
sure to connect the keyboard to the server if you work on this 
utility from the local console. 
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Master Control Menu 

The Master Control Menu is used to: 

• Read documentation, 

• Install the management software, and 

• Install the viewer application (Adobe Acrobat Reader). 

NOTES: 
� Master Control Menu requires Microsoft Windows 95 (or later) or 

Windows NT 4.0 (or later). 

� To read documentation (HTML and PDF files) in the NEC 
EXPRESSBUILDER CD-ROM, the HTML browser (Microsoft 
Internet Explorer Version 5.0 (or later) or Netscape Communicator 
Version 4.0 (or later)), and Adobe Acrobat Reader Version 4.05 (or 
later) are required in your system. 

 

 

 

 

 

 

 

 

 

Put the NEC EXPRESSBUILDER CD-ROM in the CD-ROM drive. Master Control Menu 
automatically appears on the screen. If the Autorun feature is invalid in your system, run the 
\MC\1ST.EXE file in the CD-ROM directly. Some items are grayed-out when the logon user does 
not have the authority of the Administrator or the system does not meet the requirements to install 
the application. 

 

To use Master Control Menu: 

• Click [Online Document], [Setup] or [Quit], or 

• Right-click Master Control Menu window. 



Installing and Using Utilities  5-11 

NEC ESMPRO Agent and Manager 
NEC Express5800/ft series system management applications "NEC ESMPRO Manager" and "NEC 
ESMPRO Agent" are bundled to accessory CD-ROM "NEC EXPRESSBUILDER."  

This manual describes the functions and features provided by NEC ESMPRO Manager and NEC 
ESMPRO Agent and the notes on their operations. 

These applications are necessary for continuous operation of NEC Express5800/ft series. 

Overview 

NEC ESMPRO Manager and NEC ESMPRO Agent are the server management software provided 
for the stable operation of a server system and effective system operations. They can manage the 
configuration information and operating status of server resources to prevent server faults from 
occurring. If a server fault occurs, they detect the fault to notify the system Administrator of the 
occurrence. This enables the system Administrator to take appropriate action against faults. 

� Importance of server management 

“Constantly stable operation” and “less management workload” are keywords in server 
management. 

− Stable operation of server 

Shutdown of a server immediately leads the customer to lose business opportunities 
and profits. This requires servers to always operate in their perfect state. If a fault 
occurs in a server, it is necessary to detect the occurrence as soon as possible, make 
clear the cause, and take appropriate action. The shorter the time taken from the 
occurrence of a fault to the recovery from the fault is, the smaller the loss of profits 
(and/or costs) is.  

− Load reduction of server management 

The server management requires many jobs. In particular, if the system becomes large 
or remote servers are used, required jobs increase further. The reduction of the load of 
the server management brings the decrease in costs (and thus customer's benefit). 

� What are NEC ESMPRO Manager and NEC ESMPRO Agent? 

NEC ESMPRO Manager and NEC ESMPRO Agent are server management software used 
to manage and monitor NEC Express5800 series systems on the network. The installation 
of NEC ESMPRO Manager and NEC ESMPRO Agent enables the server configuration, 
performance, and fault information to be acquired, managed, and monitored realtime and 
also the occurrence of a fault to be detected immediately by the alert report function.  
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� Effects of using NEC ESMPRO Manager and Agent 

NEC ESMPRO Manager and NEC ESMPRO Agent have sufficient effects on a variety of 
needs in versatile and complicated system environments. 

− Detection of server fault 

NEC ESMPRO Agent collects a variety of fault information on NEC Express5800 
series systems to identify the states of the systems. If a server detects a fault, the 
server provides NEC ESMPRO Manager with the proper alert report. 

− Prevention of server fault 

NEC ESMPRO Agent includes the preventive maintenance function predicting the 
occurrence of a fault in advance as countermeasures for preventing faults from 
occurring. It can previously detect the increase in the cabinet temperature and the 
empty capacity in a file system. 

− Management of server operation status 

NEC ESMPRO Agent can acquire the detailed hardware configuration and 
performance information on NEC Express5800 series systems. The acquired 
information can be viewed at any point through NEC ESMPRO Manager. 

− Collective management of distributed servers 

NEC ESMPRO Manager provides the GUI interface that allows servers distributed 
on the network to be managed efficiently. 
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Detection of Server Fault 

NEC ESMPRO Manager and NEC ESMPRO Agent detect errors causing faults to occur at an early 
stage and notify Administrators of fault information real-time. 

� Early detection of error 

If a fault occurs, NEC ESMPRO Agent detects the fault and reports the occurrence of the 
fault to NEC ESMPRO Manager (alert report). NEC ESMPRO Manager displays the 
received alert in the alert viewer and also changes the status colors of the server and server 
component in which the fault occurs. This allows you to identify the fault at a glance. 
Further, checking the content of the fault and the countermeasures, you can take 
appropriate action for the fault as soon as possible. 

� Types of reported faults 

The table below lists the typical faults reported by NEC ESMPRO Agent. 

Component Reported information 
CPU • CPU load is over the threshold 

• CPU degrading, etc. 
Memory ECC 1-bit error detection, etc. 
Power supply • Voltage lowering 

• Power failure, etc. 
Temperature Temperature increase in cabinet, etc. 
Fan Fan failure (decrease in the number of revolutions), etc. 

Storage File system usage rate, etc. 
LAN • Line fault threshold over 

• Send retry or send abort threshold over, etc. 
 
Prevention of Server Fault 

NEC ESMPRO Agent includes the preventive maintenance function forecasting the occurrence of a 
fault as countermeasures for preventing faults from occurring. 

NEC ESMPRO Manager and NEC ESMPRO Agent can set the threshold for each source in the 
server. If the value of a source exceeds the threshold, NEC ESMPRO Agent reports the alert to NEC 
ESMPRO Manager. 

The preventive maintenance function can be set for a variety of monitoring items including cabinet 
temperature, and CPU usage rate. 

 

Management of Server Operation Status 

NEC ESMPRO Agent manages and monitors a variety of components installed in the server. You 
can view the information managed and monitored by NEC ESMPRO Agent on the data viewer of 
NEC ESMPRO Manager. 

NEC ESMPRO Agent also manages and monitors all the components and conditions required to 
keep the server reliability at a high level such as hard disks, CPU, memory, fans, power supply, and 
temperature. 
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Monitoring (Management) of NEC Express5800/ft series 

NEC Express5800/ft series is a fault tolerant system. It can continue the operation even if a major 
component fails. NEC Express5800/ft series improves the system availability with the hardware, 
NEC ESMPRO, and system software functions. 

If a major componentfails, the NEC ESMPRO fault report function can notify the system 
Administrator of the occurrence of the fault. In addition, the data viewer of NEC ESMPRO 
Manager can monitor the system status and also identify the failed component. 

NEC ESMPRO provides several maintenance functions such as the update of F/W and BIOS in the 
NEC Express5800/ft series in the online state (in which the system continues the operation but the 
components used to update F/W or BIOS is suspended) and the suspension of a specific component. 

The table below lists the NEC Express5800/ft series management tasks using NEC ESMPRO and 
system functions. 

NEC Express5800/ft series 
management task 

NEC ESMPRO function or tool 
(on managed NEC 
Express5800/ft series)* 

NEC ESMPRO function or tool 
(on management manager) 

Monitoring of major 
component states 

– NEC ESMPRO Manager 
data viewer 

Diagnosis and start/stop of 
major components and F/W 
update 

NEC ESMPRO Agent 
ft server utility 

NEC ESMPRO Manager 
data viewer 

BMC F/W update NEC ESMPRO Agent 
BMC F/W update utility 

NEC ESMPRO Manager 
BMC F/W update utility 

Confirmation of alert or 
confirmation of fault 
occurrence event 
information 

Windows 2000 standard 
management tool 
Event Viewer 

NEC ESMPRO Manager 
Alert Viewer 

Confirmation of H/W error 
log 

NEC ESMPRO Agent NEC ESMPRO Manager 

 

* When the administration manager is also the managed NEC Express5800/ft series (or NEC 
ESMPRO Manager is installed on the managed NEC Express5800/ft series), all functions of the 
administration manager can be used on the managed NEC Express5800/ft series. 

 
The report of a fault occurrence in the NEC Express5800/ft series (alert) is immediately sent to the 
NEC ESMPRO Manager. When the NEC ESMPRO Manager receives the alert, a popup message 
appears.  

The alert contains the detailed information of the fault and the proper countermeasures. You can 
take the appropriate action for the alert. 
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Collective Management of Distributed Servers 

The excellent GUI provided by NEC ESMPRO Manager allows servers on a network to be 
managed collectively. The management screen is designed in the Explorer format to indicate the 
components in a server hierarchically for effective server management. 

NEC ESMPRO Manager manages servers by using the following three types of GUIs. 

� Operation Window 

The operation window is used to 
create the map of servers 
connected to network to manage 
them. The map can be 
multi-layered depending on the 
installation areas, organizations, 
and objects. 

 

 

 

.  
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� Data Viewer 

The data viewer indicates the server source configuration information in the Explorer 
format. In addition, it changes the status color of the failed server component. This 
enables you to identify the failed portion. 

 
� Alert Viewer  

The Alert Viewer manages fault reports sent from servers together. A fault occurred in a 
server is immediately reported to the Alert Viewer. 

The Administrator can recognize all faults on the network instantly. 
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NEC ESMPRO Agent 

The NEC ESMPRO Agent utility plays the role of the agent between the NEC Express5800/ft series 
and NEC ESMPRO Manager (management PC). 

 

Operation Environment 

NEC ESMPRO Agent can be operated in the hardware and software environments shown below.  

� Hardware 

• Installation system NEC Express5800/ft series 

• Memory Memory capacity required to operate OS + 22.0 MB 
or larger 

• Empty capacity of hard disk 36.0 MB or larger 

 

� Software Windows 2000 Advanced Server 
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Preparation before Setup 

Be sure to read the following description before system installation or setup. 

To operate NEC ESMPRO Agent, you need to make settings of TCP/IP and the SNMP of 
components associated with TCP/IP. 

 

TCP/IP Setting 

See the Help started from the Start menu for how to set TCP/IP. 

 

SNMP Service Setting 

To install the SNMP Service: 

1. Open [Add/Remove Programs] in [Control Panel]. 

2. Click [Add/Remove Windows Components]. 

3. Select [Management and Monitoring Tools] in the Windows component wizard and click 
the [Details...] button. 

4. Check the check box of [Simple Network Management Protocol]. 

5. Click the [Next] button. 

The file copy operation is started. 

6. After the file copy is finished, click the [Finish] button. 

 

To change the settings of the SNMP Service: 

1. Double-click [Administrative Tool] in [Control Panel]. 

2. Start [Services] in [Administrative Tool]. 

3. Select [SNMP Service] from the service list and then [Properties] in the [Action] menu. 

The "SNMP Properties" dialog box appears. 

4. Enter "public" in the [Community name] box in the [Traps] property sheet and click the 
[Add to list] button. 

IMPORTANT: To change the community name of traps to be received 
from the default "public" in the NEC ESMPRO Manager site, enter 
the same name as the community name newly set in the NEC 
ESMPRO Manager site. 
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5. Click the [Add...] button in [Trap destinations].  After entering the IP address of the NEC 
ESMPRO Manager machine of the send destination in the [Host name, IP or IPX address] 
box, click the [Add] button. 

Set the receive community name in the NEC ESMPRO Manager site and the community 
name to be sent together with the trap in the NEC ESMPRO Agent site so that they have 
the same value. It is intended to have NEC ESMPRO Manager receive the trap from NEC 
ESMPRO Agent correctly. 

IMPORTANT: If the IP address (or host name) of the remote NEC ESMPRO 
Manager specified as the trap send destination in the setup of the manager report 
(TCP/IP), the message warning the duplication appears. The specification of the 
same NEC ESMPRO Manager causes to be reported doubly. 

6. Open "Security" property sheet; add "public" to "Accepted community names" and set its 
authority to "READ CREATE" or "READ WRITE. " 

Select [Accept SNMP packets from any host.] 

IMPORTANT:  

� If you entered another community name instead of "public" in Step 4, add that 
name to “Accepted community names” too. 

� Unless you set the acceptable community’s authority to “READ CREATE” or 
“READ WRITE,” you cannot perform monitoring from NEC ESMPRO 
Manager. 

< Setup of receiving SNMP packets from specific hosts only > 

Select [Accept SNMP packets from these hosts], specify IP addresses of the hosts, IP 
addresses of the servers to install Agent, and the loop-back address (127.0.0.1). 

< Setup of receiving SNMP packets from specific communities only > 

Change the name of the community receiving SNMP packets from the default "public" to 
any name. 

IMPORTANT:  

� If the community name is changed, the community of NEC ESMPRO Agent is 
changed and registered by starting from [Control Panel]. To change the 
community to another and register it, use the [SNMP Community] list box in the 
[General] tab. 

� To allow NEC ESMPRO Agent to receive SNMP packets sent from NEC 
ESMPRO Manager, set the send community name in NEC ESMPRO Manager 
to be the same as that accepted by the SNMP Service in NEC ESMPRO Agent. 
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7. Terminate the network setup. 

IMPORTANT: 
� If the SNMP Service is added after adaptation of the service pack in installation 

of OS, adapt the service pack again. If not, the SNMP Service may not operate 
correctly. This then disables NEC ESMPRO Agent to be operated. 

� The SNMP Service is required for operating NEC ESMPRO Agent. If the SNMP 
Service is deleted after the installation of NEC ESMPRO Agent, install the 
SNMP Service and then reinstall NEC ESMPRO Agent. 

� Some software products provided by other vendors use the SNMP Service. If the 
SNMP Service and NEC ESMPRO Agent are installed in the system in which 
such software as above is installed, it may be impossible to start NEC ESMPRO 
Agent services. If so, delete the SNMP Service once and install the service again. 
After which, reinstall NEC ESMPRO Agent and the other vendor's software. 

System Update 

To install NEC ESMPRO Agent in Windows 2000 Advanced Server, necipmi.sys needs to be 
installed in advance. For the installation of necipmi.sys, use the NEC EXPRESSBUILDER 
CD-ROM shipped with the system to update the system. 

Refer to Chapter 3 for the system update. 

If necipmi.sys is not installed yet, the message shown below appears and the setup of NEC 
ESMPRO Agent is suspended. 

"NEC ESMPRO Agent requires the following file. 
Please update the NEC Express5800 system before installing NEC ESMPRO Agent. 
necipmi.sys" 

 

Installation 

NEC ESMPRO Agent is automatically installed together with the installation or re-installation of 
the NEC Express5800/ft series. 

NEC ESMPRO Agent may be installed manually on the master control menu of NEC 
EXPRESSBUILDER as follows: 

1. Login to the system with user name "Administrator." 

2. Insert CD-ROM "NEC EXPRESSBUILDER" into the CD-ROM drive. 

TIPS: The CD-ROM drive may be either the drive connected to the system or any 
drive located on the network and connected by the LAN Manager. (These are 
collectively called CD-ROM drive hereafter). 

 

IMPORTANT: To use a CD-ROM drive on the network, assign the network driver 
to the drive and then execute MC\1ST.EXE of the drive. Do not start the CD-ROM 
drive from the network computer in Explorer. 
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The autorun function automatically displays the master control menu of NEC 
EXPRESSBUILDER. 

3. Click [NEC ESMPRO] in [Software 
Setup]. 

The NEC ESMPRO setup is started 
to display the main menu. 

 

4. Click [Agent] in the main menu of 
the NEC ESMPRO setup. 

 

 

 

TIPS: The available menus vary 
depending on OS types. (The menus that 
cannot be installed are displayed gray.) 

 

 

 

IMPORTANT:  

� Double-clicking to select a menu may display two same dialog boxes. Click the 
[End] button to close one of the dialog boxes. 

� If you click the [Cancel] button during setup, the message asking whether to stop 
or not to stop the installation will appear. You can stop the installation by clicking 
on the [Stop] button (the main menu remains displayed). However, the file having 
been setup halfway will not be deleted. 

5. Click the [Next] button. 

TIPS: If NEC ESMPRO Agent is 
already installed, the dialog box "NEC 
ESMPRO Agent already installed" 
appears. Clicking on the [Update] 
button and then the [Next] button will 
erase the old agent and install the NEC 
ESMPRO Agent anew. 
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6. Select a machine to install from the list. 

TIPS: If the setup program succeeds in the definition of the machine 
type, the operation is advanced to the next step without displaying the 
dialog box for selecting the machine type. 

7. Enter the path in which NEC ESMPRO Agent is installed and click the [Next] button. 

The NEC ESMPRO Agent module is installed below the \ESM directory of the root 
partition in default. If no problem is found, click the [Next] button without any 
modification. 

To change the installation directory, click the [Reference] button, specify the desired 
installation directory with the full path including the drive name, and click the [Next] 
button. 

8. Enter the path in which DMI is installed and click the [Next] button. 

The DMI module is installed in the \DMI\WIN32 directory of the root partition as default. 
If DMI2.0 SP is already installed, the path will be the default installation path. 

To change the installation directory, click the [Reference] button, specify the desired 
installation directory with the full path including the drive name, and click the [Next] 
button. 

The setup of the file copy and NEC ESMPRO Agent operation environments is started. 

9. When the installation end window appears, click the [OK] button. 

The installed is complete. The functions of installed NEC ESMPRO Agent will be enabled 
after the system is restarted. 

IMPORTANT: If the installation of NEC ESMPRO is completed, the 
main menu for the NEC ESMPRO setup remains displayed. Note that 
the main menu may be hidden by another dialog box. To terminate the 
NEC ESMPRO setup, click [End] in the main 
menu. 

Setup of NEC ESMPRO Agent 

The settings of installed NEC ESMPRO Agent remain 
unchanged from those at shipment. Click the [Start] button, 
[Setting], and [Control Panel] sequentially to open the 
[Control Panel]. 

If you double-click the [NEC ESMPRO Agent] icon in 
[Control Panel], the property dialog box will appear. Modify 
the setting of each sheet in the dialog box to be fit to the used 
environment. The notes on setup and the necessary 
information will be explained in "Supplement" described 
below. See the supplement for setup or suspicion of 
malfunction. 
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Device ID in Alert Report 
Some NEC Express5800/ft series reports use unique device IDs which correspond to the devices 
listed in the table below as the device identification information. 

Device name Device ID 
CPU module 1 
DIMM1 on CPU module 1 
DIMM2 on CPU module 1 
DIMM3 on CPU module 1 
DIMM4 on CPU module 1 
DIMM5 on CPU module 1 
DIMM6 on CPU module 1 
CPU1 on CPU module 1 
CPU2 on CPU module 1 
Power supply unit on CPU module 1 

0 
0/0 
0/1 
0/2 
0/3 
0/4 
0/5 
0/20 
0/21 
0/100 

CPU module 3 
DIMM1 on CPU module 3 
DIMM2 on CPU module 3 
DIMM3 on CPU module 3 
DIMM4 on CPU module 3 
DIMM5 on CPU module 3 
DIMM6 on CPU module 3 
CPU1 on CPU module 3 
CPU2 on CPU module 3  
Power supply unit on CPU module 3 

2 
2/0 
2/1 
2/2 
2/3 
2/4 
2/5 
2/20 
2/21 
2/100 

PCI module 1 
PCI slot 1 on PCI module 1 
PCI slot 2 on PCI module 1 
PCI slot 3 on PCI module 1 
PCI slot 4 on PCI module 1 
SCSI adapter 1 on PCI module 1 
SCSI bus 1 of SCSI adapter 1 on PCI module 1 
SCSI bus 2 of SCSI adapter 1 on PCI module 1 
Ethernet Board 1 on PCI module 1 
Power supply unit on PCI module 1 

10 
10/0 
10/1 
10/2 
10/3 
10/5 
10/5/0 
10/5/1 
10/6 
10/100 

PCI module 2 
PCI slot 1 on PCI module 2 
PCI slot 2 on PCI module 2 
PCI slot 3 on PCI module 2 
PCI slot 4 on PCI module 2 
SCSI adapter 1 on PCI module 2 
SCSI bus 1 of SCSI adapter 1 on PCI module 2 
SCSI bus 2 of SCSI adapter 1 on PCI module 2 
Ethernet Board 1 on PCI module 2 
Power supply unit on PCI module 2 

11 
11/0 
11/1 
11/2 
11/3 
11/5 
11/5/0 
11/5/1 
11/6 
11/100 

SCSI enclosure 1 
SCSI slot 1 on SCSI enclosure 1 
SCSI slot 2 on SCSI enclosure 1 
SCSI slot 3 on SCSI enclosure 1 
Electronics 1 on SCSI enclosure 1 
Power supply unit on SCSI enclosure 1 

10/40 
10/40/1 
10/40/2 
10/40/3 
10/40/120 
10/40/100 

SCSI enclosure 2 
SCSI slot 1 on SCSI enclosure 2 
SCSI slot 2 on SCSI enclosure 2 
SCSI slot 3 on SCSI enclosure 2 
Electronics 1 on SCSI enclosure 2 
Power supply unit on SCSI enclosure 2 

11/40 
11/40/1 
11/40/2 
11/40/3 
11/40/120 
11/40/100 
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The figure below shows the actual locations of the device names displayed on the NEC ESMPRO 
screen.  In the case of the tower model, modules are mounted vertically instead of horizontally. 

 

 

 
 
 

PCI module1 
SCSI enclosure1 (SCSI 1 –
SCSI 3 from left to right) PCI module2 

SCSI enclosure2 (SCSI 1 –
SCSI 3 from left to right) 

CPU module1

CPU module3
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Supplement 

Check the following when NEC ESMPRO Agent is installed. 

 

Dual registration of event logs 

At some types of errors, two event logs are registered for a single occurrence. (However, in the case 
of NEC ESMPRO Manager, one log is reported for one occurrence.)  Such errors are as follows: 

- Temperature error 

- Voltage error 

- Thermal trip 

 

Maintenance-related Functions 

When you want to use maintenance-related functions of the NEC Express5800/ft series, contact 
your maintenance personnel. 

 

CPU Information 

If you select [CPU Module]–[CPU] in the FTServer tree of the data viewer, unknown or incorrect 
information appears in some information items. 

The CPU information can be viewed by selecting [System]–[CPU] in the NEC ESMPRO MIB tree. 

CPU Module Status 

If the CPU module is suspended, the status color of the [CPU Module] icon in the FTServer tree of 
the data viewer does not change from green. If the report indicating the occurrence of the system 
configuration change is received, check the current status with the "Status" item appearing by 
selecting [CPU Module]–[General]. 

 

PCI Module Status 

The removal of the Ethernet cable of onboard does not change "State" of [PCI Module]–[General] 
in the FTServer tree of the data viewer. Check the current state with the "State" item of [PCI 
Module]–[Ethernet board]–[General]. 
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Event Logs at PCI Module Startup 

When a PCI module is brought up either along with OS boot or manually while OS is running, the 
following event will be reported to the event log. 

Source: srabb 
Event ID: 32 
Description: "Device 10/0 is now EMPTY" or "Device 11/0 is now EMPTY" 

The above event is just informational and can be ignored if the following event is reported the Event 
Log within a few minutes after the above precedent event is reported. 

Source: srabb 
Event ID: 62 
Description: "Device 10/0 is now ONLINE" or "Device 11/0 is now ONLINE" 

 

Change of Installation States of CPU and PCI Modules 

If you dynamically change the configuration of the CPU or PCI module in the relevant system 
during review of the server information by using the data viewer, the message prompting you to 
reconstruct the tree of the data viewer will appear. If you click the [Yes] button, the tree is 
reconstructed in the data viewer to reflect the change of the system configuration on the data viewer. 
Clicking the [No] button does not cause the tree to be reconstructed in the data viewer. If so, the 
information in the data viewer may be different from the current system information because the 
change of the system configuration is not reflected on the data viewer. 

 

SCSI Adapter Information 

When you select [SCSI Adapter] → [General Information], incorrect information may appear in the 
“Serial number” column. 

 

SCSI Slot Information 

When the PCI module is detached and you select [SCSI Slot] → [General Information], the 
displayed “Hardware LED” information may not be correct. 

To check the status of SCSI slots, see the string information in the “Status” column. 

 

Impact When Module Status Changes 

PCI modules, SCSI adapters, SCSI buses, and modules under the SCSI enclosure have impact on 
each other.  For example, when the “Status” item of a module changes to “fault,” it may be caused 
by another module’s error.  Therefore, you need to check the status of the other modules based on 
alert information. 
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Status Color after Mounting a Hard Disk 

When creating a new mirror, the status of the hard disk and its upper component, SCSI enclosure, 
will continue to change frequently after you mount a hard disk until the mirror is completed.  
During this process, the status color may turn to abnormal, but when the mirror is created 
successfully, it will return normal. 

 

LAN Monitoring Report 

The LAN monitoring function defines the line status depending on the number of transmission 
packets and the number of packet errors within a certain period. Thus, the LAN monitoring function 
may report a line fault or high line load only in a temporal high line impedance state. 

If a normal state recovery is reported immediately, temporal high line impedance may have occurred 
thus there is not any problem.  

 

LAN Monitoring Threshold 

Because the NEC Express5800/ft series detects hardware faults on the network in the driver level, 
NEC ESMPRO Agent does not monitor line faults. Thus, the value set for "Line fault occurrence 
rate" of a [LAN] tab of [NEC ESMPRO Agent properties] in the control panel. 

 

Community Authority 

For Windows 2000 Advanced Server, the community authority, or the security function of the 
SNMP Service, is set to "READ ONLY" in default. With the community authority being "READ 
ONLY, " the remote shutdown and threshold change functions are not available with NEC ESMPRO 
Manager. If you desire to use these functions, set the community authority to "READ CREATE" or 
"READ WRITE." 

 

Monitoring in Sleep State 

NEC ESMPRO Manager cannot monitor the NEC ESMPRO Agent machine in the sleep state 
(system standby or system halt state).  

While NEC ESMPRO Manager monitors server shutdown, the relevant NEC ESMPRO Agent 
machine may be entered into the sleep state. If so, the report "server access disabled" is issued and  
the status color of the server icon becomes gray. This cannot indicate whether the NEC ESMPRO 
Agent machine is shut down or entered into the sleep state. Keep these in mind when operating the 
system where systems to be monitored may enter the sleep state.  
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Installation of DMI2.0 SP (Service Provider) 

NEC ESMPRO Agent uses Intel DMI2.0 SP Ver.2.54. 

DMI2.0 SP creates the environment subordinate to the DMI installation directory selected in 
installation of NEC ESMPRO (system environment variable: WIN32DMIPATH).  

If DMI2.0 SP is already installed, the installation directory cannot be changed because  the 
specified installation destination will be used. 

 

Monitoring with NEC ESMPRO Manager Ver.3.8 or Earlier 

Some items cannot be monitored with NEC ESMPRO Manager of version 3.8 or earlier.  

NEC ESMPRO Manager Ver.4.0 is registered in NEC EXPRESSBUILDER CD-ROM. Use the 
NEC ESMPRO Manager Ver.4.0. 

 

Monitoring File System in Floppy Drive 

The sleep operation may fail when the Windows 2000 sleep function is used. If so, try the sleep 
again. 

 

 



Installing and Using Utilities  5-29 

Change of SNMP Community 

If the security setting of the SNMP Service of a system, where the NEC ESMPRO Agent is installed, 
is changed from the default “public” to a community name, change the community settings of the 
NEC ESMPRO Agent, too.  

1. Double-click the [NEC ESMPRO Agent] icon in [Control Panel]. 

2. Select a desired community name from the [SNMP Community] list box in [SNMP 
Setting] of the [General] sheet. 

The community names to receive SNMP packets from are listed in the [SNMP 
Community] list box. 

3. Click the [OK] button to terminate the operation. 

 

Cooperation with BIOS on Temperature Monitoring 

For temperature monitoring, NEC ESMPRO Agent is linked to BIOS to keep the temperature 
threshold in the BIOS of the peripheral temperature sensor to be the same as that in the NEC 
ESMPRO Agent. This enables the change of either threshold to be reflected on the other threshold 
automatically. 

IMPORTANT: If OS has the ACPI function, the threshold of the temperature in the 
BIOS links to the ACPI function managed by OS. Thus, the threshold of the 
temperature in NEC ESMPRO Agent has an independent value without temperature 
monitoring cooperation. 

Either of the following operations can disable the temperature monitoring by NEC 
ESMPRO Agent: 

� Change the setting of the temperature monitoring in the BIOS from Enable to 
Disable, save the setting value, and exit the BIOS SETUP. 

� If the temperature monitoring in the BIOS is already set to "Disable," save the 
setting (even if there was no modification to the settings) and exit the BIOS 
SETUP. 

Even if the temperature monitoring in the BIOS is disabled, the temperature monitoring in the NEC 
ESMPRO Agent can be enabled from the NEC ESMPRO Manager. 

The setting of the temperature monitoring in the BIOS can be changed in the procedure below: 

1. Start the system. When the "NEC" logo appears, press Esc. 

2. Press the F2 while "Press <F2> to enter SETUP" is displayed on the screen. 

The SETUP utility of BIOS is started. 

3. Select "Thermal Sensor" in the "System Hardware" menu. 

4. After changing the settings, save the values and then exit the SETUP utility. 
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CPU Load in Coexistence with Microsoft SQLServer6.5 

If NEC ESMPRO Agent is used in the following environment, the CPU load for NEC ESMPRO 
Agent services may increase (by 10% or higher). 

Condition 

� Both Microsoft SQLServer6.5 and NEC ESMPRO Agent are installed in a single machine 
and the services are started. 

� The check of [Performance monitor integration], an option of Microsoft SQLServer6.5, is 
set to ON. 

Confirmation procedure 

Compare the following values defined when checking [Performance monitor integration], 
an option of Microsoft SQLServer6.5, when unchecking the option by using the Windows 
2000/Windows NT performance monitor: 

Object: Process 
Counter: %Processor Time 
Instance: ESMCMN 

IMPORTANT: After the option is changed, be sure to restart the 
machine. If not, the performance monitor cannot acquire the correct 
load rate of the service. 

Countermeasures 

The CPU load rate acquired in the confirmation procedure above may vary largely 
depending on whether the check of the SQLServer option is placed at ON or OFF. That 
may be caused by the increase in the CPU load rate by placing the check at ON. 

This occurs due to the cause as follows; setting of the SQLServer option to ON increases 
the performance data items acquired from OS and thus much time is required for the 
performance data analysis processing in the service acquiring the performance data from 
OS. 

If monitoring the performance data of the SQLServer is not necessary, set the SQLServer 
option to OFF to keep the CPU load from increasing due to acquisition of unnecessary 
performance data. 
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CPU Load Ratio of SNMP Service (snmp.exe) 

While monitoring the server from NEC ESMPRO Manager, the CPU load ratio of SNMP Service 
on the NEC ESMPRO Agent side may increase at every monitoring interval (default: 1 minute). 

NEC ESMPRO Manager and NEC ESMPRO Agent exchange information through SNMP Service.  
If the server status monitoring by NEC ESMPRO Manager is on (default: ON), NEC ESMPRO 
Manager regularly issues a request to NEC ESMPRO Agent to get the current status of the server.  
In response, NEC ESMPRO Agent checks the status of the server.  As a result, the CPU load ratio 
of SNMP Service increases temporarily. 

If you have trouble of terminating a movie player application, turn off the server status monitoring 
by NEC ESMPRO Manager or extend the monitoring interval.   

 

Hang of SNMP Service 

SNMP Service has a module called “SNMP Extended Agent.”  This module may be registered 
when you install some software that uses SNMP Service. 

If you start SNMP Service, SNMP Extended Agent is also loaded at the initialization.  However, if 
the initialization is not completed within a specified period, SNMP Service will hang. 

It may take time to complete the initialization due to temporary high load on the system.  In this 
case, wait for the system load become low enough before restarting SNMP Service. 

 

Setting Thresholds after Update Installation 

The threshold and other setting are maintained automatically if you perform an update installation 
of NEC EXMPRO Agent Ver4.0. 

 

Current Status of Temperature, Voltage and Fan Sensors 

Some modes are equipped with temperature/voltage/fan sensors that do not have information on 
status, current values, rpm, threshold etc.  Therefore, if you view such a sensor on EMPRO 
Manager, it may be displayed as follows: 

� The status becomes “Unknown” (grayed out) on the data viewer. 

� The current value or rpm becomes “Unknown” on data viewer. 

� The status is grayed out on the Web component data viewer. 

� The current value or rpm becomes blank on the Web component data viewer. 

 

Even if the sensor is displayed like stated above, it is monitoring the server. 
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Actions to Take When Temperature/Voltage Error Occurs on CPU/PCI Modules 

At the time when a temperature or voltage error occurs on CPU/PCI module, necessary actions will 
differ depending on their status as shown below.  You can check the status of each module from the 
data viewer of NEC ESMPRO Manager or ft server utility. 

 

 

 

 

 

NOTE:  

� If the status is “Empty,” the module is not mounted.  Sensor 
monitoring is not conducted. 

� If disks are mounted on PCI modules, the status of both modules is 
“Simplex” while the disks are mirrored.  Temperature or voltage 
error occuring during disk mirroring will result in the system to 
shut down. 

 

 

CPU Information 

In [CPU Information] of Data Viewer’s system tree, the external clock is listed as “Unknown.” 

 

1000Base Ethernet Board Information 

If you select [FTServer] → [PCI Module] → [PCI Module (ID:XX)], you will not find a 1000Base 
Ethernet Board tree. 

See [ESMPRO MIB] → [Network]. 

You can judge errors at the 1000Base Ethernet Board from error notifications to a PCI slot in which 
a board is mounted. 

You cannot clear MTBF information with ft server utility, because a 1000Base Ethernet Board tree 
is not created. 

However, you can automatically clear MTBF information on the network board by unplugging and 
re-plugging the live wire. 

 

When [ft Server] Tree Appears on Date Viewer in an Incorrect Manner 

If you perform a Data Viewer startup or tree rebuilding just after the system starts up or after the 
PCI module starts up/shuts down, the [Ft Server] tree side may not appear normally on the Data 
Viewer.  In this case, wait for 5 minutes before retrying a Data Viewer startup. 

Status Actions 

Duplex Stop the failed CPU/PCI module. 

Other than 
duplex or empty

Shut down the system. 
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Event Log Output by Inventory Service 

If the service cannot get information from the system, it will list the following messages in the 
system event log. 

The following messages will also appear if the SNMP community name in not “public.” 

If the following event log messages are listed, you need to restart Inventory Service. 

However, even if you restart the service, device configuration, monitoring will not be performed, 
provided the SNMP community name in not “public.” 

 

When the following messages are listed, change detection will not be notified even if changes have 
been made to the device configuration. 

Source:  ESMSAFT 

Type: Error 

Event ID: 1040 

Description: Error occurred at ESMPRO InventoryService during Snapshot. Specified file not 
found. 

 

Source:  ESMSAFT 

Type: Error 

Event ID: 513 

Description: Error occurred at ESMPRO InventoryService during device configuration get wait. 

 

Floppy Disk Drive Name 

After unplugging and plugging the Core I/O of the primary side, the floppy disk drive name of [I/O 
Device] on Data Viewer may be different from the name that is recognized by the OS. 

(Example: drive name on Data Viewer: “A” 

 drive name recognized by the OS: “B”) 

Check the floppy disk drive name on Explorer. 

 



5-34  Installing and Using Utilities 

Uninstall 

The configuration of NEC ESMPRO Agent and BMC and the uninstallation of BMC FW Update 
Service are described below. 

 

Uninstallation of NEC ESMPRO Agent 

The procedure of uninstalling NEC ESMPRO Agent is described below.  

IMPORTANT: Uninstallation of NEC ESMPRO Agent 

� Start the uninstallation of NEC ESMPRO Agent after the system is started 
completely. 

� If NEC ESMPRO Agent is uninstalled just after the system startup, the setup 
program may freeze displaying the [Service Being Deleted…] dialog box. 
Shutdown the system by using "Task Manager" or other operation. Then 
uninstall NEC ESMPRO Agent after the system is started completely. 

� The installation of NEC ESMPRO Agent causes the uninstaller of DMI2.0 SP 
(Service Provider) to be registered. DMI2.0 SP can be deleted by using the 
uninstaller. However, NEC ESMPRO Agent should be uninstalled before 
DMI2.0 SP can be deleted. 

 (1) Start [Add/Remove Programs] in [Control Panel]. 

 (2) Select [DMI2.0 SP (NEC ESMPRO)] and click [Add or Delete].  
 

z With use of NEC EXPRESSBUILDER: 

1. Make the main menu of the NEC ESMPRO setup appear by referring to the section 
"Install" in this document. 

2. Click [NEC ESMPRO Agent]. 

The [Welcome to Setup of NEC ESMPRO Agent] dialog box appears. 

3. Click the [Next] button. 

Message "NEC ESMPRO Agent is already installed" appears. 

4. Select [Delete] and then click the [Next] button. 

Now NEC ESMPRO Agent is uninstalled. 

z Without use of NEC EXPRESSBUILDER: 

1. Start [Add/Remove Programs] on [Control Panel]. 

2. Select [NEC ESMPRO Agent] and click [Add/Remove]. 

Now NEC ESMPRO Agent is uninstalled. 
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Uninstallation of BMC Configuration and BMC FW Update Service 

If NEC ESMPRO Agent is installed, the uninstaller of the BMC configuration and that of NEC 
BMC FW Update Service are registered. 

The use of these uninstallers allows the BMC configuration and NEC BMC FW Update Service to 
be deleted as follows: 

1. Start [Add/Remove Programs] on [Control Panel]. 

2. Select [NEC BMC Configuration] or [NEC BMC FW Update Service] and click 
[Change/Remove]. 
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NEC ESMPRO Manager 

To monitor and manage a computer, on which NEC ESMPRO Agent is installed, with a 
management PC online, use NEC ESMPRO Manager that is bundled with the product. 

For detailed procedures of installation and setting, see online documents or NEC ESMPRO Online 
Help. 

TIPS: Online documents provide cautions and information for using 
NEC ESMPRO Manager. See NEC ESMPRO Ver. 4.0 User’s Guide in 
the NEC EXPRESSBUILDER CD-ROM. 

 
Monitoring by Use of Data Viewer 

To monitor the state of the NEC Express5800/ft series on a management computer with installation 
of NEC ESMPRO Manager, the data viewer is used. If you click each of the modules and items to 
be checked sequentially on the tree view in the Windows Explorer format, the data viewer indicates 
their states on the right side of the screen. 

You can manage the status on a Web browser using Web component functions of NEC ESMPRO 
Manager. For details, see Help on Web Component. 

This section describes the tree structure and displayed screens in the data viewer. 

To make the data viewer indicate the state of each module and those of the components on it, select 
the server to be monitored from NEC ESMPRO Manager to start the data viewer (in the following 
description, the start procedure of the data viewer is omitted). 
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Monitoring CPU Module 

To monitor the CPU modules and the components on the CPU module, see the [CPU Module] tree.  
To see the information on the [CPU Module] tree, select the target CPU module from [CPU 
Module] in the [FTServer] tree. 

You can see the following information on the modules and the components on the CPU modules in 
the [CPU Module] tree. 

� General 

Allows the configuration and other information on the CPU modules to be viewed. 

 
� Maintenance 

Allows the start/stop, MTBF information clear, dump acquisition, and diagnosis of the 
CPU modules to be provided. See "Maintenance of NEC Express5800/ft series" described 
later for the start/stop and MTBF information clear of the CPU modules. 
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� Update 

Allows the device identification information of the CPU modules to be viewed and BIOS 
of the CPU modules to be updated. See "Maintenance of NEC Express5800/ft series" 
described later for the update of BIOS of the CPU modules. The detailed device 
identification information can be checked by selecting [ESMPRO MIB] tree→[Hardware] 
tree→[Field Replaceable Unit] tree. 

 
� CPU 

Allows the information of the CPU on the CPU modules to be viewed. 

 
� DIMM 

Allows the information of DIMM on the CPU modules to be viewed. 

 
 



Installing and Using Utilities  5-39 

Monitoring PCI Module 

To monitor the PCI modules and the components on the PCI modules, refer to the [PCI Module] 
tree. To see the information on the [PCI Module] tree, select the target PCI module from [PCI 
Module] in the [FTServer] tree. 

You can see the following information on the PCI modules and the components on the PCI modules 
of the [PCI Module] tree. 

(This section describes the general information screens of the PCI modules. The components on the 
PCI modules are described later.) 

� General 

Allows the configuration and other information of the PCI modules to be viewed. 

 
� Maintenance 

Allows the start/stop, MTBF information clear, and diagnosis of the PCI modules to be 
provided. See "Maintenance of NEC Express5800/ft series" described later for the 
start/stop and MTBF information clear of the CPU modules. 

 
� Update 

Allows the device identification information of the PCI modules to be viewed. The 
detailed device identification information can be checked by selecting [ESMPRO MIB] 
tree→[Hardware] tree→[Field Replaceable Unit] tree. 
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Monitoring PCI Slots and Devices on PCI Module 

To monitor the PCI slots and devices on the PCI modules, see the [PCI slot] tree. To see the 
information on the [PCI slot] tree, select [PCI Module]→[PCI module (containing PCI slot to be 
seen)]→[PCI slot] of the [FTServer] tree. 

You can see the following information on the PCI slot and the devices on the PCI slot in the [PCI 
slot] tree. 

� General 

Allows the PCI slot configuration information to be viewed. 

 
� Maintenance 

Allows a device on the PCI slot to be started. This function is not supported in the current 
version. 

 
� PCI Device – General 

Allows the information of devices on the PCI slot to be viewed. 
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� PCI Device – Detailed information 

Allows the detailed information of a device on the PCI slot to be viewed. 

 
� PCI Bridge – General 

Allows the information of bridges on the PCI bus to be viewed  

 

 

 

 

� PCI Bridge – Bus information 

Allows the bus information of a bridge on the PCI bus to be viewed. 

 

 

 

 

 

� PCI Bridge – Detailed information 

Allows the detailed information of a bridge on the PCI bus to be viewed. 

 



5-42  Installing and Using Utilities 

Monitoring SCSI Adapter on PCI Module 

To monitor the SCSI adapter on the PCI modules, see the [SCSI adapter] tree. To see the 
information on the [SCSI adapter] tree, select [PCI Module]→[PCI module (to which the SCSI 
adapter to be viewed is connected)]→[SCSI adapter] of the [FTServer] tree. 

You can see the following information of the SCSI adapter in the [SCSI adapter] tree. 

� General 

Allows the configuration and other information of the SCSI adapter to be viewed. 

 
� Maintenance 

Allows the MTBF information of the SCSI adapter to be viewed or cleared. 

See "Maintenance of NEC Express5800/ft series" described later for clearing the MTBF 
information of the SCSI adapter. 

 
� Update 

Allows the firmware of the SCSI adapter to be updated. 

However, this function is not supported in the current version. 
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� SCSI bus 

Allows the information of the SCSI bus through which the SCSI adapter is connected with 
devices to be viewed. 

See "Maintenance of NEC Express5800/ft series" described later for the primary setting of 
the SCSI bus. 

 
Monitoring BMC on PCI Module 

To monitor the base management controller (BMC), controller for system management, on the PCI 
modules, see the [BMC] tree. To see the information on the [BMC] tree, select [PCI Module]→[PCI 
module (containing BMC to be seen)]→[BMC] of the [FTServer] tree. 

You can see the BMC F/W version and other information in the [BMC] tree. 
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Monitoring Ethernet Adapter on PCI Module 

To monitor the Ethernet adapter on the PCI modules, see the [Ethernet adapter] tree. To see the 
information on the [Ethernet adapter] tree, select [PCI Module]→[PCI module (connected with 
Ethernet adapter to be seen)]→[Ethernet adapter] of the [FTServer] tree. You can see the following 
information of the Ethernet adapter from the [Ethernet adapter] tree. 

IMPORTANT: 
A 1000Base Ethernet Board tree is not created at [FTServer].  See [Network] at [ESMPRO MIB]. 

To check errors of 1000Base Ethernet Board, see error notifications to a PCI slot in which a board is 
mounted. 

� General 

Allows the configuration and other information of the Ethernet adapter to be viewed. 

 
� Detailed 

Allows the detailed statistic and other information of the Ethernet adapter to be viewed. 

 
� Maintenance 

Allows the MTBF information of the Ethernet adapter to be viewed or cleared. See 
"Maintenance of NEC Express5800/ft series" described later for clearing the MTBF 
information on the Ethernet adapter. 
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Monitoring SCSI Enclosure 

To monitor the SCSI enclosure, see the [SCSI enclosure] tree. To see the information on the [SCSI 
enclosure] tree, select [SCSI enclosure] of the [FTServer] tree. 

You can see the following information of the SCSI enclosure from the [SCSI enclosure] tree. 

� General 

Allows the configuration and other information 
of the SCSI enclosure to be viewed.  

IMPORTANT: You need to be aware that PCI 
modules, SCSI adapters, SCSI buses, and 
modules under the SCSI enclosure have impact 
on each other.  For details, see “Impact When 
Module Status Changes” described above. 

 

� Maintenance 

Allows the MTBF information of the SCSI adapter to be viewed or cleared. 

See "Maintenance of NEC Express5800/ft series" described later for clearing the MTBF 
information on the SCSI enclosure. 

 
� Update 

Allows the firmware of the SCSI enclosure to be updated. 

However, this function is not supported in the current version. 
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� Electronics – General 

Allows the configuration and other information of the SCSI enclosure electronics to be 
viewed. 

 
� Electronics – Maintenance 

Allows the MTBF information of the SCSI enclosure electronics to be viewed or cleared. 

See "Maintenance of NEC Express5800/ft series" described later for clearing the MTBF 
information on the SCSI electronics enclosure. 

 
� SCSI Slot – General 

Allows the configuration and other information of the SCSI slot to be viewed. 

 

IMPORTANT: You need to be aware of the status of hard disk during 
the mirror creation.  For details, see “Status Color Changes after 
Hard Disk is Mounted” described above.  
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� SCSI Slot – Maintenance 

Allows the MTBF information of the SCSI slot to be viewed or cleared. 

See "Maintenance of NEC Express5800/ft series" described later for clearing the MTBF 
information on the SCSI slot. 

 
 

Monitoring Mirror Disk 

To monitor the mirror disk components, see the [Mirror Disk] tree. To view information on [Mirror 
Disk] tree, select [Mirror Disk] under [FTServer] tree. 

You can see the redundancy status of the mirrors and the device IDs of the SCSI slots into which 
these hard disk components are connected. 

 
[Mirror Disk] 
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Monitoring Hard Disk 

To monitor the hard disks and detect disk failures at an early stage, use the NEC ESMPRO Manager 
and Agent.  You can see configurations and information of hard disk in the Data Viewer. 

 

Monitoring Operations 

This section describes how to maintain hard disks. 

1. Confirmation of hard disk failure 

If NEC ESMPRO Agent detects some problem with a hard disk, it will report an alert of 
the problem to NEC ESMPRO Manager. Please check the alert viewer in the manager  
regularly. 

Ex. If a hard disk in SCSI Slot (41/1) is broken, agent reports the following alert. 

Device 10/40/1 is now BROKEN. 
 

And manager displays the problem information of the hard disk in the [SCSI enclosure] 
→ [SCSI Slot] → [General] of the data viewer. 

 
[SCSI Slot] → [General] 
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2. Confirmation of mirror status 

To check the redundancy status of the failed mirror disk, open [Mirror Disk] screen under 
[FTServer].  On this screen, you can check the redundancy status of the mirror and the 
status of the mirrored hard disks.  

 
[Mirror Disk] 

IMPORTANT: The mirroring redundancy status will change depending the status of the 
two hard disks that make up a mirror as follows: 

Status of hard disk 1 Status of hard disk 2 Status of mirror volume 
Duplex Normal 

Simplex - 

Duplex 

Others Warning 

Duplex - 

Simplex Warning 

Simplex 

Others Warning 

Duplex Warning 

Simplex Warning 

Others 

Others - 

“-” : No status is shown. 

TIPS: Unless the hard disks make up a mirror, the Mirror Disk screen 
does not show any information. 
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IMPORTANT: The Mirror Disk screen shows a pair of two hard disks as a mirror.  Disk pairs are 
shown in the same manner even if a few volumes are created within a single disk or one volume 
spans a few disks (span volume).  

 

z A few volumes are created within a single disk: 

 
The screen shows information on a pair of hard disks that make up a mirror.  It does not show 
information based on volumes (ex. Volume A, Volume B). 

 

Mirror Mirror Mirror

Boot volume

Boot volume

Volume A

Volume B

Volume C

Volume D

Volume A

Volume B

Volume C

Volume D
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z A volume that spans a few hard disks is mirrored (mirror volume, span volume) 

 
Even if a volume consists of a few hard disks, the screen shows information on each pair of hard 
disks that make up a mirror.  In the above example, Volume A is shown in Mirror 2 (10/40/2, 
11/40/2) and Mirror 3 (10/40/3, 11/40/3), separately.  When a hard disk fails, that status will be 
reflected in both mirrors. 

 

Boot volume 

Mirror

Boot volume 

Volume A

Volume A
Volume A

Mirror Mirror

Volume A
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3. Recovery from a hard disk failure 

If a hard disk breaks, the broken disk must be replaced immediately.  This section 
describes alert reports and status shown by the Data Viewer while disks are replaced to 
restore mirroring. 

(1) Detecting problem of a hard disk 

See [1. Confirm of hard disk failure] above. 

(2) Removing the hard disk 

Disconnect the hard disk with the problem. At this time, NEC ESMPRO Agent 
reports the following alert to manager. And icons related to the hard disk with 
problem change the state of warning in the data viewer. 

Since the hard disk has been removed, the status of the SCSI slot will be “EMPTY.” 

 

NOTE: You can identify the new hard disk by DevicePathID (ex. 
10/40/1). 
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When one hard disk with problem was disconnected, SCSI slot changes the status to 
"Warning". 

 
[SCSI Slot] → [General] 

IMPORTANT: The status color of the SCSI slot differs depending on 
the connection of mirrored hard disks: 

� If one of the mirrored disks was removed: Warning 

� If both of the mirrored disks were removed: Gray 
 

Also, at this time, the redundant status of mirrored disks is changed to "Warning". 

 
[Mirror Disk] 

 



5-54  Installing and Using Utilities 

(3) Connect a new hard disk 

Next, connect a new hard disk to the same SCSI Slot. At this time, NEC ESMPRO 
Agent reports the following alert to manager. And icons related to the hard disk are 
changed to the state of normal in the data viewer. 

When the hard disk is connected, SCSI Slot changes the status to "Normal". 

 
[Alert report] 

TIPS: You can identify the new hard disk by DevicePathID (ex. 
10/40/1). 

When the hard disk is connected, SCSI Slot changes the status to "Normal". 

 
[SCSI Slot] → [General] 
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Also, at this time, the state of the mirrored disks change to "Normal". 

 
[Mirror Disk] 
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Maintenance of NEC Express5800/ft series 

NEC Express5800/ft series maintenance can be done in two ways; one is to use NEC ESMPRO 
Manager for remote maintenance and the other is to use the NEC ESMPRO Agent ft server utility 
on the NEC Express5800/ft series for local maintenance. 

TIPS: To start the NEC ESMPRO Agent ft server utility installed in 
the NEC Express5800/ft series, select the items as follows: 

Start Menu→[Programs]→[NEC ESMPRO Agent]→[ft server utility] 

The maintenance functions that can be executed from NEC ESMPRO include three types, those 
common to all components, those specific to particular components, and general system settings. 

The maintenance functions common to all components are operated in the same way basically (the 
operation procedure and typical examples of screen images are described below). 

The table below lists the maintenance functions common to all components. 

Start Stop MTBF 
clear 

Diag- 
nosis 

F/W 
update Component 

R L R L R L R L R L 
CPU module √ √ √ √ √ √ √ √ √ √ 
PCI module √ √ √ √ √ √ √ √ – – 
PCI slot – – – – – – – – – – 
Ethernet adapter – – – – √ √ – – – – 
SCSI adapter – – – – √ √ – – – – 
SCSI enclosure – – – – √ √ – – – – 
SCSI electronics – – – – √ √ – – – – 
SCSI slot – – – – √ √ – – – – 

 
R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
√: Support 
–: Not support 
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The table below shows the component-specific maintenance functions executable from NEC 
ESMPRO. 

Dump 
acquisition 

Dump acquisition 
during system 

operation 
Board switch Component 

R L R L R L 
CPU module – √ √ √ √ √ 

 
R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
√: Support 
–: Not support 

 
Bus reset Change of primary SCSI bus Component R L R L 

SCSI bus – √ – – 
 

R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
√: Support 
–: Not support 

 
BMC firmware update Component R L 

BMC √ √ 
 

R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
√: Support 
–: Not support 

 
The table below shows the support of the whole system setup functions. 

Quick dump Auto firmware update Auto module start Component R L R L R L 
Whole system – √ – √ – √ 

 
R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
√: Support 
–: Not support 

 
The table below shows the support of the preventive disk maintenance (S.M.A.R.T.) setup function. 

Preventive disk maintenance (S.M.A.R.T.) setup Component R L 
SCSI disk – – 

 
R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
√: Support 
–: Not support 
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Start and Stop of Components 

To start or stop a component with NEC ESMPRO Manager, use the [Maintenance] tree of the 
component in the [FTServer] tree of the data viewer. Open the tree of the component to be started or 
stopped and select the [Maintenance] tree. 

To start or stop a component with the ft server utility, use the utility screen of the component. 

The table below shows the potential cases in which a component is to be started or stopped. 

Start Stop Compo- 
nent Remote Local Remote Local 
CPU 
Module 

When the cause of 
down is reviewed 
and the system is 
restarted in module 
down state. 

Executable in any of 
the following module 
states (this can be 
viewed on manager 
screen): 
• Removed 
• Broken 
• Shot 
• Firmware Update 

Complete 
• Diagnostics 

Passed 
 

When the cause of 
down is reviewed 
and the system is 
restarted in module 
down state. 

Executable in the 
following module 
state: 
• Only the red LED 

is on 

Only the red LED is 
on when the module 
is in one of the 
following states: 
• Removed 
• Broken 
• Shot 
• Firmware Update 

Complete 
• Diagnostics 

Passed 
 

When system is 
stopped forcibly 
due to replacement 
or malfunction of 
module. 

Executable in the 
following module 
state (this can be 
viewed on manager 
screen): 
• Duplex 

When system is 
stopped forcibly 
due to replacement 
or malfunction of 
module. 
Executable in the 
following module 
state: 
• Only the green 

LED is on and in 
redundant 
configuration 
state 

The both green 
LEDs are on when 
the module is in the 
following state: 

• Duplex 

 

PCI Module Same as above Same as above Same as above Same as above 
SCSI Slot – – – – 
 
R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
–: Not support 
 

IMPORTANT: PCI modules, SCSI adapters, SCSI buses, and 
modules under the SCSI enclosure have impact on each other.  You 
need to be aware of this, for example, when you replace a PCI module.  
For details, see “Impact When Module Status Changes” described 
above. 
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Procedure in NEC ESMPRO Manager 

Start 

1. Select the target component in the [FTServer] tree. 

2. Check the current state with the "Status" display on the target component screen. 

3. Click the [Bring Up] button in the [Maintenance] screen for the target component. 

A certain time is required for the start. 

The start result can be confirmed by "State" on the target component screen. The result of 
the start operation is reported by the NEC Express5800/ft series as an alert. 

Stop 

Perform the procedure below before replacing a component. 

1. Select the target component in the [FTServer] tree. 

2. Check the current state with the "State" display on the target component screen. 

3. Click the [Bring Down] button in the [Maintenance] screen for the target component. 

A certain time is required for the stop. 

The stop result can be confirmed by "State" on the target component screen. The result of 
the stop operation is reported by the NEC Express5800/ft series as an alert. 

Sample screen of NEC ESMPRO Manager 1 

 
[Maintenance] screen of PCI module 

[PCI Module] – [Maintenance] 
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Sample screen of NEC ESMPRO Manager 2 

 
[Maintenance] screen of CPU module 

[CPU Module] – [Maintenance] 
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Procedure in the ft server utility 

Start 

1. Select the target component by using the ft server utility. 

2. Check the current state of the target component with the LEDs. 

3. Click the [Up] button of the target component. 

A certain time is required for the start. 

The start result can be confirmed by the LEDs on the target component. The result of the 
start operation is registered in the event log. 

Stop 

Stop before replacing components. 

1. Select the target component by using the ft server utility. 

2. Check the current state of the target component with the LEDs. 

3. Click the [Down] button of the target component. 

A certain time is required for the start. 

The start result can be confirmed by the LEDs on the target component. The result of the 
start operation is registered in the event log. 

 
Sample screen of ft server utility 
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Check and Clear of MTBF Information 

The MTBF information of a component can be viewed or cleared (initialized). 

NEC Express5800/ft series manages the MTBF (mean time between failure) of each component.  
If a fault occurs in a component, the NEC Express5800/ft series calculates the MTBF of the 
component again. If the calculated value is lower than the pre-defined threshold, the NEC 
Express5800/ft series disables the component to be used. 
Contact your maintenance personnel if such a symptom as above occurs. 

IMPORTANT: A disabled component with the MTBF lower than the threshold can 
be forcibly enabled by clearing the MTBF. However, contact your maintenance 
personnel for the forced use of such a component. 

To clear the MTBF information of a component with NEC ESMPRO Manager, use the 
[Maintenance] tree of the component of the [FTServer] tree of the data viewer.  Open the tree of 
the component whose MTBF information is to be cleared and select the [Maintenance] tree. 

To clear the MTBF information of a component with the ft server utility, use the utility screen of the 
component.  The table below shows the potential cases in which the MTBF information of a 
component is to be cleared. Contact your maintenance personnel for clearing MTBF information. 

MTBF clear Component 
Remote Local 

CPU Module To start the module forcibly after 
replacing a module or if MTBF became 
lower than the threshold due to 
malfunction and disabled the module. 

Executable in the following module 
state (this can be viewed on manager 
screen): 

• Broken 
MTBF is lower than the threshold. 

To start the module forcibly after replacing 
a module or if MTBF became lower than 
the threshold due to malfunction and 
disabled the module. 

Executable in the following module state: 

• Only the red LED  is on and the event 
indicating that MTBF is lower than the 
threshold is registered in the event log. 

PCI Module Same as above Same as above 

Ethernet 
Adapter 

To start the module/component forcibly 
after replacing a module or if MTBF 
became lower than the threshold due 
to malfunction and disabled the 
module/component. 

Executable in the following module 
state (this can be viewed on manager 
screen): 

Broken 
MTBF is lower than the threshold. 

You can clear MTBF information by 
unplugging and plugging the live wire 
of the PCI module. 

To start the module/component forcibly 
after replacing a module or if MTBF 
became lower than the threshold due to 
malfunction and disabled the 
module/component. 

Executable in the following module state 
(this can be viewed on manager screen): 

• Only the red LED is on and the event 
indicating that MTBF is lower than the 
threshold is registered in the event log. 

You can clear MTBF information by 
unplugging and plugging the live wire of 
the PCI module. 

SCSI Adapter Same as above Same as above 
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MTBF clear Component 

Remote Local 
SCSI 
Enclosure 

To start the module/component forcibly 
after replacing a module or if MTBF 
became lower than the threshold due 
to malfunction and disabled the 
module/component. 

Executable in the following module 
state (this can be viewed on manager 
screen): 

Broken 
MTBF is lower than the threshold. 

To start the module/component forcibly 
after replacing a module or if MTBF 
became lower than the threshold due to 
maldunction and disabled the 
module/component. 

Executable in the following module state 
(this can be viewed on manager screen): 

Only the red LED is on and the event 
indicating that MTBF is lower than the 
threshold is registered in the event log. 

SCSI 
Electronics 

Same as above Same as above 

SCSI Slot Same as above Same as above 

R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
–: Not support 

 
Procedure in NEC ESMPRO Manager 

Perform the procedure below before replacement of a component. 

1. Select the target component in the [FTServer] tree. 

2. Check the current state with the "State" display on the target component screen. 

3. Click the [Clear] button in the [MTBF Clear] of the target component. 

The MTBF clearing result can be confirmed by "State" on the target component screen. 
The result of the MTBF clearing operation is reported by the NEC Express5800/ft series 
as an alert. 

4. Start the component. 

Sample screen of NEC ESMPRO Manager 

 
[Maintenance] screen of SCSI enclosure 

[SCSI Enclosure] – [Maintenance] 
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Procedure in the ft server utility 

Perform the procedure below before replacement of a component. 

1. Select the target component by using the ft server utility. 

2. Check the current state of the target component with the LEDs and event log. 

3. Click the [Clear] button in [MTBF Clear] of the target component. 

The MTBF clearing result can be confirmed by the LEDs on the target component. The 
result of the MTBF clearing operation is registered in the event log. 

4. Start the component. 

Sample screen of ft server utility 

 
[PCI Module] 
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Diagnostics 

The NEC Express5800/ft series provides the self-check diagnosis function for some components. If 
a fault occurs in a component, the NEC Express5800/ft series can diagnose the component to detect 
the fault. 

To diagnose a component with the NEC ESMPRO Manager, use the [Maintenance] tree of the 
component in the data viewer. Open the tree of the component to be diagnosed and select the 
[Maintenance] tree. 

To diagnose of a component with the ft server utility, use the utility screen of the component. 

The table below shows the potential cases in which a component is to be diagnosed. 

Diagnosis Component Remote Local 
CPU Module When a phenomenon causing the 

module to be down occurs or a 
phenomenon supposed to be a 
malfunction occurs. 

Executable in any of the following 
module states (this can be viewed on 
manager screen): 

• Removed 
• Broken 
• Shot 
• Firmware Update Complete 

To diagnose the module under 
operation, bring down the module 
before the diagnosis. 
 

When a phenomenon causing the 
module to be down occurs or a 
phenomenon supposed to be a 
malfunction occurs. 

Executable in any of the following 
module states: 

• Only the red LED is on 
Only the red LED is on when the 
module is in one the following states: 

• Removed 
• Broken 
• Shot 
• Firmware Update Complete 

(no fault found by diagnosis) 

To diagnose the module under 
operation, bring down the module 
before the diagnosis. 
 

PCI Module Same as above Same as above 

 
R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
–: Not support 
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Procedure in NEC ESMPRO Manager 

1. Select the target component in the [FTServer] tree. 

2. Check the current state with the "State" display on the target component screen. If the 
component is operating, stop the component. 

3. Click the [Diagnostics] button in the [Maintenance] screen for the target component. 

The diagnosis result can be confirmed by "Result" of the diagnosis on the target 
component screen. The result of the diagnosis is reported by the NEC Express5800/ft 
series as an alert. 

The result of diagnosis executed last is displayed in the [Diagnosis Information] column. 
In addition, if a fault is detected by the result of the diagnosis, the state of the [General 
Information] tree of the component is changed. 

Sample screen of NEC ESMPRO Manager 

 
 [Maintenance] screen of PCI module 

[PCI Module] – [Maintenance] 
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Procedure in the ft server utility 

1. Select the target component by using the ft server utility. 

2. Check the current state of the target component with the LEDs. If the component is 
operating, stop the component. 

3. Click the [Diagnostics] button in the [Diagnosis Information] on the target component. 

The diagnosis result can be confirmed by the LEDs on the target component. The result of 
the diagnosis is registered in the event log. 

4. Start the component. 

Sample screen of ft server utility 

 
[PCI Module] 
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Firmware Update 

NEC Express5800/ft series can update firmware (including BIOS) if some hardware components 
operate in the online state (in which the system continues the operation but the component trying to 
update firmware or BIOS is stopped).  

To update firmware with NEC ESMPRO Manager, use the [Update] tree of the component in the 
data viewer. Open the tree of the component for which firmware is updated and select the [Update] 
tree. 

To update the firmware of a component with the ft server utility, use the utility screen of the 
component. 

To update the firmware of a component, the firmware image file of the firmware for update must 
previously be stored in the managed server. On the firmware update screen, specify the path to the 
firmware image file for update. 

The table below shows the potential cases in which the firmware of a component is to be updated. 

Firmware update Component Remote Local 
CPU Module When BIOS must be updated to 

new one. 
Executable in any of the 
following module states (this can 
be viewed on manager screen): 

• Removed 
• Broken or forced stop 
• No fault found by diagnosis 

To update the module under 
operation, bring down the 
module before the update. 
 

When BIOS must be updated to new 
one. 
Executable in the following module 
state: 

• Only the red LED lit red is on 

Only the red LED is on when the 
module is in one of the following states: 
• Removed 
• Broken or forced stop 
• No fault found by diagnosis 

(Firmware Update Complete) 

To update the module under operation, 
bring down the module before the 
update. 

 
R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
–: Not support 
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Procedure in NEC ESMPRO Manager 

1. Save the image data of the update firmware in an arbitrary directory of the NEC 
Express5800/ft series. 

Save the image data in any way. Write down the path to the directory in which the image 
data is saved. 

2. Select the target component in the [FTServer] tree. 

3. Check the current state with the "State" display on the target component screen. If the 
component is operating, stop the component. 

4. Click the [Firmware Update] button in the [Update] screen for the target component. 

Sample screen of NEC ESMPRO Manager 

 
 [Update] screen of CPU module 

[CPU Module] – [Update] 
 

5. Select [Specify the file path to update], enter the 
directory in which the updated firmware 
specified in the input box in step 1 is saved, and 
click the [Execute] button. 

Perform the firmware update. 

The update result can be confirmed by the state 
on the target component screen (indication of 
"Firmware update completed"). The result of the 
update processing is reported by the NEC 
Express5800/ft series as an alert. 

6. After the BIOS for a single CPU module is completed, click the [Jump Switch] button.  
The module completely updated is started and the active module is stopped. 
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7. Start the other module stopped. 

Starting the module causes the firmware to be updated automatically. However, if the 
[Enable automatic firmware update] property is invalid, update the module in the 
procedure as follows: 

(1) Check the current state with the "State" display on the target component screen. If the 
component is operating, stop the component. 

(2) Click the [Firmware Update] button in the 
[Update] screen for the target component. 

(3) Select the update method in the [Firmware 
Update] dialog box and click the [Run] button. 

 (4) Start the module. 

 

Under the following conditions, the modules can have the same 
new firmware version by copying the firmware between 
modules.  

� Due to the replacement of either of the CPU modules, the version of the firmware in a 
module does not match that in another module. 

� The image data of the update firmware has not been acquired yet. 

1. Start the system only with the CPU module of the copy source. 

2. Make invalid the [Enable automatic firmware update] property. 

3. Select the target component in the [FTServer] tree. 

4. Check the current state with the "State" display on the screen of the CPU module to be 
copy destination. If the module is operating, stop the module. 

5. Click the [Firmware Update] button in the [Update] screen for the target component. 

6. When the firmware update dialog appears, check [Copy firmware from Online module to 
Offline one.] to run the firmware update. 

Copying the firmware in the online module to the offline module allows the firmware 
update to be completed. 

7. Start the inactive module. 
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Procedure in ft server utility 

1. Save the image data of the update firmware in a desired directory of the NEC 
Express5800/ft series. 

Save the image data in some manner. Write down the path to the directory in which the 
image data is saved. 

2. Select the target component with the ft server utility. 

3. Check the current state of the target component with the LEDs. If the component is 
operating, stop the component. 

4. Click the [Firmware Update] button for the target component. 

Sample screen of ft server utility 

 
[CPU Module] 

 
5. Select [Specify new firmware for update], 

enter the directory in which the updated 
firmware specified in the input box in step 1 
is saved, and click the [Run] button. 

Perform the firmware update. 

6. Check the update result with the event log. 
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7. After the BIOS for a single CPU module is completed, click the [Jump Switch] button. 

The module completely updated is started and the module under operation is stopped. 

8. Start the other inactive module. 

Starting the module causes the firmware to be updated automatically. However, if the 
[Enable automatic firmware update] property is disabled, update the module in the 
procedure as follows: 

(1) Check the current state with the "State" display 
on the target component screen. If the component 
is operating, stop the component. 

(2) Click the [Firmware Update] button in the 
[Update] screen for the target component. 

(3) Select the update method in the [Firmware 
Update] dialog box and click the [Run] button. 

 (4) Start the module. 

 

Under the following conditions, the modules can have the same new firmware version by copying 
the firmware between modules.  

� Due to the replacement of either of the CPU modules, the version of the firmware in a 
module does not match that in another module. 

� The image data of the update firmware has not been acquired yet. 

1. Start the system only with the CPU module of the copy source. 

2. Make invalid the [Enable automatic firmware update] property. 

3. Select the target component with the ft server utility. 

4. Check the current state with the "State" display on the screen of the CPU module to be 
copy destination. If the module is operating, stop the module. 

5. Click the [Firmware Update] button in the [Update] screen for the target component. 

6. When the firmware update dialog appears, check [Copy firmware from Onlinemodule to 
Offline one] to run the firmware update. 

Copying the firmware in the online site to the offline site allows the firmware update to be 
completed. 

7. Start the inactive module. 
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Dump Collection 

To collect the dump file with NEC ESMPRO Manager, use [CPU Module] →[Maintenance] tree in 
the data viewer. 

To collect the dump with the ft server utility, use the utility screen of the component. 

IMPORTANT: Acquire the dump only for the examination of a fault. 

The dump can be collected in two ways. In each way, the dump file is collected with the same path 
and file name "%SystemRoot%\memory.dmp" as the dump file of the OS standard. 

� Collecting dump of inactive module 

The dump is acquired from the inactive CPU module (due to the occurrence of a fault or 
forced stop). 

� Collecting dump under system operation 

Either of the CPU modules is entered into the offline state and the dump is collected 
during system operation. After the acquisition, the CPU module is returned to the online 
state again. This can be done only in the duplex system. 

The table below shows the potential cases in which the dump is acquired. 

Saving dump of stopped module Saving dump of component under system 
operation Component 

Remote Local Remote Local 
CPU Module – When a fault or malfunction 

occurs in the system. 
Save the dump if requested 
by maintenance personnel. 
Executable in the following 
module state: 
• Only the red LED is on 
However, this function 
operates only in a fault 
state. An execution error 
occurs in any other cases. 
Only the red LED is on when 
the module is in one of the 
following states: 
• Removed 
• Broken 
• Shot 
• Firmware 
Completion of update 
• No fault found by 

diagnosis 
 

When a fault or 
malfunction occurs 
in the system. 
Save the dump if 
requested by 
maintenance 
personnel. 
Executable in the 
following module 
state (this can be 
viewed on manager 
screen): 
• Duplex 
 

When a fault or 
malfunction occurs in 
the system. 
Save the dump if 
requested by 
maintenance 
personnel 
Executable in the 
following module 
state: 
• When only the 

green LED is on and 
the module is in  
redundant 
configuration state 

Only the green LED is 
on when the module is 
in the following state: 
• Duplex 
 

 
R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
–: Not support 
 



5-74  Installing and Using Utilities 

Procedure in NEC ESMPRO Manager 

The [Dump] button of NEC ESMPRO Manager performs the function of "saving dump during 
system operation." 

1. Select [CPU Module] in the [FTServer] tree. 

2. Check the current state with the "State" display on the target component screen. 

3. Click the [Dump] button in the [Maintenance] screen for the target component. 

A certain time is required for the dump saving. 

The dump is stored as %SystemRoot%\memory.dmp on the managed server. 

The result of the dump saving is reported by the NEC Express5800/ft series as an alert. 

Sample screen of NEC ESMPRO Manager 

 
 [Maintenance] screen of CPU module 

[CPU Module] – [Maintenance] 
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Procedure in ft server utility 

1. Select the target CPU module by using the ft server utility. 

2. Check the current state of the target CPU module with the LEDs. 

3. Select the dump acquisition method with [Dump] of the target CPU module and click the 
[Harvest] button. 

A certain time is required for the dump acquisition. 

The dump is stored as %SystemRoot%\memory.dmp on the server. 

The result of the dump acquisition can be confirmed in the event log. 

Sample screen of ft server utility 

 
[CPU Module] 
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SCSI Bus Reset 

The SCSI bus can be reset. 

Select [FTServer] tree→[PCI Module]→[SCSI adapter]→[SCSI bus] screens with the ft server 
utility. Open the tree of the component for which the SCSI bus is to be reset and select the [SCSI 
bus] tree. 

The table below shows the potential cases in which the SCSI bus is reset. 

Bus reset Component 
Remote Local 

SCSI Bus – When a malfunction occurs in the SCSI bus to require the 
bus reset.  
Provide the bus reset if requested by maintenance 
personnel. 
 
Executable in the following module state: 
• Only the green LED is on 
 
Only the green LED is on when the module is in the 
following state: 
• Duplex 
 

 
R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
–: Not support 
 
Reset the SCSI bus with the ft server utility in the following procedure. NEC ESMPRO Manager 
cannot reset the SCSI bus. However, because the ft server utility cannot check the setup of the SCSI 
bus, check the bus state with NEC ESMPRO Manager in advance. 

1. Select the target SCSI Bus in the [FTServer] tree. 

2. Click the [Reset] button for [Bus Reset] in the SCSI bus screen. 

The modification result can be checked in the event log. 

Sample screen of ft server utility 

 
[PCI Module] – [SCSI Adapter] – [SCSI Bus] 
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Setup of Preventive Disk Maintenance 

In this section, the preventive disk maintenance (S.M.A.R.T.) is configured. 

If the preventive disk maintenance (S.M.A.R.T.) is enabled (by checking Enable on the setting 
screen), the disk fault monitoring function is enabled to detect possible disk faults. Disabling the 
preventive disk maintenance disables the disk fault monitoring function. 

The table below shows the potential cases in which the setup of the preventive disk maintenance is 
modified. 

IMPORTANT: The disk failure prediction (S.M.A.R.T.) feature is not 
supported in this server.  Use ft server utility to disable this feature. 

When a disk is replaced, be sure to change the setting described below. 

(Contact your maintenance personnel for changing the setup of the preventive disk maintenance in 
any case other than above.) 

Setup of preventive disk maintenance (S.M.A.R.T.) Component 
Remote Local 

SCSI disk – Executable if the system is operating. 
Use this function at disk replacement 
Change the setting to "Disable" before removing 
disk. 
Insert a new disk and, after termination of disk 
replacement, change the setting to "Enable." 

R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
–: Not support 
 
Change the setup of the preventive disk maintenance with the ft server utility in the following 
procedure. NEC ESMPRO Manager cannot set the preventive disk maintenance. 

1. Select [Disk Failure Prediction] in the [FTServer] tree. 

2. Check the check box of [Enable disk failure prediction [SMART]] (or cancel the check). 

3. Click the [Apply] button. 

Sample screen of ft server utility 

 
[Preventive Disk Maintenance] 
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Setup of System Operation 

The following properties can be set as the operation setup of the whole system. 

� Quick dump 

If this property is enabled (by checking "Enable" on the setup screen), the dump is 
acquired in parallel with the system startup if a fault occurs in the system. If this property 
is disabled, the dump is acquired by the dump function normally provided by OS. 

The initial setup value is "Enable." 

� Auto firmware update 

If a new CPU module containing BIOS different from that of the existing CPU module in 
version with this property being enabled (by checking "Enable" on the setup screen), the 
BIOS of the new CPU module is updated to the BIOS of the existing CPU module to 
match with each other. If this property is disabled, the BIOS of the new CPU module is 
not update automatically. 

The initial setup value is "Enable." 

� Auto module start 

If this property is enabled (by checking "Enable" on the setup screen), the CPU or PCI 
module newly inserted is automatically started to be operable. If this property is disabled, 
the module is not started automatically. 

The initial setup value is "Enable." 

The system operation can be set on [FTServer] tree→[General] screen of the ft server utility. 

The table below shows the potential cases in which the system operation setup is changed. Contact 
your maintenance personnel for the change of the system operation setup. Setting change will take 
effect after system reboot. However, the utility does not indicate that reboot is required.  

Quick dump Auto firmware update Auto module start Component Remote Local Remote Local Remote Local 
Whole 
system 

– Executable if 
the system is 
operating. 

When dump is 
acquired by 
using the dump 
function 
normally 
installed in OS 
at occurrence of 
system fault. 

– Executable if the 
system is 
operating. 

When firmware is 
updated manually 
at insertion of 
new CPU module

– Executable if the 
system is 
operating. 

When firmware is 
updated manually 
at insertion of new 
CPU/PCI module 

 
R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
–: Not support 
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Configure the system settings using the ft server utility in the following procedure. The system 
cannot be configured using the NEC ESMPRO Manager. 

1. Select [General] in the [FTServer] tree. 

2. Check the property of carrying out the modification with [System Settings] (or cancel the 
check). 

3. Click the [Apply] button. 

Sample screen of ft server utility 
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BMC Firmware Update 

The firmware of the BMC on the PCI module can be updated. 

The base management controller (BMC) is the processor exclusively used for monitoring the 
system’s operating environment faults and controlling of the system. 

The BMC firmware can be updated by using the BMC firmware update utility. 

Both NEC ESMPRO Manager and the ft server utility can start the BMC firmware update utility. 

To update the BMC firmware, the firmware image file must be updated on the managed server in 
advance. On the BMC firmware update screen, specify the path of the image file of the firmware to 
be updated. 

The table below shows the potential cases in which the BMC firmware is to be updated. 

IMPORTANT: Contact your maintenance personnel for the update of 
the BMC firmware. 

BMC firmware update Component Remote Local 
BMC When an update to new firmware is 

required. 
Executable in the following module 
state (this can be viewed on 
manager screen): 
• Duplex 
 

When an update to new firmware is 
required. 
Executable in the following module state 
• Only the green LEDs on all PCI modules 

are on 
 
Executable in the following state when only 
the green LEDs on all PCI modules are on:  
• Duplex 

 
R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
–: Not support 
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Procedure of Update from NEC ESMPRO Manager Menu 

Update firmware in the procedure as 
follows: 

1. Select [Program]→[NEC 
ESMPRO Manager] 
sequentially from the start 
menu. Then click [BMC FW 
Update Utility]. 

The [BMC FW Update] 
dialog box appears. 

 

 

 

 

2. Enter the device name and click [OK]. 

The [Execution Check] dialog box appears. 

 

3. Store the firmware in the directory specified by 
[Location]. 

The storage area may be modified. See "Change of 
Update Data Storage Destination" describedlater. 

 

4. Click [OK]. 

Run firmware update. 

The advance of the update appears 
during update. 

At the termination of update, the 
update result is displayed. 

 

5. Click [OK]. 

 

 



5-82  Installing and Using Utilities 

Procedure of Update from ft server utility 

Update the firmware in the procedure as follows: 

1. Click the [Firmware] button in the [Firmware] tree. 

The [BMC FW Update] dialog box appears. 

 
2. Enter the device name and click [OK]. 

The [Execution Check] dialog box appears. 

 

 

3. Store the firmware in the directory shown in 
[Location]. 

The storage area may be changed. See "Change of  

Update Data Storage Destination" described later. 

 

4. Click [OK]. 

Execute the firmware update. 

The progress of the update appears during the 
update. 

The update result appears after the update is terminated. 

 

5. Click [OK]. 
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Change of Update Data Storage Destination 

Perform the firmware update by using the ft server utility in the procedure below: 

1. Click the [Property] button in [BMC Firmware Update Service]. 

The [BMC FW Update Service Properties] dialog box appears. 

 
2. Enter the storage destination in [Storage directory for update data:] and click [Register]. 
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Refresh of View based on State Change Alert Setting 

A new function is supported so that NEC ESMPRO Manager window will be updated on a system 
state change basis (in other words, whenever necessary).  This function is OFF by default. See the 
[Setting] below about how to turn it ON. 

NEC ESMPRO Manager window is updated by one minute-interval polling by default.  Therefore, 
there is some time-lag for NEC ESMPRO Manager to recognize changes in NEC Agent.   By 
using this function, the time-lag can be reduced.  However, it may consume a little bit more 
network band width since each state change will be notified to NEC ESMPRO Manager as some 
kind of alert. 

[Setting] 

1. Select [Program] → [Esmpro] from the start menu and click [Manager Settings]. 

 
[Manager Settings] dialog box 

2. Check [Enable the State Change Alert Setting]. 

3. Click the [Agent Setting..] button. 

 
[State Change Alert Setting] dialog box 

4. Check the name of servers sending the state change alert to the Manager when the Agent 
recognizes changes in the state. 

Click the [Execute] button for the setting change to take effect. 
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Change of Device State Color on DataViewer 

From Manager Ver3.88 and Agent Ver3.8a, some change has been made to the color of device state 
in order to improve intuitive recognition at an abnormality or a system trouble occurrence.. 

Device State Old color New color 
CPU Module Empty Gray Yellow 
CPU Module Removed Gray Yellow 
CPU Module Simplex Yellow Green 
PCI Module Empty Gray Yellow 
PCI Module Removed Gray Yellow 
PCI Module Simplex Yellow Green 
SCSI Slot Empty (in case of mirroring) Gray Yellow 

 
As shown above, the device state color of troubled components (components that is “Empty” or 
“Removed”) affecting the FT system’s redundancy has been changed to yellow (Warning) in order 
to make it easier to determine problems. However, for the device state color of modules operating 
without hardware trouble, the color indicating the simplex state has been changed from yellow 
(Warning) to green (Normal).  

(Example of old window) 

 
 
(Example of new window) 
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NEC MWA ∼∼∼∼  Management Workstation Application ∼∼∼∼  
NEC MWA is an application that enables the remote management of the server through a 
management PC over the network.  (A management PC is a computer running NEC ESMPRO 
Manager.)  This application assists in reducing responsibility of the Administrator for managing 
the operation of the server. 

TIPS: See the online documented "NEC MWA First Step Guide" in 
NEC EXPRESSBUILDER CD-ROM for the details on NEC MWA 
setup and how to use.  See NEC MWA Online Help for the details on 
the functions and how to operate them. 

Communications (Connection) 

To use the NEC MWA, the management PC must be connected to the server via LAN, WAN or 
COM port (Serial Port.) 

IMPORTANT:  

� The Console Redirection feature (via WAN or COM port) cannot 
be used when the server is operated remotely from the other 
management PC by using the RomPilot feature (via LAN port). 

� Before using the Console Redirection feature to operate the server 
remotely, change the "RomPilot Support" in the "Advanced" menu 
of the BIOS setup utility to "disable".  See Chapter 4 for detail 
explanation. 

� The COM2 port or LAN1 port is used to communicate the Base 
Management Controller (BMC) in the server with the management 
PC.  See Chapter 2 for connector location. 

 

NEC MWA Functions 

NEC MWA enables the following functions by connecting to the extended BIOS (RomPilot), the 
standard BIOS and BMC (Baseboard Management Controller) of the server. 

� Remote console function 

This function enables you to remotely monitor the server screen during POST (Power On 
Self-Test) or booted MS-DOS through NEC MWA window on a management PC.   
During the time, you can also key in data to the NEC Express5800 series from the 
keyboard of the management PC. 

� Remote drive function* 

NEC MWA enables to boot the servers from the floppy disk drive or disk image file on the 
management PC. 

* Available only when connected via LAN. 
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� Remote power control 

NEC MWA on a management PC enables the sending the following power control 
commands to the server remotely. 

− Power on/off 

− Power cycle (power-off, then power-on) 

− Reset 

− Power switch 

� Remote information collection 

NEC MWA on a management PC enables the collection of the following information 
remotely. 

− System Event Log (SEL) 

− Sensor Device Report (SDR) 

− Field Replaceable Unit (FRU) 

− CMOS, DMI, PCI information* 

− BMC setting information 

* Available only when connected via LAN. 

IMPORTANT: ESCD information is not collected in this system.  
"ESCD data read error server report: Plug and Play call error" is 
generated when attempting to collect the ESCD information. 

� Linkage with NEC ESMPRO* 

When NEC MWA receives an alert (such as device failure) from BMC on the server, it 
analyzes the alert and automatically registers to the alert log of NEC ESMPRO. 

*Available at the time of LAN connection only. 

Operating Environment 

You can run NEC MWA in the following hardware/software environment: 

� Management PC (on which to install NEC MWA) 

MWA runs on a computer where a Windows OS is installed.  For details, see MWA First 
Step Guide. 

� Equipment that can be maintained remotely by NEC MWA 

NEC Express5800 series whose user’s guide refers to MWA.  Such servers are equipped 
with RomPilot or BMC.  This server has BMC (IPMI Ver. 1.0). 
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Installation of NEC MWA Manager 

To manage the server by using NEC MWA, install NEC MWA in the management PC.  NEC 
ESMPRO Agent must be installed in the NEC Express5800/ft series. 

Use the "NEC EXPRESSBUILDER CD-ROM" to install NEC MWA. 

1. Boot Windows NT 4.0/2000 or Windows 95/98/Me on a management PC. 

TIPS: For OS compatibility, see MWA First Step Guide. 

2. Insert NEC EXPRESSBUILDER CD-ROM into the CD-ROM drive.  Master Control 
Menu of NEC EXPRESSBUILDER will be automatically displayed. 

3. Click [Setup] → [NEC MWA]. 

TIPS: Right-clicking on the window shown below also displays the 
pop-up menu. 

 
4. Click [NEC MWA Manager]. 

NEC MWA installer will start.  Follow the directions of the installation program. 
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 Configuration 

Prepare the followings for configuring remote management. 

� NEC EXPRESSBUILDER CD-ROM 

� Configuration data 

The following configuration data must be set for each of the NEC Express5800/ft series 
servers to be remotely managed: 

Two configuration methods are available for the NEC Express5800/ft series server:  

- Configuration by starting the Express5800 series through the NEC EXPRESSBUILDER 
CD-ROM and executing "System Management Setup," and 

- Configuration by BMC Configuration Tool that is started on Windows 2000 Advanced 
Server or Windows NT of the NEC Express5800/ft series server.  Start the BMC 
configuration from the ft server utility of NEC ESMPRO Agent. 

The BMC configuration tool is similar to existing NEC MWA Agent. 

Configuration is necessary for both NEC MWA and NEC Express5800/ft series servers.  
For details on the procedure, see the "NEC MWA First Step Guide" in the "NEC 
EXPRESSBUILDER CD-ROM" or the online help of NEC MWA. 

 

Remote Console Connection When No Console is Hooked Up 

If the main unit does not have a console such as keyboard, you can operate tools on the server 
remotely using MWA’s remote console functions and NEC EXPRESSBUILDER’s consoleless 
functions. 

 

There are two ways of remote console connection depending on the condition of connection 
between the management PC and the main unit: 

� Connect from the management PC linked to the main unit through LAN. 

� Connect from the management PC directly linked (through Serial port B) to the main unit. 
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Connect from the Management PC Linked through LAN 

On the management PC that is linked through LAN, perform the steps below: 

1. Start the management PC where MWA is installed.  From the Start menu, select 
[Program] → [NEC MWA] → [MWA]. 

When MWA starts, the initial screen “Remote Control Manager” will appear. 

 
2. Insert a formatted 1.44MB floppy disk into the drive. 

3. From MWA’s [File] menu, select [Configuration] command to open [Configuration] 
dialog box. 

4. Select [New] to display the [Select a model] dialog box. 

5. Check [Write to FD] and select an applicable model to open [Configuration for ft Series] 
dialog box. 

Ex) The model name is printed on the front cover like “NEC Express5800/320Lb,” or 
“NEC Express5800/320Lb-R.” 

6. [Configuration for ft Series] dialog box, specify/register configuration information 
including the names of computers to be managed, and then write the information to FD as 
the following filename: 

<Filename> 

CSL_LESS.CFG 

Specify the items as follows: 

IP address: arbitrary Default gateway: arbitrary 

Subnet mask: arbitrary Primary contact: Management PC’s IP address 

7. Right-clicking the server name to open the pop-up menu, from which select [Property] 
command to open [Property] dialog box. 

8. When the [Property] dialog box appears: specify the items as follows: 

<[ID] page> 

Connection mode: LAN 

<[Alert notification] page> 

Uncheck [Use Default Settings] and check [Reset] of [Activate]. 
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9. Right-clicking the server 
name to open the pop-up 
menu and select [Open 
Remote Console] to open 
[MWA Remote Console]. 

 

 

 

 

 

10. Select the [Action at Remote 
Console Connect] command 
from the popup menu displayed by right-clicking the server window to display the [Action 
at Remote Console Connect] dialog box.  Then select [Go MWA mode]. 

 

11. Insert NEC EXPRESSBUILDER CD-ROM into the drive of the computer to be managed 
and insert floppy disk storing the configuration information (CSL_LESS.CFG) into the 
FDD drive. 

12. Hook up the management PC to LAN. 

13. Power off and on the main unit to reboot the system. 

After one reboot, the main menu will appear on the management PC’s screen, on which 
you can perform hardware setup and run utilities. 

TIPS: If the configuration information (CSL_LESS.CFG) in the FD 
has already been loaded, the main menu will appear without a reboot. 

14. When the main menu appears on the management PC’s screen, eject the floppy disk. 

15. If you use other tools, exit NEC EXPRESSBUILDER and power on/off the main unit. 

IMPORTANT: After completing the procedure for remote console 
connection, uncheck [Reset] of [Activate] in [Property] dialog box. 
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Connect from the Management PC Directly Linked (through Serial port B) 

On the management PC that is linked directly to Serial port B of the main unit, perform the steps 
below: 
 

1. Start the management PC where MWA is installed.  From the Start menu, select 
[Program] → [NEC MWA] → [MWA]. 

When MWA starts, the initial screen “Remote Control Manager” will appear. 

2. Select [Environment] – [Direct Connection Setting] from the [File] menu of NEC MWA 
to display the [Direct Connection] dialog box.  Configure the following settings: 

<Direct Connection> 
Port No.: COM port on the management PC to be connected 
Baud Rate: 19200 
Flow Control: None 

3. From MWA’s [File] menu, select [Configuration] command to open [Configuration] 
dialog box. 

4. Select [New] to display [Select a model] dialog box. 

5. Check [Write to FD] and select an applicable model to open [Configuration for ft Series] 
dialog box. 

Ex) The model name is printed on the front cover like “NEC Express5800/320Lb,” 
or “NEC Express5800/320Lb-R.” 

6. [Configuration for ft Series] dialog box, specify/register configuration information 
including the names of computers to be managed, and then write the information to FD as 
the following filename: 

<Filename> 
CSL_LESS.CFG 

7. Right-clicking the server name to open the pop-up menu and select [Property] command 
to open [Property] dialog box. 

8. When [Property] dialog box appears: specify the items as follows: 

<[ID] page> 
Connection mode: COM 
COM:  Direct (cross cable) 

9. Right-clicking the server name to open the pop-up menu and select [Open Remote 
Console] to open [MWA Remote Console]. 

After checking to see if the server window is open on [MWA Remote Console], click the 
[Connect] button. 

10. Hook up the management PC directly to Serial port B of the computer to be managed. 

11. Insert NEC EXPRESSBUILDER CD-ROM into the drive of the managed computer and 
insert the floppy disk storing the configuration information (CSL_LESS.CFG) into the 
FDD drive. 
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12. Power off and on the main unit to reboot the system. 

After one reboot, the main menu will appear on the management PC’s screen, on which 
you can perform hardware setup and run utilities. 

TIPS: If the configuration information (CSL_LESS.CFG) in the FD 
has already been loaded, the main menu will appear without a reboot. 

13. If you use other tools, exit NEC EXPRESSBUILDER and power on/off the main unit. 

IMPORTANT: After completing the procedure for remote console 
connection, click [Disconnect] on the [MWA Remote Console] 
window. 
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VERITAS VOLUME MANAGER 

Installing Volume Manager for Windows 2000  

In the NEC Express5800/ft series, since VERITAS Volume Manager is indispensable, it needs to be 
installed. 

VERITAS Volume Manager offers the comprehensive solution in storage management. 

Local and remote storages connected to the system can be configured and managed online. 

Installation Procedures 

1. Login as "Administrator". 

2. Insert the "NEC EXPRESSBUILDER" 
CD-ROM into the CD-ROM drive.  

The autorun function has the Master Control 
Menu of NEC EXPRESSBUILDER displayed 
automatically. 

Select [Setup] and click [VERITAS Volume 
Manager]. Then the installer will start. 

 

 

3. When the installation wizard screen appears, click [Next] to start the installation. 

 
4. Click [Yes] when the [Question] dialog box appears. 
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5. Click [Next] when [VERITAS Volume Manager 3.1 for Windows2000 setup] dialog 
appears. 

 
6. Click [OK] to install the VERITAS Enterprise Administrator Language Pack. 

 
 

7. When the [Select Installation Type] screen appears, choose the installation type, "Server", 
click [Next] to continue. 

 
8. When the [User Information] screen appears, enter your name, organization, and license 

key, and click [Next]. 

Input the License Key that appears in "Software License Key Certificate". 
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9. When the [Select Features] screen appears, delete the features "Volume Manager 3.1 
MSCS Support," "Volume Manager 3.1 DMP Support," "Volume Manager 3.1 VVR 
Support," and "Volume Manager 3.1 VCS Support" with a red X. 

After checking the installation features selection and the installation files location, click 
[Next]. 

 
 

10. When the [Ready to Install the Application] screen appears, click [Install] again to start 
the installation. 

 
11. After a screen appears with the messages that the program has been successfully installed, 

click [Finish]. 

 
And additional screen comes up to inform you that the system must be rebooted, click 
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[Yes] to restart now or [No] to restart later. 

You may be required to perform a second reboot. 

 
12. Login as "Administrator". 

13. Insert the "NEC 
EXPRESSBUILDER" CD-ROM into 
the CD-ROM drive.  The autorun 
function has the Master Control Menu 
of NEC EXPRESSBUILDER 
displayed automatically. 

14. Select [Setup] and click [NEC 
ESMPRO report service for VERITAS 
Volume Manager]. Then the installer is 
started. 

Now the installation of the VERITAS Volume 
Manager is completed. 

Perform the following procedure successively if you have the NEC Express5800/ft series ft control 
software (Ver:n.n) UPDATE CD-ROM. 
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About License Keys 

NEC Express5800/ft series includes an official license key for using FastResync function with 
VERITAS Volume Manager™ 3.1 (hereinafter “VxVM” 3.1).  The key is printed on the label 
which is place on the server cabinet. 

When you reinstall VxVM or replace the evaluation license with the official license after installation, 
use the license key printed on the label. 

This product was installed with the evaluation license key.  Be sure to replace it with the 
permanent key before using this product. 

 

1. Reinstalling 

To reinstall Volume Manager, see procedures in Chapter 2 “Install” on NEC 
EXPRESSBUILDER CD-ROM included with NEC Express5800/ft series: 

<CD-ROM>\VM\Eng\VM Documentation\VM3.1_Win2k_Quick_Start_Guide.pdf 

2. Replacement with Official License Key 

To replace the license key, see procedures to use “License Operation” and “System 
License” commands and add/replace license keys on the NEC EXPRESSBUILDER 
CD-ROM included with NEC Express5800/ft series: 

<CD-ROM>\VM\Eng\VM Documentation\VM3.1_Win2k_Users_Guide.pdf 

Numbers “0,” “1,” and “5,” or an alphabet “Q” are not used in license keys. 
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When you have the NEC Express5800/ft series ft control software (Ver:n.n) 
UPDATE CD-ROM: 

If you have the NEC Express5800/ft series ft control software (Ver:n.n) UPDATE 
CD-ROM, install the NEC ESMPRO report service for VERITAS Volume Manager in the 
following procedure. See "ft control software (Ver:n.n).doc" in the CD-ROM for details. 

 

1. Insert the NEC Express5800/ft series ft control software (Ver:n.n) UPDATE CD-ROM 
into the CD-ROM drive. 

2. Select [Program (P)] → [Accessory] → [Command Prompt] from [Start] menu in the task 
bar. 

3. Change the current directory to \VXVM\ALERTMAN of the CD-ROM drive at the 
command prompt as described below. 

C:\Documents and Settings\Administrator>Q: <Enter> 

Q:\>cd VxVM\ALERTMAN <Enter> 

Change the specified CD-ROM drive appropriately to meet the environment which you 
use. 

The display image of the command prompt may be different depending on the used 
environment. 

4. Run the commend below: 

Q:\VxVM\ALERTMAN> NECSETUP.EXE add <Enter> 

The setting is completed if "command successfully" appears. 

5. NEC ESMPRO/AlertManager requires following settings. 

 
 

IMPORTANT:  

� The VERITAS Volume Manager is required in the system. Never 
uninstall it. 

� If the NEC Express5800/ft series ft control software (Ver:n.n) 
UPDATE CD-ROM includes the latest VERITAS Volume 
Manager HotFix, apply the latest HotFix.  
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FastResync Configuration Procedures 

FastResync use: The contents of the following sections will be described as below. 
1. Creating disk groups  

The disk group containing the boot disk will not be able to utilize the FastResync 
function. Therefore to utilize the FastResync function, a new disk group must be 
created.  

2. Creating mirror volumes.  
This section will describe the creation of standard mirror volumes.  

3. Adding FastResync 
This section will describe the addition of the FastResync log to a newly created mirror 
volume.  

4. Notes 
This section includes precautions and notes pertaining to the use of the FastResync 
function.  

 
Using the VERITAS Enterprise Administrator 
 
Disk volume operations will be performed using the VERITAS Enterprise Administrator. 
Before performing any operations, the VERITAS Enterprise Administrator must connect to the 
machine in which it will administer. To make connection, follow the procedures described 
below.  
 
Start the VERITAS Enterprise Administrator: 
[Start] menu Æ [Programs] Æ [VERITAS] Æ [VERITAS Enterprise Administrator].  
 
The “Connection” window will appear. 
Enter the host name (“localhost” in case of 
local machine) of the machine to which it 
will connect, then click the [OK] button to 
continue. 
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When login is correctly 
completed and connection is 
established, the login host will 
appear in the top left corner of 
the tree view window. 
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Creating a dynamic disk group 

 
The disk group containing the boot disk can not utilize the FastResync function.  To utilize 
this function, a new disk group must be created.  
 
After inserting the new HDD to 
be used in the new disk group, 
the list of available hard disks 
will appear in the view window 
located in the right pane of the 
window. Right click the hard 
disk which appears at the top of 
the list, and chose (left-click) 
[New Dynamic Disk Group]  
 
 
 
 
 
 
 
 
 
The “New Dynamic disk Group 
Wizard” will start automatically. 
 
Click the [(N)ext] button to 
continue. 
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Enter the optional group 
name in the text box marked 
[Group Name] (newdg is 
used in this example), then 
select the hard disks which 
will be used in the New disk 
group. 
Confirm that only the 
desired disks appear under 
[Selected disks], then click 
[Next] to continue.  
 
 
 
 
 
 
 
 
 
 
 
 
Confirm that the configurations are 
correct, then click [Next] to continue.  
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The final configuration confirmation 
screen will appear. Check that there are 
no mistakes in the configuration. If there 
are no mistakes, click [Finish]. If there 
are mistakes in the configuration, click 
the [Back] button to return to the 
previous screen 
 
 
 
 
 
 
 
 
 
 
 
 
Once the operation has 
been completed the 
newly created disk 
group will appear 
under the [Disk 
Groups] folder in the 
tree view pane. 
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Creating a mirror volume 

 
In the view pane located on 
the right side of the window, 
right click the disk group in 
which a disk volume will 
be created.  When the 
menu list appears, chose 
[New Volume].  
 
 
 
 
 
 
 
 
 
The “New Volume Wizard” will 
start. Click [Next] to continue.  
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Enter the configuration 
information of the volume to be 
created. After entering the 
[Volume Name] and [Size], check 
the [Mirrored] checkbox, and 
remove the check from [Enable 
logging], then click [Next]. (This 
example utilizes the volume 
named mirror_vol_1) 
 
 
 
 
 
 
 
 
 

Caution: After the creation of the mirror volume, the FastResync log will be created; 
FastResync requires a small amount of space to function, therefore do not allocate the 
full quantity of the HDD for the volume.  
 

 
Choose the HDD which will be 
used in the mirror volume. Mark 
the radio button labeled [Manually 
Select Disks], the click [Add All]. 
Confirm that the 2 HDD have 
been added to the mirror volume 
then click [Next].  
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Specify the drive letter for the 
volume to be created. The 
default drive letter will be the 
lowest drive letter that is 
presently available. If there is 
no need for change, click 
[Next] to continue. 
 
 
 
 
 
 
 
 
 
 
 
 
Chose the desired file system, 
and click [Next] to continue. 
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The final configuration 
confirmation window will appear.  
After confirmation, click [Finish] to 
complete the process. 
 
 
 
 
 
 
 
 
 
 
 
 
The formatting and 
resynchronization of the 
mirror volume will 
automatically start. The 
process of the “format” and 
“Resync” can be confirmed 
by choosing the “Tasks” 
tab located towards the 
bottom of the window. 
 
 
 
 
 
 
 
 
 
Once formatting and 
resynchronization of the 
mirror volume has 
completed, the window 
should be displayed as 
illustrated to the right. 
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Adding a FastResync log  

 
To allow for the quick 
resynchronization of 
the mirror volume, the 
“FastResync” log must 
be added to the newly 
created mirror volume.  
 
From the tree view 
pane, right click the 
newly created volume 
(mirror_vol_1 in this 
case), and chose 
[FastResync] Æ [Add].  
 
 
 
 
 
A confirmation window will 
appear.  Click [Yes] to continue. 
 
 
 
 
 



5-110  Installing and Using Utilities 

When the operation is completed, a “DCO_VOLUME” will be created for the mirror volume. 
 

Caution: If the [Create 
Windows 2000 Disk 
Management Compatible 
Group] is checked when 
creating the disk group, a 
disk group upgrade will 
be prompted during the 
addition of FastResync. In 
such a case, left-click the 
disk group from the tree 
view pane, and chose 
[Upgrade to dynamic disk 
group]. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
From the disk view pane, 
right click the newly 
created “DCO_VOLUME” 
and chose [mirror]Æ[Add]. 
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To select the hard disk that will 
be used in the mirror volume, 
check the radio button marked 
[Manually Select Disks] then 
chose the disk corresponding to 
the mirror volume by clicking 
[Add]. 
Confirm that the disk has been 
added and click [OK].  
 
 
 
 
 
 
 
 
 
 
 
 

When the operation has 
completed successfully, 
the window should be 
displayed as illustrated 
to the right. 
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Notes 

・Regarding the Creation of a New Mirror Volume.  
After creating a mirror volume, a FastResync log will be created. Therefore, do not use 
the full quantity of the HDD for the volume. Be sure to leave a few MB of space for this 
function.  
Approximate required DCO log space for each volume.  
 
 
 
 
 
 
 

・Regarding FastResync & Snapshot 
The “Snapshot” function can be 
used to utilize the “FastResync” 
function. In such a case, the 
contents of the mirror volume 
configuration will become 
“Snapshot”.  
Caution: When “Snapshot” is 
used for the internal HDD of 
the machine, the LED of the 
machine will be displayed 
incorrectly. The “SnapShot” 
volume must be deleted by 
using “Snapclean” before a 
“FastResync” can be created. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Volume Size  DCO Size 
1.0GB → 176KB 
10GB → 1.297MB 
20GB → 2MB 
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・Regarding Error messages  
The error message 
illustrated to the right may 
appear when FastResync is 
added to the mirror volume. 
In such a case, register the 
license key for FastResync.  
FastResync can not be used without the registration of a proper license key. 
 

・Volume types supported by “FastResync” 
When using the internal HDD of the server for mirroring, only the “Simple Volume” (1 
mirror to 1 LUN construction) is supported. Striped volumes and RAID-5 volumes are 
not supported. 
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Hard Disk Configurations that can be built by VxVM on the  
NEC Express5800/ft series 

The NEC Express5800/ft series enables creation of three types of dynamic volumes (simple, mirror, 
and stripe) as shown in the figure below.  All volumes need creation of mirror disks. 

 Can/cannot be built 
Dynamic simple volume √ 
Dynamic span volume √ 
Dynamic mirror volume √ 
Dynamic stripe volume √ 
Dynamic RAID5 volume – 

 
Create mirror disks by selecting disks that are in the same slot of the SCSI enclosure.  For example, 
if the hard disks are positioned as shown in the table below, define hard disks 0 and 3, hard disks 1 
and 4, and hard disks 2 and 5 as mirrored pairs. 

 
 
The pairs of mirror disks as shown above can be created by selecting hard disks whose target IDs 
are identical in the disk properties, which are displayed through [Disk View].  The following 
explains how to confirm the target ID: 

1. Click [Start] → [Settings] → [Control Panel].  The [Control Panel] window appears. 

2. Double-click the [Administrative Tools] icon.  The [Administrative Tools] window 
appears. 

3. Double-click the [Computer Management] icon.  The [Computer Management] window 
appears. 

4. Click [Volume Manager for Windows] under [Storage] in the console tree. 

5. In [Connection] dialog box, specify “localhost” as [Host name]. 

 

PCI module (10)

PCI module (11)

Disk D Disk 1 Disk 2

Disk 5Disk 3

Mirror MirrorMirror 

Disk 4
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6. Open the [Disk View] tab, select the target disk, and view the properties. 

 
7. Confirm the target ID shown for [Device Type].  The target ID is “1” in the following 

display sample. 

 
8. Similarly, confirm the target IDs of the other disks.  In this example, the target ID of 

each disk in the [Disk View] tab is as shown below. 

 Target ID 
Hard disk 0 0 
Hard disk 1 1 
Hard disk 2 2 
Hard disk 3 0 
Hard disk 4 1 
Hard disk 5 2 

 
In this case, define hard disks 0 and 3, hard disks 1 and 4, and hard disks 2 and 5 as 
mirrored pairs, and add mirror volumes through [Volume Manager for Windows]. 
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The following shows examples of creating a mirror volume for each volume in the above 
configuration: 

� With simple volumes 

Hard disk 0 Hard disk 1 Hard disk 2 

Boot volume Volume A Volume B

Hard disk 3 Hard disk 4 Hard disk 5 

Boot volume Volume A Volume B 

Mirrored pair 
Mirrored pair 

 
� With mirror volumes 

Volume A

Volume B

Volume C

Volume D 

Volume E 

Volume F 

Hard disk 1 Hard disk 2 Hard disk 4 Hard disk 5 

Boot 
Volume 

Boot
Volume

Mirrored pair 

Mirrored pair Mirrored pair 

Volume A
Volume B

Volume C

Volume D 
Volume E 

Volume F 

Hard disk 1 Hard disk 3

 
Even if mirror volumes have been already created on hard disks in the same enclosure, be 
sure to define hard disks in the corresponding SCSI enclosure to be mirror disks and 
create mirror volumes. 
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� With stripe volumes 

Volume A

Volume B

Volume C

Volume A

Volume B

Volume C

Boot
Volume

Boot
Volume

Hard disk 0

Mirrored pair

Mirrored pair
Mirrored pair

Hard disk 1 Hard disk 2 Hard disk 3 Hard disk 4 Hard disk 5

 
Do not create stripe volumes on the hard disk containing the OS. 

Boot
Volume

Hard disk 0

Volume C

Volume A

Volume B

Hard disk 1 Hard disk 2
 

� With span volumes 

Boot
Volume

Boot
Volume

Hard disk 0

Mirrored pair

Mirrored pair Mirrored pair

Volume B

Volume A

Volume B

Volume A

Hard disk 1 Hard disk 2 Hard disk 3 Hard disk 4 Hard disk 5

 
Do not create span volumes on the hard disk containing the OS. 

Volume C

Volume B

Boot
Volume

Hard disk 0

Volume A

Hard disk 1 Hard disk 2
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ftMemory RAM Disk 

ftMemory RAM Disk is ft series-specific software that improves performance and increases 
usability of the applications that are running on the ft series.  It allows you to use the main memory 
as RAM disk that can be identified as partition disks of 10 to 256MB. 

Since ftMemory RAM Disk is not included with the NEC Express5800/ft series, you need to 
purchase it if necessary. 

 

Improve performance and usability of applications 

� With ftMemory RAM Disk, you can read and write data between applications and the RAM disk 
faster than disk I/O. 

� You can speed up applications by using ftMemory RAM Disk to save temp files that are 
frequently accessed and updated by the applications, and Web server data that you also save to 
physical media. 

� In addition to applications, you can speed up database processing by saving Oracle log files onto 
ftMemory RAM Disk. 

� Since data in the main memory is not lost by the restarting of Windows without power-off, 
ftMemory RAM Disk will be ready for use by applications just after the system re-startup.  You 
can speed up application re-start at the server startup by using ftMemory RAM Disk to save 
application status control files that are necessary to start applications. 

 

Fault-tolerant memory that can deliver quick recovery from hardware failure 

� ftMemory RAM Disk uses redundancy feature provided by the ft series.  If a hardware failure 
occurs at the main memory of one CPU module, the memory data will be retained on the other 
module. 

� In the event of OS rebooting due to a STOP error of Windows, data on the main memory will be 
retained by ftMemory RAM Disk.  In conjunction with ft series’ high-speed reboot and online 
dump features, ftMemory RAM Disk can restore its data that you’ve been using.  Hereby, server 
downtime can be minimized. 

 

 

 
 



 

Chapter 6 

Maintenance 

This chapter describes the daily maintenance of NEC Express5800/ft series and precautions when 
relocating or storing the server.  
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DAILY MAINTENANCE 
To use your NEC Express5800/ft series in best condition, check and maintain regularly as described 
below.  If an error is found on your NEC Express5800/ft series, consult your sales agent. 

 

Checking Alert 

Monitor the failure occurrence by NEC ESMPRO during the system operation. 

Always check whether any alert is reported to NEC ESMPRO Manager on the management PC.  
Check whether any alert is reported on the Joint Viewer, Data Viewer, or Alert Viewer of NEC 
ESMPRO Manager. 

Viewers of NEC ESMPRO 

 

 
Joint Viewer  Alert Viewer 

 

 

 

 Data Viewer  
 

 

 

Checking STATUS LEDs and LCD Display 

Check the LED indication on the front of the NEC Express5800/ft series, on hard disks installed in 
3.5-inch device bay, or on LCD display when the server is powered on or powered off by the shut 
down operation.  The functions and indications of LEDs are described in Chapter 2.  If any 
indication that shows an error, contact your sales agent. 
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Making Backup Copies 

NEC recommends you make backup copies of your valuable data stored in hard disks of the server 
on a regular basis.  For backup storage devices suitable for the server and backup tools, consult 
with your sales agent. 

When you have changed the hardware configuration or BIOS configuration, select "System 
Information Management" and then "Save" of the Off-line Maintenance Utility to make a backup 
copy of the system information. 

 

Cleaning 

Clean the server on a regular basis to keep the server in a good shape. 

WARNING  
  

 
Observe the following instructions to use the server safely.  Failure to follow 
these instructions may result in death or serious personal injury.  See safety 
precautions in Chapter 1. 
 
• Do not disassemble, repair, or alter the server. 
• Do not look into the CD-ROM drive. 
• Disconnect the power plug before cleaning the server. 

  
 
Cleaning the NEC Express5800/ft series 

For daily cleaning, wipe the external surfaces of the server with a dry soft cloth.  Follow the 
procedure below if stains remain on the surfaces: 

IMPORTANT:  
� To avoid altering the material and color of the server, do not use 

volatile solvents such as thinner or benzene to clean the server. 

� The power receptacle, the cables, the connectors on the rear panel of 
server, and the inside of the server must be kept dry.  Do not 
moisten them with water. 

1. Make sure that the server is off-powered (the POWER LED goes off). 

2. Unplug the power cord of the server from a power outlet. 

3. Wipe off dust from the power cord plug with a dry cloth. 

4. Soak a soft cloth in neutral detergent that is diluted with cold or warm water, and squeeze 
it firmly. 

5. Rub off stains on the server with the cloth prepared in Step 4. 
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6. Soak a soft cloth in water, squeeze it firmly and wipe the server with it once again. 

7. Wipe the server with a dry cloth. 

8. Wipe off dust from the fan exhaust opening on the rear of the server with a dry cloth. 

 

Cleaning the Keyboard and Mouse 

Make sure that the server and peripheral devices are all off-powered (the POWER LED goes off), 
and then wipe the keyboard surface with a dry cloth. 

The mouse operation depends on the degree of smoothness of the internal ball rotation.  To keep 
the mouse ball clean, use the mouse in a place with little dust.  Follow the steps below to clean the 
mouse regularly: 

1. Make sure that the server is off-powered (the POWER LED goes off). 

2. Turn the mouse upside down, and rotate the 
mouse ball cover counterclockwise to remove it.  
Take out the ball from the mouse. 

3. Wipe the mouse ball with a dry soft cloth. 

If stains remain, use a soft cloth to wipe them off. 
Soak the soft cloth in neutral detergent that is 
diluted with water or warm water, and squeeze it 
firmly,. 

4. Wipe three small rollers inside the mouse with 
cotton swab. 

Use the cotton swab soaked with alcohol if stains 
remain. 

5. Put the mouse ball back into the mouse. 

If the mouse or rollers are wet in steps 3 and 4, put 
it back after fully dried. 

6. Place the mouse ball cover, and rotate it clockwise 
until it is locked.  

 

 

 

 

Bottom

Mouse 

Mouse cover 

Mouse ball 

Rollers
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Cleaning the Floppy Disk Drive 

A read/write error may occur due to stains on the read/write head of the floppy disk drive. 

Use the cleaner dedicated for floppy disk drive to clean the read/write head.  It is recommended to 
clean the head on regular basis. 

 

Cleaning CD-ROM 

A dusty CD-ROM or dust-accumulated tray causes the device to fail to read data correctly. 

Follow the procedure below to clean the tray and CD-ROM regularly: 

1. Make sure that the server is powered (the POWER LED is lit). 

2. Press the Eject button on the front of the CD-ROM drive. 
The tray comes out. 

3. Hold the CD-ROM lightly and take it out from the tray. 

IMPORTANT: Do not touch the signal side of the CD-ROM with your 
hand. 

4. Wipe the tray with a dry soft cloth. 

IMPORTANT: Do not wipe the lens of the CD-ROM drive.  Doing so 
may damage the lens and may cause a malfunction of the drive. 

5. Gently push on the tray front to close the tray. 

6. Wipe the signal side of the CD-ROM with a dry soft cloth. 

IMPORTANT: Wipe CD-ROMs from the center to the outside.  Use 
only CD-ROM cleaner if necessary.  Cleaning a CD-ROM with record 
spray/cleaner, benzene, or thinner causes damage to the CD-ROM 
contents.  At worst, inserting the CD-ROM into the server may cause 
failure. 
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Cleaning Tape Drive 

Dirt on the tape head may be a cause of unsuccessful backup and damage to tape cartridge.  Clean 
the tape head regularly using a cleaning tape.  For procedure and interval of cleaning as well as 
lifetime of a tape cartridge to use, see instructions included with the tape drive. 
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SYSTEM DIAGNOSTICS 
The System Diagnostics runs several tests on the server. 

Select [Tool] → [System Diagnostics] in the NEC EXPRESSBUILDER to diagnose the server. 

 

Test Items 

The following items are tested in system diagnostics. 

� Memory 

� CPU cache memory 

� Hard disk used as a system 

IMPORTANT: When executing the system diagnostics, make sure to 
remove the LAN cable.  Executing the system diagnostics with the 
LAN cable connected, the network may be influenced. 

 

NOTE: On checking the hard disk, no data is written into the disk. 

Startup and Exit of System Diagnosis 

Procedures to start the diagnostic program is as follows: 

1. Shutdown the OS, and power off the server.  Then, unplug the power cord. 

2. Disconnect all the LAN cables from the server. 

3. Plug the power cord and power on the server. 

4. Use the NEC EXPRESSBUILDER CD-ROM to reboot the server. 

The following menu appears when the server is started using the NEC 
EXPRESSBUILDER.   
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5. Select [Tool]. 

6. Select [System Diagnostics]. 

Thesystem diagnosus starts and will be 
completed in approximately three minutes. 
 
 
 
 
When the diagnosis is completed, the 
following appears on the screen of the 
display unit. 

 

 

 

 

 
 

System bar: Shows information including time of progress during the diagnostics.  
Upon completion of the diagnostics, and descriptions on key operations to 
navigate the windoware shown. 

Title bar: Shows items for diagnosis.  If an error is detected, the bar is indicated in 
red. 

Test window: Shows the progress or result of diagnostics. 

Target scope: A cursor to select the test window.  Use the cursor keys on the keyboard to 
move it to another test window.  (Move the target scope to a desired 
window and press Enter.  Now you can view detailed information on the 
selected window.  To return to the previous window, press Enter once 
again.) 

If an error is detected during the system diagnostics, the title bar turns in red, and error 
information is displayed in red characters.  Note down the error message and contact 
your sales agent. 

7. Press Q and select [Reboot] from the menu. 

The server restarts and the system is started from the NEC EXPRESSBUILDER. 

8. Exit the NEC EXPRESSBUILDER, and remove the CD-ROM from the CD-ROM drive. 

9. Power off the server and unplug the power cord from the receptacle. 

10. Reconnect all the LAN cables to the server. 

11. Plug the power cord. 

This completes the system diagnostics. 

CURSOR: Select Window   ENTER: View Window    P: Log Out    Q: Quit

Target scope

Test window

System bar Title bar
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OFF-LINE MAINTENANCE UTILITY 
The Off-line Maintenance Utility is an OS-independent maintenance program.  When you are 
unable to start the OS-dependent NEC ESMPRO to troubleshoot a problem, the Off-line 
Maintenance Utility can be used. 

IMPORTANT:  
� The Off-line Maintenance Utility is intended for use of your sales 

agent.  The NEC EXPRESSBUILDER CD-ROM and the Off-line 
Maintenance Utility Bootable FD you have created contain a file 
that describes operation of the utility, but do not attempt to use the 
utility by yourself.  Contact your sales agent and follow 
instructions. 

� Starting the Off-line Maintenance Utility disables any access from a 
client to the server. 

Starting the Off-line Maintenance Utility 

The Off-line Maintenance Utility may be started in the following two ways. 

NEC Express5800/ft series does not support the feature to start the Off-line Maintenance Utility 
from the maintenance partition. 

� From the CD-ROM 

Select [Tools] → [Off-line Maintenance Utility] to start the Off-line Maintenance Utility 
from the CD-ROM. 

� From the floppy disk 

Set the Off-line Maintenance Utility Bootable FD in the floppy disk drive and reboot the 
system.  The Off-line Maintenance Utility program starts from the boot disk.  The 
Off-line Maintenance Utility Bootable FD is created by selecting [Tools] → [Create 
Support FD] on the NEC EXPRESSBUILDER top menu. 

 

Features of Off-line Maintenance Utility 

The Off-line Maintenance Utility provides the following features.  

� IPMI Information Viewer 

Provides the functions to view the system event log (SEL), sensor data record (SDR), and 
field replaceable unit (FRU) in IPMI (Intelligent Platform Management Interface) and to 
make a backup copy of them. 

Using this feature, you can find system errors and events to determine which part should 
be replaced. 

� BIOS Setup Viewer 

Provides the functions to view the current configuration data defined with the SETUP 
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utility and export it to a text file. 

� System Information Viewer 

Provides the functions to view information on the processor and the BIOS and export it to 
a text file. 

� System Information Management 

Provides the function to make a back-up copy of your data.  Without the backup data, the 
system-specific information and/or configuration may not be restored. 

NOTE: For information on making backup copy of system information, 
see Chapter 3.  Only the authorized personnel is allowed to restore the 
backup data. 
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NOTES ON CONNECTION WITH FIBRE CHANNEL DISK 
ARRAY 

When connecting with Fibre Channel disk array unit  
(ST12000 or NEC iStorage) 

� The device manager may display the name of logical drives on Fibre Channel Disk Array 
in two ways. However, there will be no difference in operation in both the cases. 

� ST12000 

"Stratus Dual Initiated Mylex DACARMRB xxxx SCSI Disk Device"  
(xxxx: arbitrary alphanumeric) 

"Mylex RAID Disk Device" 

� NEC iStorage 

"Stratus Dual Initiated NEC iStorage xxxx SCSI Disk Device"  
(xxxx: numeric such as 1000 or 2000 for device identification) 

"Disk Drive" 

� Disk access at occurrence of primary FC fault 

If a fault occurs in any of the FC boards and cables on the primary PCI module at system 
boot, it is not possible to access the FC-connected disk before the secondary PCI module 
is booted. It takes a rather long time to boot the secondary PCI module. This may cause 
unsuccessful start up of applications and/or services installed in the FC-connected disk. If 
such cases, start the applications and/or services again after the secondary PCI module is 
booted. 

� No recognition of added disk 

If the added disk does not appear on the VERITAS Volume Manager console, run 
“Action/Rescan.” If the disk status is other than online after the execution of 
“Action/Rescan,”, take the proper measures depending on the status by referring to 
"Troubleshooting" and "Using Disk and Volume Status Information" in the VERITAS 
Volume Manager manual. 

� Output of alert message during rescanning 

If the disk configuration is changed and the disks are rescanned, an alert message "pnp 
provider reported physical disk \Device\Harddiskx was removed or temporarily 
unavailable." may appear. The VERITAS Volume Manager always retains the 
configuration of the running disk. If the disk configuration at the rescanning is different 
from the saved disk configuration, the above message may appear. In such cases, perform 
the rescanning again. If the disk status is other than online after the execution of the 
rescanning, take the proper measures depending on the status by referring to 
"Troubleshooting" and "Using and Volume Status Information" in the VERITAS Volume 
Manager manual. 
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When connecting with Fibre Channel disk array unit ST12000 

� If all logical drives on ST12000 are removed, always run [Administration] → [Scan 
Devices] on the SAN Array Manager Client. If a popup message "Error returned by the 
server. Error code: 0xd001." appears after device scanning, perform the device scanning 
again. Do not run scanning for hardware changes from the device manager if no logical 
drives are created on ST12000. 

� Display of unreadable disk 

If no logical drives are created on ST12000, an unreadable disk may appear on the 
Volume Manager. However, this does not cause any trouble for the system operation. In 
addition, if logical drives are created in this status, a popup message "Unsafe Removal of 
Device" and an alert message in the Volume Manager "pnp provider reported physical 
disk \Device\Harddiskx was removed or temporarily unavailable." may appear. This does 
not also cause any trouble for the system operation. 

� Update for NEC ESMPRO Agent 

NEC ESMPRO Agent does not manage a fibre channel disk array.  Therefore, you need 
not run the update for NEC ESMPRO included in CD-ROM bundled with the fibre 
channel disk array. 
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RELOCATING/STORING THE NEC Express5800/ft series 
Follow the procedure below to relocate or store the server.  (Users should not attempt to remove 
the rack-mountable server from the rack assembly.) 

WARNING  
  

Do not attempt to remove the server. 
 

 

 

To avoid the risk of personal injury, users should not attempt to remove the 
server from the rack assembly.  Removal of the server from the rack assembly 
should be performed by suitably trained maintenance personnel. 

  
 

CAUTION  
  

Observe the following instructions to use the server safely.  Failure to follow 
these instructions may cause a fire, personal injury, or property damage.  See 
safety precautions in Chapter 1 for details. 
  • Never attempt to lift the server only by yourself. 
• Do not install the server in any place other than specified. 
• Do not connect/disconnect any interface cable with the power cord of the 

server plugged to a power source. 
  

 

IMPORTANT:  
� If the server needs to be relocated/stored due to a change in the floor 

layout to a great extent, contact the sales agent. 
� Make sure to make a backup copy of your valuable data in the hard 

disk, if any. 
� When moving the server with hard disks, make sure not to give a 

shock to the hard disks . 

1. Take a floppy disk and a CD-ROM out of the server, if any. 

2. Power off the server (the POWER LED goes off). 

3. Unplug the power cord of the server from a power outlet. 

4. Remove all the cables from the server. 

5. Remove the server from the rack cabinet. 

6. Hold the server by its bottom with at least four persons to carry the server. 

IMPORTANT: Do not hold the front bezel to lift the server.  The 
front bezel may get detached and fall off from the server, causing 
damage to the server. 

7. Protect the server with the shock-absorbing materials, and pack it securely. 
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Chapter 7 

Troubleshooting 

If the product does not work properly, see this chapter before deciding that it is a breakdown. 
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TO LOCATE THE ERRORS 
Use NEC ESMPRO to Monitor the occurrence of fault during the system operation. 

Especially take note on whether any alert is reported to NEC ESMPRO Manager on the language 
PC.  Check whether any alert is reported on the Joint Viewer, Data Viewer, or Alert Viewer of NEC 
ESMPRO Manager. 

[Example] 
 

NEC ESMPRO Manager

 
Determine type and location of
server/workstation trouble. 
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ERROR MESSAGES 
If the NEC Express5800/ft series enters the abnormal state, the error is posted by various means.  
This section explains the types of error messages. 

 

Error Messages by LED Indication 

The LEDs on the front and rear panels of the NEC Express5800/ft series and near the handles of 
hard disks inform the user of the various server statuses by the colors and the patterns of going on, 
going off, and flashing.  If trouble seems to have occurred, check the LED indication.  For the 
LED indication and meanings, see Chapter 2. 

 

Error Messages on the Liquid Crystal Display (LCD) 

The LCD on the front panel of the NEC Express5800/ft series displays the NEC Express5800/ft 
series status all the time.  If an error occurs, the LCD displays the error message. 

The following tables show the messages that are to be displayed on the LCD, and explain the 
meanings and procedures: 

IMPORTANT: Although NEC Express5800/320Lb(-R) does not have 
an LCD on its front, you can check error messages from MWA or NEC 
ESMPRO Manager as follows: 

� MWA: On a desired server, select [Start BMC dialog] from the 
Server menu.  BMC dialog box will show the LCD status as well 
as server power status and LED status. 

� NEC ESMPRO Manager: On Joint Viewer, select a desired server 
and start Data Viewer.  You can check the messages on Data 
Viewer. 
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STATUS LEDIndication Color State
Suspected 

module Explanation Procedure 

= A == A == A == A =         
AmbientTempAlm
00 

Amber Blink CPU module Temperature alarm (lower 
limit) 

AmbientTempAlm
02 

Amber Lit CPU module Fatal temperature alarm 
(lower limit) 

AmbientTempAlm
07 

Amber Blink CPU module Temperature alarm (upper 
limit) 

AmbientTempAlm
09 

Amber Lit CPU module Fatal temperature alarm 
(upper limit) 

Contact your sales 
agent. 

= B == B == B == B =         
BMC Unsync - - PCI module #1 The BMC cannot be 

synchronized. 
Contact your sales 
agent. 

BMC0 Not Ready Green Blink PCI module #1 
BMC1 Not Ready Green Blink PCI module #2 

PCI module’s BMC is 
disconnected 

If disconnection 
continues for a while, 
contact your sales 
agent. 

= C == C == C == C =         
Cor0 +12vAlm 00 Amber Blink PCI module #1 12-V power voltage alarm 

(lower limit) 
Cor0 +12vAlm 02 Amber Lit PCI module #1 Fatal 12-V power voltage 

alarm (lower limit) 
Cor0 +12vAlm 07 Amber Blink PCI module #1 12-V power voltage alarm 

(upper limit) 
Cor0 +12vAlm 09 Amber Lit PCI module #1 Fatal 12-V power voltage 

alarm (upper limit) 
Cor0 +2.5vAlm 
00 

Amber Blink PCI module #1 2.5-V power voltage alarm 
(lower limit) 

Cor0 +2.5vAlm 
02 

Amber Lit PCI module #1 Fatal 2.5-V power voltage 
alarm (lower limit) 

Cor0 +2.5vAlm 
07 

Amber Blink PCI module #1 2.5-V power voltage alarm 
(upper limit) 

Cor0 +2.5vAlm 
09 

Amber Lit PCI module #1 Fatal 2.5-V power voltage 
alarm (upper limit) 

Contact your sales 
agent. 
 
 

Cor0 +3.3vAlm 
00 

Amber Blink PCI module #1 3.3-V power voltage alarm 
(lower limit) 

Cor0 +3.3vAlm 
02 

Amber Lit PCI module #1 Fatal 3.3-V power voltage 
alarm (lower limit) 

Cor0 +3.3vAlm 
07 

Amber Blink PCI module #1 3.3-V power voltage alarm 
(upper limit) 

Cor0 +3.3vAlm 
09 

Amber Lit PCI module #1 Fatal 3.3-V power voltage 
alarm (upper limit) 

 

Cor0 +3.3vsAlm 
00 

Amber Blink PCI module #1 3.3-V power voltage alarm 
(lower limit) 

Cor0 +3.3vsAlm 
02 

Amber Lit PCI module #1 Fatal 3.3-V power voltage 
alarm (lower limit) 

Cor0 +3.3vsAlm 
07 

Amber Blink PCI module #1 3.3-V power voltage alarm 
(upper limit) 

Cor0 +3.3vsAlm 
09 

Amber Lit PCI module #1 Fatal 3.3-V power voltage 
alarm (upper limit) 

 

Cor0 +5.0vAlm 
00 

Amber Blink PCI module #1 5-V power voltage alarm 
(lower limit) 

Cor0 +5.0vAlm 
02 

Amber Lit PCI module #1 Fatal 5-V power voltage alarm 
(lower limit) 

Cor0 +5.0vAlm 
07 

Amber Blink PCI module #1 5-V power voltage alarm 
(upper limit) 

Contact your sales 
agent. 
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Indication STATUS LED Suspected 
module Explanation Procedure 

Cor0 +5.0vAlm 
09 

Amber Lit PCI module #1 Fatal 5-V power voltage alarm 
(upper limit) 

Cor0 +5.0vsAlm 
00 

Amber Blink PCI module #1 5-V power voltage alarm 
(lower limit) 

Cor0 +5.0vsAlm 
02 

Amber Lit  PCI module #1 Fatal 5-V power voltage alarm 
(lower limit) 

Cor0 +5.0vsAlm 
07 

Amber Blink PCI module #1 5-V power voltage alarm 
(upper limit) 

Cor0 +5.0vsAlm 
09 

Amber Lit PCI module #1 Fatal 5-V power voltage alarm 
(upper limit) 

Cor0 -12vAlm 00 Amber Blink PCI module #1 -12-V power voltage alarm 
(lower limit) 

Cor0 -12vAlm 02 Amber Lit PCI module #1 Fatal -12-V power voltage 
alarm (lower limit) 

Cor0 -12vAlm 07 Amber Blink PCI module #1 -12-V power voltage alarm 
(upper limit) 

Contact your sales 
agent. 
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STATUS LEDIndication Color State
Suspected 

module Explanation Procedure 

Cor0 -12vAlm 09 Amber Lit PCI module #1 Fatal -12-V power voltage 
alarm (upper limit) 

Cor0 Bus PERR 01 Green Blink PCI module #1 PCI bus parity error 
Cor0 Bus SERR 01 Green Blink PCI module #1 Fatal PCI bus error 
Cor0 CLK Alm 00 Amber Blink CLOCK board Clock alarm (lower limit) 
Cor0 CLK Alm 02 Amber Lit CLOCK board Fatal Clock alarm (lower 

limit) 
Cor0 CLK Alm 07 Amber Blink CLOCK board Clock alarm (upper limit) 
Cor0 CLK Alm 09 Amber Lit CLOCK board Fatal Clock alarm (upper 

limit) 

Contact your sales 
agent. 
 

Cor0 FAN Alm 01 Amber Blink PCI module #1 Cooling fan1 alarm 
Cor0 FAN Alm 02 Amber Blink PCI module #1 Cooling fan2 alarm 
Cor0 FAN Alm 03 Amber Blink PCI module #1 Cooling fan3 alarm 
Cor0 FAN Alm 04 Amber Blink PCI module #1 Cooling fan4 alarm 
Cor0 FAN Alm 05 Amber Blink PCI module #1 Cooling fan5 alarm 

Check to see if dust is 
accumulated on the 
internal fans. Check also 
if the fan cables are 
connected securely.  If 
not solved by the above, 
contact your sales 
agent.  

Cor0 offline Green Blink PCI module #1 PCI module logically isolated Start the PCI module by 
ft sever utility or 
dismount and remount 
that module.  If not 
solved by the above, 
contact your sales 
agent. 

Cor0 removed Green Blink PCI module #1 PCI module detached Dismount and remount 
the PCI module.  If not 
solved by the above, 
contact your sales 
agent. 

Cor0 Temp Alm 00 Amber Blink PCI module #1 Temperature alarm (lower 
limit) 

Cor0 Temp Alm 02 Amber Lit PCI module #1 Fatal temperature alarm 
(lower limit) 

Cor0 Temp Alm 07 Amber Blink PCI module #1 Temperature alarm (upper 
limit) 

Cor0 Temp Alm 09 Amber Lit PCI module #1 Fatal temperature alarm 
(upper limit) 

Check to see if dust is 
accumulated on the 
internal fans. Check also 
if the fan cables are 
connected securely.  If 
not solved by the above, 
contact your sales 
agent. 

Cor1 +12vAlm 00 Amber Blink PCI module #2 12-V power voltage alarm 
(lower limit) 

Cor1 +12vAlm 02 Amber Lit PCI module #2 Fatal 12-V power voltage 
alarm (lower limit) 

Cor1 +12vAlm 07 Amber Blink PCI module #2 12-V power voltage alarm 
(upper limit) 

Cor1 +12vAlm 09 Amber Lit PCI module #2 Fatal 12-V power voltage 
alarm (upper limit) 

Cor1 +2.5vAlm 
00 

Amber Blink PCI module #2 2.5-V power voltage alarm 
(lower limit) 

Cor1 +2.5vAlm 
02 

Amber Lit PCI module #2 Fatal 2.5-V power voltage 
alarm (lower limit) 

Cor1 +2.5vAlm 
07 

Amber Blink PCI module #2 2.5-V power voltage alarm 
(upper limit) 

Cor1 +2.5vAlm 
09 

Amber Lit PCI module #2 Fatal 2.5-V power voltage 
alarm (upper limit) 

Cor1 +3.3vAlm 
00 

Amber Blink PCI module #2 3.3-V power voltage alarm 
(lower limit) 

Contact your sales 
agent. 
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STATUS LED Indication Color State 
Suspected 

module Explanation Procedure 

Cor1 +3.3vAlm 
02 

Amber Lit PCI module #2 Fatal 3.3-V power voltage 
alarm (lower limit) 

Cor1 +3.3vAlm 
07 

Amber Blink PCI module #2 3.3-V power voltage alarm 
(upper limit) 

Cor1 +3.3vAlm 
09 

Amber Lit PCI module #2 Fatal 3.3-V power voltage 
alarm (upper limit) 

Cor1 +3.3vsAlm 
00 

Amber Blink PCI module #2 3.3-V power voltage alarm 
(lower limit) 

Cor1 +3.3vsAlm 
02 

Amber Lit PCI module #2 Fatal 3.3-V power voltage 
alarm (lower limit) 

Cor1 +3.3vsAlm 
07 

Amber Blink PCI module #2 3.3-V power voltage alarm 
(upper limit) 

Cor1 +3.3vsAlm 
09 

Amber Lit PCI module #2 Fatal 3.3-V power voltage 
alarm (upper limit) 

Cor1 +5.0vAlm 
00 

Amber Blink PCI module #2 5-V power voltage alarm 
(lower limit) 

Cor1 +5.0vAlm 
02 

Amber Lit PCI module #2 Fatal 5-V power voltage alarm 
(lower limit) 

Cor1 +5.0vAlm 
07 

Amber Blink PCI module #2 5-V power voltage alarm 
(upper limit) 

Cor1 +5.0vAlm 
09 

Amber Lit PCI module #2 Fatal 5-V power voltage alarm 
(upper limit) 

Cor1 +5.0vsAlm 
00 

Amber Blink PCI module #2 5-V power voltage alarm 
(lower limit) 

Cor1 +5.0vsAlm 
02 

Amber
 

Lit PCI module #2 
 

Fatal 5-V power voltage alarm 
(lower limit) 

Cor1 +5.0vsAlm 
07 

Amber Blink PCI module #2 5-V power voltage alarm 
(upper limit) 

Cor1 +5.0vsAlm 
09 

Amber Lit PCI module #2 Fatal 5-V power voltage alarm 
(upper limit) 

Cor1 -12vAlm 00 Amber Blink PCI module #2 -12-V power voltage alarm 
(lower limit) 

Cor1 -12vAlm 02 Amber Lit PCI module #2 Fatal -12-V power voltage 
alarm (lower limit) 

Cor1 -12vAlm 07 Amber Blink PCI module #2 -12-V power voltage alarm 
(upper limit) 

Cor1 -12vAlm 09 Amber Lit PCI module #2 Fatal -12-V power voltage 
alarm (upper limit) 

Cor1 Bus PERR 01 Green Blink PCI module #2 PCI bus parity error 
Cor1 Bus SERR 01 Green Blink PCI module #2 Fatal PCI bus error 
Cor1 CLK Alm 00 Amber Blink CLOCK board Clock alarm (lower limit) 
Cor1 CLK Alm 02 Amber Lit CLOCK board Fatal Clock alarm (lower 

limit) 
Cor1 CLK Alm 07 Amber Blink CLOCK board Clock alarm (upper limit) 
Cor1 CLK Alm 09 Amber Lit CLOCK board Fatal Clock alarm (upper 

limit) 

Contact your sales 
agent. 
 

Cor1 FAN Alm 01 Amber Blink PCI module #2 Cooling fan1 alarm 
Cor1 FAN Alm 02 Amber Blink PCI module #2 Cooling fan2 alarm 
Cor1 FAN Alm 03 Amber Blink PCI module #2 Cooling fan3 alarm 
Cor1 FAN Alm 04 Amber Blink PCI module #2 Cooling fan4 alarm 
Cor1 FAN Alm 05 Amber Blink PCI module #2 Cooling fan5 alarm 

Check to see if dust is 
accumulated on the 
internal fans. Check also 
if the fan cables are 
connected securely.  If 
not solved by the above, 
contact your sales 
agent. 
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STATUS LEDIndication Color State
Suspected 

module Explanation Procedure 

Cor1 offline Green Blink PCI module #2 PCI module logically isolated Start the PCI module by 
ft sever utility or 
dismount and remount 
that module.  If not 
solved by the above, 
contact your sales 
agent. 

Cor1 removed Green Blink PCI module #2 PCI module detached Dismount and remount 
the PCI module.  If not 
solved by the above, 
contact your sales 
agent. 

Cor1 Temp Alm 00 Amber Blink PCI module #2 Temperature alarm (lower 
limit) 

Cor1 Temp Alm 02 Amber Lit PCI module #2 Fatal temperature alarm 
(lower limit) 

Cor1 Temp Alm 07 Amber Blink PCI module #2 Temperature alarm (upper 
limit) 

Cor1 Temp Alm 09 Amber Lit PCI module #2 Fatal temperature alarm 
(upper limit) 

Check to see if dust is 
accumulated on the 
internal fans. Check also 
if the fan cables are 
connected securely.  If 
not solved by the above, 
contact your sales 
agent. 

CPU IERR 00 Green Blink CPU module #1 CPU#1 internal error 
CPU IERR 01 Green Blink CPU module #1 CPU#2 internal error 
CPU IERR 20 Green Blink CPU module #2 CPU#1 internal error 
CPU IERR 21 Green Blink CPU module #2 CPU#2 internal error 
CPU T-Trip 00 Green Blink CPU module #1 CPU#1 thermal change error 

(upper limit) 
CPU T-Trip 01 Green Blink CPU module #1 CPU#2 thermal change error 

(upper limit) 
CPU T-Trip 20 Green Blink CPU module #2 CPU#1 thermal change error 

(upper limit) 
CPU T-Trip 21 Green Blink CPU module #2 CPU#2 thermal change error 

(upper limit) 
CPU0 +12ss Alm 
00 

Amber Blink CPU module #1 +12-V power voltage alarm 
(lower limit) 

CPU0 +12ss Alm 
02 

Amber Lit CPU module #1 Fatal +12-V power voltage 
alarm (lower limit) 

CPU0 +12ss Alm 
07 

Amber Blink CPU module #1 +12-V power voltage alarm 
(upper limit) 

CPU0 +12ss Alm 
09 

Amber Lit CPU module #1 Fatal +12-V power voltage 
alarm (upper limit) 

CPU0 +12v Alm 00 Amber Blink CPU module #1 12-V power voltage alarm 
(lower limit) 

CPU0 +12v Alm 02 Amber Lit CPU module #1 Fatal 12-V power voltage 
alarm (lower limit) 

CPU0 +12v Alm 07 Amber Blink CPU module #1 12-V power voltage alarm 
(upper limit) 

CPU0 +12v Alm 09 Amber Lit CPU module #1 Fatal 12-V power voltage 
alarm (upper limit) 

CPU0 +1.5v Alm 
00 

Amber Blink CPU module #1 1.5-V power voltage alarm 
(lower limit) 

CPU0 +1.5v Alm 
02 

Amber Lit CPU module #1 Fatal 1.5-V power voltage 
alarm (lower limit) 

Contact your sales 
agent. 
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STATUS LED Indication Color State 
Suspected 

module Explanation Procedure 

CPU0 +1.5v Alm 
07 

Amber Blink CPU module #1 1.5-V power voltage alarm 
(upper limit) 

CPU0 +1.5v Alm 
09 

Amber Lit CPU module #1 Fatal 1.5-V power voltage 
alarm (upper limit) 

CPU0 +2.5vAlm 
00 

Amber Blink CPU module #1 2.5-V power voltage alarm 
(lower limit) 

CPU0 +2.5vAlm 
02 

Amber Lit CPU module #1 Fatal 2.5-V power voltage 
alarm (lower limit) 

CPU0 +2.5vAlm 
07 

Amber Blink CPU module #1 2.5-V power voltage alarm 
(upper limit) 

CPU0 +2.5vAlm 
09 

Amber Lit CPU module #1 Fatal 2.5-V power voltage 
alarm (upper limit) 

CPU0 +2.5VcAlm 
00 

Amber Blink CPU module #1 2.5-V power voltage alarm 
(lower limit) 

CPU0 +2.5VcAlm 
02 

Amber Lit CPU module #1 Fatal 2.5-V power voltage 
alarm (lower limit) 

CPU0 +2.5VcAlm 
07 

Amber Blink CPU module #1 2.5-V power voltage alarm 
(upper limit) 

CPU0 +2.5VcAlm 
09 

Amber Lit CPU module #1 Fatal 2.5-V power voltage 
alarm (upper limit) 

CPU0 +3.3vAlm 
00 

Amber Blink CPU module #1 3.3-V power voltage alarm 
(lower limit) 

CPU0 +3.3vAlm 
02 

Amber Lit CPU module #1 Fatal 3.3-V power voltage 
alarm (lower limit) 

CPU0 +3.3vAlm 
07 

Amber Blink CPU module #1 3.3-V power voltage alarm 
(upper limit) 

CPU0 +3.3vAlm 
09 

Amber Lit CPU module #1 Fatal 3.3-V power voltage 
alarm (upper limit) 

CPU0 +3.3vsAlm 
00 

Amber Blink CPU module #1 3.3-V power voltage alarm 
(lower limit) 

CPU0 +3.3vsAlm 
02 

Amber Lit CPU module #1 3.3-V power voltage alarm 
(lower limit) 

CPU0 +3.3vsAlm 
07 

Amber Blink  CPU module #1 Fatal 3.3-V power voltage 
alarm (upper limit) 

CPU0 +3.3vsAlm 
09 

Amber Lit CPU module #1 Fatal 3.3-V power voltage 
alarm (upper limit) 

CPU0 +5.0vAlm 
00 

Amber Blink CPU module #1 5-V power voltage alarm 
(lower limit) 

CPU0 +5.0vAlm 
02 

Amber Lit CPU module #1 Fatal 5-V power voltage alarm 
(lower limit) 

CPU0 +5.0vAlm 
07 

Amber Blink CPU module #1 5-V power voltage alarm 
(upper limit) 

CPU0 +5.0vAlm 
09 

Amber Lit CPU module #1 Fatal 5-V power voltage alarm 
(upper limit) 

CPU0 +5.0vsAlm 
00 

Amber Blink CPU module #1 5-V power voltage alarm 
(lower limit) 

CPU0 +5.0vsAlm 
02 

Amber Lit CPU module #1 Fatal 5-V power voltage alarm 
(lower limit) 

CPU0 +5.0vsAlm 
07 

Amber Blink CPU module #1 5-V power voltage alarm 
(upper limit) 

CPU0 +5.0vsAlm 
09 

Amber Lit CPU module #1 Fatal 5-V power voltage alarm 
(upper limit) 

CPU0 broken Green Blink CPU module #1 CPU module breakdown 

Contact your sales 
agent. 
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STATUS LEDIndication Color State
Suspected 

module Explanation Procedure 

CPU0 FAN Alm 01 Amber Blink CPU module #1 Cooling fan1 alarm 

CPU0 FAN Alm 03 Amber Blink CPU module #1 Cooling fan2 alarm 

CPU0 FAN Alm 04 Amber Blink CPU module #1 Cooling fan3 alarm 

Check to see if dust is 
accumulated on the 
internal fans. Check also if 
the fan cables are 
connected securely.  If 
not solved by the above, 
contact your sales agent. 

CPU0 offline Green Blink CPU module #1 PCI module logically isolated Start the PCI module by ft 
sever utility or dismount 
and remount that module.  
If not solved by the above, 
contact your sales agent. 

CPU0 removed Green Blink CPU module #1 PCI module detached Dismount and remount the 
PCI module.  If not 
solved by the above, 
contact your sales agent. 

CPU0 Temp Alm 00 Amber Blink CPU module #1 Temperature alarm (lower limit)
CPU0 Temp Alm 02 Amber Lit CPU module #1 Fatal temperature alarm (lower 

limit) 
CPU0 Temp Alm 07 Amber Blink CPU module #1 Temperature alarm (upper limit)
CPU0 Temp Alm 09 Amber Lit CPU module #1 Fatal temperature alarm (upper 

limit) 

Check to see if dust is 
accumulated on the 
internal fans. Check also if 
the fan cables are 
connected securely.  If 
not solved by the above, 
contact your sales agent. 

CPU0 VccpAlm 00 Amber Blink CPU module #1 CPU operating voltage alarm 
(lower limit) (VCCP) 

CPU0 VccpAlm 02 Amber Lit CPU module #1 Fatal CPU operating voltage 
alarm (lower limit) (VCCP) 

CPU0 VccpAlm 07 Amber Blink CPU module #1 CPU operating voltage alarm 
(upper limit) (VCCP) 

CPU0 VccpAlm 09 Amber Lit CPU module #1 Fatal CPU operating voltage 
alarm (upper limit) (VCCP) 

CPU0 Vtt Alm 00 Amber Blink CPU module #1 1.25-V power voltage alarm 
(lower limit) 

CPU0 Vtt Alm 02 Amber Lit CPU module #1 Fatal 1.25-V power voltage 
alarm (lower limit) 

CPU0 Vtt Alm 07 Amber Blink CPU module #1 1.25-V power voltage alarm 
(upper limit) 

CPU0 Vtt Alm 09 Amber Lit CPU module #1 Fatal 1.25-V power voltage 
alarm (upper limit) 

Contact your sales agent. 
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STATUS LED Indication Color State 
Suspected 

module Explanation Procedure 

CPU00 Temp Alm 
00 

Amber Blink CPU module #1 CPU#1 temperature alarm 
(lower limit) 

CPU00 Temp Alm 
02 

Amber Lit CPU module #1 CPU#1fatal temperature alarm 
(lower limit) 

CPU00 Temp Alm 
07 

Amber Blink CPU module #1 CPU#1temperature alarm 
(upper limit) 

CPU00 Temp Alm 
09 

Amber Lit CPU module #1 CPU#1 fatal temperature 
alarm (upper limit) 

CPU01 Temp Alm 
00 

Amber Blink CPU module #1 CPU#2 temperature alarm 
(lower limit) 

CPU01 Temp Alm 
02 

Amber Lit CPU module #1 CPU#2 fatal temperature 
alarm (lower limit) 

CPU01 Temp Alm 
07 

Amber Blink CPU module #1 CPU#2 temperature alarm 
(upper limit) 

CPU01 Temp Alm 
09 

Amber Lit CPU module #1 CPU#2 fatal temperature 
alarm (upper limit) 

Check to see if dust is 
accumulated on the 
internal fans. Check also 
if the fan cables are 
connected securely.  If 
not solved by the above, 
contact your sales 
agent. 

CPU2 +12ss Alm 
00 

Amber
 

Blink 
 

CPU module #2 12-V power voltage alarm 
(lower limit) 

Contact your sales 
agent. 

CPU2 +12ss Alm 
02 

Amber Lit CPU module #2 Fatal 12-V power voltage 
alarm (lower limit) 

CPU2 +12ss Alm 
07 

Amber Blink CPU module #2 12-V power voltage alarm 
(upper limit) 

CPU2 +12ss Alm 
09 

Amber Lit CPU module #2 Fatal 12-V power voltage 
alarm (upper limit) 

CPU2 +12v Alm 00 Amber Blink CPU module #2 12-V power voltage alarm 
(lower limit) 

CPU2 +12v Alm 02 Amber Lit CPU module #2 Fatal 12-V power voltage 
alarm (lower limit) 

CPU2 +12v Alm 07 Amber Blink CPU module #2 12-V power voltage alarm 
(upper limit) 

CPU2 +12v Alm 09 Amber Lit CPU module #2 Fatal 12-V power voltage 
alarm (upper limit) 

CPU2 +1.5vAlm 
00 

Amber Blink CPU module #2 1.5-V power voltage alarm 
(lower limit) 

CPU2 +1.5vAlm 
02 

Amber Lit CPU module #2 Fatal 1.5-V power voltage 
alarm (lower limit) 

CPU2 +1.5vAlm 
07 

Amber Blink CPU module #2 1.5-V power voltage alarm 
(upper limit) 

CPU2 +1.5vAlm 
09 

Amber Lit CPU module #2 Fatal 1.5-V power voltage 
alarm (upper limit) 

Contact your sales 
agent. 

CPU2 +2.5vAlm 
00 

Amber Blink CPU module #2 2.5-V power voltage alarm 
(lower limit) 

CPU2 +2.5vAlm 
02 

Amber Lit CPU module #2 Fatal 2.5-V power voltage 
alarm (lower limit) 

CPU2 +2.5vAlm 
07 

Amber Blink CPU module #2 2.5-V power voltage alarm 
(upper limit) 

CPU2 +2.5vAlm 
09 

Amber Lit CPU module #2 Fatal 2.5-V power voltage 
alarm (upper limit) 

Contact your sales 
agent. 
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STATUS LEDIndication Color State
Suspected 

module Explanation Procedure 

CPU2 +2.5VcAlm 
00 

Amber Blink CPU module #2 2.5-V power voltage alarm 
(lower limit) 

CPU2 +2.5VcAlm 
02 

Amber Lit CPU module #2 Fatal 2.5-V power voltage 
alarm (lower limit) 

CPU2 +2.5VcAlm 
07 

Amber Blink CPU module #2 2.5-V power voltage alarm 
(upper limit) 

CPU2 +2.5VcAlm 
09 

Amber Lit CPU module #2 Fatal 2.5-V power voltage 
alarm (upper limit) 

CPU2 +3.3vAlm 
00 

Amber Blink CPU module #2 3.3-V power voltage alarm 
(lower limit) 

CPU2 +3.3vAlm 
02 

Amber Lit CPU module #2 Fatal 3.3-V power voltage 
alarm (lower limit) 

CPU2 +3.3vAlm 
07 

Amber Blink CPU module #2 3.3-V power voltage alarm 
(upper limit) 

CPU2 +3.3vAlm 
09 

Amber Lit CPU module #2 Fatal 3.3-V power voltage 
alarm (upper limit) 

CPU2 +3.3vsAlm 
00 

Amber Blink CPU module #2 3.3-V power voltage alarm 
(lower limit) 

CPU2 +3.3vsAlm 
02 

Amber Lit CPU module #2 Fatal 3.3-V power voltage 
alarm (lower limit) 

CPU2 +3.3vsAlm 
07 

Amber Blink CPU module #2 3.3-V power voltage alarm 
(upper limit) 

CPU2 +3.3vsAlm 
09 

Amber Lit CPU module #2 Fatal 3.3-V power voltage 
alarm (upper limit) 

CPU2 +5.0vAlm 
00 

Amber Blink CPU module #2 5-V power voltage alarm 
(lower limit) 

CPU2 +5.0vAlm 
02 

Amber Lit CPU module #2 Fatal 5-V power voltage alarm 
(lower limit) 

CPU2 +5.0vAlm 
07 

Amber Blink CPU module #2 5-V power voltage alarm 
(upper limit) 

CPU2 +5.0vAlm 
09 

Amber Lit CPU module #2 Fatal 5-V power voltage alarm 
(upper limit) 

CPU2 
+5.0vsAlm00 

Amber Blink CPU module #2 5-V power voltage alarm 
(lower limit) 

CPU2 
+5.0vsAlm02 

Amber Lit CPU module #2 Fatal 5-V power voltage alarm 
(lower limit) 

CPU2 
+5.0vsAlm07 

Amber Blink CPU module #2 5-V power voltage alarm 
(upper limit) 

CPU2 
+5.0vsAlm09 

Amber Lit CPU module #2 Fatal 5-V power voltage alarm 
(upper limit) 

CPU2 broken Green Blink CPU module #2 CPU module breakdown 

Contact your sales 
agent. 

CPU2 FAN Alm 01 Amber Blink CPU module #2 Cooling fan 1 alarm 
CPU2 FAN Alm 03 Amber Blink CPU module #2 Cooling fan 2 alarm 
CPU2 FAN Alm 04 Amber Blink CPU module #2 Cooling fan 3 alarm 

Check to see if dust is 
accumulated on the 
internal fans. Check also 
if the fan cables are 
connected securely.  If 
not solved by the above, 
contact your sales 
agent. 
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STATUS LED Indication Color State 
Suspected 
module Explanation Procedure 

CPU2 offline Green Blink CPU module #2 The CPU module has been 
logically disconnected. 

Start the PCI module by 
ft sever utility or 
dismount and remount 
that module.  If not 
solved by the above, 
contact your sales 
agent. 

CPU2 removed Green Blink CPU module #2 The CPU module has come 
off. 

Dismount and remount 
the PCI module.  If not 
solved by the above, 
contact your sales 
agent. 

CPU2 Temp Alm 00 Amber Blink CPU module #2 Temperature alarm (lower 
limit) 

CPU2 Temp Alm 02 Amber Lit CPU module #2 Fatal temperature alarm 
(lower limit) 

CPU2 Temp Alm 07 Amber Blink CPU module #2 Temperature alarm (upper 
limit) 

CPU2 Temp Alm 09 Amber Lit CPU module #2 Fatal temperature alarm 
(upper limit) 
 

Check to see if dust is 
accumulated on the 
internal fans. Check also 
if the fan cables are 
connected securely.  If 
not solved by the above, 
contact your sales 
agent. 
 

CPU2 VccpAlm 00 Amber Blink CPU module #2 CPU operating voltage alarm 
(lower limit) (VCCP) 

CPU2 VccpAlm 02 Amber Lit CPU module #2 Fatal CPU operating voltage 
alarm (lower limit) (VCCP) 

CPU2 VccpAlm 07 Amber Blink CPU module #2 CPU operating voltage alarm 
(upper limit) (VCCP) 

CPU2 VccpAlm 09 Amber Lit CPU module #2 Fatal CPU operating voltage 
alarm (upper limit) (VCCP) 

CPU2 VttAlm 00 Amber Blink CPU module #2 1.25-V power voltage alarm 
(lower limit) 

CPU2 VttAlm 02 Amber Lit CPU module #2 Fatal 1.25-V power voltage 
alarm (lower limit) 

CPU2 VttAlm 07 Amber Blink CPU module #2 1.25-V power voltage alarm 
(upper limit) 

CPU2 VttAlm 09 Amber Lit CPU module #2 Fatal 1.25-V power voltage 
alarm (upper limit) 

Contact your sales 
agent.  

CPU20 TempAlm 
00 

Amber Blink CPU module #2 CPU#1 temperature alarm 
(lower limit) 

CPU20 TempAlm 
02 

Amber Lit CPU module #2 Fatal CPU#1 temperature 
alarm (lower limit) 

CPU20 TempAlm 
07 

Amber Blink CPU module #2 CPU#1 temperature alarm 
(upper limit) 

CPU20 TempAlm 
09 

Amber Lit CPU module #2 Fatal CPU#1 temperature 
alarm (upper limit) 

CPU21 TempAlm 
00 

Amber Blink CPU module #2 CPU#2 temperature alarm 
(lower limit) 

CPU21 TempAlm 
02 

Amber Lit CPU module #2 Fatal CPU#2 temperature 
alarm (lower limit) 

CPU21 TempAlm 
07 

Amber Blink CPU module #2 CPU#2 temperature alarm 
(upper limit) 

CPU21 TempAlm 
09 

Amber Lit CPU module #2 Fatal CPU#2 temperature 
alarm (upper limit) 

Check to see if dust is 
accumulated on the 
internal fans. Check also 
if the fan cables are 
connected securely.  If 
not solved by the above, 
contact your sales 
agent. 
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STATUS LEDIndication Color State
Suspected 

module Explanation Procedure 

= D == D == D == D =         
DUMP Request! Off  - DUMP switch request Contact your sales 

agent. 
= F == F == F == F =         
FRB Processing Off  - During POST execution or OS 

start processing 
The server is operating 
normally. 

= M == M == M == M =         
Memory U-Err 01 Green Blink CPU module #1 DIMM#1 2-bit error 
Memory U-Err 02 Green Blink CPU module #1 DIMM#2 2-bit error 
Memory U-Err 03 Green Blink CPU module #1 DIMM#3 2-bit error 
Memory U-Err 04 Green Blink CPU module #1 DIMM#4 2-bit error 
Memory U-Err 05 Green Blink CPU module #1 DIMM#5 2-bit error 
Memory U-Err 06 Green Blink CPU module #1 DIMM#6 2-bit error 
Memory U-Err 21 Green Blink CPU module #2 DIMM#1 2-bit error 
Memory U-Err 22 Green Blink CPU module #2 DIMM#2 2-bit error 
Memory U-Err 23 Green Blink CPU module #2 DIMM#3 2-bit error 
Memory U-Err 24 Green Blink CPU module #2 DIMM#4 2-bit error 
Memory U-Err 25 Green Blink CPU module #2 DIMM#5 2-bit error 
Memory U-Err 26 Green Blink CPU module #2 DIMM#6 2-bit error 
= O == O == O == O =         
OS shutdown Alm Off  - Shutdown due to a timeout 

error of the watch dog timer 
(fatal error) 

Contact your sales 
agent. 

= P == P == P == P =         
Power-off Off  - The DC power is turned off. - 
= S == S == S == S =         
SSR Processing Off  - Reboot processing for 

recovery 
DUMP is being 
collected. 

= W == W == W == W =         
WDT timeout Off  - Timeout error of the watch dog 

timer (fatal error) 
Contact your sales 
agent. 
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POST Error Messages 

Powering on the server automatically starts the self-diagnostic program, POST (Power On 
Self-Test).  When POST detects any error, it displays an error message and its measure on the 
display unit.  Follow the table below to troubleshoot such errors. 

Phoenix BIOS 4.0 Release 6.0.XXXX
:

CPU=Pentium III XXX MHz
0640K System RAM Passed
0127M Extended RAM Passed
WARNING:
02B0: Diskette drive A error.

:
press <F1> to resume, <F2> to SETUP

Message indicating a floppy disk drive error  
 

TIPS: For error messages on optional SCSI controller board and disk 
array controller, refer to the manual provided with those options. 

On-screen error message Cause Action 
0200 Failure Fixed Disk • Configuration error in Setup 

menu.  
• Hard disk is faulty. 
• CPU module board is faulty. 
• PCI module board is faulty. 

• Check configuration in Setup 
menu. 

• Replace the hard disk. 
• Replace the CPU module 

board.  
• Replace the PCI module 

board. 
0210 Stuck Key Keyboard connection error • Disconnect the keyboard 

and connect it back again. 
• Replace the keyboard. 
• Replace the PCI module 

board. 
0211 Keyboard error Keyboard is faulty. 
0212 Keyboard Controller 

Failed 
Keyboard controller is faulty. 

• Check the keyboard 
connection. 

• Restart the server. 
• Replace the PCI module 

board. 
0213 Keyboard locked - 

Unlock key switch 
Keyboard is locked. Unlock the key switch. 

0220 Monitor type does not 
match CMOS - Run 
SETUP 

Illegal monitor type is 
specified. 

• Select "Get Default Value" 
from the Setup menu. 

• Clear the CMOS data. 
0230 System RAM Failed at 

offset 
DIMM is faulty. • Replace DIMM. 

• Replace the CPU module 
board. 

0231 Shadow RAM Failed at 
offset 

DIMM is faulty. • Replace DIMM. 
• Replace the CPU module 

board. 
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On-screen error message Cause Action 
0232 Extend RAM Failed at 

address line 
DIMM is faulty. • Replace DIMM. 

• Replace the CPU module 
board. 

0233 Memory type mixing 
detected 

DIMMs of the different types 
are installed. 

Replace DIMM with 
appropriate one. 

0234 Single - bit ECC error DIMM is faulty. • Replace DIMM. 
• Replace the CPU module 

board. 
0235 Multiple - bit ECC error DIMM is faulty. • Replace DIMM. 

• Replace the CPU module 
board. 

0250 System battery is dead 
-Replace and run 
SETUP 

NvRAM battery is dead. Replace the CPU module 
board. 

0251 System CMOS 
checksum bad-Default 
configuration used 

NvRAM is faulty. • Re-configure using the 
Setup menu.  

• Replace the PCI module 
board. 

0252 Password checksum bad 
-Password cleared 

NvRAM is faulty. • Re-set the password in the 
Setup menu. 

• Replace the PCI module 
board. 

0260 System timer error CPU module board is faulty. Replace the CPU module 
board. 

0270 Real time clock error RTC is faulty. Replace the CPU module 
board. 

0271 Check date and time 
setting 

Date and time of RTC are 
incorrectly set. 

• Set the correct date and time 
in Setup menu. 

• Replace the PCI module 
board. 

0280 Previous boot incomplete 
-Default configuration 
used 

Configuration error in Setup 
menu. 

Check configuration in Setup 
menu. 

02B0 Diskette drive A error Floppy drive A is faulty. Replace the floppy disk drive 
A. 

02B2 Incorrect Drive A type - 
run SETUP 

Configuration error in Setup 
menu. 

Specify the correct drive type 
in Setup menu. 

02D0 System cache error - 
Cache disabled 

• CPU is faulty.  
• CPU module board is faulty. 

• Replace the CPU. 
• Replace the CPU module 

board. 
0B1B PCI System Error on 

Bus/Device/Function 
PCI device is faulty. 

0B1C PCI Parity Error on 
Bus/Device/Function 

PCI device is faulty. 

• Replace the PCI device 
board. 

• Re-install the PCI device 
board. 

• Re-configure the PCI board. 
0B22 CPUs are installed out of 

order 
CPU is faulty. Replace the CPU. 

0B28 Unsupported Processor 
detected on Processor 1

The processor (CPU) not 
supported by this server is 
installed in Processor 1. 

Install the CPU appropriate to 
the server. 



Troubleshooting  7-17 

On-screen error message Cause Action 
0B29 Unsupported Processor 

detected on Processor 2
The processor (CPU) not 
supported by this server is 
installed in Processor 2. 

Install the CPU appropriate to 
the server. 

0B30 CPU FAN #1 Alarm 
occurred 

0B31 CPU FAN #2 Alarm 
occurred 

• Dusts are clogged in fan. 
• Fan is faulty. 
• CPU module board is faulty. 

• Replace the fan. 
• Replace the CPU module 

board. 
• Connect fan cable properly. 

0B32 CPU FAN #3 Alarm 
occurred 

• Dusts are clogged in fan. 
• Fan is faulty. 
• PCI module board is faulty. 

• Replace the fan. 
• Replace the PCI module 

board. 
• Connect fan cable properly. 

0B40 Invalid System 
Configuration Data 

• Configuration error in 
SETUP. 

• CPU/PCI module board is 
faulty. 

 

• Reset the setting by 
selecting [Yes] at [Reset 
Configuration Data] 

• Replace the CPU/PCI 
module board. 

0B41 System Configuration 
Data Read error 

• Configuration error in 
SETUP. 

• CPU/PCI module board is 
faulty. 

• Reset the setting by 
selecting [Yes] at [Reset 
Configuration Data] 

• Replace the CPU/PCI 
module board. 

0B42 Resource Conflict Configuration error in SETUP. Correct device configuration in 
SETUP 

0B43 Warning: IRQ not 
configured 

Configuration error in SETUP. Correct settings in SETUP 

0B44 Expansion Rom not 
initialized 

Configuration error in SETUP. In SETUP, disable 
decompression of expansion 
ROM on unnecessary optional 
PCI cards. 

0B45 System Configuration 
Data Write error 

• Configuration error in 
SETUP. 

• CPU/PCI module board is 
faulty. 

 

• Reset the setting by 
selecting [Yes] at [Reset 
Configuration Data] 

• Replace the CPU/PCI 
module board. 

0B47 Missing date and time 
synchronization 

The date and time are 
incorrect due to a 
communication error between 
BMCs. 

• Restart the system. 
• Re-set the date and time in 

SETUP. 
If the error persists, replace the 
PCI module board. 

0B49 BMC Issued Reset 
Command, but failed 
System Reset 

• System cannot be reset by 
BMC’s reset command. 

Replace PCI module board. 

0B6E DIMMs are installed out 
of order 

• DIMM is faulty. Replace DIMM. 

0B70 The error occurred 
during temperature 
sensor reading 

• SMBus device is faulty. 
• SMBus is faulty. 

Replace the CPU/PCI module 
or back panel board. 

0B71 System temperature out 
of Range 

• Ambient temperature is out 
of range. 

• Fan is faulty.  
• CPU/PCI module board is 

faulty. 

• Check the setting in SETUP 
• Clean the fan. 
• Replace the fan. 
• Replace the CPU/PCI 

module board. 
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On-screen error message Cause Action 
0B80 BMC Memory Test Failed
0B81 BMC Firmware Code 

Area CRC check failed 
0B82 BMC core Hardware 

failure 
0B83 BMC IBF or OBF check 

failed 

BMC is faulty. Replace the PCI module 
board. 

0B90 BMC Platform 
Information Area 
corrupted 

0B91 BMC update firmware 
corrupted 

BMC is faulty. 

0B92 Internal Use Area of 
BMC FRU corrupted 

• SROM is faulty.  
• BMC is faulty. 

Replace the PCI module 
board. 

0B93 BMC SDR Repository 
empty 

0B94 IPMB signal lines do not 
respond 

0B95 BMC FRU device failure 
0B96 BMC SDR Repository 

failure 
0B97 BMC SEL device failure 

BMC is faulty. Replace the PCI module 
board. 

0B98 BMC SEL Overflow SEL (System Event Log) 
overflowed. 

Erase the unnecessary SEL. 

0BB0 SMBIOS - SROM data 
read error 

0BB1 SMBIOS - SROM data 
checksum bad 

• SROM is faulty.  
• Front panel board is faulty. 

Replace the back panel board. 

0BD0 1st SMBus device 
address not 
acknowledged 

0BD1 1st SMBus device Error 
detected 

0BD2 1st SMBus timeout 
0BD3 2nd SMBus device 

address not 
acknowledged 

0BD4 2nd SMBus device Error 
detected 

0BD5 2nd SMBus timeout 
0BD6 3rd SMBus device 

address not 
acknowledged 

0BD7 3rd SMBus device Error 
detected 

0BD8 3rd SMBus timeout 
0BD9 4th SMBus device 

address not 
acknowledged 

0BDA 4th SMBus device Error 
Detected 

Board is faulty. • Check cable connection. 
• Replace the board. 
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On-screen error message Cause Action 
0BDB 4th SMBus device 

timeout 
0BDC 5th SMBus device 

address not 
acknowledged 

0BDD 5th SMBus device Error 
detected 

0BDE 5th SMBus timeout 
0BDF 6th SMBus device 

address not 
acknowledged 

0BE0 6th SMBus device Error 
detected 

0BE1 5th SMBus timeout 
0BE2 7th SMBus device 

address not 
acknowledged 

0BE3 7th SMBus device Error 
detected 

0BE4 7th SMBus timeout 
0BE5 8th SMBus device 

address not 
acknowledged 

0BE6 8th SMBus device Error 
detected 

0BE7 8th SMBus timeout 

Board is faulty. • Check cable connection. 
• Replace the board. 

0BF0 Vendor ID cannot be 
retrieved from BP 
IDPROM 

Back panel board is faulty. Replace the back panel board. 

0BF1 System Structure cannot 
be retrieved from BP 
IDPROM 

Back panel board is faulty. Replace the back panel board. 

0C00 Rompilot reports error 
number xx 

• Configuration error in 
SETUP.  

• CPU/PCI module board is 
faulty. 

• Re-configure Rompilot. 
• Replace the CPU/PCI 

module board. 

8600 No working DQS value 
found 

• DIMM is faulty 
• DIMM is not supported 

• Replace DIMM 
• Replace DIMM with 

appropriate one. 
8610 MAC Address update 

failed – 
CoreI/O#010/100Mbit 
Ethernet COntroller 

FRB2 timeout occurred when 
setting MAC address, and 
rewrite was unsuccessful. 

• Replace the back panel 
board. 

• Replace the PCI module 
board. 

8611 MAC Address update 
failed – CoreI/O#0 Gbit 
Ethernet COntroller 

FRB2 timeout occurred when 
setting MAC address, and 
rewrite was unsuccessful. 

• Replace the back panel 
board. 

• Replace the PCI module 
board. 

8612 MAC Address update 
failed – CoreI/O#110/100 
Mbit Ethernet Controller 

FRB2 timeout occurred when 
setting MAC address, and 
rewrite was unsuccessful. 

• Replace the back panel 
board. 

• Replace the PCI module 
board. 
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On-screen error message Cause Action 
8613 MAC Address update 

failed – CoreI/O#1 Gbit 
Ethernet Controller 

FRB2 timeout occurred when 
setting MAC address, and 
rewrite was unsuccessful. 

• Replace the back panel 
board. 

• Replace the PCI module 
board. 
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Error Notification by BEEP 

An error message may not be displayed on the display unit even though the POST detected an error.  
In such a case, the beep sounds notifies you an error.  The error contents are indicated by the 
combination of beep sound patterns.  For example, beep sounds once, consecutively three times, 
once, and then once (beep code: 1-3-1-1) indicates DRAM refresh test error. 

The following table lists the meaning of beep codes and measures against them. 

Beep code Meaning Action 
1-2-2-3 ROM checksum 

error 
Contact your sales agent to replace the CPU module 
board. 

1-1-2-4 ROMEXEC code 
error 

1-3-1-1 DRAM refresh test 
error 

Check the installation of DIMM board. 
If the error persists, contact your sales agent to replace 
the DIMM or CPU module board.  

1-3-1-3 Keyboard controller 
error 

Disconnect the keyboard and connect it back on.  If the 
error persists, request your sales agent to replace the 
CPU module board. 

1-3-3-1 Failed to detect 
memory. 
Or, DIMM board 
type is incorrect. 

1-3-3-2 Initial setting error of 
the POST memory 
manager 

1-3-4-1 RAM address error 
1-3-4-3 RAM low byte data 

error 
1-4-1-1 RAM high byte data 

error 

Check the installation of DIMM board. 
If the error persists, contact your sales agent to replace 
the DIMM or CPU module board.  

2-2-3-1 Illegal interrupt test 
error 

2-1-2-3 Copyright check 
error 

 

Failed to initialize 
the video BIOS 
 
Failed to initialize 
the option ROM 

1-2 

Failed to expand the 
option ROM 

Check the motherboard installation if nothing is 
displayed on the display unit.  If the error persists, 
contact your sales agent to replace the CPU module 
board. 
Check the PCI board installation if the Option ROM of 
the added PCI board is not displayed.  If the error 
persists, contact your sales agent to replace the CPU 
module board, PCI module board or added PCI board 
with new one. 
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Windows 2000 Advanced Server Error Messages 

If a fatal error (e.g., a STOP or system error) occurs after Windows 2000 Advanced Server starts, the 
screen of the display unit turns blue and displays detailed error messages. 

STOP: C0 0 0 0 2 1 A (FATAL SYSTEM ERROR)

Th e  Windows  lo gon  pro c es s ..  Sys te m  proc es s  te rm in ate d.

Une xpec te dly  with  a s tatus  o f 0 x0 0 0 0 0 0 0 1
(0 x0 0 0 0 0 0 0 0  0 x0 0 0 0 0 0 0 0 ).

Th e  sys te m  h as  bee n sh utdown.

c rash dum p : in it ializ in g m in iport  drive r

c rash dum p : dum pin g phys ic al m e m ory to  dis k

The screen
background is "blue".

 
 
Take notes of the messages displayed on the screen, and call your sales agent. 

If a fatal error occurs, the server automatically executes memory dump processing and saves the 
memory dump data in an arbitrary directory.  (See the end of this chapter)  The maintenance 
personnel of your sales agent may ask you to provide this data.  Thus, copy the file into a medium 
(e.g., DAT) to be ready to pass it to the maintenance personnel. 

IMPORTANT: A message may appear indicating that virtual memory 
is insufficient when you restart the system after a STOP or system error 
has occurred.  Ignore the message and start the system. 

 

NOTE: Before copying the file into a medium, start the Event Viewer 
to confirm that the Save Dump event log is included in the system event 
logs and the memory dump has been saved. 

The following message may be displayed during usage. 

"Your system is low on virtual memory. To ensure that Windows runs properly, increase the 
size of your virtual memory paging file. For more information, see Help." 

When this message is displayed, extend a physical memory following the procedure below. 

1. Add a physical memory 

2. Change the configuration of the paging file (Change more than < physical memory 
capacity × 1.5 >) 

The system also displays a warning message if an internal device or peripheral equipment (e.g., disk, 
network, or printer) encounters an error.  Take notes of the message, and call your sales agent. 
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Server Management Application Error Message 

If the server management tool such as NEC 
ESMPRO Agent, NEC ESMPRO Manager, or 
GAMServer has been installed in the NEC 
Express5800/ft series or management PC, you 
can obtain the error information from the display 
unit of the server or management PC. 

See Chapter 5 or online documentation for 
details of such application programs. 
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SOLVING PROBLEMS 
When the server fails to operate as expected, see the following to find out your problem and follow 
the given instruction before asking for repair. 

If the server still fails to operate successfully after solving your problem, take a note on the 
on-screen message and contact your sales agent. 

 

Problems with NEC Express5800/ft series 

Fail to power on the server: 
� Is the server properly supplied with power? 

→ Check if the power cord is connected to a power outlet (or UPS) that meets the 
power specifications for the server. 

→ Check if the two pieces of the provided power cord are connected to the main unit 
properly. 

→ Make sure to use the power cord provided with the server.  Check the power cord 
for broken shield or bent plugs. 

→ Make sure the power breaker for the connected power outlet is on. 

→ If the power cord is plugged to a UPS, make sure the UPS is powered and it 
supplies power.  See the manual that comes with the UPS for details. 

Power supply to the server may be linked with the connected UPS using the BIOS 
setup utility of the server. 

<Menu to check:  [System Hardware] → [AC-LINK] → [Power On]> 

→ Make sure the POWER switch on the power unit is on. 

� Did you press the POWER switch? 

→ Press the POWER switch on the front of the NEC Express5800/ft series to turn on 
the power (the POWER LED lights). 

� Did you install the CPU/PCI module properly? 

→ Check if the CPU/PCI module is properly installed in the server.  Secure the 
module with screw located on the module handle. 

The screen turns blue during OS boot: 

→ Wait for the period of time you set at BIOS [Boot Monitoring]; after the boot pair 
is automatically swapped, the server will be rebooted and the OS will start up. 

→ Start the OS from the other PCI module’s hard disk. 
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Fail to power off the server: 
� Is the POWER switch enabled? 

→ Restart the server and start the BIOS setup utility. 

<Menu to check:  [Security] → [Power Switch Mask] → [Unmasked]> 

 

POST fails to complete: 
� Is the DIMM installed? 

→ At least one DIMM is required for operation. 

� Is the memory size large? 

→ The memory check may take a time if the memory size is large.  Wait for a while. 

� Did you perform any keyboard or mouse operation immediately after you started the 
server? 

→ If you perform any keyboard or mouse operation immediately after start-up, POST 
may accidentally detect a keyboard controller error and stops proceeding.  In 
such a case, restart the server once again.  Do not perform any keyboard or 
mouse operation until the BIOS start-up message appears when you restart the 
server. 

� Does the server have appropriate memory boards or PCI card? 

→ Operation of the server with unauthorized devices is not guaranteed. 

 

Fail to access to internal or external devices: 
� Are cables properly connected? 

→ Make sure that the interface cables and power cord are properly connected.  Also 
make sure that the cables are connected in the correct order. 

� Is that device compliant with NEC Express5800/ft series? 

→ Operation of the server with unauthorized devices is not guaranteed. 

� Is the power-on order correct? 

→ When the server has any external devices connected, power on the external 
devices first, then the server. 

� Did you install drivers for connected optional devices? 

→ Some optional devices require specific device drivers.  Refer to the manual that 
comes with the device to install its driver. 

→ Some optional devices connected to the serial port require settings for I/O port 
address and operation mode. Refer to the manual that comes with the device to 
configure the device. 

<Menu to check:  [Advanced] → [Peripheral Configuration]> 
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� Is SCSI controller (including options) configuration correct? 

→ If the sever has an optional SCSI controller board and SCSI devices are hooked up 
to the server, make correct settings by the SCSI controller board’s BIOS setup 
utility.  For details, see manuals included with the SCSI controller board. 

� Is SCSI device configuration correct? 

→ If external SCSI devices are connected to the server, you need to make settings of 
SCSI ID and terminal resistance.  For details, see manuals included with the 
SCSI device. 

 
CPU not in Dual mode: 

→ Check if the memory configuration is correct. 

→ Check if third-party CPUs or memory (DIMM) are used. 

 
Disk not in Dual mode: 

→ Unless you perform mirroring (including reconfiguration after failed disks are 
replaced) in correct order, the mirror may not be [re]configured.  Check if the 
steps were correct. 

 
The keyboard or mouse fails to operate: 

� Is the cable properly connected? 

→ Make sure that the cable is connected to the correct connector on the rear of the 
server. 

� Are the keyboard and mouse are compliant with NEC Express5800/ft series? 

→ Operation of the server with unauthorized devices is not guaranteed. 

� Is BIOS configuration correct? 

→ The keyboard and mouse may be disabled with the BIOS setup utility of the server.  
Check the settings with the BIOS setup utility. 

<Menu to check:  [Advanced] → [Keyboard Features]> 

� Does the server have drivers installed? 

→ Refer to the manual that comes with your OS to check that the keyboard and 
mouse drivers are installed.  (These drivers are installed along with the OS.)  
Some OS's allow you to change the keyboard and mouse settings.  Refer to 
manual that comes with your OS to check that the keyboard and mouse settings 
are correct. 

� Are you using a PS2-USB conversion connector? 

→ The PS2-USB conversion connector is not supported.  Use the keyboard and 
mouse that come with the server or use N-code products. 
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Screen freezes, keyboard and mouse don’t work: 

→ If the amount of memory is large, it take time to copy the memory in dual mode 
and the system stops working during the copying.  It’s not system trouble. 

 
Message “New Hardware Found” appears: 

→ Such a message may appear at the system startup or when a PCI module is 
replaced and incorporated into the system.  This is due to the server’s operating 
specifications and does not pose any problem. 

 
Fail to access (read or write) to the floppy disk: 

� Does the floppy disk drive contain a floppy disk? 

→ Insert a floppy disk into the floppy disk drive until it clicks. 

� Is the floppy disk write-protected? 

→ Place the write-protect switch on the floppy disk to the "Write-enabled" position. 

� Is the floppy disk formatted? 

→ Use a formatted floppy disk or format the floppy disk in the floppy disk drive.  
Refer to the manual that comes with the OS for formatting a floppy disk. 

 
Fail to access to the CD-ROM: 

� Is the CD-ROM properly set in the CD-ROM drive tray? 

→ The tray is provided with a holder to secure the CD-ROM.  Make sure that the 
CD-ROM is placed properly in the holder. 

� Is the CD-ROM applicable to the server? 

→ The CD-ROM for Macintosh is not available for use. 

� Is the CD-ROM on the PCI module whose POWER switch is on (primary module)? 

→ Although there are two CD-ROM drives, you can only use the one 
located on the primary module whose POWER switch is on. 

 
Fail to access the hard disk: 

� Is the hard disk applicable to the server? 

→ Operation of any device that is not authorized by NEC is not guaranteed. 

� Is the hard disk properly installed? 

→ Make sure to lock the hard disk with the lever on its handle.  The hard disk is not 
connected to the internal connector when it is not completely installed (see 
Chapter 8).  When the hard disk is properly installed, the drive power LED for 
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the hard disk is lit while the server is powered. 
 

Fail to start the OS: 
� Is a floppy disk in the floppy disk drive? 

→ Take out the floppy disk and restart the server. 

� Is the NEC EXPRESSBUILDER CD-ROM (or the other bootable CD-ROM) in the 
CD-ROM drive? 

→ Take out the CD-ROM and restart the server. 

� Is the OS damaged? 

→ Use the recovery process of the OS to attempt to recover the damaged OS. 
 
Failed to install Windows 2000 Advanced Server: 

� Did you install Windows 2000 Advanced Server according to precautions for 
installation? 

→ See Chapter 3. 
 
Reboot starts during setup: 

� Are BIOS settings correct? 

→ See settings of Boot Monitoring. 
 

OS behavior is unstable: 
� Have you updated your system? 

→ If you install a network driver after installing the OS, the OS may become 
unstable.  For update procedure, see Chapter 3. 

 

The system does not operate according to the configured settings of "Automatic 
Restart" at the occurrence of error. 

→ The system may or may not restart automatically even if the "Automatic Restart" 
settings are made at occurrence of an error is set.  If the system does not restart 
automatically, restart it in manual mode. 

 
The power cannot be turned off while the blue screen of Windows 2000 Advanced 
Server is displayed. 

→ The forced power-off (forced shutdown) procedure is necessary to turn off the power 
with the blue screen displayed.  Keep pressing the POWER switch for 4 seconds. 
Pressing the POWER switch only once does not turn off the power in this case. 

 
The server is not found on the network: 

� Is the LAN cable connected? 

→ Make sure to connect the LAN cable to the network port on the rear of the server.  
Also make sure to use the LAN cable that conforms to the network interface 
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standard. 

� Is BIOS configuration correct? 

→ The internal LAN controller may be disabled with the BIOS setup utility of the 
server.  Check the setting with the BIOS setup utility. 

<Menu to check:  [Advanced] → [Option Rom] → [On Board LAN]> 

� Have the protocol and service already configured? 

→ Install the distinctive network driver for the server.  Make sure that the protocol, 
such as TCP/IP, and services are properly specified. 

� Is the transfer speed correct? 

→ Open the [Network Property] dialog box in control panel to specify the “Link Speed 
& Dual” value the same as the value specified for HUB. 

 
Icon of drive A is changed to that of removal disk: 

→ Does not cause any problem. 
 
"The NMS Service service terminated unexpectedly." is recorded in the system event log: 

→ Although the following log may be recorded in the system event log when starting 
the system, or after exchanging PCI modules, there is no real problem on 
operation. Change of a setup with PROSet II will become invalid if NMS service 
stops, but you can change a setup normally because NMS service will be 
automatically started when PROSet II is started. 

“Source:  Service Control Manager 
Event ID: 7031 
Description: The NMS service terminated unexpectedly.This has occurred 1 

time(s). The following corrective action will be taken in 0 
milliseconds: No action.” 

 
iANSMiniport-related logs are recorded in the system event log: 

→ Although the following log may be recorded in the system event log when starting 
the system, there is no real problem on operation (In the description, “X” 
represents a number). 

“Source:  iANSMiniport 
Event ID: 35 
Description: Initializing Team #X missing adapters. Check the configuration to 

verify that all the adapters are present and functioning.” 
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ESMCpuPerf-related logs are recorded in the system event log: 

→ If NEC ESMPRO Agent cannot get performance information from the OS due to a 
temporary resource shortage or high load ratio on the system, it will record the 
following event log. However, there is no real problem on operation (In the 
description, Y and Xrepresent alphanumeric characters). 

Source:  ESMCpuPerf 
Event ID: 9005 
Description: Cannot get system performance information now (YYYY 

Code=xxxx). 

If NEC ESMPRO Agent cannot get information, it will treat the load ratio as 0%.  
So, if NEC ESMPRO Agent cannot get information continuously, the CPU load 
ratio may appear lower than the actual value. 

 

 

WMI log is recorded in the application event log: 
When you view the Application Event Viewer log on your computer, one or more of the following 
events may be logged. This has no effect on the functionality of VERITAS Volume Manager.  

Source: WinMgmt 

ID: 41 

Description: WMI ADAP was unable to create object index 2902 for Performance 
Library vxio because no value was found in the 009 subkey. 

 

vmperf log is recorded in the application event log: 
When you view the Application Event Viewer log on your computer, one or more of the following 
events may be logged. This has no effect on the functionality of VERITAS Volume Manager.  

Source: vmperf  

ID: 11  

Description: The description for Event ID (11) in Source (vmperf) cannot be found. The 
local computer may not have the necessary registry information or message 
DLL files to display messages from a remote computer. The following 
information is part of the event:  

Source: vmperf  

ID: 12  

Description: The description for Event ID (12) in Source (vmperf) cannot be found. The 
local computer may not have the necessary registry information or message 
DLL files to display messages from a remote computer. The following 
information is part of the event: 

 



Troubleshooting  7-31 

Failure in PCI module duplication: 

→ At the occurrence of PCI module fail-over, the PCI module duplication may fail 
with the following message saved in the system event log. If so, the system can be 
recovered from the failure by reinserting the PCI module for which the duplication 
failed. 

Source: srabb 

ID: 98 

Description: Diagnostic Test Failure! 11: IRQ1 Interrupt (0xd5a1) 

→ If the simultaneous replacement of the CPU and PCI modules causes the CPU and 
PCI to operate synchronization control for duplication simultaneously, the PCI 
module duplication may fail with the following message saved in the system event 
log. If so, the system can be recovered from the failure by reinserting the PCI 
module for which the duplication failed. 

Source: srabb 

ID: 98 

Description: Diagnostic Test Failure! 10: Xena Sanity Check (0xd630) 

 

Disk information is not correct on VERITAS Enterprise Administrator after system 
starts: 

→ If the primary PCI cannot access the FC disk, the disk information may not be 
displayed correctly. In this case, run “Action/Update” or “Action/Rescan.” 

 If the information is not displayed correctly even after the above step, check the 
connection between the module and disk. 

 

“Stratus Fault Tolerant Virtual 69000 Video” is displayed on “Remove Hardware” 
dialog box: 

→ If you double-click an icon “Remove Hardware” on the system tray, two “Stratus 
Fault Tolerant Virtual 69000 Videos” will appear.  Do not remove them. 
Otherwise, the connected PCI modules will be disconnected forcefully and the 
system may operate normally. 
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Problems with NEC EXPRESSBUILDER 

When the server is not booted from the NEC EXPRESSBUILDER CD-ROM, check the following: 

� Did you set the NEC EXPRESSBUILDER during POST and restart the server? 

→ If you do not set the NEC EXPRESSBUILDER during POST and restart the 
server, an error message will appear or the OS will boot. 

� Is BIOS configuration correct? 

→ The boot device order may be specified with the BIOS setup utility of the server.  
Use the BIOS setup utility to change the boot device order to boot the system from 
the CD-ROM drive first. 

<Menu to check:  [Boot]> 

When an error occurs while the NEC EXPRESSBUILDER is in progress, the following message 
appears.  After this message appears, check the error and take the appropriate corrective action 
according to the error codes listed in the table below. 

Message Cause and Remedy 
This machine is not supported. This NEC EXPRESSBUILDER version is 

not designed for this server.  Execute the 
NEC EXPRESSBUILDER on the compliant 
server. 

NvRAM access error An access to the nonvolatile memory 
(NvRAM) is not acceptable. 

Hard disk access error The hard disk is not connected or it is 
failed. 
Check whether the hard disk is correctly 
connected. 

The system-specific information 
does not exist on the baseboard. 
Please restore the backup data or 
write the data by using [System 
Information Management] of the 
Off-line Maintenance Utility. 
Only the authorized personnel are 
allowed to do this operation. 

These messages appear when NEC 
EXPRESSBUILDER cannot find 
sever-specific information, for example 
when you replace the motherboard. 
Maintenance personnel can use the offline 
utility to write the information. 
 

 

An error message will also be displayed when an error was detected during system 
diagnosis.  Take a note or print the error message displayed, and contact your sales agent. 
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Problems with NEC Express5800 ft series Setup 

The following message is displayed when the setup starts. 

The specified disk is not found.  Terminating SW installation.
 

→ The disk to install the system is not connected properly.  Check if the hardware is 
properly installed and connected. 

The following message is displayed while copying files from CD-ROM. 

xxxxx : Not Ready xxxxxxxxxxxxxxxxxxZ
xxxxx(A), xxxxx(R), xxxxx(F)

 
→ Press R.  If this message still appears, perform the setup again.  If the error 

persists, contact your sales agent to examine the CD-ROM drive. 

Entered an incorrect Product ID or CD-key. 

→ You will be prompted to enter again when the entry you made was incorrect.  
Enter the correct one. 

Failed to setup in detail for network adapter. 

→ The detailed setup of network adapter is not available in setup of NEC 
Express5800/ft series.  Open the control panel after starting Windows 2000 
Advanced Server to configure the network adapter. 

 

Problems with Master Control Menu 

Failed to read online documentation 
� Is HTML browser installed properly? 

→ Online documentation is an HTML-format file.  Install the HTML browser 
(Internet Explorer 5.x or later) in your operating system. 

� Is HTML file properly associated to the browser software? 

→ Online documentation accesses the local files in CD-ROM. 

If the extension of HTML file (.htm or .html) is not associated to your browser 
correctly, the local HTML file may not be browsed from Internet Explorer or the 
other applications.  Initialize your browser and set the association of extension 
(.htm or .html) correctly. 
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� Is Adobe Acrobat Reader installed properly? 

→ A part of online documentation is supplied in PDF file format.  Install the Adobe 
Acrobat Reader (Version 4.05 or later) in your operating system.  You can also 
install the Adobe Acrobat Reader using the NEC EXPRESSBUILDER.  Launch 
the Master Control Menu and select [Setup] → [Adobe Acrobat Reader].  

Image of online documentation is not clear 
� Is your display unit set to display 256 colors or more? 

→ Set the display unit to display 256 colors or more. 

 

The master control menu fails to appear: 
� Is your system Windows NT 4.0 or later, or Windows 95 or later? 

→ The CD-ROM Autorun feature is supported by Windows NT 4.0 and Windows 95.  
The older versions do not automatically start from the CD-ROM. 

� Is Shift pressed? 

→ Setting the CD-ROM with Shift pressed down cancels the Autorun feature. 

� Is the system in the proper state? 

→ The menu may not appear depending on the system registry setting or the timing 
to set the CD-ROM.  In such a case, start the Internet Explorer and run 
\MC\1ST.EXE in the CD-ROM. 

 

Problems with NEC ESMPRO 

NEC ESMPRO Agent  

→ See Chapter 5. 

NEC ESMPRO Manager 

→ See Chapter 5.  See also online document in NEC EXPRESSBUILDER 
CD-ROM for troubleshooting and other supplementary information. 
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COLLECTION OF TROUBLE LOGS 
In the event of trouble, you can get information in the procedures described below: 

IMPORTANT:  
� You can perform the procedures described below only when you are asked by 

your maintenance personnel to get trouble logs. 

� When the system restarts after the trouble, it may show a message that there is a 
shortage of virtual memory. However, continue the system startup. If you reset 
and restart the system, you cannot get correct information. 

Collection of Event Logs 

Collect the logs of various events that have occurred in the NEC Express5800/ft series. 

IMPORTANT: If a STOP error or system error has occurred or the system has 
stalled, restart the system, and then start collecting event logs. 

1. Click [Start] → [Settings] → [Control Panel] → [Administrative Tools] → [Event 
Viewer]. 

2. Select the type of the log to be collected. 

[Application Log] contains events related to the applications that were active at 
occurrence of the events.  [Security Log] contains security-related events.  [System 
Log] contains events that occurred in system components of Windows 2000 Advanced 
Server. 

3. Click [Save Log File As...] in the [Action] menu. 

 
4. Enter the name of the target archive log file in the [File name] box. 

5. Select the format of the target log file from the [Save as type] list box, and click [OK]. 
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Collection of Configuration Information 

Collect information such as the hardware configuration and internal setting information of the NEC 
Express5800/ft series. 

IMPORTANT: If a STOP error or system error has occurred or the 
system has stalled, restart the system, and then start the work. 

1. Click [Start] → [Settings] → [Control Panel]. 

The [Control Panel] window appears. 

2. Double-click the [Administrative Tools] icon, and then the [Computer Management] icon. 

The [Computer Management] window appears. 

3. Click [System Tools] → [System Information]. 

4. Click [Save As System Information File...] in the [Action] menu. 

 
5. Enter the name of the target file in the [File name] box. 

6. Click [Save]. 

 

Collection of Diagnostic Information by Dr. Watson 

Collect diagnostic information related to application errors by using Dr. Watson. 

You can designate any destination to save diagnostic information. 

For details, see help information.  Click [Start] → [Run...], execute "drwtsn32.exe," and click 
[Help] in the [Dr. Watson for Windows 2000] dialog box. 
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Collection of the Memory Dump 

If a failure occurs, the memory data should be dumped to acquire the required information.  If you 
stored the dump data in a DAT, label it so as to indicate the software (e.g. NTBackup) you used for 
storing it.  You may save the diagnosis data to a desired destination. 

IMPORTANT:  
� Consult with your sales agent before dumping the memory.  Executing memory 

dumping while the server is in the normal operation may affect the system 
operation. 

� Restarting the system due to an error may display a message indicating 
insufficient virtual memory.  Ignore this message and proceed.  Restarting the 
system again may result in dumping improper data. 

Preparing for Memory Dump 

Memory dumping with the DUMP switch may disable the server to restart.  In such a case, it is 
required to force the server to shut down.  This forced shutdown, however, is not available if 
"Masked" is selected for "Power Switch Mask" on the Security menu of the BIOS setup utility, 
SETUP, because this setting disables POWER switch operation. 

Follow the procedure below to change the setting to enable the forced shutdown and restart of the 
server. 

1. Power on the server and start the BIOS setup utility, SETUP. 

2. Select "Unmasked" for "Power Switch Mask" in the Security menu. 

3. Save the configuration data and exit the SETUP. 

 

Saving Dump Files 

Press the DUMP switch to save the dump file 
when an error occurs.  Insert a metal pin (a 
straightened large paper clip will make a 
substitute) into the switch hole to press the 
DUMP switch. 

Pressing the DUMP switch saves the dump file 
in the specified directory.  (Memory dumping 
may not be available when the CPU stalls.) 

IMPORTANT: Do not use a 
toothpick or plastic stick that is 
easy to break. 

Dump switches
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 SYSTEM REPAIR 
If a file required to operate OS is defected, repair the system by using the repair process. 

IMPORTANT:  
� After the system repair, always update several drivers referring to 

"System update" in Chapter 3. 

� If hard disks cannot be recognized, the system cannot be repaired. 

� After removing all of the PCI board that is the option, start setup. 

Before performing procedures described here to repair a system, you need to prepare a support 
disk called “Windows 2000 OEM-DISK for EXPRESSBUILDER.” 

 

� If you do not have a computer that runs Windows 2000/NT or Windows 95/98/Me. 

Follow the steps below to create a “Windows 2000 OEM-DISK for 
EXPRESSBUILDER”: 

1. Prepare a 3.5-inch floppy disk. 

2. Power on the peripherals and then NEC Express5800/ft series. 

3. Modify the BIOS settings. 

Select [Advanced] → [Monitoring Configuration] and “Disable” the settings of [Boot 
Monitoring]. 

4. Insert the EXPRESSBUILDER CD-ROM into the drive of the server. 

5. Then, reset (pressing Ctrl + Alt + Delete) or power off/on NEC Express5800/ft series to 
reboot it. 

The system will start up from the CD-ROM to start EXPRESSBUILDER. 

6. From [Tool] menu, select [Create Support Disk]. 

7. From [Create Support Disk] menu, select [Windows 2000 OEM-DISK for 
EXPRESSBUILDER]. 

8. Follow the instructions on the screen to insert the floppy disk. 

Windows 2000 OEM-DISK for EXPRESSBUILDER will be created on the floppy disk. 
Write-protect and place a label on the disk and keep it in a safe place. 
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� If you have a computer that runs Windows 2000/NT or Windows 95/98/Me. 

You can also create a “Windows 2000 OEM-DISK for EXPRESSBUILDER” by the steps 
below: 

1. Prepare a 3.5-inch floppy disk. 

2. Insert the EXPRESSBUILDER CD-ROM into the drive of a computer that runs Windows 
2000/NT or Windows 95/98/Me. 

3. From [Software Setup], select [Create OEM disk]. 

4. Follow the instructions on the screen to insert the floppy disk. 

Windows 2000 OEM-DISK for EXPRESSBUILDER will be created on the floppy disk. 
Write-protect and place a label on the disk and keep it in a safe place. 

 

� If you have an update CD-ROM “NEC Express5800/ft Series ft Control Software 
(Ver:n.n).” 

Follow the steps below to create a “Windows 2000 OEM-DISK for 
EXPRESSBUILDER”: 

1. Prepare a 3.5-inch floppy disk. 

2. Insert the update CD-ROM into the drive of a computer that runs Windows 2000/NT or 
Windows 95/98/Me. 

3. From the Start menu, select [Specify Filename and Run] to run 
\WINNT\BINMAKEFD\W2K\MAKEOEM.BAT on the CD-ROM. 

4. Follow the instructions on the screen to insert the floppy disk. 

Windows 2000 OEM-DISK for EXPRESSBUILDER will be created on the floppy disk. 
Write-protect and place a label on the disk and keep it in a safe place. 
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In the steps below, repair the system using information inside the disk instead of a system 
repair disk: 

1. Modify the BIOS settings. 

Select [Advanced] → [Monitoring Configuration], and “Disable” the setting of [Boot 
Monitoring]. For details, see Chapter 4 "Monitoring Configuration". 

2. Power on the system. 

3. Insert the Windows 2000 Advanced Server CD-ROM into the drive of the server. 

4. Then, reset (pressing Ctrl + Alt + Delete) or power off/on NEC Express5800/ft series to 
reboot it. 

5. Wait until message "Press any key to boot from CD" appears on the screen. 

6. Press any key to select the start from CD-ROM. 

IMPORTANT: Unless an arbitrary key is pressed during the display of 
the message, the system is started from the hard disk drive. The repair 
process cannot be started. 

7. Wait until message "Press F6 if…" appears on the screen. 

8. Press the F5 and F6 quickly. 

IMPORTANT: If you press neither the F5 nor F6, the repair process is 
not started. 

9. If the text-base setup is started, follow the directions on the screen to proceed. 

As you follow the directions, the screen for selecting HAL will appear. 

10. Insert the Windows 2000 OEM-DISK for EXPRESSBUILDER into the floppy disk drive 
and specify the module saved in the OEM disk. 

As you follow the directions, the screen for selecting the SCSI driver will appear. 

11. Insert the Windows 2000 OEM-DISK for EXPRESSBUILDER into the floppy disk drive 
and specify the SCSI driver saved in the OEM disk. 

As you follow the directions, the screen for selecting the SCSI driver will appear. 

NOTE: The OEM disk contains more than one SCSI driver. Press S to 
select all the SCSI drivers. 

Message "Press R key to repair Windows 2000 already installed" appears. 

12. Press R to select the repair option. 

13. Select the type of the keyboard. 
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14. If the selection is prompted, press R to select the system repair processing. 

15. If the selection is prompted, select either of the following options: 

[Manual repair]  
(press M) 

Do not select this option unless you are skilled user or system 
Administrator. The use of this option allows the problems of 
system files, partition boot sectors, and startup environment to be 
repaired. 

[High speed repair] 
(press F) 

This option can be used quite simply. The user may not do 
anything. If this option is selected, the system repair disk program 
starts repairing the problems associated with system file, system 
disk partition boot sector, and startup environment (when more 
than one operating system are installed in the system). 

 
16. Followi the directions on the screen. Press L on the screen prompting you to insert the 

system repair disk. 

After the disk is reviewed, the system is restarted once. 

NOTE: The processes without use of the system repair disk are 
performed. 

17. Repeat Steps 1 to 15 above. 

The repair process is started. 

During the repair process, unfound or defected files are replaced with the corresponding 
files in C:\1386 of the hard disk or the systemroot\ Repair folder of the system partition. 
The configuration changes performed after the setup are notupdated to the replaced files . 

18. Follow the directions on the screen. 

Write down the names of files in which faults are detected. This helps to diagnose how the 
system has been defected. 

19. Terminate the process if it succeeds in the system repair. 

If the computer is restarted without any problem, the replaced files are copied to the hard 
disk appropriately. 

20. Execute system update.  

For details, see Chapter 3 "Updating the System". 

21. Change the BIOS setup.  

Select [Advanced] → [Monitoring Configuration], and select “Enable” the setting of 
[Boot Monitoring]. For details, see Chapter 4 "Monitoring Configuration". 
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(This page is intentionally left blank.) 
 



 

Chapter 8 

System Upgrade 

This chapter describes procedures to add options and replace failed components. 

IMPORTANT:  

� Optional devices described in this chapter may be installed or 
removed by the user.  However, NEC does not assume any liability 
for damage to optional devices or the server or malfunctions of the 
server resulted from installation by the user.  NEC recommends 
you ask your sales agent to install or remove any optional devices. 

� Be sure to use only optional devices and cables designated by NEC.  
Repair of the server due to malfunctions, failures, or damage 
resulted from installing such devices or cables will be charged. 
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SAFETY PRECAUTIONS 
Observe the following notes to install or remove optional devices safely and properly. 

WARNING  
  

Observe the following instructions to use the server safely.  Failure to follow 
these instructions may result in death or serious personal injury.  See safety 
precautions in Chapter 1 for details. 
 

 

 

 
• Do not disassemble, repair, or alter the server. 
• Do not look into the CD-ROM drive. 
• Do not remove the lithium battery. 
• Disconnect the power plug before working with the server. 

  
 

CAUTION  
  

Observe the following instructions to use the server safely.  Failure to follow 
these instructions may cause a fire, personal injury, or property damage.  See 
safety precautions in for details. 
  
• Do not install or remove components by a single person. 
• Do not install the server leaving the cover removed. 
• Make sure to complete component installation. 
• Do not pinch your finger(s). 
• High temperature 
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ANTI-STATIC MEASURES 
The server contains electronic components sensitive to static electricity.  Avoid failures caused by 
static electricity when installing or removing any optional devices. 

� Wear wrist straps (arm belts or anti-static gloves). 

Wear wrist straps on your wrists.  If no wrist strap is available, touch an unpainted metal 
part of the cabinet before touching a component to discharge static electricity from your 
body. 

Touch the metal part regularly when working with components to discharge static 
electricity. 

� Select a suitable workspace. 

– Work with the server on the anti-static or concrete floor. 

– When you work with the server on a carpet where static electricity is likely to be 
generated, make sure take anti-static measures beforehand. 

� Use a worktable. 

Place the server on an anti-static mat to work with it. 

� Clothes 

– Do not wear a wool or synthetic cloth to work with the server. 

– Wear anti-static shoes to work with the server. 

– Take off any metal accessories you wear ( ring, bracelet, or wristwatch) before 
working with the server. 

� Handling of components 

– Keep any component in an anti-static bag until you actually install it to the server. 

– Hold a component by its edge to avoid touching any terminals or parts. 

– To store or carry any component, place it in an anti-static bag. 
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PREPARING YOUR SYSTEM FOR UPGRADE 
Note the followings, when installing or replacing devices, to improve the performance of NEC 
Express5800/ft series. 

� With the NEC Express5800/ft series server, devices can be replaced during the continuous 
operation.  Take extreme care for electric shock and damage to the component due to 
short-circuit. 

� Optional devices cannot be installed or removed during continuous operation.  Normally, 
shutdown Windows 2000 Advanced Server, check that the server is powered off, 
disconnect all power cords and interface cables from the server before installing or 
removing the optional devices. 

� To remove the CPU or PCI module during the continuous operation, disable the intended 
module (place the module off-line) by using the ft series utility of the NEC ESMPRO 
Agent or the NEC ESMPRO Manager from the management PC on the network.  After a 
new module is installed to the server, enable the module using the ft series utility or the 
NEC ESMPRO Manager. 

NOTE: The system is defaulted to automatically boot the module, once 
installed.  This setting can be changed with the ft series utility or the 
NEC ESMPRO Manager.  For more information, see Chapter 5. 

� Make sure to provide the same hardware configuration on both groups. 

� Use the same slots and sockets on both groups. 

� Do not install those devices having different specifications, performance, or features. 

� Before removing the setscrews from the CPU and PCI modules, place the desired module 
off-line using the ft series utility or the NEC ESMPRO Manager. 
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3.5-INCH HARD DISK DRIVE 
The 3.5-inch device bay in front of the server contains six slots in which hard disks with the SCA2 
interface are installed. 

The figures used in this section show the tower model.  The orientation is the only difference from 
the rack-mount model. 

IMPORTANT:  

� Do not use any hard disks that are not authorized by NEC.  Installing a 
third-party hard disk may cause a failure of the server as well as the hard disk.  
Purchase hard disks of the following models (as of June 2001): 

   – N8150-105F (18.1GB, 10,000rpm, Ultra 160/m SCSI) 
   – N8150-106F (36.3GB, 10,000rpm, Ultra 160/m SCSI) 

� The OS starts from the hard disk that is mounted in Slot 1 of the primary module 
(whose POWER LED is on). 

� A SCSI controller error having sraql160 as its source may sometimes be recorded 
in the system event log. This error is likely to be issued when the hard disk drive 
processing cannot keep up in time with requests of the OS, but the processing is 
carried on normally thanks to the retry function. So, this does not affect the 
operation at all. In case such an error is issued, check the detailed data indicated 
below, and if it is "f0030004" or "f0030015," just ignore that log.  
If, however, a SCSI controller error whose detailed data is "f0030004" or 
"f0030015" is recorded repeatedly (ten times or more in a week time as a rough 
guide), a hard disk drive failure is suspected. Contact the maintenance personnel 
in such a case. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOTES:  
� POWER LED is on to indicate that it is the primary module. 

� The module that you plug in first will be the primary module (see Chapter 3). 

Description:  
The driver detected a controller 
error on \Device\Scsi\sraql160x 
[x is a numeral as 1 or 2 for 
example.] 

In the case where the detailed 
data of the above event 
properties is represented in 
words, the error represents no 
trouble if the value from 0034:is 
“f0030004” or “f0030015”. 
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You can install hard disks, each of which is about 25.4 mm (1 inch) in thickness, to the three slots of 
each module.  Each device bay has a label describing the slot number. 

Disks of the same slot number are mirrored between the groups.  The figure below shows the 
groups and mirroring slots. 

 

 

 

Empty slots in the hard disk bay contain dummy trays.  The dummy trays are inserted to improve 
the cooling effect within the device.  Always insert the dummy trays in the slots in which hard 
disks are not installed. 

Attach an HDD ID label indicating the slot number of installed hard disk to the handle of the hard 
disk. 

Group 1 

Group 2 

Slots 1 Slots 2 Slots 3

Slots used in mirroring  
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Installing 3.5-inch Hard Disk Drive 

Follow the procedure below to install the hard disk.  A hard disk may be installed in another slot in 
the same procedure. 

IMPORTANT:  

� Make sure to read "Anti-static Measures" and "Preparing Your System for 
Upgrade" before starting installing or removing options. 

� Install two hard disks for dual disk configuration before starting Windows 2000 
Advanced Server.  Make sure to configure the hard disks as dual disk. 

1. Shutdown Windows 2000 Advanced Server. 

The system turns off automatically and the POWER LED goes off. 

2. Disconnect all the power cords from the power outlet. 

3. <Tower model> 

Unlock the front bezel with the security key and open it. 

<Rack-mount model > 

Unlock the front bezel with the security key and remove the upper and lower panels. 

4. Identify the slot to which you want to install the hard disk. 

Install a hard disk in an empty slot in the group, starting from the left slot. 

5. Remove dummy trays. 

All the slots except Slot 1 have a dummy 
tray. 

IMPORTANT: Carefully keep the 
removed dummy tray. 

 

 

6. Unlock the hard disk to be added. 
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7. Firmly hold the handle of the hard disk to install 
and insert the hard disk into the slot. 

NOTES:  
� Engage the upper and lower frames of the 

tray with the left and right grooves on the 
device bay and insert the hard disk. 

� Insert the disk until the lever hook touches 
the server frame. 

� Check the orientation of lever.  Insert the 
hard disk with the lever unlocked. 

8. Slowly close the lever. 

When the lever is locked, you will hear a click sound. 

IMPORTANT: Be careful not to pinch your finger(s) between the lever 
and handle. 

 

NOTE: Check the hook of the lever is engaged with the frame. 

9. Connect all the power cords. 

10. Press the POWER switch to turn on the system power. 

11. <Tower model> 

Close the front bezel and lock it with the security key. 

<Rack-mount model> 

Install the upper and lower panels and lock the front bezel with the security key. 

A while after Windows 2000 Advanced Server is started, [New Hardware Detection] 
wizard is displayed. 

12. Select [Make known drivers for this device displayed and select a driver from the list] and 
click [Next]. 

13. Check that "Stratus Dual Initiated disk Device" is displayed in the list, and click [Next] 
repeatedly until [Finish] is displayed. 

14. Set the dual disk configuration (see Chapter 3). 
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Removing 3.5-inch Hard Disk Drive 

Follow the procedure below to remove the hard disk. 

IMPORTANT: Make sure to read "Anti-static Measures" and 
"Preparing Your System for Upgrade" before starting installing or 
removing options. 

1. Shutdown Windows 2000 Advanced Server. 

The system turns off automatically and the POWER LED goes off. 

2. Disconnect all the power cords from the power outlet. 

3. <Tower model> 

Unlock the front bezel with the security key and open it. 

<Rack-mount model> 

Unlock the front bezel with the security key and remove the upper and lower panels. 

4. Push the lever of the hard disk to unlock 
the handle. 

5. Hold the handle and hard disk to pull them 
off. 

6. Install the dummy tray in an empty tray 
according to procedures described in 
"Installation". 

Make sure to install the dummy tray in the 
empty slot to improve the cooling effect 
within the device. 
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Replacing 3.5-inch Hard Disk Drive 

Follow the procedure below to remove the failed hard disk.  If the hard disk fails, it should be 
replaced with new device with the server powered-on. 

IMPORTANT: Make sure to read "Anti-static Measures" and 
"Preparing Your System for Upgrade" before starting installing or 
removing options. You can replace disks during continuous operation. 

Replacing the Hard Disk Drive 

1. Locate the failed hard disk of which DISK Error LED on the handle of the hard disk drive 
is lit in amber. 

The DISK Power/Access LED also lights in amber. 

NOTE: Even if a hard disk is faulty, the DISK LED may not illuminate 
in amber.  See “How to Locate Failed Disks” on the next section to 
identify failed disks. 

2. Referencing the steps in "Removing the hard disk", remove the failed hard disk. 

No need to shutdown Windows 2000 Advanced Server.   

3. Refer to the steps in "Installing the hard disk" to install a new hard disk. 

NOTE:  

� The hard disk to be installed for replacement must have the same 
specifications as its mirroring hard disk. 

� Use an unsigned hard disk to replace the failed one.  If you use a 
signed disk, you need to restore the redundant configuration in the 
procedure of “How to Restore Redundant Configuration Manually” 
below.  

 

4. The system will automatically restore its redundant configuration. 

Since the redundant configuration is restored automatically, you do not need to use 
VERITAS Volume Manager to restore it. 

IMPORTANT: The redundant configuration is not restored 
automatically in the following cases: 

� If you use a signed hard disk. 

� If you replace a disk that is connected to a fibre channel. 

� If you replace a disk that has partitions or volumes. 

� If you replace a disk while the system is shut down. 
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How to Locate Failed Disks  

This section describes a procedure to locate failed disks. 

1. Open [Data Viewer] from ESMPRO Manager. 

If trouble occurs, the color changes from green to red. 

In this case, you will notice that there is trouble with both the SCSI Enclosures (ID:10/40) 
and (ID:11/40). 

 
2. Check the SCSI Enclosures (ID:10/40) and (ID:11/40) on the tree. 

See the path information in [General Information] of [SCSI Slot] to locate a group of 
3.5-inch device bays that corresponds to each enclosure. 

 
The table below shows the path information on Groups 1 and 2: 

Slot PCI module SCSI adapter SCSI bus 
Group1 10 5 0 
Group2 11 5 0 

 

3. See the path information in [General Information] of [SCSI Slot (ID: 10/40/1)]. 

It shows that PCI module, SCSI adapter, and SCSI bus are 10, 5, and 0, respectively. 

 
This allows you to find that SCSI Slot (ID: 10/40/1) belongs to Group 1.  SCSI slots 
under SCSI Enclosure (ID: 10/40/1) correspond to Group 1.  Therefore, Group 2 
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corresponds to SCSI slots under SCSI Enclosure (ID: 11/40). 

You will find that the failed disks located in SCSI slots (ID: 10/40/2) and (ID: 11/40/3) are 
the 2nd disk of Group 1 and 3rd disk of Group 2, respectively. 
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How to Format Disks 

After replacing a hard disk that has partitions or volumes inside, the redundant configuration will 
not be restored automatically.  To restore the configuration, you need to format the new disk. 

1. Insert only the desired hard disk into the slot. 
To avoid formatting other disks by mistake, insert only the desired hard disk into Slot 1.  

2. Insert the "ROM-DOS Startup FD" into the floppy disk drive, and start the machine. 

For the creation of " ROM -DOS Startup FD," see Chapter 5, 'NEC EXPRESSBUILDER 
Top Menu'-'Tool'-'Create Support Disk' of the User's Guide. 

Short time after ROM-DOS starts up, the A:\ prompt will appear. 

3. Execute the FDISK command. 

4. Select 3 (Delete partition or Logical DOS Drive) from the menu. 

5. Select 4 (Delete Non-DOS Partition) from the menu, and delete the area according to the 
messages. 

6. Repeat Step 5 until deleting all the areas. 

7. Press Esc to terminate the FDISK command when having deleted all the areas. 

8. The message "System will now restart." appears.  Press any key to restart the system. 

9. When the restart processing starts, remove the "MS-DOS Startup FD" from the floppy 
disk drive, and turn off the power. 
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How to Restore Redundant Configuration Manually 

If the system does not restore the redundant configuration automatically after you replace the failed 
disks, follow the steps below to restore the configuration manually: 

IMPORTANT: The redundant configuration is not restored 
automatically in the following cases: 

� If you use a signed hard disk. 

� If you replace a disk that is connected to a fibre channel. 

� If you replace a disk that has partitions or volumes. 

� If you replace a disk while the system is shut down. 
 

This section describes procedures to re-establish the dual configuration of hard disks whose 
volumes are created by VERITAS Volume Manager at the time of failure recovery.  Although 
there are procedures for simple volume, stripe volume, and span volume, see “In the Case of Simple 
Volume Mirroring” for the basic procedure.  

IMPORTANT:  

� If you need to remove a hard disk due to a failure, identify that hard 
disk on Data Viewer, not the disk number on [VERITAS Enterprise 
Administrator]. 

� When you make resetting of the mirrors, see the target IDs of 
[Device types] listed in [Properties], not the disk numbers on 
[VERITAS Enterprise Administrator]. 

� If a hard disk included a Boot volume (if it was used to store OS), 
you cannot use it in a dual disk configuration (you cannot import it 
by [Import dynamic group] command).  You need to format the 
disk before using it in a dual configuration. 

 

In the Case of Simple Volume Mirroring 

The following steps use the example described in Section “How to Locate Failed Disks” above, 
where the second disk of Group 1 (in Slot#2) and the third disk of Group 2 (in Slot#3) failed.  

 

1. In [Start] menu, click [Setting] and [Control Panel]. 

[Control Panel] window will appear. 

2. Double-click [Management Tools] icon. 

[Management Tools] window will appear. 

3. Double-click [Computer Management] icon. 

[Management Tools] window will appear. 
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4. Under [Storage Area] of the Console tree, click [Disk Management] and [VERITAS 
Enterprise Administrator] to connect to the localhost. 

An example in this figure shows that one of the mirrored disks in which Drives E and F 
are included broke.  Some disks are indicated as “Unknown disk.”  However, they may 
be indicated differently depending on the error type.  Even in such cases, failed disks can 
be recovered by following the steps below: 

 
5. Remove the hard disks from Slot#2 of Group 1 and Slot#3 of Group 2. 

 
6. Open [VERITAS Enterprise Administrator]. 

 

7. Select a volume that has “x” and view the mirror tab. 

8. Right-click the degenerated mirror and select [Erase mirror]. 
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9. After checking to see if the “degenerate” disk is selected, click [Yes]. 

 

At Drive (F), [Mirror] and [Degenerate] will change to [Connected] and [Normal]. 

 

10. At [DynamicGroup], right-click [Unknown] disk that no longer has any volumes, and 
select [Erase disk from Dynamic Disk Group].  
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11. After checking to see if [Unknown disk] is selected, click [OK].  

 

 

 

 

 

 

 

 

 

 

 

12. In the same way, erase the other [Unknown] disk.  
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13. The inserted disks will appear on [VERITAS Enterprise Administrator].  

If the status of a disk is “No signature,” right-click that disk to place signature. 

 

14. Select and right-click a disk and select [Add to dynamic disk group].  

IMPORTANT: If you add a used disk, do the following steps: 

� If [Unknown disk group] appears: 

Perform [Disk outer join].  Then, erase [Unknown disk] as described in Steps 
7 to 11 above.  Erase the volumes and perform [Erase disk from dynamic disk 
group].  Follow the wizard to perform [Add disk to dynamic disk group]. 

� If [Different format] appears: 

Perform [Erase disk from dynamic disk group]. Then, follow the wizard to 
perform [Add disk to dynamic disk group]. 
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15. Check the disk you selected and click [Next].  

 

16. Click [Complete]. 
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17. Check the properties of Disk 1 to see if the Target ID is 1.  Check also the other disks: 

Disk 1: Target ID 1 

Disk 2: Target ID 2 

Disk 3: Target ID 1 

Disk 4: Target ID 2 

 Disk with the same ID are mirrored. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

IMPORTANT:  

Hard disks are numbered at the time of OS startup based on their 
inserted positions.  After the OS startup, each time you insert a new 
hard disk, a larger number will be given.  When you restart the OS, the 
hard disks will be numbered again based on their inserted position 
regardless of their former numbers.  Since disk numbers change due to 
restartup in this way, you need to make mirror setting of disks based on 
their IDs instead of their numbers.  
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18. Make a mirror setting of Disks 1 and 4. 

Right-click a volume on Disk 4 (Drive (E) in this example) and select [Mirror] and [Add]. 

 

19. When [Add mirror] appears, check [Select disks manually], select Disk 1, and click 
[Select].    

After checking to see if the configuration is correct, click [OK] to add the mirror. 

 

NOTE: Although Disks 1 and 4 are mirrored in this example, other 
disks may be selected at the default.  If so, click [Modify], select Disk 
1, and click [OK]. 

 

20. In the same way, make a mirror setting of Disks 2 and 5.  

Upon completion of synchronous processing, recovery is completed. 
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In the Case of Stripe Volume Mirroring 

The following is a procedure of mirror recovery for stripe volumes.  

In this example, stripe volumes are mirrored as shown below:  

 
The figure below shows [View Disk] tab of Dynamic Disk Group. 
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TIPS: In this example, assume that target IDs are the same between 
Disks 1 and 4, and between Disks 2 and 5. 

 

The figure below shows Drive (E) in [View Disk] tab of Volume.  Appearance is the same in other 
stripe volumes.  The volume type is dynamic mirror stripe volume.  

 
The next procedure is to perform recovery when Disk 2 fails in the above environment. 

1. Check disks.  

If a failure occurs on a disk that includes a mirror volume, the volume will show 
[Degenerate] status.  Its disk name will change to [Unknown Disk] and “x” will appear 
on its disk icon.  “!” will appear on the failed disk and on the stripe volume disk.  

 

 

If you click [View Disk] tab of [Unknown Disk], “!” marks are placed on each volume to 
indicate that a redundancy failure occurred. 
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Click [Volume] tab to see the volumes in the disk where the failure occurred. 

 

2. Locate the failed disk and remove it from the slot. 

For procedures to locate failed disks, see “How to Locate Failed Disks” above. 

3. Erase stripe volume mirrors on [Unknown Disk]. 

After selecting Volume (E:) on [Unknown Disk], right-click a mirror with “x” on [Mirror] 
tab and select [Erase Mirror]. 

 

 

When a confirmation message appears, click [Yes].  

 

 

 After you erase the mirrors, Volumes (E:) in Disks 4 and 5 change from “Degenerate” to 
“Normal” dynamic stripe volume. 
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 Then perform [Erase Mirror] for Volumes (F:) and (G:) as well.  After you erase all 
volume mirrors on [Unknown Disk], there are no volumes on [Unknown Disk] and the 
space of Disk 1, which made up stripe volumes with Disk 2, is empty. 

 
 

4. Erase [Unknown Disk] 

Right-click [Unknown Disk] and select [Erase Disk from Dynamic Disk Group].  
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5. Mount a new hard disk. 

If the new disk is indicated as [Basic Disk], right-click the disk in [View Disk] and select 
[Add Disk to Dynamic Disk Group]. 

If the new disk is indicated as [Different Format] or [Unknown Disk], right-click the disk 
in [View Disk], select [Erase Disk from Dynamic Disk Group] and select [Add Disk to 
Dynamic Disk Group].  

IMPORTANT: You need to format a used hard disk before reusing it 
in a disk dual configuration.  Perform the steps described in “How to 
Format Disks” above. 

 

6. Create mirrors for each stripe volumes. 

Create mirrors of disks based on their target IDs in Disk Properties, not their disk numbers 
in [View Disk].  In this example, create mirrors between Disks 1 and 4, and between 
Disks 2 and 5.  For details of disk combination, see Step 17 of “In the Case of Simple 
Volume Mirror” above. 

Use [Add Mirror] to add a new mirror in the new disk’s space.  

At Disk 4 or 5, right-click Volume (E:), and select [Mirror] → [Add].  

 

 

Select [Select Disk Automatically] and check to see if the mirror combinations are 
correct. 

Perform [Mirror] → [Add] for Volumes (F:) and (G:) as well. 

Upon completion of synchronous processing between the volumes where mirrors have 
been added, recovery is completed. 
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In the Case of Span Volume Mirror 

The following is a procedure of mirror recovery for span volumes.  

In this example, span volumes are mirrored as shown below:  

 

 

Volumes (E:) are span volumes. 

The figure below shows [View Disk] tab of Dynamic Disk Group. 
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The figure below shows Drive (E) in [View Disk] tab of Volume.  Although the volume type is 
dynamic mirror stripe volume, they are span volume mirrors because one prefix includes more than 
one disk. 

 
 

The next procedure is to perform recovery when Disk 1 fails in the above environment. 

1. Check disks. 

If a failure occurs on a disk that includes a mirror volume, the volume will show 
[Degenerate] status.  Its disk name will change to [Unknown Disk] and “x” will appear 
on its disk icon.  “!” will appear on the failed disk and on the stripe volume disk. 

 

 

2. Locate the failed disk and remove it from the slot.  

For procedures to locate failed disks, see “How to Locate Failed Disks” above. 

3. Erase span volume mirrors on [Unknown Disk]. 

After selecting Volume (E:) on [Unknown Disk], right-click a mirror with “x” on [Mirror] 
tab and select [Erase Mirror]. 
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4. Erase [Unknown Disk]. 

[Right-click [Unknown Disk] and select [Erase Disk from Dynamic Disk Group]. 

 

 

5. Mount a new hard disk. 

If the new disk is indicated as [Basic Disk], right-click the disk in [View Disk] and select 
[Add Disk to Dynamic Disk Group]. 

If the new disk is indicated as [Different Format] or [Unknown Disk], right-click the disk 
in [View Disk], select[Erase Disk from Dynamic Disk Group] and select [Add Disk to 
Dynamic Disk Group]. 

IMPORTANT: You need to format a used hard disk before reusing it 
in a disk dual configuration.  Perform the steps described in “How to 
Format Disks” above. 

 
 

6. Create mirrors.  
Create mirrors of disks based on their target IDs in Disk Properties, not their disk numbers 
in [View Disk].  In this example, create mirrors between Disks 1 and 4, and between 
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Disks 2 and 5.  For details of disk combination, see Step 17 of “In the Case of Simple 
Volume Mirror” above. 

When creating span volume mirrors, disks with different target IDs may be combined if 
other disks have free space.  In this case, you can make correct combinations by creating 
temporary volumes in such free space. 
 

 
 

Select [Select Disk Manually] and check to see if the mirror combinations are correct. 

Erase the temporary volumes you created before. 

Upon completion of synchronous processing, recovery is completed. 

 

 
 

 



System Upgrade  8-31 

CPU MODULE 
Concerning the CPU module, you can add or replace the following components, or CRU 
(customer-replaceable units): 

� CPU (processor) 

� DIMM (memory) 

Remove the CPU module to install or remove these devices.  The figures used in this section show 
the tower model.  The orientation is the only difference from the rack-mount model. 

IMPORTANT:  
� Ask your sales agent to replace the CPU module and components of 

the PCI module. 

� Make sure to read "Anti-static Measures" and "Preparing Your 
System for Upgrade" before installing or removing options. 

� To install or remove CPU or DIMM, first power off the server 
before removing the CPU module.  The procedures described 
below are for replacement of DIMMs. 

� Removing the module being operating may cause unexpected 
trouble. Use the management software (e.g., ft series utility or NEC 
ESMPRO Manager) to identify the module to be removed so that 
the module is removed when it is stopped, without fail  
Then remove the relevant module after verifying the status LED on 
the CPU module. 

� Handle the module fixing screw with your hand, not by using any 
tool. 

� If you have replaced the module, attach an HDD ID label indicating 
the replaced module number to the upper part of the fixing screw of 
the module. 
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Removing CPU Module 

Follow the procedure below to remove the CPU module. 

1. Stop the CPU module you want to remove. 

To this end, use the ft series utility of the NEC ESMPRO Agent installed to your server or 
the Data Viewer of the NEC ESMPRO Manager. 

For the detailed procedure, see "NEC ESMPRO Agent and Manager" - "Maintenance of 
NEC Express5800/ft series" in Chapter 5. 

  

NEC ESMPRO Manager 
Select [FTServer] → [CPU Module] → [[*]CPU 
Module (to be removed)] → [Maintenance] → 
[Bring Up/Bring Down] → [Bring Down]. 

ft series utility 
Select [FTServer] → [CPU Module] → [CPU 
Module (to be removed)] → [Bring Up/Bring Down] 
→ [Down]. 

 
After the CPU module enters into off-line status, the status LED will change as follows. 

Fail LED: Red 

State LED:  Off 

2. <Tower model> 

Unlock the front bezel with the security key and open it. 

<Rack-mount model> 

Unlock the front bezel with the security key and remove the upper and lower panels. 

3. Loosen the setscrews that secured the CPU module’s release lever. 

4. Hold the release lever of the CPU module and pull it off.   

The CPU module is slightly pulled out toward you. 

5. Firmly hold the handle and pull the CPU module slowly and carefully until the main unit 
is locked. 

IMPORTANT: Do not hold the other parts than the release lever to pull 
the module. 
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6. Pull off the module, pushing down the latch lever to unlock it. 

When half of the module is pulled out, ask another person to support it. 

IMPORTANT:  
� Do not hold the other parts than the release lever to pull the module.  

� Carefully handle the CPU module so that you will not drop it or 
strike it against other server internal devices. 

 

 

 

7. Carefully place the CPU module on the flat and sturdy table. 

Avoid the dusty or humid place. 

8. Remove the two setscrews on the front of the CPU module and one setscrew on the back. 

 

 

9. Slide the top cover a little to remove it. 

Release lever

Release lever

Latch lever 
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This allows you to access the devices in the CPU module.  For more information on how 
to handle these devices, see the associated sections.  
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Installing CPU Module 

Follow the procedure below to install the CPU module:  

IMPORTANT: Make sure to read "Anti-static Measures" and 
"Preparing Your System for Upgrade" before starting installing or 
removing options. 

1. Install the top cover to the CPU module. 

NOTE: Check the left, right, and upper tabs on the cover are certainly 
engaged with the CPU module. 

 

2. Secure the top cover to the CPU module with the three setscrews. 

3. Firmly hold the CPU module with both hands and insert it into the server.  

Hold the module in such a way that its back plane connector faces the back of the rack and 
engage the guides of the module and chassis to insert it slowly. 
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4. Hold and push the release lever until the module is locked. 

5. Push down the latch lever to unlock it and push the module as far as it goes. 

6. Hold the release lever to push the module as far as it goes. 

7. Close the release lever. 

IMPORTANT: Unless the release levers are located inside the rack 
frame, the module won’t be mounted correctly. 

8. Screw the release levers.  

Release levers

Latch lever 

Wrong (The hook is 
located behind the frame.) 
 

Correct (The hook is located above the frame.) 
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9. Boot the installed CPU module. 

The system is defaulted to automatically boot the CPU module, once installed. 

If the automatic feature is disabled, boot the CPU module using the ft series utility of the 
NEC ESMPRO Agent installed to the server or the Data Viewer of the NEC ESMPRO 
Manager. 

For the detailed procedure, see "NEC ESMPRO Agent and Manager" - "Maintenance of 
NEC Express5800/ft series" in Chapter 5. 

  
NEC ESMPRO Manager 

Select [FTServer] → [CPU Module] → [(installed) 
[*]CPU Module] → [Maintenance] → [Bring 
Up/Bring Down] → [Bring Up]. 

ft series utility 
Select [FTServer] → [CPU Module] → [(installed) 
CPU Module] → [Bring Up/Bring Down] → [Up]. 
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DIMM 
The DIMM (dual inline memory module) is installed to the DIMM socket in the CPU module on the 
NEC Express5800/ft series. 

The CPU module board is equipped with six sockets.  Two standard DIMMs are mounted in 
DIMM#1 and #2 each.  (The standard DIMM can be replaced with another DIMM.) 

� N8800-027F: Two 128MB DIMMs 

� N8800-028F: Two 256MB DIMMs 

DIMMs should be installed to these sockets, starting from the lowest socket number. 

TIPS:  
� The memory capacity can be increased up to 3 GB (four 512 MB 

DIMMs). 

� The DIMM connector may be identified as "group" in POST, NEC 
ESMPRO, or error message/log of the Off-line Maintenance Utility.  
The number displayed after the group corresponds to the connector 
number shown in the figure below. 

 

IMPORTANT:  
� The DIMM is extremely sensitive to static electricity.  Make sure 

to touch the metal frame of the server to discharge static electricity 
from your body before handling the DIMM.  Do not touch the 
DIMM terminals or on-board parts with a bare hand or place the 
DIMM directly on the desk.  For static notes, see the section 
"Anti-static Measures" described earlier. 

� Make sure to use the DIMM authorized by NEC.  Installing a 
third-party DIMM may cause a failure of the DIMM as well as the 
server.  Repair of the server due to failures or damage resulted 
from installing such a board will be charged. 

� Before adding or removing DIMMs, power off the server and detach 
the CPU module. 

� Make sure to read "Anti-static Measures" and "Preparing Your 
System for Upgrade" before installing or removing options. 
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Note the followings to install or replace DIMM. 

� The DIMMs with the same number are linked among the groups.   When a DIMM is 
added to one group, another identical DIMM should be installed to the socket with the 
same number in another group.  This rule is applied to the case of removal. 

� The linked DIMMs should be of the same product with same performance. 

� DIMMs should be installed in sockets, starting from the lowest socket number. 

 

CPU module board
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Installing DIMM 

Follow the procedure below to install the DIMM.  Make sure to power off the server before 
starting installation except when replacing DIMM. 

1. Shutdown OS. 

The system turns off automatically and the POWER LED goes off. 

2. Disconnect power cord from outlet. 

3. Remove the CPU module. 

4. Check to be sure in which socket you are mounting the DIMM. 

5. Remove the connector cover from the socket. 

A DIMM connector cover is installed to the open socket.  When the levers on both ends 
of the connector are opened, the DIMM connector cover is unlocked and you can remove 
the cover. 

IMPORTANT: Carefully keep the removed DIMM connector cover. 
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6. Insert a DIMM into the DIMM socket straight. 

 

NOTE: Pay attention to the orientation of the DIMM.  The terminal of 
the DIMM has a cutout to prevent misinsertion. 

After the DIMM is completely inserted into the socket, the levers are automatically 
closed. 

7. Mount the CPU module. 

8. Connect the power cords. 

 

9. Press POWER switch to power on the module. 

10. Verify that POST displays no error messages. 

If POST displays an error message, take a note on the massage and see the POST error 
messages listed in Chapter 7. 

11. After starting the OS, set the paging file size to at least the recommended value (1.5 times 
the installed memory size). 
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Removing DIMM 

Follow the procedure below to remove the DIMM. Make sure to power off the server before 
installation except when replacing DIMM. 

NOTE: Unless at least two DIMMs are installed, the server does not 
work. 

1. Shutdown OS. 

The system turns off automatically and the POWER LED goes off. 

2. Disconnect power cord from outlet. 

3. Remove the CPU module. 

4. Open the levers on the target DIMM socket.  The DIMM is unlocked and you can 
remove the device. 

5. Mount the CPU module. 

 

6. Connect the power cable. 

7. Press the POWER switch to power on the module. 

8. Verify that POST displays no error messages. 

If POST displays an error message, take a note on the massage and see the POST error 
messages listed in Chapter 7. 
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Replacing DIMM 

Follow the procedure below to replace the failed DIMM. 

1. Identify the failed DIMM using the Data Viewer of the NEC ESMPRO Manager. 

 
2. Remove the CPU module. 

3. Replace a DIMM 

4. Install the CPU module. 

5. Boot the CPU module using the NEC ESMPRO Manager or ft series utility. 
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PROCESSOR (CPU) 
In addition to the standard CPU (Intel® Xeon™ Processor), you can add one CPU to make a 
multi-processor system. 

IMPORTANT:  
� The CPU is extremely sensitive to static electricity.  Make sure to 

touch the metal frame of the server to discharge static electricity 
from your body before handling the CPU.  Do not touch the CPU 
terminals or on-board parts with a bare hand or place the CPU 
directly on the desk.  For static notes, see the section "Anti-static 
Measures" described earlier. 

� Do not use the system before checking to see it works correctly. 

� Make sure to use the CPU authorized by NEC.  Installing a 
third-party CPU may cause a failure of the CPU as well as the server.  
Repair of the server due to failures or damage resulted from 
installing such a board will be charged. 

� Before adding or removing CPU, power off the server and detach 
the CPU module. 

� Make sure to read "Anti-static Measures" and "Preparing Your 
System for Upgrade" before starting installing or removing options. 

 

CPU#2 
(additional) 

CPU#1 
(standard) 
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Installation 

Follow the steps below to mount a CPU: 

1. Shut down OS. 

The server will be powered off automatically. 

2. Unplug the power cord. 

3. Remove the CPU module. 

4. Detach the CPU air duct. 

  
5. Check to be sure of the location of the CPU socket. 

 

6. Remove the anti-dust sheet from the socket. 

IMPORTANT: Carefully keep the removed sheet. 

7. Lift the socket lever. 

IMPORTANT: Open the lever fully. It can be opened 120° or more. 
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8. Place the CPU carefully on the socket. 

NOTE: Pay attention to the 
orientation of the CPU.  The CPU 
and socket have pin marks to 
prevent misinsertion.  

 

9. After pressing the CPU softly against 
the socket, close the levers to fasten it. 

 

 

 

 

10. Affix an included cool sheet 
(heat-radiation sheet: one piece) on top 
of the CPU. 

Place the sheet to cover the chip 
segment. 

IMPORTANT:  
� Since a cool sheet is very easy 

to break, you need to handle it 
carefully.  If it breaks, replace 
it with new one.  It cannot be 
reused. 

� Use one sheet for one CPU.  
Do not place more than one 
sheet on a single CPU.  Keep 
the rest of the sheets for future 
use. 

� Sometimes, a cool sheet has 
already been affixed on the heat 
sink. 

 

11. Place the heat sink on top of the CPU. 

Pin marks

Cool sheet 

Chip 
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12. Fasten the heat sink with its clip. 

Engage the clip holes with tabs on the sides of the retention: engage one hole first and 
engage the other holding the first hole. 

 
13. Check to see if the heat sink is mounted parallel with the motherboard. 

IMPORTANT:  
� If the heat sink is not parallel to the motherboard, dismount and 

remount it.  You cannot mount the heat sink correctly due to the 
following: 

- CPU is not mounted correctly 

- The heat sink clip is not engaged correctly. 

� Do not hold the fastened heat sink to move the CPU. 
 

14. Attach the CPU air duct. 

NOTE: Check to see if the air duct is attached securely with its 
projected parts inserted into the chassis.  

 
15. Install the CPU module. 

16. Connect the power cord. 
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17. Press the POWER switch to power on the module. 

18. Verify that POST displays no error messages. 

If POST displays an error message, take a note on the massage and see the POST error 
messages listed in Chapter 7. 

19. To operate a multi-processor system, do the following: 

If in “Computer” of Device Manager, [Driver] is set to “ACPI single processor PC,” 
change it to “ACPI multi-processor PC” and restart the server to update the system. 

 

Removing CPU 

Follow the steps below to remove the CPU.  Except when you replace the CPU with a new one, 
power off the server. 

IMPORTANT:  
� Do not remove the CPU unless it is faulty. 

� If a CPU is not mounted on CPU#2, cover it with an anti-dust sheet. 

� After operation, the cool sheet at the bottom of the heat sink may 
stick to the CPU because of heat.  When you dismount the heat 
sink, turn it lightly to make sure that the heat sink is not sticking to 
the CPU.  Otherwise, the CPU or socket may be damaged. 

 

1. Shut down OS. 

The server will be powered off automatically. 

2. Unplug the power cord. 

3. Remove the CPU module. 

4. Detach the CPU air duct. 

5. Dismount the heat sink using the dismount tool included with the additional CPU. 
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6. Remove the CPU. 

7. Affix an anti-dust sheet on the CPU socket. 

Place the adhesive part on the opposite side of the lever.  Any part of the sheet place off 
the socket. 

8. Install the CPU module. 

9. Connect the power cable. 

10. Press the POWER switch to power on the module. 

11. Verify that POST displays no error messages. 

If POST displays an error message, take a note on the massage and see the POST error 
messages listed in Chapter 7. 

 

Replacing CPU 

Follow the steps below to replace a failed CPU: 

 
1. Use Data Viewer of NEC ESMPRO Manager to check the failed CPU. 

2. Remove the CPU module. 

3. Replace the CPU. 

4. Install the CPU module. 

5. Start the CPU module from ft Series Utility or NEC ESMPRO Manager. 

In the initial setting, the server will start up automatically upon mounting the PCI module.  
If it is set not to start up automatically, use Data Viewer of NEC ESMPRO Manager or ft 
Series Utility to start it. 
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PCI MODULE 
Three PCI boards can be installed to the PCI module. 

Up to two PCI boards can be added to each PCI module, therefore, the server can accommodate four 
additional PCI boards at a maximum (one video board has already been installed to each PCI 
module in standard configuration). 

Remove the PCI module when adding or replacing the PCI board.  The figures used in this section 
show the tower model.  The orientation is the only difference from the rack-mount model. 

IMPORTANT:  
� Ask your sales agent to replace the cooling fan and PCI module. 

� Make sure to read "Anti-static Measures" and "Preparing Your 
System for Upgrade" before starting installing or removing options. 

� Handle the module fixing screw with your hand, not by using any 
tool. 

� If you have replaced the module, attach an HDD ID label indicating 
the module number to the upper part of the screw fixing the module. 

 

TIPS: The primary PCI module is the one whose POWER LED is on. 
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Precautions 

� If you remove a PCI module during operation, dual configuration of its internal hard disks 
will be cancelled.  If you mount the module again, the dual configuration will be restored 
automatically.  However, do not perform a system shutdown or remove any of the PCI 
modules before the dual configuration is completed.  Otherwise, hard disk data could be 
corrupted. 

� Removing the primary (active) module will cause unexpected trouble.  Be sure to 
remove the secondary (inactive) module. 

� When the secondary BMC is not in synchronous condition, removing the PCI module on 
the primary BMC will lose the SG data (system data).  If one of the STATUS LEDs is 
blinking in red, do not remove the PCI module associated with another STATUS LED. 

When DC power is off: 

BMC#1 BMC#2 Status 
Off (Primary) Blinking in red 

(Secondary) 
(At 1-second intervals) 

Do not remove the PCI module on Primary 
BMC side.  
BMC Sync disabled. 

Off (Primary) Lit in red (Secondary) Do not remove either PCI modules. 
During BMC Sync. 

Off (Primary) Blinking in red 
(Secondary) 
(At 0.5-second intervals) 

Do not loosen a screw securing the PCI 
module or turn off the system power while 
the LED is blinking in red. 

 
When DC power is on: 

BMC#1 BMC#2 Status 
Lit in green 
(Primary) 

Blinking in red 
(Secondary) 
(At 1-second intervals) 

Do not remove the PCI module on Primary 
BMC side.  
BMC Sync disabled. 

Lit in green 
(Primary) 

Lit in red (Secondary) Do not remove either PCI modules. 
During BMC Sync. 

Lit in green 
(Primary) 

Blinking in red 
(Secondary) 
(At 0.5-second intervals) 

Do not loosen a screw securing the PCI 
module or turn off the system power while 
the LED is blinking in red. 

 
� When you remove a PCI module, the system will be powered off automatically.  If there 

is a CD-ROM in the drive, eject it before removing the module. 
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Removing PCI Module 

Follow the procedure below to remove the PCI module.  

1. Stop the PCI module you want to remove. 

To this end, use the ft series utility of the NEC ESMPRO Agent installed to your server or 
the Data Viewer of the NEC ESMPRO Manager. 

For more information, see "NEC ESMPRO Agent and Manager" - "Maintenance of NEC 
Express5800/ft series" in Chapter 5. 

  
NEC ESMPRO Manager 

Select [FTServer] → [PCI Module] → [[*]PCI 
Module (to be removed)] → [Maintenance] → 
[Bring Up/Bring Down] → [Bring Down]. 

ft series utility 
Select [FTServer] → [PCI Module] → [PCI Module 
(to be removed)] → [Bring Up/Bring Down] → 
[Down]. 

 

After the CPU enters into off-line status, the status LEDs of the PCI board and PCI 
module will change as follows.  

PCI board slot status LEDs (all of them): Off 

PCI module 

Fail LED: Red  

State LED: Off 
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2. <Tower model> 

Unlock the front bezel with the security key and open it. 

<Rack-mount model> 

Unlock the front bezel with the security key and remove the upper and lower panels. 

3. Disconnect the PCI module’s network cable and cables connected to the options. 

4. Loosen the setscrew securing the PCI module’s release lever. 

5. Hold the release lever of the PCI module and pull it off. 

The PCI module is slightly pulled out toward you. 

6. Firmly hold the handle and pull the PCI module slowly and carefully until the main unit is 
locked. 

IMPORTANT: Do not hold the other parts than the release lever to pull 
the module. 

 

7. Pull off the module, pushing down the latch lever to unlock it. 

When half of the module is pulled out, ask another person to support it. 

IMPORTANT:  
� Do not hold the other parts than the release lever to pull the module.  

� Carefully handle the PCI module so that you will not drop it or 
strike it against other server internal devices. 

 

 

8. Carefully place the PCI module on the flat and sturdy table. 

Avoid the dusty or humid place. 

Latch lever Release lever
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9. Remove the two setscrews on the front of the PCI module and one setscrew on the back.  

10. Slide the top cover a little to remove it. 

This allows you to access the devices in the PCI module.  For more information on how 
to handle these devices, see the associated sections. 
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Installing PCI Module 

Follow the procedure below to install the PCI module: 

IMPORTANT: Make sure to read "Anti-static Measures" and 
"Preparing Your System for Upgrade" before starting installing or 
removing options. 

1. Install the cover to the PCI module. 

NOTE: Check the left, right, and upper tabs on the cover are certainly 
engaged with the PCI module. 

 

 
2. Secure the top cover to the PCI module with the three setscrews.  

3. Firmly hold the PCI module with both hands and insert it into the server. 

4. Hold the module in such a way that its back plane connector faces the back of the rack and 
engage the guides of the module and chassis to insert it slowly.  

5. Hold and push the release lever until the module is locked. 

IMPORTANT: Do not hold the other parts than the release lever to pull 
the module. 

6. Push down the latch lever to unlock it and push the module as far as it goes. 
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7. Connect the network cable and option cables. 

8. Close the release lever. 

IMPORTANT: Unless the release levers are located inside the rack 
frame, the module won’t be mounted correctly. 

9. Screw the release levers. 

 
 

Release lever Latch lever 

Release lever

 
Wrong (The hook is located behind the frame.) 

Correct (The hook is located above the frame.)
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10. Boot the installed PCI module. 

The system is defaulted to automatically boot the PCI module, once installed.  If this 
feature is disabled, boot the PCI module using the ft series utility of the NEC ESMPRO 
Agent installed to the server or the Data Viewer of the NEC ESMPRO Manager. 

For more information, see "NEC ESMPRO Agent and Manager" - "Maintenance of NEC 
Express5800/ft series" in Chapter 5. 

  

NEC ESMPRO Manager 
Select [FTServer] → [PCI Module] → [(installed) 
[*]PCI Module] → [Maintenance] → [Bring 
Up/Bring Down] → [Bring Up]. 

ft series utility 
Select [FTServer] → [PCI Module] → [(installed) 
PCI Module] → [Bring Up/Bring Down] → [Up]. 
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PCI BOARD 
Up to four PCI boards can be installed to the PCI module (however, one video board is already 
installed in each module in standard configuration). 

IMPORTANT:  
� The PCI board is extremely sensitive to static electricity.  Make 

sure to touch the metal frame of the server to discharge static 
electricity from your body before handling the PCI board.  Do not 
touch the PCI board terminals or on-board parts by a bare hand or 
place the PCI board directly on the desk.  For static notes, see the 
section "Anti-static Measures" described earlier. 

� Make sure to read "Anti-static Measures" and "Preparing Your 
System for Upgrade" before starting installing or removing options. 

� PCI#1 is a slot dedicated for video board, which is standard 
equipment.  Do not replace this broad with any other board. 

 

TIPS: When a PCI board is installed or removed, or the slot is changed, 
use the BIOS setup utility "SETUP" to change the detailed settings such 
as interrupt line (IRQ), when necessary.  See Appendix B for details. 

 

Note the followings to install or replace PCI board. 

� To make a dual PCI board configuration, install the same type of board (i.e., having the 
same specifications and performance) to the same slot in another group. 

When a PCI board is installed to one group, another identical PCI board should be 
installed to the same slot in another group.  This rule is applied to the case of removal. 

� Install the PCI boards, starting from the one with the smallest number. 

 

Video board

PCI#2

PCI#3

Built-in riser cards of PCI module
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Installing PCI Board 

Follow the procedure below to install the board to be connected to the PCI board slot. 

NOTE: To install the PCI board, make sure the shape of the board 
connector matches with the shape of the PCI board slot connector. 

1. Remove the PCI module. 

2. Remove the PCI module’s top cover. 

3. Identify the slot to which you want to install a PCI board and remove the connector cap. 

IMPORTANT: Carefully keep the removed connector cap. 

 

4. To install a long card, loosen the setscrew, slide the bracket, and secure it with the 
setscrew. 

5. Pull the PCI board retainer bracket from the inside. 

6. Unscrew the setscrew of the additional slot cover at the same position (level) as the target 
slot, and remove the slot cover. 

IMPORTANT: Carefully keep the removed additional slot cover. 

Screw 

Bracket 
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7. Align the terminal segment of the board with the connection of the slot and insert the 
board slowly into the slot. 

 

 

NOTE: Check to see if the edge of the bracket (taper) is inserted into a 
slot of the chassis.  In the case of a long board, check also to see if its 
other edge is inserted into the bracket guide. 

PCI board retainer
bracket 

Additional slot cover 

Guide Slots for inserting  
bracket edges 
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8. Align the PCI board with the guide rail groove and insert the board slowly. 

 
 

 

IMPORTANT:  
� If the insertion is unsuccessful, remove the board once and retry 

installation.  Note that if excessive force is applied to the board, it 
may be damaged. 

 

9. Attach the retainer bracket to fasten the PCI board. 
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10. In the case of a long board, slide the bracket to fasten the other edge of the board. 

 
 

11. Install the PCI module cover. 

12. Install the PCI module. 

13. Connect the network cable and option cables. 

14. Close the release lever. 

15. Secure the release lever with the setscrew. 

16. Boot the PCI module using the NEC ESMPRO Manager or ft series utility to establish a 
dual configuration. 

In the initial setting, the server will start up automatically upon mounting the PCI module.  
If it is set not to start up automatically, use Data Viewer of NEC ESMPRO Manager or ft 
Series Utility to start it. 

For more information, refer to "NEC ESMPRO Agent and Manager" - "Maintenance of 
NEC Express5800/ft series" in Chapter 5.  

17. Check the PCI module status LED and PCI board status LED. 

For description of LED indications, see “LED” in Chapter 2 and “Setup of Optional PCI 
Board” later in this chapter. 

18. Use cable ties to fasten the extra length of cables. 

Screw 

Bends for fastening
boards 
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 Cable ties (included

with cabinet) 
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Removing PCI Board 

Follow the procedure below to remove the PCI board.  

1. Remove the PCI module. 

2. Remove the PCI module’s top cover. 

3. Remove the PCI board retainer bracket to dismount the PCI board. 

In the case of a long board, unscrew the guide at the other edge and slide it to the front of 
the board. 

4. Install the additional slot cover to the open slot. 

5. Install the connector cover to the relevant slot. 

6. Attach the PCI board retainer bracket. 

7. Install the PCI module’s top cover. 

8. Install the PCI module. 

Do not close the release lever at this time. 

9. Connect the network cable and option cables. 

10. Close the release lever. 

11. Secure the release lever with the setscrew. 

12. Boot the PCI module using the NEC ESMPRO Manager or ft series utility to establish a 
dual configuration. 

In the initial setting, the server will start up automatically upon mounting the PCI module.  
If it is set not to start up automatically, use Data Viewer of NEC ESMPRO Manager or ft 
Series Utility to start it. 

For more information, refer to "NEC ESMPRO Agent and Manager" - "Maintenance of 
NEC Express5800/ft series" in Chapter 5. 

13. Check the PCI module status LED and PCI board status LED. 

For description of LED indications, see “LED” in Chapter 2 and “Setup of Optional PCI 
Board” later in this chapter. 
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Replacing PCI Board 

Follow the procedure below to replace the failed PCI board.  

1. Check the PCI board LED and identify the failed PCI board. 

When the PCI board is failed or incorrectly installed, the two LEDs associated with the 
PCI board slot are being turned off. 

2. Remove the PCI module. 

3. Remove the PCI module’s top cover. 

4. Remove the PCI board retainer bracket to dismount the PCI board. 

In the case of a long board, unscrew the guide at the other edge and slide it to the front of 
the board. 

5. Replace the board and fasten it. 

6. Install the PCI module’s top cover. 

7. Install the PCI module. 

Do not close the release lever at this time. 

8. Connect the network cable and option cables. 

9. Close the release lever. 

10. Secure the release lever with the setscrew. 

11. Boot the PCI module using the NEC ESMPRO Manager or ft series utility to establish a 
dual configuration. 

In the initial setting, the server will start up automatically upon mounting the PCI module.  
If it is set not to start up automatically, use Data Viewer of NEC ESMPRO Manager or ft 
Series Utility to start it. 

For more information, refer to "NEC ESMPRO Agent and Manager" - "Maintenance of 
NEC Express5800/ft series" in Chapter 5. 

12. Check the PCI module status LED and PCI board status LED. 

For description of LED indications, see “LED” in Chapter 2 and “Setup of Optional PCI 
Board” later in this chapter. 
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Setup of Optional PCI Board 

IMPORTANT:  

� To enable the fault-tolerant feature of the optional device, the 
identical devices must be installed to the same slots in groups 1 and 
2, respectively. 

� A video board is already installed to slot #1 as standard 
configuration.  This board may not be removed or replaced with 
any other board. 

� Change the BIOS settings.  For some optional PCI boards you may 
need to start up the BIOS setup utility to change the [Boot 
Monitoring Time-out Period] configuration in [Advanced] – 
[Monitoring Configuration].  For more details, see page 4-15. 

 

N8803-002F SCSI Controller                       

� Slots to install the board 

PCI slot 
Group 1 Group 2 N code Name 

#1 #2 #3 #1 #2 #3
Remarks 

N8803-002F SCSI controller – √ √ – √ √ Each PCI module can 
contain one board only. 

√: Can be installed.   –: Cannot be installed. 
 

� Installation of driver 

When you start the system with the N8803-002F SCSI Controller installed, the driver 
automatically becomes available by the plug-and-play feature. 

If the [Digital Signature Not Found] dialog box appears, click [Yes]. 

IMPORTANT: Insert N8803-002F after the installation of OS is 
completed. 
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� PCI Board Status LED Indications  

LED 
indications Description Action 

PCI board is mounted 
correctly and operates 
in duplex mode. 

The system operates normally. Off 

The PCI board is not 
mounted; is mounted 
incorrectly; or power 
is not supplied. 

If the PCI board is not mounted or is mounted 
incorrectly, just mount it correctly; there is no problem. 
Check the condition of power unit. 
When not solved, contact your sales agent. 

Amber Performing POST; or 
the PCI board is 
mounted correctly and 
operates in simplex 
mode. 

Simplex mode is not a problem. 
To use ft series features, attach a PCI board to a slot 
of the same on the other PCI module. 

Red Although the PCI 
board is mounted, it 
may be offline or not 
be working. 

Remount the PCI board correctly. 
Remount the PCI module correctly. 
When not solved, contact your sales agent. 

 

N8804-001P1 100BASE-TX Adapter Set 

� Slots to install the board 

PCI slot 
Group 1 Group 2 N code Name 

#1 #2 #3 #1 #2 #3 
Remarks 

N8804-001P1 
100BASE-TX 
adapter set 

100BASE-TX Adapter – √ √ – √ √  

√: Can be installed.   –: Cannot be installed. 

� Installation of driver 

The NEC Express5800/ft series duplicates one or two pairs of 100BASE-TX adapter sets 
(N8804-001P1) before using. 

After installing Operating System, install the drivers in the following procedure and make 
dual settings of the PCI board. 

TIPS: To perform this procedure, you have to log on the system as an 
Administrator or a member of the Administrators group. 

After installing the OS, follow the steps below to install a driver and establish a dual 
configuration: 
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1. Mount the N8804-001P1 100BASE-TX adapter to the slot with the same number in PCI 
module #1 and #2, and then start Windows 2000 Advanced Server. 

After starting Windows 2000 Advanced Server, the drivers are installed automatically. 

IMPORTANT: If the [Digital Signature Not Found] dialog box 
appears, click the [Yes] button. 

2. Build a dual LAN configuration. (See "Setting Dual LAN Configuration") 

IMPORTANT:  

� You can also select [Load Balancing] in step 3 in "Setting Dual 
LAN Configuration".  In this case, [Team #1:Adaptive Load 
Balancing Mode] is added to Network Component Tree. 

� Moreover, select [Stratus AA-U51500 10/100 Enet Adapter] instead 
of [Stratus emb-82559 10/100 Enet Adapter] in Steps 4 and 5. 

� If you build a dual configuration by using two pairs of adapters in 
Step 5, add an adapter in the same way. 

 
� PCI Board Status LED Indications 
 

LED 
indications Description Action 

Green Duplex is specified, however, 
the server works in simplex 
mode. 

Specify duplex (AFT, ALB). 
Specify an appropriate driver. 

PCI board is properly installed 
and operates in non-duplex 
mode (AFT, ALB).  (Does not 
depend on simplex or duplex.) 

In non-duplex mode, no special problem 
occurs. 

POST is operating or the PCI 
board is installed to operate in 
the duplex mode. 

The system is operating normally in duplex 
mode. 

Off 

The PCI board is not installed 
yet, the PCI board is installed 
incorrectly, or the power is not 
supplied. 

Mount the PCI board correctly. 
If the PCI board was not mounted, there is no 
problem. 
Check the condition of power unit. 
Remount the PCI module. 

The PCI board is not mounted; 
is mounted incorrectly; or power 
is not supplied. 

Wait for a while until the indication changes. If 
the indication unchanged, check the PCI board 
slot status using NEC ESMPRO Manager. 

Red 

Although the PCI board is 
mounted, it may be offline or not 
be working. 

Make the slot of the board installed from NEC 
ESMPRO Manager online. 
Mount the PCI board correctly. 

 



System Upgrade  8-69 

N8803-030F Fibre Channel Controller 

N8803-031F Fibre Channel Controller 

� Slots to install the board 

PCI slot 
Group 1 Group 2 N code Name 

#1 #2 #3 #1 #2 #3
Remarks 

N8803-030F Fibre Channel 
Controller 

– √ √ – √ √

N8803-031F Fibre Channel 
Controller 

– √ √ – √ √

Each PCI module can 
contain one board only. 
Only one of them can be 
mounted. (cannot be 
mounted together) 

√: Can be installed.   –: Cannot be installed. 

� Installation of driver 
When you start the system with the N8803-030F/031F Fibre Channel Controller installed,  
the driver automatically becomes available by the plug-and-play feature 

If the [Digital Signature Not Found] dialog box appears, click [Yes]. 

IMPORTANT: Insert Fibre Channel Controllers after the installation 
of OS is completed. Use Fibre Channel Controllers in pairs. Insert a 
Fibre Channel Controller into a slot in a PCI module and another Fibre 
Channel Controller into the slot at the same location in another PCI 
module. 

� PCI Board Status LED Indications 
LED 
indications Description Action 

PCI board is mounted 
correctly and operates 
in duplex mode. 

The system operates normally. Off 

The PCI board is not 
mounted; is mounted 
incorrectly; or power 
is not supplied. 

If the PCI board is not mounted or is mounted 
incorrectly, just mount it correctly; there is no problem. 
Check the condition of power unit. 
When not solved, contact your sales agent. 

Amber Performing POST; or 
the PCI board is 
mounted correctly and 
operates in simplex 
mode. 

To use ft series features, attach a PCI board to a slot 
of the same on the other PCI module. 

Red Although the PCI 
board is mounted, it 
may be offline or not 
be working. 

Remount the PCI board correctly. 
Remount the PCI module correctly. 
When not solved, contact your sales agent. 
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N8104-84 1000BASE-SX Adapter 

Consult your sales personnel for details when purchasing this hardware. 

IMPORTANT: Note the following about this product: 

� It is advisable to add this product to such environment that each 
system is used for a different purpose (ex. system line, maintenance, 
monitoring) and multiple accesses do not occur simultaneously. 

� If there are multiple accesses, the processing power and 
transmission speed may be somewhat affected. 

� Slots to install the board 

PCI slot 
Group 1 Group 2 N code Name 

#1 #2 #3 #1 #2 #3
Remarks 

N8104-84 1000BASE-SX Adapter – √ √ – √ √ Each PCI module 
can contain one 
board only. 

√: Can be installed.   –: Cannot be installed. 
� Installation of driver 

The NEC Express5800/ft series uses a pair of N8104-84 boards in duplex mode. 

After installing the drivers in the following procedure, perform a dual configuration setup. 

TIPS: To perform this procedure, you have to log on the system as an 
Administrator or a member of the Administrators group. 

After installing the OS, follow the steps below to install a driver and establish a dual 
configuration: 

1. Mount the N8104-84 adapter to the slot with the same number in PCI module #1 and #2, 
and then start the Windows 2000 Advanced Server. 

After starting Windows 2000 Advanced Server, the drivers are installed automatically. 

IMPORTANT: If the [Digital Signature Not Found] dialog box 
appears, click the [Yes] button. 

2. Build a dual LAN configuration. (See "Setting Dual LAN Configuration") 

IMPORTANT:  

� You can also select [Load Balancing] in step 3 in "Setting Dual LAN 
Configuration".  In this case, [Team #1:Adaptive Load Balancing Mode] is 
added to Network Component Tree. 

� Moreover, select [Stratus AA-U5700 Fiber Gigabit Server Adapter] instead of 
[Stratus emb-82559 10/100 Enet Adapter] in Steps 4 and 5. 
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� PCI Board Status LED Indications 

LED 
indications Description Action 

Green Duplex is specified, 
however, the server 
works in simplex 
mode. 

Specify duplex (AFT, ALB). 
Specify an appropriate driver. 

PCI board is properly 
installed and operates 
in non-duplex mode 
(AFT, ALB).  (Does 
not depend on 
simplex or duplex.) 

In non-duplex mode, no special problem occurs. 

POST is operating or 
the PCI board is 
installed to operate in 
the duplex mode. 

The system is operating normally in duplex mode. 

Off 

The PCI board is not 
installed yet, the PCI 
board is installed 
incorrectly, or the 
power is not supplied. 

Mount the PCI board correctly. 
If the PCI board was not mounted, there is no 
problem. 
Check the condition of power unit. 
Remount the PCI module. 

The PCI board is not 
mounted; is mounted 
incorrectly; or power 
is not supplied. 

Wait for a while until the indication changes. If the 
indication unchanged, check the PCI board slot status 
using NEC ESMPRO Manager. 

Red 

Although the PCI 
board is mounted, it 
may be offline or not 
be working. 

Make the slot of the board installed from NEC 
ESMPRO Manager online. 
Mount the PCI board correctly. 
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N8104-103 1000BASE-T Adapter 

Consult your sales personnel for details when purchasing this hardware. 

IMPORTANT: Note the following about this product: 

� It is advisable to add this product to such environment that each 
system is used for a different purpose (ex. system line, maintenance, 
monitoring) and multiple accesses do not occur simultaneously. 

� If there are multiple accesses, the processing power and 
transmission speed may be somewhat affected. 

� Slots to install the board 

PCI slot 
Group 1 Group 2 N code Name 

#1 #2 #3 #1 #2 #3
Remarks 

N8104-103 1000BASE-T Adapter – √ √ – √ √ Each PCI module 
can contain one 
board only. 

√: Can be installed.   –: Cannot be installed. 
 

� Installation of driver 

The NEC Express5800/ft series uses a pair of N8104-103 boards in duplex mode. 

After installing the drivers in the following procedure, perform a dual configuration setup. 

TIPS: To perform this procedure, you have to log on the system as an 
Administrator or a member of the Administrators group. 

After installing the OS, follow the steps below to install a driver and establish a dual 
configuration: 

1. Mount the N8104-103 adapter to the slot with the same number in PCI module #1 and #2, 
and then start the Windows 2000 Advanced Server. 

After starting Windows 2000 Advanced Server, the drivers are installed automatically. 

IMPORTANT: If the [Digital Signature Not Found] dialog box 
appears, click the [Yes] button. 

2. Build a dual LAN configuration. (See "Setting Dual LAN Configuration") 

IMPORTANT:  

� You can also select [Load Balancing] in step 3 in "Setting Dual 
LAN Configuration".  In this case, [Team #1:Adaptive Load 
Balancing Mode] is added to Network Component Tree. 

� Moreover, select [NEC 8490XT Copper Gigabit Adapter] instead of 
[Stratus emb-82559 10/100 Enet Adapter] in Steps 4 and 5. 
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� PCI Board Status LED Indications 

LED 
indications Description Action 

Green Duplex is specified, 
however, the server 
works in simplex 
mode. 

Specify duplex (AFT, ALB). 
Specify an appropriate driver. 

PCI board is properly 
installed and operates 
in non-duplex mode 
(AFT, ALB).  (Does 
not depend on 
simplex or duplex.) 

In non-duplex mode, no special problem occurs. 

POST is operating or 
the PCI board is 
installed to operate in 
the duplex mode. 

The system is operating normally in duplex mode. 

Off 

The PCI board is not 
installed yet, the PCI 
board is installed 
incorrectly, or the 
power is not supplied. 

Mount the PCI board correctly. 
If the PCI board was not mounted, there is no 
problem. 
Check the condition of power unit. 
Remount the PCI module. 

The PCI board is not 
mounted; is mounted 
incorrectly; or power 
is not supplied. 

Wait for a while until the indication changes. If the 
indication unchanged, check the PCI board slot status 
using NEC ESMPRO Manager. 

Red 

Although the PCI 
board is mounted, it 
may be offline or not 
be working. 

Make the slot of the board installed from NEC 
ESMPRO Manager online. 
Mount the PCI board correctly. 
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Appendix A 

Specifications 

NEC Express5800/320Lb NEC Express5800/320Lb-R 
Item N8800-027F N8800-028F 

CPU Type Intel  Xeon™ Processor × 1 
 Clock/second cache 2.4GHz/512KB 
 Number of processors 1 
Chipset Server Works Server Set III GC-LE 

256MB (128MB × 2*) Standard 
*Each module has a DIMM in standard configuration. 

Maximum 3GB (The standard DIMM must be replaced.) 
Expansion unit 2 DIMMs (128MB × 2/ 256MB × 2/ 512 MB × 2) 
Memory module DDR200 SDRAM DIMM (Registered Type) 

Memory 

Error check ECC 
Graphics (VRAM) CT69000 (VRAM 2MB) 

Floppy disk (standard) 3.5-inch drive × 1 (USB) 
Hard disk (standard) None 
Hard disk (maximum) 329.0GB* (18.1GB × 2 + 73.2GB × 4) 
 * The user area is reduced to a half of the physical capacity 

due to software mirroring. 

Auxiliary 
input 
device 

CD-ROM (standard) ATAPI interface × 1 (Load on tray type, x24 speed) 
A ready drive is indicated by POWER LED of that PCI 
module. 

5.25 inch  None File bay 
3.5 inch 6 slots 
PCI  6 slots Additional 

slot  (2 slots are used for graphics board.) 
LAN interface 1000BASE-T/100BASE-TX/10BASE-T (2 ports); 

100BASE-TX/10BASE-T (2 ports) 
USB 4-pin (2 ports) 2 ports are used by keyboard and external USB 

FDD. 
Serial D-sub 9-pin (2 ports) 
Network RJ-45 (4 ports) 

External 
interface 

Display MINI D-sub 15-pin (1 port) 
Cabinet design Deskside and mini-tower Rack-mount type 
External dimensions 222 (width)* × 560 (height) × 

795 (depth) mm 
*370mm if stabilizers included

480 (width) × 177 (height) × 
790 (depth) mm  

Weight 68 kg (Max. 73kg) 56 kg (Max. 61kg) 
Power supply 100 to 120 VAC ±10%, 200 to 240 VAC ±10%, 50/60 Hz ±1 

Hz 
Power consumption 880 VA, 870 W 

Temperature 10 to 35°C Environmental 
requirements Humidity 20 to 80% RH (no condensation) 

Use the factory-set configuration.  Modifications to the hard disk configuration may cause trouble. 
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Appendix B 

I/O Port Address 

The factory-set I/O port addresses for the server are assigned as follows: 

Address Chip in Use 
00-1F
20-21
2E-2F
40-43

60
61
64

70-71
80-8F
A0-A1
C0-DF
E0-E9

F0
F1-FF

170-177 or BAR2
1F0-1F7 or BAR0

278-27F
2F8-2FF

BAR or 376
370-377
378-37F
3B0-3BB
3BC-3BE
3C0-3DF

3F6 or BAR1
3F0-3F7
3F8-3FF

40B
4D0
4D1
4D6

580-58F
C00
C01
C14
C49
C4A
C52
C6C
C6F

CA2-CA3

8-bit DMA control register 
Master 8259 programming interface 
Configuration 
8254 programming interface 
Keyboard & mouse 
NMI status register 
Keyboard & mouse 
NMI enable register/real-time clock 
16-bit DMA control register 
Slave 8259 programming interface 
DMA controller page register 
Base address register 
Register IRQ13 
Logical device configuration 
EDMA2-compatible mode primary command block register 
EDMA2-compatible mode secondary command block register 
(Parallel port 3) 
Serial port 2 
EDMA2-compatible mode secondary command block register 
(Floppy disk drive 2), IDE 2 
(Parallel port 2) 
VGA 
Parallel port 1 
VGA 
EDMA2-compatible mode primary command block register 
(Floppy disk drive 1), IDE 1 
Serial port A 
DMA1 expansion write mode register 
Master 8259 ELCR programming 
Slave 8259 ELCR programming 
DMA2 expansion write mode register 
SMBus control 
PCI IRQ mapping index register 
PCI IRQ mapping data register 
PCI error status register 
Address & status control 
Rise time counter control 
General register (GPMs) 
ISA wait register 
Other control registers 
IPMI (IMPI KCS interface) 
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Address Chip in Use 
CA4-CA5 

CA6-CA-7 
CD6 
CD7 

CF8, CFC 
CF9 

F50-F58h 
BAR4+00-0F 

IPMI (SMI interface) 
IPMI (SCI/SW1 interface) 
Power management index register 
Power management data register 
PCI configuration space 
Reset control 
General chipset 
EDMA2 PCI base address register 4 

* Expressed in hexadecimal digits. 
* I/O port addresses of PCI devices are specified based on the type and number of PCI devices. 

 


